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Chapter 1 Introduction 
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Welcome! 
EFI PrintSmith ® is the latest in a series of management applications for Apple Macintosh ® and 
Microsoft Windows ® based computers. PrintSmith is an incredibly powerful and flexible, yet easy 
to use program, that fully supports many of the most powerful features built into your computer 
including: color, multiple monitors, drag and drop, asynchronous i/o, multi-threaded execution, 
integrated e-commerce, integrated credit card approval and more. All of these technical features 
are used to create the most flexible and powerful management package you have ever seen. 
PrintSmith combines estimating, invoicing, billing, point of sale, e-commerce, and accounts 
receivable into a single software package. Automating and streamlining the estimating process lets 
you spend more time selling your products and managing your shop. Automating your front counter 
and accounts receivable makes managing your shop simpler and improves your cash flow. 
PrintSmith allows you to do many different things at once – use the cash register, post payments, 
create estimates, look up old orders and customer history – without interrupting other functions.  

This flexibility translates into increased profits by speeding up the order cycle, reducing errors, 
giving you more control over pricing and production with less management time wasted on 
repetitive tasks. 

PrintSmith was carefully designed to support commercial printing, trade printers, copy shops, and 
quick printers. It provides the sophistication needed in commercial printing (like support for web 
presses, signatures, and large format presses) without requiring that you use or understand 
features, which do not apply to your business. With PrintSmith, you are assured that as your 
business grows and changes, your management system is flexible and powerful enough to grow 
with you.  

PrintSmith offers fully networked, multi-user systems enabling more than one user to take 
advantage of the power of PrintSmith. It is so powerful, when you create a new estimate or invoice, 
it instantly appears on all Workstations on the network. We do not require you to dedicate a 
computer as a traditional “file server”, the Master station is expected to be used as an integral, 
working PrintSmith program – even as a front counter machine serving cash register duty. We can 
do this because the networking software is built right into PrintSmith so you will not require any 
other networking software to use it. 
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Using This Guide 
This guide describes how to use the PrintSmith Management System. It is divided into sections 
corresponding to the system’s modules, as well as configuration and administration tasks. The 
manual assumes that users: 

• Have fundamental computer skills and knowledge. 

• Understand basic computer terminology. 

• Have read the PrintSmith Installation Guide and properly installed PrintSmith. 

Notes:  Certain features discussed in this guide are based on specific PrintSmith configuration 
parameters including add-on modules and therefore are not applicable to all users.  
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PrintSmith Modules Overview 
PrintSmith has several modules; the Estimator, Point Of Sale, Accounts Receivable, and 
Administration. 

Estimator 
The Estimator contains all the functionality needed to perform the most sophisticated estimating, 
while still providing a streamline process for creating a simple quote. With PrintSmith, you can price 
products, services, or materials using any combination of pricing methods: flat rate, cost plus 
markup and/or rate, hourly rates, variable markups, and price lists. You name and define the pre-
press and bindery functions specific to your shop or you can use the predefined operations. With 
virtually unlimited number of charges available for pre-press and bindery functions, plus on-line 
stock lists, press definitions, copier definitions and price schedules, we give you the flexibility the 
graphic arts industry and a growing business demands. PrintSmith comes with a completely 
defined pricing system with definitions and functions for everything from camera work to packaging. 
This pricing system can be quickly adapted to your operation. At any time, you can print an 
estimate, an invoice, quote or thank you letter, a job ticket, or price list for any job using pre-printed 
forms, letterhead, or blank sheets.  

Point of Sale 
Point Of Sale (POS) provides all the functions you normally expect of a dedicated Cash Register. 
You have the ability to enter sales and payments, keep a record of each transaction, print receipts, 
process credit cards, and open a cash drawer (with the optional Cash Drawer, Credit Card 
activation and Receipt Printer). Because the cash register function is implemented in software 
rather than a dedicated machine, it can provide a detailed breakdown of each transaction by: 
date/time, who performed it, what was done, and the account to which the transaction was posted. 
If you have an external Cash Register, use Point Of Sale to enter the totals from that machine into 
PrintSmith, which will become part of the detailed sales analysis PrintSmith performs each day. 
Even if you have no need for a cash register, POS functions as a link between the Estimator and 
Accounts Receivable by tracking each Estimate and the status of all jobs in progress and those 
awaiting pick up or delivery. When an invoice is delivered to your customer and picked up in 
PrintSmith, it is automatically posted to accounts receivable and added to the full account history 
for each customer.  

Accounts Receivable 
Accounts Receivable is a full featured “open item” system. It is very simple to use and is capable of 
generating statements and tracks account history by open items or by the month, quarter, year, and 
more. It generates a detailed sales or cost analysis for any period or customer; you will know where 
your sales revenue is coming from (printing, copying, bindery, etc.) PrintSmith also tracks sales tax 
by sales or by cash receipts, which accommodates both accrual and cash basis tax reporting. 
PrintSmith calculates and applies finance charges, keeps track of credit limits for each account, 
ages accounts (providing either a detailed or summary aging report), freezes accounts, and marks 
inactive accounts for follow-up. You can print mailing labels for both customers and prospects, 
generate mail merge documents for form letters, rank customers by sales volume, track, for each 
customer, sales by month, by year including average order, and even track the ratio of estimates to 
orders. AR can handle partial payments and payments on account and keeps track of the payment 
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history for each invoice. PrintSmith’s comprehensive sales tax reporting system supports many tax 
tables if there are multiple tax rates in your region. Best of all, it does all this quickly, intuitively, and 
simply.  

Administration 
Administration is a series of tools that set preferences for how PrintSmith is used on a daily basis, 
security for access to those features, how documents are presented, how the integrated e-
commerce web site is configured and many other tools that have sweeping effects on how 
PrintSmith works in your operation.  

Optional Features/Modules 
PrintSmith comes in a variety of configurations. The following is a simple description of key 
features. Please see www.printsmith.com or contact a sales representative for more detailed 
information. 

• PrintSmith Estimator - This system is suitable for shops that only need to generate 
estimates. It fully supports all pricing functions available in PrintSmith, but does not include any 
reports, POS or AR functions. 

• PrintSmith Lite - PrintSmith Lite is the Estimator plus Invoicing, Customer Lists, Work in 
Progress, and Stock Ordering. It does not include any sales analysis reports, Account History, 
or POS and AR functions. 

• PrintSmith CopyShop - The CopyShop version of PrintSmith was designed to support copier 
based operations. It does not support estimating for traditional printing but is otherwise a 
complete PrintSmith system. 

• PrintSmith - The full PrintSmith system contains all of the function in the PrintSmith CopyShop 
and adds support for printing and list pricing. 

• Multi-User - PrintSmith supports multi-user networks for each of the above system 
configurations. With the Multi-User software and Workstation software installed, you can have 
more than one person creating invoices, estimates, posting payments and so on. Everyone 
shares the same database and a change made in one Workstation instantly shows up at all 
Workstations. Upgrading to Multi-User is easy. Install the Workstation software on each 
machine. You can purchase as many Workstations as you need. 

• Multi-Platform Networks - This upgrade is included in PrintSmith for Windows and 
Macintosh. It supports any mixture of Macintosh and Windows supported computers on the 
same network. 

• PrintSmith Portable - This version of PrintSmith was designed for people who need to take 
their business with them on the road. With the PrintSmith Portable you have access to 
customer accounts and prospects, can create quotes or even invoices, capture new account 
information and then, when you get back to the office, automatically transfer all the information 
into your central database. 

• DownLoader - PrintSmith creates and manages a database that contains, among other 
things, the details of each invoice and estimate in the system. The DownLoader is a utility for 
extracting this information from PrintSmith for use in spreadsheets, other accounting 
packages, and other databases. In addition to invoices, you can extract customer and sales 
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information and almost all of the data in your pricing system. It comes with templates for the 
popular FileMaker Pro® data base program from Claris. 

• Report Writer - Report Writer is a world class report editor and management system that is 
fully integrated with PrintSmith. Using the Report Writer you can modify reports identical to the 
ones built into PrintSmith to suit your specific business needs or build your own. Report Writer 
includes a Report Wizard to assist in building your own custom reports and job tickets from any 
workstation. With Report Manager you can easily distribute, schedule automatic report 
generation.  

• PrintSmith Site - This E-commerce product offers unparalleled ease of use and management. 
If you already have a web site, you can add E-Commerce capabilities easily and quickly! 

• PrintSmith Composer – Also referred to as Design Composer, this tool is used to create 
online editable variable data items.  Customers can then enter variable data online through 
PrintSmith Site and provide you with a print ready file. 

• Integrated Credit Card Approval - This integrated processing provides seamless credit card 
approval within PrintSmith from every workstation. It’s a secure, safe, and reliable method to 
get immediate payment. 

• Extended Price Book Generator - This option, available on PrintSmith and CopyShop 
systems only, allows you to create templates for price books and to generate complete high 
quality counter price books. It includes such things as font control, shading, rules, plus many 
pricing controls. You can easily create a price book for 4 color printing with just your coated 
stocks, for example.  

• Cash Drawer and Receipt Printer - PrintSmith includes support for a mechanical cash drawer 
and receipt printer. By adding these optional hardware items, you can use PrintSmith as a full 
featured cash register. 

• Bar Code Reader - PrintSmith supports job tracking using bar codes on job tickets with a 
menu of standard bar coded locations. You can attach a bar code to any computer running 
PrintSmith software and use it to track jobs.  

• International Versions - PrintSmith has versions of PrintSmith for a variety of international 
markets and languages. Contact us for availability of a system in your language and for 
information on ordering and support for these products. 

• Tracker Module – This module allows shop floor data collection for those customers looking 
for true costing of time and materials on all jobs.  
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Chapter 2 PrintSmith Overview 
PrintSmith is a menu driven application. As such, you do not need to memorize codes and rules. 
Menu commands open windows in which you enter data to complete tasks. 

In this chapter 

Starting PrintSmith 19 
Standard Interface Features 20 

 

Starting PrintSmith 
To start PrintSmith: 

1. Double click on the PrintSmith Application  icon within the PrintSmith Folder or 
your PrintSmith alias/shortcut (if you created one). Following a splash screen, the 
PrintSmith Log In window opens. 

Figure 2.1: PrintSmith Log In Window 

  

2. Leave the User ID and Password fields blank. PrintSmith ships with a disabled 
security system. Initially, you will not be required to enter a User Name and 
Password. As part of the setup, you will enable the security system, restricting the 
ability to access PrintSmith without entering a user ID and password. 

3. Click the OK button to enter PrintSmith. The PrintSmith Menus are displayed at the 
top of the screen. 
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Standard Interface Features 

Macintosh versus Windows Interfaces 
PrintSmith is available for both the Windows and Macintosh operating system platforms. The look 
and feel of screens may be slightly different but the tasks performed are essentially the same. Most 
of the differences are user interface items such as button shapes, window frames, and keyboard 
commands. For example, Windows users will perform entries using the Control (CTRL) key and 
Mac users will use the Command key ( ). 

Interface Windows 
Windows appear differently based on the operating system. Following are sample windows that 
depict the window differences between Windows Operating Systems, Classic OS Operating 
Systems, and OSX Operating Systems. 

Figure 2.2: OSX Macintosh Example 
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Figure 2.3 Windows Example 

 
 

Moving a Window 
When you move a window, PrintSmith remembers the location and displays the window in the 
same location the next time the window is opened. 

To return a window to the original default position, press the <option> key (on Macintosh) or the 
<Alt> key (on Windows) while opening the window. To center a window, press the <shift> key while 
opening the window. 

Resizing a Window 
Some windows can be resized by clicking and holding on the bottom right corner of the window, 
and then moving the mouse in the appropriate direction to increase or decrease the window size.  

To return the window to the original default size, press both the <option> and <control> keys when 
opening the window. 

Note:  On Macintosh, the window can also be resized to full screen by selecting Zoom Window 
from the Window menu.  

Closing Windows 
To close all windows, press the <option> key (Macintosh) or the <Alt> key (Windows) while closing 
one of the windows. 



EFI PrintSmith 7.2 |  Reference Guide 

 
 

 
Page 22 

Switching Windows 
Selecting the Window menu displays a list of all open windows, from which the user can select one 
of the windows to bring to the front and make the active/working window. 

Note: The Window menu only appears in Mac installations. 
Figure 2.4: Window Menu 

 

Zoom Window Expands the active window to maximum size. This item is only available for some 
windows. If this functionality is not available for the active window, the menu item is 
grayed out. 

Minimize Window Collapses the active window, making the next available window the active window. 
Bring All To Front Brings all PrintSmith windows to the front (since other application’s windows can get 

mixed in with the PrintSmith windows in OSX). 
 

Table 2.1: Window Status Key 
Symbol Definition 

   

 Dot 
Data has been entered but not 
saved/filed. 

 Diamond Window has been minimized. 

 Checkmark Active window. 
   

 

List of Open Windows

Window Controls
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Hierarchical Lists 
Hierarchical lists present large lists of data in a manageable format. A hierarchical list consists of 
containers and items. A container (as the name suggests) has items within it. Containers are 
denoted with arrows to the left of container name. When the arrow is pointing to the right, the 
container is collapsed (not displaying its contents). When the arrow is pointing downward, the 
container is expanded (contents of the container are displayed). There can be containers within 
containers. These sub-containers are also denoted with an arrow and can be expanded and 
collapsed to display or hide the items within the container. 

Figure 2.6: Hierarchical Lists 

 

 

 

 

 

 

Navigating Hierarchical Lists Using the Keyboard 
If using the keyboard to navigate a hierarchical list, use the following commands: 

Right Arrow Key – Expands Container 

Left Arrow Key – Collapses Container 

Up/Down Arrow Keys – Moves to the item above or below the currently highlighted item. The 
option key pressed simultaneously with the up or down arrow key, moves up or down to the next 
item at the same level in the hierarchy. If the control key is pressed simultaneously, the nearest 
container at a higher level is highlighted. 

Container 

Sub-Container 

Item 
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Scrollable List with Column Headers  
Scrollable lists with column headers display select information regarding an item. Each column is 
adjustable, allowing you to view more or less information for a specific column. In some lists, the 
data can be sorted based on specific columns.  

Figure 2.6: Scrollable List with Column Headers Example 

 
 

Sorting Scrollable List Columns 
Information in many scrollable lists with headers can be sorted. An arrow to the right of the column 
name (in OSX) denotes the direction in which this column in the table is sorted. On other platforms, 
the direction of the sort is denoted on the right side of the header. To sort table information by a 
specific column:  click the column heading of the column to be sorted. The column by which the list 
is currently sorted is highlighted. An arrow icon is displayed. If the arrow is pointing upward, the list 
is being sorted in ascending order. If the arrow is pointing downward, the list is being sorted in 
descending order. 

Note:  If in the OSX environment, each column can be sorted in separate directions. 
 

Sorted Column Column Header 

Scrollable List with 
Column Headers 

Number of Items 
Displayed and the 

Number of Items 
Available 
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Drop Tabs 
Many PrintSmith windows contain Drop Tabs. Drop tabs present a group of options from which 
users can select one item associated with the screens information, such as customer name, 
account number and/or reference number. A displayed tab extends below non-selected tabs and 
the tab’s text is displayed in green. 

Figure 2.7: Example of Drop Tabs 

 

Users select tabs using the mouse or they may choose to use the keyboard by pressing [Cmd/Ctrl] 
+ [shift] plus the underlined letter of the appropriate tab.  

Buttons 
Identifying the Default Button 
Most system windows contain a default button. The default button is indicated by a dark highlight 
around the button. When highlighted, pressing the [return] key performs the same action as clicking 
the button. A windows default button may change as users perform entries. 

Using Common Buttons 
Generally in each PrintSmith window contains the following buttons: 

OK — Users process and/or save information. 

Cancel — Cancel any changes made on the screen and close the window. 

Close (or Done) — Users wish to close and exit the screen. If changes have been made in the 
window, PrintSmith prompts the user to save the changes. 

Keyboard Combinations 
Some users would rather make keyboard entries instead of using the mouse. PrintSmith allows 
users to press key combinations on the keyboard to perform the same action as clicking a button 
with the mouse.  



EFI PrintSmith 7.2 |  Reference Guide 

 
 

 
Page 26 

Data Entry Fields 
Text and Memo Fields 
Some PrintSmith text fields have a limit to the number of characters that may be entered in the 
field. If a user exceeds the numbers of characters available, the system will beep and refuse to 
accept any more data.  

If there is room in a field for more text than can be displayed, PrintSmith automatically scrolls the 
text as you type to keep it visible.  

Users may use the keyboard arrow keys to move about in a text field. If the text is too large to fit in 
the display area, PrintSmith scrolls the text so that the cursor is always visible.  

Navigating Text Fields 

Pressing the [Tab] key advances the cursor to the next field.  

Pressing [Shift] + [Tab] moves the cursor to the previous field. 

Macintosh:  Use the Delete and the Forward Delete keys to delete text to the right and left of the 
cursor, respectively. 

Windows:  Use the Delete and Backspace keys to delete text to the right and left of the cursor, 
respectively. 

Many windows contain scrolling lists. In these lists, you can use the arrow keys as well as the 
<home>, <end>, <page up>, and <page down> keys to move within the list and to change the 
selected item. You can usually select items by name by typing the first few characters in the name. 
If your keyboard has special function keys, <F1> through <F4> are equivalent to Cut, Clear, Copy, 
and Paste. PrintSmith allows you to override most of the prices it generates. It indicates an override 
by displaying the number in outlined text on Macintosh and with underlined text on Windows. You 
cancel an override by selecting the entire field and pressing <delete> to remove it (<backspace> on 
some keyboards), then <return>, or <tab> to restore the original price.  
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Using PrintSmith Menus 
File Menu 
The File menu presents a group of standard menu commands whose actual functions will vary 
depending on the currently selected window. For example: If an invoice window is the active 
window, selecting Save As from the File menu will save the invoice as a template. If the active 
window is a job window, it will create a job template. 

In windows where the New, Open, Save, Save As, or Revert functions are not applicable, the menu 
items are disabled (grayed out). The following tables identify how windows implement a file menu 
command and what it does. 

File > New 

Table 2.2: New Menu Item 
Active Window Action Performed When New Item Is Selected 

  

Stock Definitions Sets up a new stock definition by copying the pricing information and clearing the 
name. Used to duplicate stocks. 

Press Definitions Sets up a new press definition by copying the pricing information and clearing the 
name. 

Target Pricing Creates a new target pricing table. The existing one is thrown out, the new one 
has all 1’s for target factors. 

Copier Definitions Sets up a new copier definition by copying the pricing information and clearing the 
name. 

Charge Definitions Sets up a new category or a new charge depending on whether the category or 
charge list is selected. 

Prospects Sets up a new prospect. 

Invoice Account Info Creates a new contact. 

User Security Creates a new user ID. 
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File > Open 

Table 2.3: Open Menu Item 
Active Window Action Performed When Open Item Is Selected 

  

Any Document Opens Job Template. 

No Window Opens Document Template 

Cash Register Opens Job Template for QuickEst transaction. 

Pending Document Opens the selected document in the Pending Document Window. 

Accounts Opens account history for currently selected account. 

Extended Price Book Opens a saved price book specification. 

History Windows – 
Account and Estimate 

Opens the applicable document window for a history entry for an invoice, estimate 
or journal entry is selected. 

System Monitor Turns on the network so other users can connect (multi-user system).  

  

 

File > Close 

This command closes the selected window. Hold down the <option> / <alt> key while selecting this 
command closes all open windows. 

 

File > Save 

The Save command in PrintSmith is the equivalent of clicking the File or OK buttons. The following 
list shows instances where the command functions somewhat differently. 

Table 2.4: Save Menu Item 
Active Window Action Performed When Save Item Is Selected 

  

Aging Saves the option settings without closing the window or performing an aging. 

Invoice Files the document without closing the window. This is particularly handy if you 
want to know the document number before you file a new document. 

Document Preferences Saves any changes without closing the window. Holding down the <option> / <alt> 
key allows you to change the name of the preference. 

Statements Saves the option settings without generating statements or closing the window. 

Templates Updates the template file. 
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File > Save As 

Table 2.5: Save As Menu Item 
Active Window Action Performed When Save As Item Is Selected 

  

Any Document Creates a document template. 

Job Creates a job template. 

Document Preferences Duplicates the current invoice preference setup with a different name. 

List Price Schedule Duplicates the selected price schedule with a different name. 

Price Lists On 
Charges, Speed 

Duplicates the current price list with a different name. 

Extended Price Book 
Generator 

Saves the current price book with a different name. 

  

 

File > Revert 

The Revert command is used to restore the data to the same state it was in when it was last saved 
in the selected window. 

Table 2.6: Revert Menu Item 
Active Window Action Performed When Revert Item Is Selected 

  

Document Preferences Returns preference setting to last saved values. 

Extended Price Book 
Generator 

Returns price book specification to its last saved condition. 

Stock Definitions Resets stock definition to its last saved values. 

Target Pricing Table Resets table to its last saved state. 

User Definitions Reset selected definition to its last saved value. 

  

 

File > Print Setup 

The File Print Setup command allows you to indicate the paper size, whether to print in Portrait or 
Landscape mode and other options that depend on the printer being used. Once you have selected 
a particular set of print setup options, PrintSmith will remember them unless you change the printer. 
In cross platform environments (Macintosh and Windows) you’ll want to standardize your Print 
Setup so forms print the same on either platform. 
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File > Print 

The print command always asks you to specify printing options. Selecting this command prints 
some type of document. For example: In the Estimator, this command prints the open document. 
While in the Stock Definition command, it prints a stock listing. 

Table 2.7: Print Menu Item 
Active Window Action Performed When Print Item Is Selected 

  

Charge Definitions Prints list of all categories and charges in command. 

Copier Definitions Prints list of copier definitions. 

Copier Matrix Prints copier matrix. 

Customer List Prints selected report type. 

Cut Out Diagram Prints diagram. Opened from Paper Calculator or Show Cut-out button in 
Production Data window. 

Daily/Monthly Sales Prints a list showing all closeouts with totals. 

Deposit Ticket Used to re-print old deposit tickets. 

Extended Price Book 
Generator 

Used when viewing price lists on screen to print a single price list. 

Generate Price Book Prints Counter Price book. 

History Prints History for selected account. 

History Analysis Prints History Analysis report shown in window. 

Invoice Prints document using selected invoice preference. 

Invoice Costing Prints costing report for the document. 

Memo Used when opening an old memo from History to re-print. 

System Monitor Prints current display page. Most used for printing the “Sessions” page to generate 
a snapshot of your network configuration. 

Open Old Tape Prints old register tape. 

Pending List Prints report as formatted, sorted and displayed on screen. 

Paper Calculator Prints cut-out diagram. 

Press Definition Prints list of press definitions. 

Price List Prints price list. 
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Active Window Action Performed When Print Item Is Selected 
  

Price Schedule Prints the selected price schedule. 

Prospect List Prints prospect list report. 

Register Tape Prints current register tape. 

Stock Definition Prints list of stock definitions 

Stock Order Report Prints stock order report. 

Synchronize Portable Prints upload status report. This report is available after completing uploading of 
documents. System Monitor Prints contents of system monitor window. 

Waste Chart Prints waste chart. 

Work In Progress Prints work in progress report. 

  

 

If there is no defined action for the print command in the current window, or if the <option> key (Alt 
key on Windows) is held down, PrintSmith will print the current contents of the window – in this 
case the Print command is changed to Print Window. 

 

File > Quit/Exit 

Exit from the PrintSmith program. In a Multi-User system, the network is shut down before 
PrintSmith quits. If there are active Workstations, you will have the opportunity to warn them before 
quitting.  
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Edit Menu 
There are a number of standard editing capabilities expected of both Macintosh and Windows 
applications. These functions are supported by PrintSmith and allow you to copy text (and more) 
from one part of the system to another. It is important that you understand the concept of an 
electronic clipboard. PrintSmith uses the clipboard as a temporary storage area for items you cut or 
copy with Edit menu commands. When you paste, PrintSmith copies what’s in the clipboard leaving 
the clipboard unchanged. Your operating system reference manuals discuss this process in detail. 

Generally, the currently selected edit field is the target for Cut and Paste commands. In some 
windows, these commands are used on the entire record. Because the Edit menu is context 
sensitive (the command descriptions change to describe their function based on the current 
selection) you can easily tell what will happen when you use it. Currently, Job and Charge records, 
and Press, Copier, and Charge definitions, support copying and pasting entire records and the title 
of the menu commands change to tell you what they can be used for such as “Copy Charge 
Definition”. 

Undo  

The Undo command is not implemented in PrintSmith. 

Cut  

The Cut command deletes the selected text and places it in the clipboard. 

Copy  

The Copy command copies the selected text to the clipboard. 

Paste  

The Paste command inserts the text in the clipboard at the current location of the insertion point. If 
text is selected, it will replace it with the contents of the clipboard. If there is no text in the clip 
board, Paste does nothing. 

Clear  

The Clear command removes the currently selected text without copying it to the clipboard. 

Hide Item  

The Hide Item command is used to select an individual line item on a document and hide it so it will 
not be printed. The price of a hidden item is included in the total of the job. Hidden items are shown 
underlined in the document window. You can hide jobs that are part of a multipart job and charges 
that are attached to jobs. In addition, you can set the default by hiding a charge in the charge 
definition. You can not hide invoice level charges (these charges have an asterisk in the first 
column on the window) or jobs unless they are part of a booklet. You can not get around this 
restriction by using a hidden definition in a way that does not allow it to be hidden. If, for example, 
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you add a hidden charge definition to an invoice as an Invoice Level charge, and the charge is not 
a markup, PrintSmith warns you and un-hides it. The same holds true for dragging or drag copying 
a charge. 

Spell Check Selection  

The Spell Check Selection command checks the spelling of the selected text. If a document is open 
and the document window is selected, it checks the spelling of the entire document. In order to use 
this command, a dictionary must be installed in the PrintSmith Folder. The dictionary PrintSmith 
comes with is named Main Dictionary. It is in your PrintSmith Folder and is unique to the specific 
PrintSmith Folder. This dictionary is not shared. When a word is detected which is not in the 
dictionary, the affected text displays highlighted. The word appears in the Not in dictionary field. 
The Change word to: field shows what the word will be changed to. Initially, it displays the first 
suggestion, or, if there are no suggestions, the word itself. You can change this field as you see fit. 
If a document (Invoice or Estimate) is open and the document window is selected, it checks the 
spelling of the description and notes fields of all jobs and charges, job ticket notes, the Estimator’s 
Note Pad, and the document special instructions. 

 

Table 2.8: Spell Check Selection Buttons 
Button Action Performed When Selected 

  

Correct Replaces the misspelled word with the suggested correction. 

Ignore Ignores the misspelled word and continues checking the rest of the text block. 
 

Learn Adds the word to the site dictionary stored in the PrintSmith folder. The site dictionary is named 
User Dictionary and is unique to the specific PrintSmith Folder. This dictionary is not shared. 

Stop Closes the window without checking or correcting any other text in the text block. 
 

  

 

Send Mail 

The Send Mail command launches the user’s email application and sends an email version of the 
open Invoice or Estimate. 
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Invoice Menu 
The Invoice menu is used to manage Estimator documents – Estimates, Invoices and Templates. 
You also use it in conjunction with the Cash Register window to set up “QuickEst” transactions.  

This menu is divided into three sections. The first section is used to create, modify, and review 
documents. The second section is used to specify the different jobs and services to be added on 
the document. The third section provides functions, which affect the entire document such as filing 
or canceling the document. 

The Estimator relies on the information managed in the AR menu (accounts), Admin menu 
(preferences) and Pricing menu. Assigning keyboard commands to the items in the Invoice menu 
can significantly increase your speed when creating documents.  

Create Invoice  

The Create Invoice command creates a new Invoice. Selecting this command opens the Account 
Picker and Account Info windows on top of the Invoice window. Select a Customer, Prospect, or 
Contact from the Account Picker and enter necessary information in the Account Info window. Click 
the OK button to close this window and the Invoice window appears. 

Copy to new Invoice 

The Create Invoice command copies the document into a new Invoice. When a document is 
copied, the dates (ordered, picked up, proof, etc.) and deposit data are cleared and you are given 
the option to update the pricing information. If you use this command on a new estimate that has 
not been filed, it simply changes the document to an invoice rather than making a copy. On a new 
invoice, this command does nothing. 

Update Pending Document 

The Update Pending Document command opens the Pending List window from which you can 
select a document. When you create new estimates and invoices, they are automatically placed in 
the Pending List. This is an easy way to manage recent estimates, work in progress, and 
completed jobs awaiting pickup or delivery. On PrintSmith Portable systems not on an active 
PrintSmith Network, the Pending List is a list of all the portable documents in the “Portable…” 
folder. 

Review Any Document 

The Review Any Document command opens a window where you can specify the document type 
(Estimate, Invoice or Web) and the number. Finds any document and opens it. When this window is 
opened, it is set up to find the last invoice or estimate used. Pressing the <return> key will open 
that document. As the system is originally shipped, you can open the last document from the 
keyboard by selecting <ctrl>/<command>+<R> and pressing <enter>/<return>. 

Create Estimate 

The Create Estimate command creates a new Estimate. 
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Copy to new Estimate 

When a document (estimate or invoice) is opened, the Create Estimate command becomes Copy 
to new Estimate. When selected, it copies the open document to a new estimate in exactly the 
same manner as Copy to new Invoice. If you use this command on a new invoice that has not been 
filed yet, it simply changes the document to an estimate rather than making a copy. 

Account Info 

The Account Info command opens the Account Info window for any document. An account must be 
assigned to the document. If no account is assigned, the Account Picker will open. When an 
account is selected, the Account Info window automatically opens. Use this window to enter 
information about the customer such as order title, phone numbers, contact person, PO numbers, 
resale (tax) information, delivery instructions, due dates, sales rep., reorder date and special 
instructions to be printed on the invoice. For documents in which the <<< WALK - IN >>> account is 
selected, you also use this window to enter the customer’s name and address.  

Change Account 

The Change Account command opens the Account Picker window.  The selected document is 
reassigned to the customer, account, or contact selected in this window.  

Note: This command is not supported for Web Documents created through PrintSmith Site. 

Jobs 

The Jobs command creates a new job. Much of the actual work performed in the Estimator will be 
working with Jobs. Jobs and Charges are used to describe all of the prices in an invoice or 
estimate. You can open a Job without opening a document. This is useful if you are working on the 
phone and simply want to find a price quickly or to run a job through the Cash Register without 
creating an invoice. A job opened without a base document open is thrown away when the job 
window is closed unless you save it as a template.  

Charges  

The Charges command opens the Charges window. Assigned charges depend on the document 
selected and can be document level or job level charges. 

Deposit Entry 

The Deposit Entry command allows you to enter deposits on Invoices. Deposits are not allowed on 
Estimates. You can enter two different deposits and specify whether each is cash, check, or credit 
card. PrintSmith requires a check number before it will accept a check deposit. To remove a 
deposit, open this window and erase the reference number, if any, and the amount. If PrintSmith 
sees a zero balance when a document is filed and there used to be a deposit, it assumes that the 
deposit was returned to the customer and makes the appropriate accounting entries.  
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Document Totals 

The Document Totals command opens the sales summary window for the active document. Each 
item in the invoice is totaled and displayed by its sales category. You can use this window to 
specify a special tax table and to override a customer discount. You can also enter shipping 
charges, although defining charges to specify shipping charges is a better approach. Clicking the 
Recalculate button in this window updates the pricing information for the entire document. This 
window also shows the various dates and times associated with the document: order date, proof 
date, due date, date order was finished, date and time of customer notification and delivery date. A 
lock prices button allows you to lock the prices on a document and change production details 
without changing the locked price.  

Note Pad 

The Note Pad’s purpose is to provide a simple method of recording the specifics of a customer 
order for later use in finishing an estimate or invoice (especially if you get backed up or are working 
on the phone). It prompts you for specifics on the order: what it is, who wants it, when, how many, 
type of stock, etc. The Note Pad can also be handy for recording notes about the estimating 
process for this particular order. For example, you were able to purchase the stock at a special 
discount because it was on sale, and you passed some of the savings on to your customer. You 
could record this in the note pad. If the customer places the order again and the stock is normally 
priced – they might question the price. A note recorded in the note pad would give you the reason 
for the special deal and could save you from unnecessarily reducing the price. Estimator notes can 
be added to all documents including Locked documents in History. These notes are separate from 
the Special Instructions in the Account Info window and job ticket notes.  

Convert to Invoice 

The Convert to Invoice command is used to convert an Estimate (quote) to an Invoice. When you 
convert an Estimate to an Invoice the original estimate is saved in Estimate History, recorded as a 
Win, and a new invoice is created that highlights the source estimate number and retains the quote 
information.  

File Document 

The File Document command saves all of the information in the document and closes all of the 
windows associated with it. During this process, PrintSmith assigns a document number and adds 
it to the Pending List if the document is new, and records any deposit data. The Save command in 
the File menu does the same thing without closing the window. 

Cancel Document 

The Cancel Document command is used to cancel invoices and estimates. If the invoice or 
estimate was a mistake you should cancel the document to remove it from the pending list. You 
can also remove estimates from the pending list by using the Clear Estimates command. There are 
two types of cancellations: voids and deletions. Normally, when you cancel a document, it is 
voided. The document’s details and original totals still exist but are marked as voided. If you want 
to reuse the number of a voided document, you have to delete the document. To do this, open the 
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voided document, select the Review Any Invoice command, and then select the Cancel Document 
command. This action deletes all record of the document. When documents are voided or deleted, 
an entry is made in the register tape recording the fact, the dollar amount and the user who 
performed the action. On PrintSmith Portable systems, the Cancel Document command deletes the 
portable document from the Portable… folder on the hard disk. You can also manually remove 
documents from this folder and place them in the Trash (Recycle Bin). 

Create Customer (Prospect) fm Document 

This command converts the customer information in a document written on the “<<< WALK - IN 
>>>” account into a separate account and contact and assigns the new account to the document. 
This greatly simplifies capturing customer information gathered at the time of the initial order. It can 
also be used to recreate an account that has been deleted and recover the account history.  

The best way to use this command with a new customer is to create an estimate using the “<<< 
WALK - IN >>>” account. When you have entered complete customer information, select this 
command to create the account. The account created contains the name, address, phone, FAX, 
sales rep., resale number, and is a “Check” type account (no charges to AR are allowed). Creating 
an account from an Invoice creates a customer account and corresponding contact. Creating an 
account from an estimate creates a prospect account and corresponding contact. 

An additional benefit of this Invoice menu command is that your CSR’s do not need access to the 
AR menu. You or a manager can review the account in the AR menu and change the account type 
to charge and set a credit limit at a later time. In this scenario, counter staff never has access to an 
account balance or other AR information and cannot give credit. They can however establish initial 
accounts, which accept cash, check and credit cards for repeat walk in customers. 

Tracker Status 

The Tracker Status command is only available if you have purchased the optional Tracker Module.  
Selecting this command opens the Tracker Status window, which is a management tool displaying 
Tracker information collected for the selected invoice.  See the Tracker Module Instructions for 
additional information. 

Generate Delivery Ticket 

The Generate Delivery Ticket command opens the Delivery Ticket window for the selected 
document.  Multiple delivery tickets can be created for each job.  And, multiple jobs from multiple 
invoices can be included within one delivery ticket.  Through five tabs you can select what is to be 
delivered, designate the delivery address and contact information, select a shipping method, print 
delivery labels, and track the status of the delivery. 

Open Estimator Checklist(s) 

The Open Estimator Checklist(s) command opens the Estimator Checklist window for each job that 
is a part of the open estimate or invoice.  This window allows a view of the entire job, from 
specification creation to production.   
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POS Menu 
The POS (Point Of Sale) menu contains commands used to control work in progress and picking 
up invoices to Accounts Receivable. It also performs all of the functions of a cash register including 
operating a cash drawer and receipt printer. 

Even if your operation does not require the functions of a cash register, you will be using POS for a 
wide variety of operations: adjusting due dates, checking the status of work in progress, voiding 
erroneous transactions, checking accounts receivable, picking up completed work, updating job 
locations, making notes about the status of invoices, updating the location of a document or job and 
so on. 

Open Cash Register 

The Open Cash Register command opens three windows: the Cash Register, Pending Document, 
and Status windows.  

Cash Register Window 

The Cash Register has three primary purposes: Use it like a cash register to enter transactions 
without creating invoices; use it to pick up invoices and post them to accounts receivable; and/or 
use it to check an invoice’s outstanding AR balance for invoices already posted.  

Pending Document Window 

The Pending Documents window allows you to review and control the contents of the Pending List. 
When a group of documents is selected, these functions are performed sequentially on each 
document in the group (repeatedly clicking the Status button displays status for the first item in the 
group, then the second and so on). The exception is the Pick Up button which will attempt to 
perform the pickup operation on the entire group (documents must all be invoices for the same 
account). 

Status Window 

The Status window is used to display information generated by the Pending Document window and 
the Cash Register window. There are 3 displays: Document status is generated in response to 
every pending window function except Open and shows the current status of a document; 
Transaction summary shows the amount due, tendered and any change and is generated after 
each cash register transaction; Cash Drawer status is generated in response to the Cash Drawer 
Status command in the POS menu.  

Transaction Window 

The Transaction window shows the current transaction in a form that matches how the transaction 
would be posted to the Register Tape if it was processed (except the date, which is shown as “not 
set”). In addition to displaying the transaction, you can delete items from the current transaction by 
selecting the offending line and clicking the “Void Transaction” button.  
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Open Tape 

The Register Tape is used to record each transaction, much like the register tape in a standard 
cash register. PrintSmith’s Register Tape is much more detailed than a standard register tape. This 
information is used during the Closeout to generate all of the sales information. The Register Tape 
is also where you correct mistakes. You can select an entire transaction (such as a Picked Up 
invoice) and void the transaction by clicking the Void Transaction button. 

Cash Drawer Status 

PrintSmith maintains a running record of the current Accounts Receivable balance as well as the 
total cash, checks and credit card slips that are supposed to be in the cash drawer.  

Change Due Date 

Enter the initial due date in the Account Info window. If you want to change the due dates on a 
number of documents, use this command to select the document or group of documents you wish 
to change, and then click the Change Due Date button. PrintSmith opens a window where you can 
quickly modify the due date and click the OK button to save the changes to each document.  

AR Menu 
The AR menu controls PrintSmith’s Accounts Receivable module. It contains all the commands you 
will need to manage accounts receivable. Use it to add accounts (customers or prospects) and 
contacts, post payments to accounts, generate statements and credit memos, age accounts, and 
close out each day and each month. In PrintSmith Portable, this menu contains only an Accounts 
command, which is used solely for reviewing account information. Accounts can only be created in 
a non-portable PrintSmith system.  

Accounts 

Use the Accounts command to set up and manage accounts (customers and prospects) in 
PrintSmith. 

Contacts 

The Contacts command is used to set up and manage contacts in PrintSmith. 

Post Payments 

The Post Payments window is used to enter AR payments for invoices that have been Picked Up 
and are posted to Accounts Receivable. You can also use this command to enter payments “on 
account” which is a payment posted to the account but not applied to any particular invoice. This 
command is used for customers who have been extended charge terms. These customers sign for 
the job when it is ready, the invoice is “Picked Up” which moves the invoice to the customer’s AR, a 
statement can be generated and sent and usually the customer mails their payment in the form of a 
check, which is applied in the Post Payment window. 
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Closeout 

Closeout is the process used by PrintSmith to summarize the sales and accounting activity for a 
“day”. A “day” in PrintSmith is generally the period between two closeouts. For example, if you elect 
to perform a Closeout every Wednesday, PrintSmith would treat the entire week as a single day. 
During a Closeout, PrintSmith prepares a deposit ticket. Matching the actual deposit slip to 
PrintSmith is an excellent way to compare the data, so it is a good idea to do a closeout whenever 
you make a bank deposit.  

Note:   It is possible to perform multiple closeouts within one day. 

Monthly Closeout 

Like Closeout, Monthly Closeout generates sales summaries and other reports. It gathers all the 
closeouts for a month and summarizes them. PrintSmith keeps track of which months have not 
been closed out and automatically decides what it needs to do. You can perform a Monthly 
Closeout whenever you wish to generate a month-to-date sales report. Alternatively, you can use 
the Daily Sales report in the Reports menu to generate a composite report for any period. 

Generate Statements 

Generating Statements is an important, but completely optional, part of managing Accounts 
Receivable. PrintSmith gives you complete control over the process. You decide when, and for 
whom, to generate statements, how accounts are to be aged, if finance charges are to be added to 
past due items, which of two formats to use when printing statements, and whether PrintSmith is to 
print the form image as well as the statement data. Anytime PrintSmith generates a statement, it 
“ages” the account. You should always set the aging options before generating statements for the 
first time. PrintSmith remembers both the aging options and statement options you select and will 
automatically use them the next time the command is selected.  

Verify Receivable Balance 

The Verify Receivable Balance command checks the balance shown in the Cash Drawer against 
the total balances shown in all of the accounts and will notify you of any discrepancy. The “official” 
balance is the total of the accounts. Obviously, there should never by a difference between the two. 
If there were a power failure in the middle of posting a payment or something of that nature, this 
command can correct the discrepancy. If it reports a problem, you should try to locate where the 
error originated.  

Verify Customer Balance 

The Verify Customer Balance command compares the balance in a particular account to the total of 
the open items in the account history. The “official” balance is the total of the open items. Should 
this command report a discrepancy, you should attempt to ascertain the reason for the error.  
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Verify All Balances 

The Verify All Balances command compares the balances for all accounts against their open items. 
If any discrepancies are found, it will stop and give you an opportunity to fix the problem. You 
should also Verify Receivable Balance, if any problems are identified. 

Account Aging 

Account aging is the process whereby PrintSmith compares the open items in the account history 
against the aging date and standard time periods you select. It determines if the account is current, 
past due or delinquent. There are a variety of options you can select for aging and it is important 
that you perform at least one aging before generating statements. The statement generator uses 
the aging options you select in the Account Aging command when generating statements. 

Journal Entry 

Journal Entries are used to modify an account balance or adjust sales information. You can use a 
Journal Entry to write off an invoice as a bad debt, give a credit on an account, enter a beginning 
balance for an account when setting up PrintSmith, or to remove sales tax from an invoice that was 
picked up in a previous day (if it is picked up in the “current” day you would simply void the pick up 
using the Open Tape command in the POS menu). Most journal entries are unnecessary if you 
identify a problem prior to finishing the Daily Closeout on the day in which the error occurred.  

Post POS Charges 

The Cash Register allows you to post charges to an account without creating an invoice. This 
makes it much simpler to handle situations where a customer with a charge account comes into 
your shop and makes a couple of copies and asks that it be charged to their account. Rather than 
picking up lots of tiny transactions and wasting invoices, you post it as a charge without writing up 
an invoice. PrintSmith creates a “log” of these types of transactions and keeps the total of these 
charges in a special account balance called “Merchandise Charges”. Periodically (once a month or 
so) you should use the Post POS Charges command to create a special statement for those 
charges, which posts the total to Accounts Receivable.  

Pricing Menu 
The pricing menu controls PrintSmith’s pricing system. The first group of six commands control 
pricing for jobs.  This includes Charge Definitions, which can be added to jobs or directly to invoices 
and estimates. The next section contains commands for controlling sales tax and other tables that 
affect the entire pricing system. The final section contains commands used to manipulate the entire 
pricing system. 

Stock Definitions 

Stock Definitions are entered into PrintSmith using this command. Use this command to define the 
stocks you use most often. You do not need to actually have a particular paper in inventory to set 
up a stock definition. 
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Press Definitions 

Press definitions are used by the Printing and List pricing methods to determine the time required 
for the job as well as the labor rate and markup.  

Copier Definitions 

Copier definitions define how the Copier 1 and Copier 2 pricing methods calculate copier prices.  

List Price Schedules 

You will use this command to manage the price schedules used by the List pricing method. 

Stamp Schedule 

The Lines and Inches pricing method uses this schedule to price rubber stamps.  

Charge Definitions 

Charge Definitions are entered using this command. 

Waste Chart  

When running a job on a press, you anticipate that some of the sheets will be ruined, either 
intentionally or accidentally. Generally, the amount of spoilage varies with the type of press and the 
type of stock and can be expressed as a percentage of the run length. PrintSmith uses a waste 
curve to estimate the spoilage rate on printing jobs based on the length of the run. This command 
is used to modify the default waste chart. In addition, you can create and add additional waste 
charts to each press definition using the Press Definition command. 

Sales Tax 

This command is used to define the sales tax rate to be used by PrintSmith. PrintSmith is shipped 
with a built in “default” tax table which must be set to the tax rate in your area. In addition to the 
default Tax Table, you can use this command to maintain any number of additional tax tables. Each 
account and each document can be set up to use a special tax table by changing the Tax Table ID 
in the account definition  

Generate Price Book 

This command generates a price list for every stock in the selected stock categories or for stocks 
you select. The prices are generated using the default press (unless a press is specifically 
assigned to a stock definition) and the Printing In Stock pricing method. The price list has two 
columns, one with prices for a single color on the front and one with prices for a single color on the 
front and back.  
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Change Prices 

Use this command to automatically adjust all stock prices and / or to increase/decrease all of your 
prices by a certain percent.  

Work Station Maintenance 

This command opens the WS Maintenance window, which allows force pricing updates from the 
master to the workstation, either immediately or on the next login. 

Import Stock Catalog 

This command is used to import and update your stock definitions from vendor catalogs. If your 
stock supplier provides an electronic price list you maybe able to import and update all of your 
stock pricing automatically.  

Extended Price Book Generator 

This command is present only if you have purchased this optional product. It opens the Extended 
Price Book Generator, which is used to prepare and maintain a high quality Price Book.  

 

Reports Menu 
The Reports menu is where you will find the information that provides most of the management 
information in PrintSmith. Because you can generate these reports instantly and view those on 
screen, at any Workstation, your need for printed reports may be reduced. 

Account History 

This report shows all of the invoices, journal entries and payments for the selected account. 
PrintSmith filters the history by the first open item, the first entry for this month, last month, this 
quarter, this year, last year and all items. Selecting one of these bookmarks instantly locates that 
entry in the account history and displays the entry and all of the subsequent entries. Double clicking 
on an entry in the account history opens the source document or displays a detailed summary of 
activity connected with the entry. There are two types of printed reports. To print a history for all 
accounts, select the Print command (without selecting an account). You could, for example, 
generate a report consisting of just those accounts with open items and show a detailed history for 
each account. Selecting the Print command when an account is selected generates a report for just 
that account.  

Estimate History 

Estimate History provides a historical record of the estimate activity for each customer or prospect. 
Use Estimate History to answer specific questions about past estimates, easily access an old 
estimate for a new request, determine when a particular estimate was entered, whether the order 
was won or lost, or open the Estimate and copy it to new Estimate or Invoice.  
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Work in Progress 

This lets you display and print all documents in the Pending List in a variety of formats. It is a 
powerful tool for managing production.  

Mailing Labels 

The mailing label generator in PrintSmith is both simple and extremely powerful. You can generate 
mailing labels or shipping labels in any format, for any set of customers, prospects or contacts you 
wish. You can also use it to generate an address list for use with word processors and other 
programs capable of generating form letters. You indicate if you want labels, a mail merge file, or 
both. You can also sort the selected accounts by name, account status, business type, sales per 
year, or zip code. Mail merge files can be generated with either a Macintosh or Windows format. 

Customer List 

The Customer List report provides a variety of different views of your accounts. You sort the list and 
select the report type from pop up menus.  

Daily Sales 

The Daily Sales command opens a window showing summary sales information for every daily 
closeout. Select the day or days of interest then the report type you wish to generate. There are 
many different reports you can generate. The first report is a quick summary of each daily closeout. 
To generate other reports, select the day and choose the report format from the pop up menu. Click 
the select button or double click on a day to generate the report selected from the menu. You can 
create a composite report for any group of days by clicking on the first day, holding down the 
<shift> key, and clicking on the last day. 

Account Ranking 

Opens the Account Ranking window, where accounts can be ranked by several different methods, 
within specified date ranges, and the rankings can be saved. 

Monthly Sales 

The Monthly Sales report is functionally identical to Daily Sales. The data however, is based on 
Monthly Closeouts. 

Open Old Tape 

Whenever a Daily Closeout is performed, the register tape is placed in the “History…” folder of your 
PrintSmith system. Use this command to open an old tape. 
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Deposit Ticket 

Daily Closeout generates deposit tickets and stores them in the History folder. This command 
allows you to open an old deposit ticket. 

Stock Order 

The Stock Order report displays the current contents of the Stock Order. Entries are made in this 
report from the Order Stock command in the Job menu or the Order Stock command in the Admin 
menu. 

Re-Order List 

The Re-Order List report generates a list of all the invoices with a re-order date that fall within the 
range of dates you specify.  

Mailer Campaigns 

The Mailer Campaigns command allows the creation of mailings that can be grouped together and 
assigned to contacts. 

Report Manager 

With the optional Report Manager, you easily schedule and control distribution of your Report 
Writer reports. 

Report Writer 

Using the Report Writer you can modify reports identical to the ones built into PrintSmith as well as 
add new custom reports. Included are: a Report Wizard, custom reports, custom job tickets, multi 
user functionality, and scheduling of automatic report generation. 
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DownLoader Menu 

DownLoader is used to extract information from your PrintSmith database. The data extracted by 
the DownLoader is placed into a text file, which can be also read by other programs. Depending 
upon the type of analysis you desire, a spreadsheet, word processor, or data base program may be 
most appropriate. DownLoader is an optional product further defined in the Report Writer / 
DownLoader manual. 

• Export Documents - Use the Export Documents command when you wish to export complete 
documents for a range of dates. To analyze jobs or charges by invoice (document) number, 
export documents using this command. 

• Export Pending Documents - This command is used to export an invoice, job, and charge 
data for all pending invoices and estimates. To view work in progress for multiple locations, 
use this command to combine several data sets. 

• Export Data - This command is used by the DownLoader to extract all or part of a data file, 
depending upon the specifications you select. 

• New Script - This command is used to create a script for the DownLoader to follow when 
exporting data. A script is a list of fields that you have selected to export to your report. Scripts 
are useful when creating large reports because they save time and ensure data is extracted 
properly. 

• Open Script - This command is used to open scripts. 

• Run Script - This command starts the script you have selected. 

• Browse - The command allows you to browse your PrintSmith data by file name and record. 
This command allows you to see the fields in each of your files and the contents of those 
fields. 

 

Admin Menu 
The Admin menu is used to administer your PrintSmith system. Its commands deal with basic 
configuration of security, pricing and receivable systems, setting options for printouts, and so forth. 

Change Password 

This command allows each individual to change his or her password.  The System Administrator 
creates a new user with no password.  The new user will set the password when he or she logs in 
for the first time. 

User Log In 

The User Log In command is used to identify the individual using PrintSmith and determine which 
menu commands that user has access to. Normally, selecting this command also closes all open 
windows. To invoke the command without closing windows, hold down the <shift> key while 
selecting the command. This is useful for temporarily overriding some type of security related 
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restriction. When PrintSmith is shipped, the security system is partially disabled; you click the OK 
button to enter the system. 

User Definitions 

User Definitions are used to identify each user and establish their access group in PrintSmith.  

Security Setup 

Security Setup defines the access level for each menu and menu command in PrintSmith for the 
access groups. User definitions define the access level for each user. Together, they determine 
what menu commands each PrintSmith user has access to.  

Keyboard Shortcuts 

This command allows you to customize your keyboard shortcuts.  

Web Administration 

This command is used to set the preferences for the optional E-Commerce feature which allows 
customers to access your product offering and PrintSmith pricing and request a quote from your 
web site.  

Tracker Console 

The Tracker Console command launches the optional Tracker Module, which allows for shop floor 
data collection.  See the Tracker Module Instructions for additional information. 

Tracker Manager 

The Tracker Manager command launches the setup and management application of the Tracker 
Module.  See the Tracker Module Instructions for additional information. 

Employee Manager 

The Employee Manager launches the Employee Manager portion of the optional Tracker Module.  
See the Tracker Module Instructions for additional information. 

Delivery Ticket Manager 

The Delivery Ticket Manager allows delivery ticket history to be reviewed (History tab), delivery 
ticket forms to be created and modified (Form Preferences tab), and new brokers to be created or 
added from the customer list (Brokers tab). 
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System Monitor 

The system monitor shows information on open files, users at each Workstation, etc. 

Credit Card Manager 

This command is only available when the Credit Card Processing system is enabled. The Credit 
Card Transaction Manager displays all credit card transactions since the last Closeout. This applies 
to transactions entered manually or with the optional credit card magnetic stripe reader. 
Transactions can be viewed or voided. Voids performed in this window do not affect the 
transactions listed on the cash register tape, but are transmitted to the credit card processing 
system. 

Show/Hide Help Bar 

Show or Hide the Help Bar. This window is usually at the bottom of the screen and provides 
support for selecting a certain command via an icon; instant help, access to on-line documentation 
as well as PrintSmith’s on line e-commerce store and update page.  

Preferences 

Preferences are used to define a wide variety of pricing options and customize your operation of 
PrintSmith.  

Document Preferences 

Document Preferences control all facets of the appearance and content of printed invoices, 
estimates, and other documents. This command controls these settings and manages multiple 
preference settings. 

Table Editor 

This command is used to edit, order, and sort tables (and their contents) used throughout 
PrintSmith.  

Clear Estimates 

If you do a lot of estimates, you can accumulate quite a few in the pending list. To remove them 
you can open them individually and use the Cancel Document command in the Invoice menu, 
which is treated as mistake or voided estimate. The Clear Estimates command is used to process 
them as a group. This process clears the estimates from the pending list and moves them to 
estimate history. The Clear Estimates command tends to be a much easier, faster and more 
appropriate to use. 
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Paper Calculator 

The paper calculator is a handy tool for determining how to cut or layout a particular size out of 
another size and generates a cutout diagram.  

Order Stock 

The order stock function is designed to assist you in preparing vendor orders. You can look up the 
stock requirements for any job and order the required stock or adjust the required amount. You can 
also select any stock and enter the amount to be ordered. The Auto Order function will let 
PrintSmith handle the entire operation for you. The Auto Order function searches through each 
invoice in the pending list and checks to see if stock has been ordered for each job. Any stock that 
has not been ordered is placed on the Stock Order Report for your review.  

Batch Print Documents 

This command prints a group of invoices or estimates. It can be used as a management tool to 
ensure that all documents created by PrintSmith are printed or serve as an auditing tool. There are 
options for printing today’s or any other day or group of day’s new documents (Invoices and/or 
Estimates) or invoices pickups and can automatically skip any document, which has already been 
printed. Before printing, it will let you know approximately how many documents are to be printed.  

Network Chat 

The Network Chat command allows you to send instant messages to other PrintSmith users in your 
network. 

Send File 

This tool, available at Workstations, sends a file to the PrintSmith Master’s PrintSmith Folder. It is 
useful for sending Reports and Document Preferences to the master station. 

Synchronize Portable 

This command is used to transfer information gathered while in portable mode to a normal, non-
portable PrintSmith system. It does not appear on a PrintSmith Portable system until it is connected 
to a PrintSmith Network and started as a Workstation.  

Update Pricing Folder 

This command updates the pricing system on a Workstation by copying the necessary pricing 
information from the PrintSmith Master’s pricing folder. This function needs to be performed 
whenever a change is made to pricing at the PrintSmith master. 
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Help Menu 
The Help Menu is composed of About Balloon Help, Show Balloons and PrintSmith Help on 
Macintosh. On Windows the options are Contents, Keys, How to use Help and About PrintSmith. 
The About PrintSmith menu is a special menu detailed in the next section. 

PrintSmith Help 

The PrintSmith Help command launches a file called “Help.pdf ” stored in the PrintSmith Folder, if 
installed. 

Contents - Not supported by PrintSmith. 

Keys - Not supported by PrintSmith. 

How to Use Help - The How to Use Help command opens a window with instructions on how to 
use Windows Help system. 
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Support Center 

The Support Center window provides Customer Information, PrintSmith Information, and System 
Information.  Your current support agreement and any available version updates will be listed. 

Figure 2.1:  Support Center window, System Information tab 

 
 

Customer Information 

This tab displays Contact Information on File with PrintSmith and Company Information from 
System Preferences.  

PrintSmith Information 

This tab displays version information, Serial Number and expiration date, Program Type, Service 
Agreement information, Customer Support information, and Sales information. 

System Information 

This tab displays your Operating System, IP Address, Network Protocol, and Key Type. 

Web Updates 

Click the Web Updates button to get current updates. 

Note:  Support Center functionality is only available with multi-user versions of PrintSmith. 
 

About PrintSmith  

This special window is available under the Help menu on Windows and under the PrintSmith menu 
on OS X. This window identifies your system version and serial number. This information is 
required when contacting our support team. 

Clicking Web Updates 
opens 
www.printsmith.com/serv
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Event Logging 
Each time the PrintSmith system is launched; it accesses an Event Log file that maintains a record 
of internal events. On systems that have a Closeout function, (everything but Estimator and Lite) a 
new event log is started after each closeout. On other systems, the event log is a continuous 
operation. It records important events and, if there is an error of some type during the operation of 
PrintSmith, the text of the error message is recorded. The Event Log is useful as an internal audit 
trail and provides valuable information when contacting PrintSmith to resolve potential system 
difficulties. 

Record Locking 
PrintSmith allows multiple end users to access the system simultaneously. As a result, there may 
be times when multiple users on different computers or multiple functions on the same computer 
are attempting to change the same information simultaneously. To prevent this from happening, 
PrintSmith provides a function called record locking. As users modify system data, the data record 
becomes temporarily locked. When the record is saved or exited it becomes unlocked and 
available to other users. 

When a record is locked, PrintSmith prompts the user with a message that the record is already in 
use, and on a multi-user system the name of the person using the records is displayed. Typically, 
the time a record is locked is so short in duration that users are not even aware. However, there 
are times when records are locked for longer periods, including the following: 

When a document is opened, it remains locked until the document window is closed. When 
processing a Pick Up in the cash register.  Both the invoice for pick up and the associated account 
are locked until the process is complete. This is the process PrintSmith uses to post an invoice to 
Accounts Receivable. 

Data Considerations 
It is important to understand how different this database type of application is from a word 
processing application. In a word processing application you create documents, which are kept in 
files you name. You can give someone else a file and they can open, change, and print it as long 
as they have a suitable application. PrintSmith is delivered with a set of files already created and 
stored in separate folders. These folders and the files they contain, together constitute your 
PrintSmith management information system; your data base. 

Always remember these files are all designed to work together – they are not interchangeable. You 
cannot use a Jobs file or a Copier Definition file from a different data base without serious side 
effects. Replacing the Jobs file basically destroys all of your invoices. Replacing the Copier 
Definitions file can change the prices on all your existing estimates, invoices and templates in ways 
you cannot predict. 

The idea that entire folders are treated as a single entity is especially important when performing 
backups and restoring from backups. You must always back up the entire “Data…” and “Prices…” 
folders. It is recommended you copy the entire PrintSmith folder when backing up. If you own 
several PrintSmith licenses for various stores and you want to keep all of the pricing systems in 
each store the same, you must pick one store as the only location that ever modifies any prices. 
Always update the pricing system in your other stores by copying the “Prices…” folder to each 
store. Otherwise, folders and their contents must never be swapped between different installations. 
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Another important element when using a data base system is ensuring your hard disk does not fill 
up. The files created by PrintSmith can eventually become quite large. If you run out of storage 
space on the hard disk of your computer, PrintSmith has to quit. Unfortunately, this could occur in 
the middle of saving an important transaction. To prevent this, PrintSmith monitors the amount of 
disk space available on your computer. If the available space falls below 1,000K (1 megabyte), 
PrintSmith starts closely watching the hard disk. When the available space falls below 100K, 
PrintSmith will warn you frequently. When there is less than 5K, PrintSmith will no longer save 
anything to the hard disk to prevent not being able to finish a transaction partially written out to disk.
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One of the most important parts of any business is Sales. One of PrintSmith’s most important 
functions is to determine the selling price and prepare documentation for sales in your business. 
Some sales may be simple, 25¢ copies of a resume, and some may be complex, 50,000 full color 
brochures or a mail order catalog. 

PrintSmith was designed to make estimating and documenting each of these sales as simple as 
possible. In the first example, you might not even want to create an invoice – the cost of preparing 
the invoice might actually exceed the amount of the order! 

For small, simple jobs, PrintSmith’s POS (Point Of Sale) functions can be used to record the sale 
and print out a cash register style receipt with the optional receipt printer. 

On more complex work, you may have to submit bids on different quantities and different stock. 
Automation of this type of work is why PrintSmith’s Estimator was developed. When using the 
Estimator, you’ll be working with estimates (quotes), pending invoices (work orders), invoices, and 
templates. 

Estimates are quotations you give to a prospective customer indicating what you will charge for the 
work. Pending Invoices are used as work orders and show the actual price of the job. A finished 
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invoice constitutes a bill for services rendered or goods delivered. Templates are usually complex, 
sample quotations for work you anticipate doing more than once. In PrintSmith, these are all 
referred to as document templates. 

These documents are used for completely different purposes: estimates for bidding on jobs, 
invoices for work orders and billing customers, templates for increasing productivity during the 
estimating cycle. Once a document is open, adding jobs and charges works the same way for all 
types of documents. 

Working with New Documents 
Selecting either Create Invoice or Create Estimate from the Invoice menu creates a new document. 
Templates are created from existing estimates, invoices or jobs, so the procedure is a bit different. 
Templates are discussed later in this chapter. Invoices and Estimates are stored in PrintSmith’s 
database – the process of storing a document is usually referred to as filing. This makes efficient 
use of the space on your hard disk and gives PrintSmith the control it needs over this important 
data. There are several ways to store a document. You can: 

• Save it using the Save command in the File menu. This assigns a document number to the 
new document, adds it to the Pending List, and writes the information to the hard disk. The 
document window remains open and you can continue to work on it. Once a document has 
been saved, additional changes made to the document must be saved again to be permanent. 

• File it using the File Document command in the Invoice menu or the File button on the 
Document Control Pad. This saves the document and closes the document window and any 
other windows associated with the document (such as Job windows or the Deposit Entry 
window). Use this command when you are finished with the document. 

• Print it using the Print command in the File menu or the Print button on the Invoice Control 
Pad. Before printing the document, it is first saved. Use this command when you are finished 
with the document and you want a hard copy. You can reprint any document at any time; 
however, PrintSmith will verify that you wish to reprint a document that has already been 
printed. 

• No File it using the No File button in the Document Control Pad, the Close command in the 
File menu, or by clicking the close box in the upper left corner of the document window. When 
you click the No File button, any changes you’ve made since the document was last filed are 
thrown away. If the document is a new document (the document number will be “*new*”) it is 
simply thrown away. 

When you create a new invoice or estimate it has no number. When you file a new document, 
PrintSmith assigns it a unique document number. Estimates and invoices each have separate 
numbering sequences, which you control. PrintSmith does not allow duplicate numbers. In addition 
to a document number, each document has a title. The document title is used extensively 
throughout PrintSmith to provide a description of the document. You enter the document title in the 
Account Info window. If the title is blank when the document is saved or filed, PrintSmith takes the 
description from the first line item in the document and uses it for the title. A well defined document 
title will make future searching much easier. 
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Document Numbers 
PrintSmith automatically assigns document numbers to both Estimates and Invoices. This means 
that if you pre-print your forms, they should not be numbered. We strongly recommend that you do 
not use numbered forms. If you do, eventually you’ll encounter situations where the computer 
assigns and prints an invoice number, but the pre-printed invoice has a different one. This can 
become an accounting nightmare. 

Invoices and Estimates each have their own numbering sequence. The default starts at 1; however, 
you can and should change the numbering sequence. If you are using numbered invoices now, you 
should change the numbering sequence for your invoices when you start using PrintSmith so that it 
follows along with your old number sequence. Estimate numbers are less important; but you might 
want to set the sequence so that there is a considerable gap between estimates and invoices.  

New PrintSmith Users:  Although the choice is yours, it is generally not a good idea to start 
numbering sequences for invoices at 1 or any other small number. This can give your 
customers the impression that you are just getting started and may not know what you are 
doing. 

As mentioned earlier, when a document is new, it has no number assigned to it. Before PrintSmith 
assigns an automatic number, you can assign one to the document manually. When you assign a 
new document number, PrintSmith checks to make sure that the number you have assigned is 
unique. If the number has already been used, PrintSmith won’t allow you to use it again. 

Note:  On a Multi-User system, this doesn’t guarantee the number is unique since, theoretically, 
everyone on the system could manually assign the same number to a document and 
PrintSmith can only check existing documents, not documents in the process of being 
created. Because of this, PrintSmith checks the number again when it is filed to make sure 
the number is still unique. So it is possible, though unlikely, that you will get a warning at 
the time the document is filed. 

Manually assigning a document number does not change the numbering sequence. After a 
document is filed with a manually assigned number, PrintSmith will ask you if you want to start a 
new numbering sequence. This allows you to reuse an old number without changing the normal 
numbering sequence. 
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Filing Documents 
When you file a new document, the following occurs: 

• A unique number is assigned to the document. 

• The invoice and all the jobs, charges and notes are stored on your hard disk. 

• The document is added to the Pending List and indexed for retrieval by number. On a Multi-
User system, all of the other Workstations update their pending lists to show the new 
document. 

• If there is a deposit on the document (invoices only), PrintSmith makes an entry in the Register 
Tape for the deposit and adds the deposit into the electronic cash drawer it maintains. 

• The customer account is updated to reflect any changes in the sales statistics caused by the 
new document (the date of the last invoice or estimate and the number of estimates made for 
the customer).  

When you file an existing document, the procedure is slightly different: 

• The invoice and all of the jobs, charges and notes are updated on your hard disk. 

• If the document is on the Pending List, PrintSmith checks to see if the entry in the Pending List 
is still correct. If it needs to be changed, PrintSmith removes the old entry from the Pending 
List and adds the updated entry. On a Multi-User system, the Pending List is updated 
simultaneously. 

• If any deposit information in the document being filed differs from the information last saved on 
disk, PrintSmith removes the old deposit, if any, and adds a new deposit. 

Customer Accounts 
The customer account is central to all of PrintSmith, just like in your business. When documents 
are picked up, they are placed in the account history of that customer. The Pending Document List 
can be sorted by customer accounts. PrintSmith tracks sales statistics for each customer account. 
You tell PrintSmith which account to use by assigning each document to a customer account. 
Usually, it is best to assign an account when a document is created. 

In addition to the name, address and phone number in the account, the customer account is used 
to determine if an invoice will exceed the customer’s credit limit. PrintSmith assigns the sales rep. 
automatically based on the information in the customer account or contact and uses the User ID 
name for Taken by. It also determines whether a deposit is needed or a PO is required or if an 
automatic discount should be applied to the order. The tax table (which may change the tax rate), 
tax code and tax status is based on the assigned account. Assigning a customer account can even 
affect special instructions on job tickets and documents. 

Note:  Each time you open a document that is not assigned a customer account, PrintSmith will 
ask you to assign a customer account by displaying the Account Selection list. 

When setting up customer accounts, it is important you set up accounts for all your regular 
customers, even if you do not extend them credit. PrintSmith is quite capable of handling 
customers who do not have credit, have lost their credit or even those you will not do any more 
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business with. If you have not set up an account for a customer, PrintSmith can’t track the history 
or provide valuable sales information. 

PrintSmith has a special account for customers who do not have their own account. It is referred to 
as the “<<< WALK IN >>>” account. When you first start using PrintSmith, the Walk In account is 
the only account. When you assign this account to a document, you can enter the name and 
address of the customer. Later, you can tell PrintSmith to create an account or prospect for that 
customer using the information in the document. 

As you use PrintSmith, create a customer account for almost all your orders and estimates. 

If a customer uses your services once, you want them to continue using your services. If you have 
set up an account for them, you can examine their history, mark them as inactive, generate mailing 
labels, and market to them. This will also help you identify customers who only use you as a source 
for quotes and never send you any orders. You can find out why you never get their orders and 
decide whether you want to continue giving them estimates. 

Should your customer list become cluttered with accounts you never use just move them over to 
the Prospect list or let the aging process do it for you. 

It is possible to get confused between the walk in account and a regular account. Imagine that you 
create an invoice for “Bob’s Hardware”, assign it to the Walk In account and enter the customer 
name and address directly into the invoice. Later, you create a customer account named “Bob’s 
Hardware” and create more invoices. Now you’ve got several invoices in the Pending List for “Bob’s 
Hardware”. The first one is on the Walk In account and the rest are assigned to the “Bob’s 
Hardware” account. If you try to pickup all three at once, PrintSmith won’t let you since they must 
all belong to the same account. Worse, if you pickup just the first one, it will seem as though the 
document went off to never-never land as it won’t show up in Bob’s history — it’s in the history for 
the Walk In account. 

To assist you in identifying documents assigned to the Walk In account, the Status window in the 
POS module always shows “(Walk In)” at the beginning of the account name. Further, the Cash 
Register window shows a description for the “Walk In” account (which is account #1) when you pick 
up a Walk In account invoice. Documents in the Pending Documents window assigned to the Walk 
In account are shown in italics. 

Note:  To reduce these types of problems, we recommend that after you create a document for a 
new customer, you use the Create Customer fm Document command to create an 
account for that customer. This will also greatly reduce the number of documents 
assigned to the cash account. If an account already exists and the invoice was created 
using the <Walk In> account, simply select the correct account or Change Account icon in 
the invoice window.  
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Working with Existing Documents 
Once you have created a document, you need to be able to find it again. How you find it depends 
on the document type and its status. You can open any document by using Review any Document, 
specifying the document type (Invoice or Estimate) and the number. Remember document 
numbers comes easily to computers, but not so easily to humans, so PrintSmith has several other 
methods you can use to quickly find documents. 

When you first create a new document, either by creating it from scratch or copying it from an older 
document, PrintSmith puts it in the Pending List. The Pending List is used by PrintSmith to organize 
and track all of the “active” documents (Invoices and Estimates) in your shop. An active invoice can 
be modified any way you see fit, even cancelled. When you tell PrintSmith the work has been 
delivered, it’s picked up and removed from the Pending List. It is now part of Accounts Receivable 
and Account History. You remove an estimate from the Pending List using the Cancel Document 
command in the Invoice menu, the Clear Estimates command in the Admin menu, from the 
Pending List using the Archive button, or by converting it to an invoice using the Convert to Invoice 
command in the Invoice menu (at which time it becomes a pending invoice). 

When you need to find an active document, you’re more likely to be looking for an invoice for 
letterhead for Joe’s Plumbing Service than invoice #1234. PrintSmith recognizes this and groups all 
of the documents in the Pending List by the account name followed by the document number. You 
can use the Update Pending Document command in the Invoice menu to open any document on 
the Pending List. For even more flexibility and control, you can use the Pending Document Window 
in the POS menu. Using this window, you are able to view more information about pending (active) 
documents without opening them. 

Eventually, each document in the Pending Document Window is removed from the list. Estimates 
are converted to invoices if you get the job or cleared if you did not get the job. 

Invoices are finished and picked up to Accounts Receivable or paid. Cleared estimates can be 
tracked in estimate history or voided. Invoices that are picked up or paid are kept track of in the 
Account History. You can open these documents directly from the history entry or use the Review 
Any Document command to retrieve it by number.  

These old documents are “locked” since they form part of the audit trail PrintSmith maintains. 
However, all of the details in the document are retained and you can copy these documents to new 
estimates or invoices. PrintSmith optionally updates the pricing information with the latest prices 
when the document is copied, but retains all of the descriptive information and notes you’ve made 
on the job (the location and condition of the artwork, special pricing instructions and so on). 

When you copy a document from history, PrintSmith remembers the source invoice. The old 
document number is displayed in the invoice window and printed on job tickets. The purpose of 
remembering the old document numbers is so that you can file artwork by document number. 
When you get a repeat order, the job ticket will have the old job number making locating the old 
artwork very easy. Using this system has the added benefit of automatically “aging” your art files. 
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Copying Documents 
The longer you use PrintSmith, the more likely it is that you will receive orders for work that you 
have done before. A tremendous amount of time and effort can be saved by simply copying an old 
invoice to a new one and updating the quantities and pricing. 

Selecting either the Copy To New Invoice or Copy to New Estimate commands under the Invoice 
menu copies the information in the old document to a new document. The order date is 
automatically updated to the current date. The document number, delivery, posting, and customer 
notification dates are automatically removed. 

PrintSmith remembers the number of the document from which you copied. This number is 
displayed in the invoice window and is printed on job tickets so you can file artwork by the invoice 
number. If you copy an invoice to an estimate and then convert or copy it to an invoice both 
numbers are remembered. 

When documents are copied, the current tax status of the customer account is copied to the 
document. If the account is not taxable at the time the document is copied, the document is not 
taxed. 

When you copy a document or open a template PrintSmith asks if you wish to reload the latest 
pricing information and recalculate the entire document. This is a powerful feature and it is 
important you understand all the ramifications. 

On the plus side, you can open an invoice that is 5 years old and the work specification will be 
correct and the prices will be current. On the minus side, pricing folders and templates are not 
interchangeable among different PrintSmith systems. This is because PrintSmith has to be able to 
locate all stock, press, copier, and charge definitions in order to update the prices. It does this using 
an internal, unique identifier for each of these elements. PrintSmith automatically assigns this 
identifier and you never see it; however, the same press or copier definition created on a different 
machine will almost certainly have a different identifier. Imagine a situation where a typesetting 
charge in one system had the same internal ID as a folding charge in another system! PrintSmith 
checks the names of charges to see if they match and will ask you if it is OK to proceed if there’s 
any difference. It will also inform you if it can’t find a matching definition for a stock, press or charge 
or if the new price differs from the old. 

Note:  Even though all pricing information is updated, PrintSmith will not change the price if you 
have overridden it or locked pricing. 

Copying Jobs in Documents 
Perhaps the easiest problem you’ll ever solve is the all too common situation where you finish a 
complex quote for multiple quantities and the customer asks you to quote it with a couple of 
different stocks or bound in a different way. 

You can copy and paste a job using the standard Edit menu commands; but the fastest way to 
duplicate a job is to hold down the <option>/<alt> key, point to the job to be copied, and drag it to a 
new location in the document. This copies the job and all its charges. Open the new job and 
change as needed to finish the quote. 
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Managing Templates 
PrintSmith supports an additional document type called a template. A template is a document 
containing a complete specification of a job or a complete order. You can create a template from 
any open invoice, estimate, or job by selecting Save As in the File menu. 

Templates are stored in individual files with names assigned by you. PrintSmith normally stores 
them in the Templates folder inside your PrintSmith Folder, but you can put them anywhere you 
want. 

There are two types of templates: document templates and job templates. A document template 
consists of an entire document. It includes everything in the document except dates and customer 
account information. A job template consists of a single job and all of the charges for pre press and 
bindery on that job. A job template can also be created for multi-part jobs. This type of template 
contains the multi-part job, its charges, and all of the parts of the book and their charges. 

When a template is first opened, PrintSmith will ask if you want to update the template with current 
prices from your pricing database. Any prices that you have manually overridden will remain 
unchanged even if you reload the prices. Even if you do not reload pricing, PrintSmith will 
recalculate a job template and this can sometimes result in a change in the price due to changes 
you may have made in tables, new tax rates and so on. 

Note:  On multi-user systems, you can avoid copying templates to each Workstation by setting 
up an alias to the Templates folder in the PrintSmith Master and copying that alias into the 
templates folder of each Workstation. Selecting the alias opens the template folder on the 
PrintSmith Master and you will be able to create new templates and open existing ones on 
the PrintSmith Master. This requires that you enable File Sharing on the PrintSmith 
Master. 

Document Templates 
A document template is an easy way to pre-define a common order. Say, for example, that you 
want to offer a special promotion featuring letterhead, envelopes and business cards at a special 
price. You could create a document for the special promotion and override the prices to reflect the 
sale price, and then save it as a document template with everything, including the price overrides, 
preset. Each time you sell one of these special offers, you simply open the template, copy it to an 
invoice, and enter the customer information. 

Creating a document template is easy. First, create a complete document (you can use any 
existing document including other templates). Instead of filing the document, select the Save As 
command in the File menu. PrintSmith automatically opens the Templates folder and asks you to 
name the template. Use a name such as “Fall Special Offer” or “Businessman’s Special” so it’ll be 
easy to find later. When you click the Save button, PrintSmith will create a file in the Templates 
folder that contains the complete order except for the customer information. 

Selecting the Open Template command opens a list containing all of the document templates 
stored in the Templates folder. Select the desired template and a document window opens which 
contains all of the specifications you saved when the template was created. 

Select the customer account the order is for and then use either the Copy to new Invoice or Copy 
to new Estimate command in the Invoice menu. 

To edit a template, use the Save command to update the contents of the template file. You can 
save complete customer information in a document template by holding down the <control> key 
when saving the template. This is useful when restoring from backups where you want to save 
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work done since last backup. When using this method to preserve data in preparation for a 
restoration from backups and the document is for a new customer (one created after the last 
backup), change the account to the “Walk-In” account before saving the template. After restoring, 
you can use the account information in the template to re-create the customer account with the 
Create Cust Acct fm Document command. 

The Document Windows 
There can be multiple document windows open at one time. Document window types are: Estimate 
or Invoice. 

Figure 3.1: Invoice Window 
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Elements of a Document 
General Elements 
Account  

The name of the (customer or prospect) account assigned to the document is shown here. To 
assign an account to a document, double click anywhere on the name. If no account has been 
assigned, the account list is displayed. If an account is already assigned, the Account Info window 
is opened. Select the Change Account icon (or select Change Account option under the Invoice 
menu) in the invoice window to assign a different account to a document. 

Document Body  

This area is used to display all the jobs and charges that are part of the document. You open an 
existing job or charge by double-clicking on the line it is displayed on. You can create a new job by 
double clicking on “double click to create new job” or clicking the New Job icon. 

Document Format Menu 

This menu contains a list of all of the document formats. You can create more formats using the 
Document Preferences command in the Admin menu. 

Deposit Entry  

This area shows deposit information and document status information such as the source 
document number. You can open the Deposit Entry window in an invoice by double clicking in this 
area.  

Document Totals  

The invoice totals are displayed here. Double clicking in this area is the same as selecting the 
Document Totals command in the invoice menu and opens a window showing a detailed 
accounting summary of the document. If the document has been posted, “Amt. due” shows the 
current outstanding balance including all payments. 

Document Number 

The document number is used to uniquely identify each document.  

Window Title  

The window title describes the type of document and number. The types of documents are 
Estimates, Invoices, and Templates. You can click and drag the window title to move the entire 
window around on your screen. 
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Functionality Toolbar 
This toolbar lets you perform common functions with the mouse. The File, No File, Notes, and Print 
icons have equivalent menu commands and are subject to the same security as the menu 
commands. The buttons are grayed out when the menu command is not available. 

Figure 3.2: Functionality Toolbar 

 

File  

The File icon saves the document in the PrintSmith database and closes the document window. 

No File  

The No File icon is equivalent to the Close command in the File menu. It closes the document 
window without saving any changes. 

Notes  

The Notes icon is equivalent to the Note Pad command in the Invoice menu. It opens the 
Estimator’s Note Pad window, which can be used to record notes about the document for later use. 

New Job 

Click the New Job icon to add a new job to the document. 

Change Acct 

The Change Account icon allows you to switch the selected customer to another customer. 

Tickets  

The Tickets icon gives you an easy way to generate job tickets for an entire Invoice. The Tickets 
icon is equivalent to opening each job on the invoice and selecting Job Ticket command in the Job 
window. However, it can also print a job ticket for invoice level charges. When you click the icon, 
the Invoice is filed before the tickets are printed. Usually, the document window remains open after 
tickets have been printed. You decide whether to close the document window after printing tickets 
using the Close Invoice After Printing Tickets setting in the Estimator preference panel.  

Print  

The Print command is equivalent to selecting Print from the File menu. It is used when you want to 
generate a hard copy of the document. Before a document is printed, it is first filed. There are many 
options and adjustments you can make to the printed form to customize it for your shop. When a 
document is printed, it uses the format selected in the format menu to control what is printed. 
PrintSmith remembers what format was selected and automatically selects it the next time the 
document is opened. 
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Preview  

This icon opens a window showing the document, as it will be printed. This is an excellent tool for 
adjusting the appearance of documents as a result of changes made to the format menu selection 
and/or Invoice Preferences. 

Costing  

Changes the invoice display from pricing to costing. The button then becomes Invoicing to switch 
back to the pricing display.  

 

Additional Buttons Displayed (PrintSmith Estimator and PrintSmith Lite) 
Pickup  

The Pickup button is visible only with PrintSmith Estimator and PrintSmith Lite. These systems do 
not have a POS Menu although they do support a Pending List. Clicking this button removes the 
document from the Pending List. It is similar in function to the Pickup function in the Pending 
Document Window except there are no accounting functions performed and there is no account 
history to update. 

Quote  

Quote appears on request for quotes (RFQ’s) received from PrintSmith Site. Clicking here sends 
an E-mail estimate with a web link where they can accept or reject the estimate.  

Accept  

Accept appears on orders received from PrintSmith Site, and allows for electronic notification of 
invoice details to clients. Clicking here sends an E-mail invoice complete with updated tax and 
shipping information. You can delete any line item from a document by selecting it and pressing the 
<delete> key. 

 

Preset Charges 
An extremely powerful feature is the ability to assign charges to stock, press and copier definitions, 
which are automatically added to documents. In the illustration below, plates, ink and cutting was 
added because they were preset on the press. This is indicated by “•”. “Padding - carbonless” has a 
“◊” symbol because it is preset in the stock definition. 

You can delete preset charges, but they are not actually taken off the document. That way if you 
later recalculate the document or copy it and update prices, preset charges are not added back - 
they remain in their deleted state. If you change the stock, copier, or press definition used with a 
job, the preset charges belonging to that definition are removed. 

When a preset charge is deleted, the item is grayed out and is displayed on screen with a strikeout. 
The charge is removed from the job ticket and pricing calculations, but stays with the job so 
PrintSmith knows you don’t want to use it in this particular job. 
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Special Flags 
In each job and charge window there is a group of buttons across the top of the window used to 
indicate if the job is Finished, Brokered or Taxable.  

Note:  These flags are displayed in the document window for information. They are not printed on 
the document; your customers will never see them. If in doubt, use the Preview button to 
see what the printed document will look like. 

Table 3.1: Document Line Item Flags 
Flag Meaning 

  

(nontx) This item is not taxable. 

? The “Finished” button has been turned off indicating that pricing is incomplete for this item. 

B The Brokered button has been turned ON indicating that this item was sent to another vendor for 
completion. 

¶ Job Ticket notes have been entered. Only applies to jobs. 

+ Indicates that there are additional quantities that will be printed for the job. Displays to the right 
of the quantity. 

italic Job total in italics indicates that the job price includes Overs or Unders. 

* After price indicates that the price has been manually overridden. 

underline Items that are underlined have been hidden using the Hide Item command in the Edit menu. 

 Charge is not a discounted price. 

  

 

Multi-Part Job Elements 
A multi-part job consists of two parts: first, a control job for specifying overall quantities, and 
second, parts and charges which describe the contents. Because a multi-part job has other jobs 
that are “attached” to it, a somewhat different display format is used. 

A multi-part job (sometimes referred to as “booklet” or “booklet control job”) is numbered just like a 
regular job. In this case it is job number 1. Note that there is a charge for saddle stitching below the 
multi-part job. This is for stitching the entire multi-part job. Below that is another job. This job 
belongs to the multi-part job and describes its cover. You can tell it belongs to a multi-part job 
because PrintSmith does not show a quantity next to the job description (the quantity for multi-part 
jobs is entered in the control job) and the job number is different. This is job number 2 belonging to 
the multi-part job defined in job number 1, hence “1.2” is the designation for the job. The charges 
below this job are used only for that part of the multi-part job. The next job is 1.3. (A fourth job not 
connected to the multi-part job would be number “4”.) 

Jobs that belong to a multi-part job can be “hidden” using the Hide Item command in the Edit menu. 
Alternatively, you can choose to always hide jobs that are part of a multi-part job by using 
Document Preferences. 
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Using the Mouse on Open Documents 
Many of the commands dealing with the contents of open documents can be invoked by double-
clicking on the appropriate part of the Invoice window. You can also use the mouse to rearrange 
line items in the invoice window by dragging them around or to copy items by holding down the 
<option>/<alt> key when dragging. 

Double-clicking anywhere in an existing line item in the document body opens that job or charge for 
editing. Double-clicking on the line “Double-click to create new job line” creates a new job. 

Double-clicking on the account line opens the Account Info window. Double clicking in the 
Document totals area opens the Document Totals window. Double clicking on the format box opens 
the Deposit Entry window. 

When there are more line items in the document than can be displayed at once, you can use the 
scroll bar to scroll through the list. PrintSmith always displays a line at the end of the line items that 
reads ‘double click here to create new jobs’. When the mouse pointer is over a section of the 
window which you can double-clicked on it is shaped like a hand. 

Using the Keyboard on Open Documents 
You can use the arrow keys on the keyboard to select items in the document window. The left 
arrow selects the customer account line, document details, document totals; the right arrow selects 
document totals, document details, and then customer account. The up and down arrows select 
individual line items. The <return> or <enter> keys open the selection (just as though you double-
clicked). 

Using the Edit Menu on Open Documents 
Generally, it is much easier to drag-copy items than to use the Edit menu to copy them. You can 
use the Hide/Show item command to selectively show or hide items in the document. 

Cut and paste entire jobs including entire multi-part job specifications, or individual charges using 
the Cut, Copy, Paste, and Clear commands. Pasting a job always puts it at the end of the job list 
just before invoice level charges. Charges can also be cut, copied or pasted. To paste a charge 
into a job, select the job, then the Paste command. Charges are added to the end of the 
appropriate charge list in the selected job. 

If you copy or cut a job that is part of a multi-part job, it becomes a regular job that is not part of any 
multi-part job when it is pasted in. 
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Manipulating Document Elements 
Direct manipulation of document elements is one of the reasons PrintSmith is so easy to use. You 
can rearrange items, remove them, copy them, and change quantities and prices all from the 
document window. Once a job has been defined, the only time you need to open it up again is to 
change production specifications other than the quantity. You can even add jobs to documents by 
dragging them into the document with a mouse. 

 

Re-arranging Document Line Items 
Using Drag and Drop in the invoice window is extremely powerful and incredibly easy. 

• Point to any item in the invoice window and move it wherever you like. 

• Press the <option>/<alt> key to make any drag a copy operation. 

• Drag jobs into and out of multi-part jobs. Rearrange multi-part job parts or charges. 

• Mac Only: Drag any item to the Trash to delete it. Drag a deleted item out of the Trash back 
into the document. 

• Mac Only: Create a Job Template by dragging a job to the Desktop or to a window in the 
Finder. 

• Mac Only: Drag a job template from the Finder into a document to add it to a document without 
even opening the job window. 

• Mac Only: Drag charges to the desktop to create clipping files that can be dragged to other 
jobs. 

When dragging, an outline of the item moves with the mouse and a “highlighting” line indicates 
where the item will be “dropped” if you release the mouse. 

 

Editing Quantities or Prices in the Document Window 
When you submit a bid or generate an invoice, you may often need to change the quantity or price 
on a line item. As long as the document is not locked, you can change any part of it at any time. 

Usually, you simply double click on the line in the document you need to change and edit the 
charge or job in the estimating window. If the only thing that changed was the quantity or you want 
to override a price, you can edit the item directly in the document window without opening the job 
window for it. 

Point to the quantity or price you want to change, click on it, and type in the new quantity or price, 
then press <return> or <tab>. Changing a quantity causes PrintSmith to recalculate the job and all 
associated charges. Changing the price is an easy way to override a price. 

Note:  If your User ID does not allow you to override prices, you will not be able to override the 
quantity on most job aware charges or charges that do not allow overrides as part of their 
basic definition. 
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Overriding the Estimator 
Although you will probably want to use the price calculated by the Estimator most of the time; you 
may occasionally need to modify a price to reflect special circumstance like a rush job or a difficult 
customer. You could set up a special set of markups for both of these things – it is hard to think of 
something PrintSmith cannot price. Nevertheless, you can always change the Estimator’s price; 
and, like most things in PrintSmith, it is a matter of pointing and clicking. 

In all the windows of the Estimator in which you enter data, you can move from one text box to the 
next by using the <tab> or <return> key (if there is no default button). 

The Estimator skips those text boxes that you normally would not want to change or rarely use. A 
good example is the “Price:” field in the job window. You can change the price in this box by 
clicking in it and entering a new price. This is how you override a price. The rules the Estimator 
uses to determine if the price has been overridden are the same for all prices and factors: 

• When a text box, which accepts overrides, is selected (a blinking cursor is in the box or the text 
is highlighted) the Estimator assumes that you are overriding the price. 

• If you type anything in the box it becomes the new value and is marked as an override and 
displayed as a text style. In Microsoft Windows, overrides are shown in underlined italics. 

• To cancel an override, simply remove the entire value from the text box. The easiest way to do 
this is to select the overridden value, then press <delete> or <back-space>, then <tab>. 
Entering a 0 in place of the price will not cancel the override since 0 is a possible override. 
When PrintSmith sees a completely blank (empty) field, it will replace it with the calculated 
price and remove the override mark. 

 

When you override, be aware that any changes to the invoice, which would normally change the 
price, will not change an override. For example, if a job for 100 envelopes was priced at $20.00 and 
you changed the price to $15.00, altering the quantity to 500 would not change the price. If you 
remove the override, PrintSmith recalculates the job using the current quantities. To remind you 
that a price has been overridden, PrintSmith shows a “*” in the price column of the document 
window for any line item that has its price overridden. 

Note:  Price overrides are dangerous when you are generating a quote for multiple quantities. 
For example, if you override a folding charge on a job, that price stays overridden for all quantities. 
This may not be what you want. Where possible, it is usually better to use markups or discounts. 

Create Invoice 

Create a new invoice by selecting the Create Invoice command from the Invoice menu. Assign the 
document to a customer account from the customer account list. “Customers” “Prospects” and 
“Contacts” appear at the top of the window.  

Note:  The first account in the list is always the <<< WALK - IN >>> account. Use this account for 
new customers that do not have their own account yet. You can then create a customer 
account from the document (by selecting Create Customer Fm Document in the Invoice 
menu). 
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Copy to New Invoice 

Selecting the Copy to New Invoice command copies the document into a new Invoice. When a 
document is copied, the dates (ordered, wanted by, proof, etc.) and deposit data are cleared or 
reset and you are given the option to update the pricing information. 

If you use this command on a new estimate that has not been filed, it simply changes the document 
to an invoice rather than making a copy. On a new invoice, this command does nothing. 

Update Pending Document 

This command opens the Update Pending Document List. The Update Pending Document List 
shows all invoices in progress, awaiting pickup and all estimates grouped by account name. Use 
the keyboard to rapidly search through the list by typing the name you are looking for. Selecting an 
entry from this list opens the selected document. 

Figure 3.3: Update Pending Documents List 

 

 

Searching the Pending List 
In addition to searching alphabetically, you can search for text embedded in a name, all or part of 
phone numbers, PO Numbers, and other data using the search tool at the bottom of the window. 

The process is very simple. Click the drop tab for the data you want to look for, enter the text in the 
text box, and click the Find button. The drop tab is used to select the data to search for. It can also 
be used to examine data for the selected item because it shows that item’s data to the right of the 
search text entry field. 

Notes:  Pending list is highlighted so typing searches the list instantly. To perform other searches, 
select a drop tab, enter the search data, and click the Find button. 
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Review Any Document 
The Review Any Document command allows you to open any document using its document 
number. 

Figure 3.4: Review Document Window 

 

Select the document type you want to find by clicking on one of the buttons or by typing an “I” for 
Invoice, an “E” for Estimate or “W” for Web Reference (if you have the optional e-commerce 
product). Enter the document number and click the OK button. 

If the document cannot be found PrintSmith will tell you and will leave the window open. 

Click the Cancel button or enter zero for the document number and press <return> to close the 
window without opening a document. 

This command can be used to open any document so you can use it to open an invoice, which has 
already been posted to Accounts Receivable (or paid off). Invoices, which have been posted, 
cannot be changed and PrintSmith displays “<<< LOCKED >>>” in the total display area of the 
document window. You can copy a locked document into a new invoice or estimate and make 
whatever changes you need. 

Notes:  You can also open documents that are voided. The word VOID with the date on which the 
void occurred is displayed in the document body. 

 

Create Estimate 

This command operates exactly like the Create Invoice command except the document created is 
an Estimate rather than an Invoice. Once an Estimate has been opened, you will see a new field 
called Copy to New Estimate.  
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Account Info 

This command is used to enter information about the customer account and other information 
pertaining to the entire document. This window will open when an account is assigned to the 
document. If the selected account is the <<<Walk In>>> account, then this window opens with the 
Edit Address window on top of the Account Info window. 

Figure 3.5: Account Info Window 

 

Title 

The text in title field is used in Account History to describe the product priced in the invoice. 
PrintSmith automatically assigns the description of the first line item in the document (usually a job) 
as the title if you do not enter one. You can change the title in this window at any time prior to 
posting the invoice. After posting, the title can be changed in Account History.  

Changing Document Numbers 

If PrintSmith has not already assigned a document number, you can assign one manually by 
clicking on “**new **” and entering the desired number. PrintSmith checks the number you entered 
to make sure it has not been used and makes you change it if it has. When you file or print a 
document and you have manually assigned a document number, PrintSmith will ask you if you 
want to start a new numbering sequence starting from the number you entered. 

Notes:  It is possible, though very unlikely, PrintSmith will reject the number you select when you 
file the document. This can happen in a multi-user system if two users simultaneously file 
a document that has the same manually assigned number. 
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Address 

When you select an account for a document, the invoice name and address, and default invoice 
contact information are copied from the customer information and displayed in this section. The 
“<<< WALK - IN >>>” account is a special account which is designed to be used for customers that 
do not have their own account. When you use this account, PrintSmith expects you to supply the 
customer’s name and address. However, you are not required to do so. The account name and 
address can be changed if you are signed on with proper access. This can be changed via the Can 
Change Address On ALL Documents setting in the Estimator preference, which allows the address 
to be changed on all documents. In addition to this system wide preference change, there is the 
<<< WALK - IN >>> account. 

This block shows the formatted address, as it will appear on the document. The text may be shown 
in blue. Indicates that the address is not the same as the default Invoice address of the Customer 
Account. There are two possible reasons: 

• A contact was selected that has it’s own address. 

• Can Change Address On All Documents is disabled in the Estimator Behavior preference 
window and this address was manually changed when that option was enabled. 

This preference is a local Workstation preference so one Workstation can make changes while 
another might not. 

Contact Block 

The contact block usually contains information from the contact record. You can change the contact 
information for each document. 

When you have changed the contact information in the document, the Contact List reflects this by 
changing the selected contact to “Temporary Contact”. This provides a visual clue and allows you 
to change back to the stored contact information by selecting it from the contact list again. 

The Contact field allows you to enter a contact for this document if there is not an existing contact 
already in PrintSmith. Use the pop up menu to select one of many contacts assigned to the 
account. If the contact you require is not present you can easily add one by selecting New from the 
File menu or using the shortcut Command N. This new contact will be added to the customer 
account when the document is filed. You can have up to 100 contacts per account. 

PO # 

If the assigned account requires a PO on all orders, PrintSmith will remind you regularly to enter 
one, and until you do, you cannot pick up the document. This field holds up to 24 characters. 

Resale # 

This is used to record the tax exemption ID or license number of accounts that do not pay sales 
tax. This information is automatically copied from the account info. Taxable status is determined 
solely by the No Tax button in the Document Totals window.  

Whenever this field is changed, a message is displayed asking if you want to change the taxable 
state. You can click the Yes button to make it taxable, click the No button to make it non taxable, or 
the Cancel button to leave it unchanged. This message is removed when the Eliminate some 
warnings button is turned on in the System Behavior preference panel. 
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Ordered on, Wanted by Proof by, Re-order 

The Estimator automatically supplies the date and time ordered when you create the document but 
can be modified. PrintSmith calculates the date wanted if the number of days specified is not zero 
in the Normal Due Date (Days) setting in the Estimator preference panel. You can supply a 
different date and time wanted if you wish. 

The date wanted is used in many different locations, the most visible being Work In Progress (WIP) 
and Pending Documents. The Proof date is printed on Job Tickets and in many of the WIP reports. 
The Re-order date is used by the Re-Order List report - it is the date on which you, or the account, 
expect to need a re-run of the order. 

Note: The Re-order Date can be changed on locked documents. 
PrintSmith is pretty smart about dates. If you enter a date as “+5” it is understood to be five days 
from today, but if that day falls on a Saturday or Sunday, the following Monday is selected. If you 
enter a date as “5” and today's date is March 20th it assumes you mean April 5th. You can also 
enter the day of the week and PrintSmith will find the date on which that day next falls. For 
example, if today is Tuesday and you enter Monday, PrintSmith will return the date of the following 
Monday. You can specify the day as one or more letters (S = Sunday, M = Monday, T = Tuesday, 
W = Wednesday, TH = Thursdays, F = Friday, SA = Saturday). 

You can of course fully specify the date in the form month-day-year or month-day. The parts of the 
date can be separated by anything except another number. When you specify a date, PrintSmith 
always gives you the day of the week it falls on. 

Note: Select the Firm wanted by date option if the date specified is the exact date the customer 
wants the order. 

Account Status and Type 

The account type and status is displayed for your information. The account type optionally prints on 
the invoice and job ticket. 

Taken by 

This identifies the person who created the document in PrintSmith. Initially, it is always the User ID 
of the person currently signed in, but you can change it to any name you want. 

Sales Rep. 

You can use the Sales Rep. ID to identify the person who sold the order or created the invoice. It is 
limited to fifteen characters. When a customer account is first assigned to a document, the contact 
sales rep. defined in the customer account is used. If none, the customer sales rep is used. 

Notes:  Changing the customer account also changes the sales representative if one has been 
assigned to the account. 

 If you pay commission on invoices you might consider locking sales rep. names so they 
cannot be changed without proper access.  

Ship Via 

Specify customer notification instructions using the pull down table that lists the notification options: 
Call, Will Call, Deliver and Ship, Fed Ex, etc. You can customize this Ship Via Table in the Table 
Editor in the Admin menu. This delivery designation can be printed on your invoice and job tickets. 
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File Originals 

The default setting is entered in the Account’s setup in the Settings panel. It is used as an 
instruction for filing artwork. 

Hold State 

The Hold State field is for indicating or changing a document’s hold status. Clear the hold state by 
pressing the delete key while the hold state description is highlighted. Hold State tracks a 
customer’s credit or job hold status. A display column can be added to the Pending Document 
window and is also tracked on the WIP report. The Hold State table can be changed in the Table 
Editor. 

Special Instructions 

Enter remarks that optionally appear on customer facing documents. Although there is limited room 
in the Special Instructions block, enter as much data as you like and PrintSmith will print it with the 
document and save it with the document. If you exceed the available display area, PrintSmith will 
scroll the text as you type. You can move around in the text by using the arrow keys on your 
keyboard. 

Customer Comments 

If you have PrintSmith Site, you may also receive customer comments in this window. This contains 
data that a customer entered when placing an order or RFQ. 
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Jobs 
Most of the work completed in the Estimator involves jobs and charges. Jobs are created from the 
Jobs command in the Invoice menu or from within an Invoice or Estimate. The first step to creating 
a job is to select a Pricing Method. The Pricing Method determines the properties of the job (i.e. 
what parts of the pricing system are used to generate the price). Each of the pricing methods that 
PrintSmith uses was designed to handle a particular kind of job. Once the pricing method is 
selected, the Job window will display only the fields applicable to that pricing method. After you 
create the job, you add charges for pre press and bindery operations to complete the quote. 

The major pricing methods supported by PrintSmith are: 

Table 3.2: Pricing Methods 
Pricing Methods Pricing System Components Used 

  

Printing Stock Definitions, Press Definitions, Speed Tables, Waste Charts 

B&W Copying Stock Definitions, Copier Definitions 

Color Copying Stock Definitions, Copier Definitions 

Blank Stock Definitions 

List Stock Definitions 

Outside Services Outside Services Markup in Preferences 

Merchandise Merchandise Markup in Preferences 

Lines & Inches Lines & Inches Price Schedule (Rubber Stamps) 

Multi-Part Job Not applicable – contains other jobs. 

Mailing Merchandise Markup in Preferences 
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Creating Jobs 
Jobs can be created from the menu or from within a document window. To create a job: 

• Select Jobs from the Invoice menu.  

Or 

• Click the New Job  icon in the open document window. 

Or 

• Double click the line item reading <double click to create new job> in the open document 
window to which the job will be added. 

Figure 3.6: Job Window 

 
 

Note:  The window title for a job shows the document number and job number in addition to the 
pricing method. If a job is created from the invoice menu and has not yet been associated 
with a document, “New Job” is listed in the window title until a pricing method is selected. 
Once a pricing method is selected, the pricing method is displayed in the window title. 

 

Pricing Method 
Icons 

Pricing Method 
Commands  
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Selecting Pricing Method for Jobs 
The Pricing Method is selected within the Job window.  Select the pricing method to be used to 
define the job by either clicking the applicable pricing method icon or by selecting the applicable 
pricing method from the hierarchical list.  

Note:   See Table 3.2, page 76 for an overview of the available Pricing Methods. 
Depending on the Pricing Method selected, the stock picker window may be displayed. If this 
window is displayed, select the applicable stock, define it as Customer Supplied Stock, or specify 
Special Order stock. Additional instruction can be found in the Specifying Stock Information section. 

Note:  Depending on preference settings in the Estimator Behavior preference panel, the Paper 
Calculator window may also be displayed when pricing jobs requiring paper. Refer to the 
Using the Paper Calculator section for additional instructions. 

The fields displayed in the job window depend on the method selected. The Job Method category is 
collapsed and the Charges and Commands categories are expanded in the Task List. 

Figure 3.7: Job Pricing Information 

 
 

Note:  The Submit button supports integrated devices.  If no integrated devices are defined, or if 
the job does not use a press or copier that is an integrated device, the Submit button is 
disabled. 

Task List 
includes the 

Charges 
and 

Commands 

Functionality Icons 

 

Details of the 
Selected Pricing 
Method 



Chapter 3:  The Estimator 

 
 

 
Page 79 

Printing Pricing Method 
This pricing method is designed to price printing. When setting up a printing job, PrintSmith makes 
a number of assumptions and selections. Before a price can be generated and the job window set 
up, PrintSmith needs information on the stock and the press. Once the stock and press data have 
been set up, PrintSmith calculates a preliminary price for the job (often this will consist only of the 
charge for setting up the press). For simple jobs, change the description and enter a quantity. 

Figure 3.8: Printing Pricing Method Job Example 

 
 

Note: Clicking in the Ink field opens the Ink Editor, which allows for seven ink descriptions that 
can be auto-populated from the Ink Color Table.  CMYK should be entered in four 
separate fields. 

Stock 
Information  

Press 
Information  
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Table 3.3: Printing Pricing Method Quantity Fields 
Field Definition 

  

Press This is the number of Impressions needed to get the finished quantity. It is normally 
calculated for you by dividing the number Ordered by the number Up. You can enter the 
Press total directly and PrintSmith will change the number Ordered as needed. If the 
Press total cannot be divided evenly by the Up number, PrintSmith will round up. 

Est Waste This is calculated based on the number of passes and impressions. The actual rate is 
taken from the Waste chart based on the Press count. If for example, you had a job with 
1000 impressions and 2 runs and the waste percentage (taken from the Waste Chart) 
was 10% the estimated waste would be 100 for each run for a total of 200. You can 
override this quantity to use a particular value. 

Imp/Run The number of impressions for each run. This is the press count plus the waste count 
times the set count. Your pressman can use this for the impression counter. PrintSmith 
supports a partial run concept (6 sheets 4 up 4 on would be 1.5 runs). To see the number 
of runs hold down the <shift> key when opening the job window and change any pricing 
specification. This quantity is calculated by PrintSmith and cannot be changed by you. 
Note that “Imp/Run” shows the number of sheets run rather than sets. 

Tot Imp This is the total number of impressions for the entire job. PrintSmith calculates this 
quantity, you cannot change it.  

  

 

The next section of the job is for specifying production run. There is a separate specification for 
printing on the Front and Back. In addition, PrintSmith differentiates between the number of colors 
and the number of passes. This allows you to specify the number of colors independently of the 
Press on which it is to be run and lets you handle situations where you have to run one color twice 
or are only printing one color at a time on a multiple head press. 

When using a roll fed press definition, PrintSmith always shows a zero for passes on the back. For 
Work & Turn, passes on the back are always blank. 

You can move from one field to the next by using either the <tab>, <return>, or <enter> key. Each 
time you do this you will go to the next field with a box around it. Fields with no box, but a white 
background (on color machines) indicate fields where you can override the balance. 
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Table 3.4: Printing Pricing Method Press Information Fields 
Field Definition 

  

Press The name of the press selected for the job. A press is always selected. If you select a stock 
which has a preset press it is used initially. If the selected stock has no preset press, the first 
press in the list is loaded.  
To change the Press selection you can type enough of the Press name to identify the Press and 
press <tab>. If PrintSmith can find a press with a name matching what you have typed, it selects 
that press and loads it in the definition; otherwise, it will open a selection window so you can 
select a press from the list. 
When you load in a new Press definition, PrintSmith also loads in any preset charges (each 
press can have 10 preset charges). If the previous press definition had any preset charges, they 
are removed. 
If the new press has a different number of print heads than the old one, the number of passes 
required (for multi-color runs) is recalculated. For example, if you were running a two color job on 
a press with only one printing head you would have to make two passes. If you changed the 
press to a press with two heads, you would only have to make one pass. When this happens, the 
estimated waste is recalculated as well and the entire job is re-estimated 

Colors The number of colors to be printed on the front and back. The Estimator always recalculates the 
minimum number of passes needed for the press when you change the number of colors. This 
number is also used to generate the number of plates needed on each side. 

Passes The number of runs that will be needed for the number of colors specified. It will initially be the 
minimum number of passes needed for the particular press. If you need to run one color twice, 
for example, you can change the number of passes as long as the number is greater than the 
minimum number of passes. This is treated as an override. However, PrintSmith will 
automatically cancel this override if you change the press definition, the number of colors or 
anything else that affects the number of passes. 
Labor and run time is based on the number of passes, not the number of colors. Charges, on the 
other hand, use the number of colors and ignore the number of passes. 

Washes The number of press washes to be charged to each side of the job. The number of washes (on 
both sides) is multiplied by the “Wash Rate” in the Press definition and included in the job price. 

  

 

Note: For additional information on Press Definitions, see page 253. 
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Waste Calculations 

Waste calculations are directly reflected in the total impression figure. In all cases, you can 
manually calculate running time by dividing total impressions by the speed of the press. There are 
two basic waste calculation models in PrintSmith, one which says that waste occurs in the first run 
when there are multiple runs. The other which says that all of the waste is run in each pass. 

Consider a job consisting of 2 originals run 2/2 on a single color press with a waste factor of 10% 
and a run length of 1000. There would be 100 sheets of waste on this job. The total number of run 
sheets under either model would be 2200. 

In the first model, the total number of impressions used for the estimator would be 4100 for each 
original for a total of 8200 (1000 time 4 colors plus waste of 100 for each original). The second 
model calculates waste in all runs so the total number of impressions would be 1100 times 4 (for 
each color) times 2 (for each original) for a total of 8800. If the press was run at 4000 impressions 
per hour the resulting run time would be 2 hours 3 minutes for the first model and 2 hours 12 
minutes for the second. At $60.00/hour that would translate to a difference in price of $9.00. The 
difference is larger when there are more colors or more originals on multi-color jobs. 

In reality, total impressions are likely to be somewhere between the two numbers and will actually 
vary on each run – the method you use depends on your preference. PrintSmith is shipped using 
the model which calculates waste only at the beginning of each original’s run rather than on each 
pass since that typically results in more competitive prices. Once you have decided on a model you 
should stick with it. If total impressions are not a multiple of impressions per run, you are using the 
default model and only calculating waste in the first run. If, after careful consideration, you want to 
permanently change this to the second model, call your service provider for help. 

Work & Turn Pricing 

Work & Turn is disabled unless the job specs support it. A simple Work & Turn job is printing on the 
front and back running 2 up. Its effect is to double the length of each run while reducing the set up 
time (actually it reduces additional pass setups). It also affects plate charges (and any other pre 
press charges based on the press count) by cutting the number of plates in half. It has no effect on 
bindery or production charges. The total number of impressions is the same with it turned on or off. 
However, Imp/Run changes to show the longer run length. 

The Work & Turn button becomes Work & Tumble when that setting is turned on in the Paper 
Calculator. PrintSmith then allows for two gripper edges in determining how many run sheets will 
cut out of a parent sheet. This can result in a different price if the additional gripper edge changes 
the number of sheets that can be cut out of a parent sheet. 
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Copier Pricing Method 
There are two different copier pricing methods, one for black and white and one for color. Each is 
identical in operation and differs only in the default copier definition selected. You control how 
copier pricing works using Copier Definitions. Each copier definition completely defines the pricing 
model to be used for pricing. The default copier definition is determined by selecting a default 
copier, either B&W or Color, in the Copier Definitions window. In either case, if the stock selected 
for the job already has a preset copier definition, this overrides all other considerations and the 
copier definition for the stock is used for pricing. No matter which copier is selected, you can 
always change it to a different definition using the Change Copier Selection command. 

There are many possible pricing styles which may be used in a copier definition and each copier 
definition is completely independent of any other definition. The job window looks and is used in 
exactly the same manner regardless of the underlying pricing style being used. For many jobs, a 
description and the number of copies is all that is required to completely price the job. 

Figure 3.9: Copier Pricing Method Job Example 

 
 

Note: For additional information on Copier Definitions, see page 277. 
 

Stock 
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Copier 
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Table 3.5: Copier Pricing Method Quantity Fields 
Field Definition 

  

Copies This is the number of “clicks” needed to get the finished (ordered) quantity. It is normally 
calculated for you by dividing the number Ordered by the number Up. You can enter this 
total directly and PrintSmith will change the number Ordered as needed. If the Copies total 
cannot be divided evenly by the Up number, PrintSmith will round up. 

Est Waste Normally, waste is set to 0 but it can be overridden by a user with override authority to 
indicate the number of sets wasted (10 copies of 50 originals with 2 wasted means a total of 
100 extra copies because 2 complete sets of 50 are specified) Waste in copy jobs is 
intended to serve two purposes: to adjust the quantity of stock to order and to add the cost 
of the stock when the pricing method uses marked up stock cost. As a general rule, waste is 
added to the run length. This affects the estimated run time for the job and the amount of 
labor. Where labor is a factor in calculating the price, the price changes to reflect this. If 
stock cost is part of the price calculation and is either marked up stock cost or from copier 1 
or 2 in the stock definition, waste is included in the price. 

Tot Copy This is the total number of copies for the entire job. This is calculated by PrintSmith, you 
cannot change it. 

  

 

 

Table 3.6: Copier Pricing Method Copier Information Fields 
Field Definition 

  

Copier The name of the copier definition being used in the job. There will always be a copier 
definition assigned to copy jobs; but you can change it at any time using the Change Copier 
Selection command in the Job menu. 

 There are two options for specifying the production run: 
1. Single Sided 
2. Double Sided 
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Blank Pricing Method 
The Blank Stock pricing method is used to price blank stock. 

Prices for blank stock are taken from the Blank pricing section of the stock definition for In Stock 
pricing. For special order stock, PrintSmith uses the quantity level and markup factors you define in 
the Stocks and Sizes Preference panel. 

When calculating the price, PrintSmith will take the pricing information from the stock definition if it 
is available. Special Order stock uses the three quantity breaks and markups defined in Pricing 
Preferences and the cost of the stock in the job window to generate the unit price which is then 
multiplied by the quantity ordered. 

Figure 3.10: Blank Pricing Method Job Example 
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List Pricing Method 
List pricing is a method of pricing which uses price schedules to generate a price for any stock in 
the stock list. Except for a lack of fields to specify the number of passes, data entry for this method 
is identical to the Printing pricing method. 

Note:  This pricing method is useful for exactly matching another pricing system or a printed price 
list. However, it’s the most difficult to maintain since virtually every price it generates is 
manually entered. In that sense, the prices generated are the least accurate in terms of 
production costs. For this reason, we recommend using this pricing method ONLY when 
you must exactly match an existing price list. 

Figure 3.11: List Pricing Method Job Example 

 
A press is always selected.  If you select a stock which has a preset press, it is used initially. If the 
selected stock has no preset press, the first press in the press list is loaded. 

There is a separate specification for printing on the Front and the Back. List pricing supports up to 5 
colors per side. You can move from one field to the next by using either the <tab>, <enter>, or 
<return> key. Each time you do this you will go to the next field with a rectangle around it. You can 
also change Est Waste and Price by clicking on the number with the mouse. Changing any of these 
numbers is treated as an override. 

Note: Clicking in the Ink field opens the Ink Editor, which allows for seven ink descriptions that 
can be auto-populated from the Ink Color Table.  CMYK should be entered in four 
separate fields. 

Stock 
Information  

Press 
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Schedule Field 



Chapter 3:  The Estimator 

 
 

 
Page 87 

Outside Services Pricing Method 
Outside Services provides a simple means of specifying work that you send out to other vendors 
(signs, etc.). 

Figure 3.12: Outside Services Pricing Method Job Example 

 
 

Total cost is calculated by multiplying the unit cost by the quantity. Price is total cost times the 
markup. The Production button is also available in this pricing method to support production dates 
and times used with Report Writer. 

quantity x unit cost = total cost 
total cost x markup = price 

Note:  For Multiple Quantity quotes, you enter the total price including charges and markup for 
each additional quantity. 
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Merchandise Pricing Method 
This pricing method can be used to enter just about anything into the document. 

Figure 3.13: Merchandise Pricing Method Job Example 

 
 

Total cost is calculated by multiplying the unit cost by the quantity. Price is the total cost times the 
markup. The Production button is also available in this method to support production dates and 
times used with Report Writer. 

quantity x unit cost = total cost 
total cost x markup = price 

Note:  For Multiple Quantity quotes, you enter the total price including any charges and the 
markup for each additional quantity. 
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Lines and Inches Pricing Method 
This pricing method prices standard lines and inches from the Rubber Stamps schedule. This 
schedule is maintained using the Stamp Schedule command in the Pricing menu. You specify the 
number of lines of text and the number of inches wide the stamp is and PrintSmith looks up the 
price in the schedule. You can enter fractional values (e.g., 2.5 lines or 6.25 inches) and the next 
largest value in the price schedule will be used for the Unit Price. Unit Price is multiplied by 
Quantity for the Price. 

Figure 3.14: Lines and Inches Pricing Method Job Example 

 
 

 

User Defined Pricing Method 
There are five user-defined pricing methods. When PrintSmith is shipped, these pricing methods 
are disabled. When enabled, the pricing methods are handled exactly like Outside Services. They 
are useful mostly if you want to subdivide outside services into various sales categories. 
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Multi-Part Jobs Pricing Method 
The multi-part jobs pricing method is designed to make estimating for complex multi-part orders 
easy. (Jobs using the multi-part job pricing method are sometimes referred to as Booklet control 
jobs.) 

Figure 3.15: Multi-Part Jobs Pricing Method Job Example 

 
You enter a description for the entire multi-part job order and the number ordered. Then you add 
pre press and bindery charges for the entire multi-part job (such as assembly and binding). Finally, 
you set up jobs for each part of the book, putting the prep and bindery needed for each part on the 
individual job. 

For example, a multi-part job might have a blank cover, inside pages, and a blank back cover. The 
Multi-part Control Job is used to enter the total number desired. You then use the “Add Job” button 
to create three jobs: the cover is a single page job on some type of cover stock, the inside pages 
are on a different stock and the back cover is a blank stock job using the same stock as the cover. 
You add bindery charges for gathering and binding to the Multi-part Control job. Charges for things 
like scoring or embossing the cover would be added directly to the cover job rather than the Booklet 
Control job. 

As you add parts to the job, PrintSmith calculates the number of pages and displays the leaf count 
and page count (number of “surfaces” with printing on them) below the quantity ordered. The page 
count is the number of sheets of paper in the booklet and is printed in the job description on the 
document. 
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The Has Cover button is used to change how the job is displayed and printed in the document. If it 
is turned on, PrintSmith displays “(12 pages inc. cover) after the booklet description. If it is turned 
off, PrintSmith displays “(12 pages)” after the booklet description. “No page count on document” 
overrides the “Has cover” button and does not display a page count at all. 

The Multi-part job does not do much all by itself. Think of it as a convenient way to group a lot of 
different elements together so they can be treated as a whole. A typical simple booklet has a cover 
and a number of inside pages. The cover might be a process color job on coated stock while the 
inside pages might be photocopied. The cover might need stripping, negatives, plates, scoring, etc. 
while the inside pages are a simple copy job. You want to be able to collate and bind the finished 
booklet. That is what the Multi-part job is designed to do. 

You use the Prep and Bindery charge commands in the booklet window to set up charges, which 
apply to the entire job (like collating and binding). You use Add Job to add jobs specifying the parts 
of the book, like the cover and the inside pages. 

Each time you click on Add Job, PrintSmith asks for a pricing method and creates a new job. These 
jobs are different from normal jobs only in that the quantity you specify in the booklet job is 
automatically inserted into the job. You change the quantity ordered in the Booklet Control Job. You 
add pre press and bindery charges to these jobs in the normal way and they are calculated for that 
part of the book alone. 

When you click the OK button in a “sub” job, PrintSmith figures out how many pages that job 
contributes to the finished book and updates the booklet job and recalculates the pre press and 
bindery charges that were set up for the entire booklet. Outside Services or Merchandise jobs in 
booklets have special requirements when quoting multiple quantities. 

You can also add jobs to booklets by dragging them into the booklet job from the invoice window. 
To do this, there must already be at least one job in the booklet and you must drag the job to be 
added to the booklet above a job that is already part of the booklet. 

Notes:  The Delete Job button deletes the entire booklet job including all of the parts. 

Multiple Quantities on Multi-Part Jobs 

The procedure used to specify multiple quantities in booklets is the same as that used for Printing 
jobs. You select Multi-Quantity from the job window command list and enter the quantities. When 
the Estimator calculates the price for each quantity in a booklet, it copies each additional quantity to 
each job and uses it to calculate the additional prices. 

This procedure is different for Outside Services, Merchandise and User defined pricing methods 
that belong to a multi part job because you must enter both the quantity and price for these 
methods – PrintSmith does not calculate them. It treats the multiple quantity prices you enter for 
these jobs as a sort of lookup table and when it prices the second multiple quantity in the booklet 
job, it inserts a second price in the Outside Services multi-quantity table into the overall book price. 
If there is no quantity or price in the position of the table, the job price is used. 

In those cases where you must have multiple quantities on an Outside Service, Merchandise, or 
User Defined job that must be part of a booklet job, be sure to add multiple quantities and prices to 
the outside service job as well as the multi-part job. 
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Multi-part Jobs and Bindery 

The principle function of a multi-part job is to gather the parts of the multi-part together for 
assembly and packaging. There are other benefits: multi-part templates, hiding jobs in the multi-
part pricing, simplified job specifications, fewer errors and so on. However, bindery is the single 
most important function of the multi-part job in terms of pricing. 

The window itself has no place to specify the number up, the number of colors in the job – these 
are production details that do not affect the multi-part job. If you run part of a booklet six up, the 
multi-part control job expects to see the finished pages already cut apart. After all, there may be 
other parts of the job that were not run six up. PrintSmith can handle finish cuts at the multi-part 
level, but any operations on press sheets should be done at the “sub” job level. 

In addition, the multi-part job does not know anything about the number of colors, the number up, 
or work & turn. A multi-part job knows the overall number ordered and the total number of pages. 
This places some restrictions on the kinds of charges that you put in a multi-part job. 

These types of charges should not be added to multi-part control jobs: 

• Any charge definition that relies on knowing the number of colors. PrintSmith will substitute 
one color on one side. There could be six different jobs with six different color combinations. 

• Charges that price in sets are always priced as though the “Bindery Operation” button is turned 
on. 

• Charges that rely on sizes must only be placed on “sub” jobs. The multi-part job itself knows 
nothing about sizes. 

Note: The quantities within each part of a multi-part job can be adjusted.  In the Invoice window, 
the different quantities will be displayed if a quantity has changed.  If the quantity has 
changed within any of the parts, do not use the control job to add charges.  Instead, add 
charges within the job part that has a changed quantity. 

 

Specifying Stock Information 
There are no longer separate pricing methods for In Stock, Special Order, and Customer. Instead, 
customer and special order have become modifiers on the Printing, Copying, Blank, and List pricing 
methods.  

Special Order has changed radically from prior versions – our conceptual bias in this release is that 
all jobs that use stock should have a stock definition attached to them. This is not required – but for 
special order a major new enhancement is creating a stock definition for that job on the fly.  
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Specifying Stock (In Stock) 
To select an “In Stock” stock, use the Stock Picker. If you selected a pricing method that includes 
stock (Printing, Copier, Blank, or List pricing methods), the Stock Picker will automatically be 
opened. From the Stock Picker window, select the applicable stock to be used for the order. 
Information from the Stock Picker is populated in the Paper Calculator window. Specify additional 
information in the Paper Calculator window, if needed.  

Figure 3.16: Stock Picker Window  

 
Note:  The Search feature can be used to quickly locate a stock. Just enter information into at 

least one of the search fields, click off of the field, and available stocks that include the 
criteria you specified will be displayed. Clicking the downward pointing arrow icon to the 
left of the word search can hide search fields. 

Stock information specified in the Paper Calculator window will be populated in the Job window. 

Figure 3.17: Stock Information Example 
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Table 3.7: Job Window Stock Field Definitions 
Field Name Definition 

  

Customer 
Supplied 

Customer Supplied option indicates that the stock used for the order will not come from 
inventory but will be supplied by the customer. Checking this option changes the way stock 
is calculated in the job. 

Special 
Order 

This setting is in two parts; the checkbox simply marks the job as special order and the 
Special Order button is used to either create a new special order stock definition or edit an 
existing special order stock definition. 

Stock The name of the stock, originally taken from the stock definition. 

Color The color of the stock taken from the stock definition. It is purely descriptive and has no 
effect on the price. 

Parent Size Parent size comes from the stock definitions and is also displayed in the paper calculator. 

Run Size The size of the paper to be run. PrintSmith uses the Parent size of the stock as the basic 
unit of cost. It calculates the number of sheets (at the Run Size) that you can get out of a 
parent sheet and uses this to calculate the cost for each sheet as run. Changing the Run 
Size can result in a change in the price of the job.  

Finish The size of the paper when delivered to the customer. Initially, this is the same size as the 
Run Size. The finish size must be no larger than the run size. If you change the run size to 
be smaller than the finish size, PrintSmith automatically changes this size to match. It also 
sets the finish size to the run size, if you erase the finish size. Changing the finish size will 
not change the price of a job but can affect the price in charges attached to the job. 

Folded Size Folded size is initially the same as finish size if the preference to add folded size is enabled. 
Otherwise it is initially blank. It has no effect on the price, but it does show on the job ticket. 

  

 

Specifying Customer Supplied Stock 
If a customer is supplying the stock, check the Customer Supplied option in the Stock Picker and 
select the stock that they are supplying. In the Job window, the stock information will be included 
and the Customer Supplied option will be checked. Two additional fields will be displayed: Stock 
Cost and Unit Price. These values are used to calculate the amount to be deducted from the Price. 

Figure 3.18: Customer Supplied Stock Information In The Job Window 

 
Note:  If the Customer decided not to supply the paper, the Customer Supplied Stock option can 

be unchecked. The amount of the stock will then be added to the Price of the order. 

When Customer 
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Specifying Special Order Stock 
If the desired stock is not available, it can be specified as a special order. 

1. Click the Special Order button in the Stock Picker window. The Stock Definitions 
window opens.  

Figure 3.19: Stock Definitions Window 

 
 

2. Enter the necessary information. 

3. Click the File icon to save the specifications, close the window, and view the stock 
information in the job window. Special Order stock information will be populated and 
the Special Order option will be checked. 
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Figure 3.20: Special Order stock information in the Job window 

 

Note:  Special Order Stock can also be modified within the job window by clicking the Special 
Order button, modifying the specifications, and clicking the File icon to save. 

 

Using the Paper Calculator 
Depending upon the pricing method and preferences selected you will see the paper calculator to 
define the job in visual terms. Though not an imposition tool, it handles gripper edges, bleeds, 
gutters, folio edges, white space and back trimming. The calculator displays the number of sheets 
out and the number of cuts for any combination of parent, run, and finished sheet sizes. Define the 
characteristics of your jobs and click OK to enter the information into the job window.  

Figure 3.21: Paper Calculator Window 
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Entering Quantities in Jobs 
There are a number of different quantities you will need to enter to set up a job – the number to be 
produced, sheets in a set, originals, the number up, etc. This is where the most errors occur in 
setting up a job, so it is important to understand each quantity and how it is used. A basic premise 
used in PrintSmith is that each quantity should always mean the same thing and be used 
consistently throughout the Estimator.  

Table 3.8: Job Window Quantity Field Definitions 
Field Name Definition 

  

Ordered The number of finished items ordered by the customer. 

In sets of This is used primarily for carbonless sets. It tells PrintSmith that the number ordered 
means the number of sets ordered and that each set consists of ‘x’ number of sheets. 
You would normally enter this in the stock definition and never change it here.  
You can also change this value to price pads. In this case, you enter the number of pads 
in “Ordered” and the number of sheets per pad here. 

Sheets The number of original pages. If the job is two sided, sheets are also 2 sided. 

Up The number of times an original will fit on the size stock being run. 

On The number of unique originals placed on each plate. This number cannot be larger than 
Sheets or Up. 

  

 

Working with Quantities 
Business cards are a good example of work that sometimes causes confusion. If, when a sheet 
comes off the press, you cut it into 8 cards; you are running the job 8 up. If 4 of the cards have 1 
name and the other 4 have different names, you are still running the job 8 up with 5 on.  

Table 3.9: Business Cards Example 
     

Ordered 1,000 1,000 1,000 1,000 

Sheets (Names) 2 6 8 16 

Up 8 8 8 8 

On 2 4 8 8 

Press 250 500 (1.5 runs) 1000 1000 (2 runs) 
     

End Result 1,000 cards 
2 names 

2,000 total 

1,000 cards 
6 names 

6,000 total 

1,000 cards 
8 names 

8,000 total 

1,000 cards 
16 names 

16,000 total 
 

Using On in addition to Up removes ambiguity in specifying how a job is run. Up is the number of 
finished sheet images on a plate. On is the number of those images, which are different. 3 up 3 on 
is normal pricing - 3 up 1 on is 3 passes. In a run of 1000 of four different originals, the job could be 
run in the following ways. 
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Table 3.10: Using Up and On 
Up On Passes Run Length 

    

4 4 1 1000 

4 3 2 (1.2) 1000 (see notes) 

4 2 2 500 

4 1 4 250 
    

Note:  The On value does not have to be a multiple of Up or Originals. In the table, the second 
line shows 4 up, 3 on. Admittedly, this is probably not a great way to run the job since it 
creates much more waste and adds an additional run. However, you can do it and in this 
case, the first run is 1000 3 up 3 on and the second run is 250 4 up 1 on. 

PrintSmith supports a concept of fractional runs that you will see when running multiple up if up is 
not a multiple of originals. There are some common jobs where this type of specification has great 
value: 1000 of 6 sheets, 4 up 4 on is calculated as a total run length of 1500 (1.5 runs) since 4 
sheets are done in one run of 1000 and the remaining 2 sheets are run 4 up 2 on, in a run of 500. 

If you are unsure how the Estimator is calculating a job of this sort, hold down the <shift> key when 
opening the job or changing a pricing specifications and the number of runs is displayed along with 
impressions per run. 

Generally, using the maximum number for On generates a lower price since there are fewer and 
longer runs. It also reduces the number of plates and set up time. The Multi-part jobs table shows 
how signature pricing affects the number of runs and how the number up affects other quantities. 

Table 3.11: Signatures and Multi-Part Jobs 
   

Ordered 1,000 1,000 

Sheets (Names) 32 32 

Up 4 2 

Press With Maximum On 1,000 (8 runs) 1,000 (16 runs) 

Press With 1 On 250 (32 runs) 500 (32 runs) 
   

End Result 1,000 books 
32 leaves 
64 pages 

1,000 books 
32 leaves 
64 pages 

 

In this example, the customer wants 1,000 copies of a 64 page 8.5 x 5.5 multi-part job that is to be 
printed or copied on 2 sides. You are going to run it on 11 x 17 stock so it is 4 up. 

This example introduces a new concept – specifying 2 sided work. What do you mean and what 
does your customer mean when they say a 64 page book? In PrintSmith, you enter the number of 
“Pages” as sheets. To PrintSmith, a 64 page book means that there are 64 sheets of paper in the 
finished book. Sometimes this is referred to as leaves. The customer, on the other hand, might 
have a stack that contains 64 single sided originals that they want copied on 2 sides. This is a 32 
page book to PrintSmith. 
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For consistency, PrintSmith always treats the number of sheets as the number of finished sheets of 
paper. If the job is two sided, sheets are two sided, whether or not the customer furnishes two 
sided originals or single sided originals. 

The common method of laying out signatures for a book requires that the number up and number 
of sheets are always divisible by 4. Not only is this restriction not needed with PrintSmith, but also 
you can specify the job incorrectly if you do not understand the difference. 

First of all, sheets are not necessarily two sided. Secondly, the number “up” refers to the number of 
images on each plate rather than the number of pages in the signature. 

A good illustration is a 36 page multi-part job to be run as nine 4-page signatures: quantity ordered 
of 1000. A traditional 4 page signature would have two pages on the front and two on the back. You 
might enter 36 for the number of sheets, 4 up with printing on two sides. This is incorrect. 
PrintSmith would price this as a 72 page book because it is a two sided job and number of sheets 
is taken as the number of two sided sheets. The proper number of sheets should be 18, which is 
the correct number of two sided sheets. The number up should be 2 rather than 4 because there 
are two images on each side of the sheet as it is run. 

Except for waste, the price for printing both the correct and incorrectly specified jobs should be 
approximately the same as the total number of impressions (excluding waste) is 9000 in both cases 
(36 ÷ 4 and 18 ÷ 2 both equal 9). However, in the first example, charges for bindery that uses the 
finish count would be drastically overstated because the page count would be 72 instead of 36. 

Multi-Quantity 
Use this command when you need to generate a price for more than one quantity. This window is 
for entering up to three additional order quantities. The Estimator generates a price for each 
quantity and keeps the prices current as you change the job or add charges. 

The customer discount and any invoice level charges are included in the price when PrintSmith 
generates it. Outside Services, Merchandise and User Defined pricing methods require you to enter 
the price for each additional quantity. 

Clicking the Hide button will not print multiple quantities on the document, but still retains the 
quantities you entered. To show multiple quantities on the document, select Multi-Quantity again 
and click the Show button. Jobs that show multiple quantities are shown with a “+” after the quantity 
in the document window. 

When this feature is turned on, the additional quantities are printed on the Invoice or Estimate on 
the line following the last part of the job after all charges. They are not shown in the document 
window except for a “+” after the job quantity. When the price includes invoice level markups or a 
customer discount, “(with discount)” is printed after the quantities. 

Notes:  You can trick PrintSmith into drawing a line after a job by clicking the Show button with all 
the quantities set to zero. 

 If you have overridden any prices, PrintSmith will not cancel the override for the extra 
quantities. This means that if you have overridden the price of the entire job, the extra 
quantities will all have the same price. If your purpose in making the override was to 
provide a quantity discount, you can define a charge with a price list, which will generate 
the same results without the use of an override, or you can use Overs & Unders to 
accomplish nearly the same thing. 
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 PrintSmith automatically shuts off multiple quantity printing when you change an estimate 
to an invoice. To turn it back on, open the Multi-Quantity window and click the Show 
button. 

Multiple Quantities on Outside Services, Merchandise, Lines & Inches, and User 
Defined Pricing Methods 
When you quote multiple quantities for outside services you must enter both the quantity and the 
price since PrintSmith has no way of knowing how the outside service gets priced at different 
quantity levels. This price must also include any charges added to the job. 

Multiple Quantities on Multi-part Jobs 
Use care when specifying multiple quantities on multi-part jobs. If the price for any element of the 
multi-part job is overridden, it will not be adjusted for additional quantities. When adding jobs using 
Outside Services, Mailing Services, Merchandise or any of the user-defined pricing methods to a 
multi-part job, PrintSmith expects you to specify the quantity and price in the multi-quantity window. 
For this reason, any multi-part job that contains these types of jobs should have multiple quantities 
specified on each of these jobs in addition to the multi-part job so PrintSmith will know how to price 
the additional quantities. 

If you do not enter additional prices for multi-part job parts that require manual entry of these prices 
PrintSmith uses the price in the job window, which may not be what you want. 

Overs/Unders 
Overs and Unders is used to simplify charging for differences between the ordered quantity and the 
quantity actually delivered. Delivering 10% more or less than the quantity ordered is an accepted 
trade practice. This command is designed to support this practice. 

Enter the over quantity or a negative quantity if it is under. PrintSmith divides the total price of the 
job (including all charges) by the quantity ordered to get a unit price and then multiplies the unit 
price by the quantity entered as over or under. This is added to the job price and the total job price. 

You can also override the unit price or Overs Price. Over Price is added to the job price. Overs and 
Unders are included in multi-quantity and price list calculations.  If there is no override, it 
recalculates the Overs unit price for each separate quantity. When the job price is overridden, 
Overs are ignored. 

Note:  Any job that has Overs or Unders is shown with the quantity and price italicized. 
Normally, the quantity ordered is printed, if you wish to show the actual quantity delivered on the 
document, a document preference is available to include Overs and Unders in the quantity for the 
job on the printed document. 

Note:  The Overs/Unders function is meant to bill at the initial quantity unit cost for Overs/Unders. 
It does not in any way change any of the job specifications. There are no instructions on 
the job ticket about Overs so if a customer asks for extras at the start of the job, you 
should change the ordered quantity rather than enter it as Overs. 
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Changing Stock Selection 
The Change Stock Selection command is used to select a stock from the stock list. In Printing and 
Copying, when you change the stock selection, a press or copier definition attached to that stock 
might also be changed. 

Figure 3.22: Changing stock in the Stock Picker 

  
Note:  Once an alternate stock is selected, the originally selected stock is marked with a bullet. 

The newly selected stock is marked with an arrow. 
 

Ordering Stock 
PrintSmith can generate a report of all the stocks waiting to be ordered. This command is a quick 
way to add a stock entry to this report. It generates a line in the report identifying the invoice and 
job and the number of parent sheets (including waste) to order for the job. Before you can order 
stock for any job on an Invoice, the Invoice must be assigned a document number. The best way to 
order stock is to use the Auto Order function of the Stock Order command in the Admin menu. This 
feature is ideal for when you need to re-order stock for this job. 

The stock that is 
currently selected is 

highlighted and 
marked with an 

arrow 
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Changing Press Selection 
You can change the press selection at any time. Changing the press selection changes most of the 
pricing information used to calculate the job price. To change the press:  

1. Select the Change Press Selection command from the hierarchical list. The Press 
list window opens. 

Figure 3.23: Press List Window 

 

2. Select the new press. 

3. Click the Select button. The list window will be closed and the selected press will be 
changed in the job. 

You can also change the selected press from the job window by selecting it from the drop down 
menu in that field. This menu is also opened if the press name is empty. 

Note:  When the job being priced is using one of the copier pricing methods, the Change Press 
Selection command becomes Change Copier Selection. 

 

Changing Copier Selection 
You can change the copier selection at any time. Selecting a different copier can radically alter the 
price of a job because each copier completely specifies how the job is priced. 

You can also change the selected copier from the job window by selecting it from the drop down 
menu in that field. This menu is also opened if the copier name is empty. 

Note:  When the job being priced is using the printing pricing methods, the Change Copier 
Selection command becomes Change Press Selection. 
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Changing Schedule Selection 
The Change Schedule Selection command is only available on jobs using the List pricing method. It 
allows you to change the price schedule used to price jobs. Normally, the list used for pricing is 
determined by the selected stock. The production data window shows the name of the currently 
selected price schedule. To change the schedule: 

1. Select Change Schedule Selection command from the hierarchical list. A Schedule 
list window opens. 

Figure 3.24: Schedule List Window 

 
2. Select the new schedule. 

3. Click the Select button. The list window will be closed and the selected schedule will 
be changed in the job. 

 

Changing Job Pricing Method 
You are able to change the pricing method of a job. To do so: select the pricing method from the 
Job window commands list. Any applicable data will be used. 
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Generating Price List 
The price list contains prices for printing plus pre-press and bindery just as if you created a 
separate job for each quantity. This list allows you to include jobs of any complexity in a counter 
price book or to give it to a customer. 

When this type of list is printed, a description of the elements used to create the job is printed after 
the price list. You print the price list by selecting the Print command on the File menu. Printed Price 
lists generated from jobs include a description of the job. To view the Price List, select the 
Generate Price List command from the hierarchical list. Hold down the shift key to view Price per 
Thousands instead of Price Per Each. 

Figure 3.25: View Price List Window 
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Adding Job Ticket Notes 
You may want to add additional instructions to be placed on job tickets. You can preset standard 
instructions for certain customers using the customer account notes facility and you can use this 
command to modify this text or add additional notes. Although there is no limit to the amount of text 
you can put in this window, the job ticket will only display about 1/3 of a typed page. Use the arrow 
keys to move up and down the text entry. To view, add, or modify notes: open the Job Ticket Notes 
window by clicking the Job Notes icon or by selecting the Job Ticket Notes command from the 
hierarchal list. 

Figure 3.26: Job Ticket Notes Window 

 

When notes have been entered in the Job Ticket Notes window, a green indicator is displayed to 
the left of the Job Ticket Notes command in the hierarchal tree. 

Viewing Web Worksheet 
This feature is only available if you have an active PrintSmith Site portal. The Web Worksheet 
contains information provided by the customer and PrintSmith Site regarding e-commerce orders. 
To view the Web WorkSheet, select the Web WorkSheet command from the hierarchal list. 

Items can be moved from the Web WorkSheet to the job ticket notes by clicking the item 
description and clicking the Copy button. 

Once items have been moved to from the Web WorkSheet to Job Ticket Notes, mark the item as 
done so that it can be deleted when the window is closed. Items are marked by clicking in the done 
column to the left of the applicable line item. A check mark is displayed. Clicking the OK button to 
close the window will delete all checked items. 
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Previewing Job Ticket 
You can preview the job ticket. Like printing job tickets, the job must belong to an invoice, which 
has been filed at least once (and assigned a document number) before it can be previewed. To 
preview a job ticket: Click the Preview icon or select the Preview Job Ticket command. 

Figure 3.27: Previewing Job Ticket Window 

 

Printing Job Ticket 
The Job Ticket is designed for use as a production control document. PrintSmith remembers when 
you have printed a Ticket for a job and will ask you before printing a duplicate. If the document has 
not been filed or if the job has just been added to the document and not filed, you cannot print a 
ticket using this command. Most of the time, it is best to use the Tickets button in the document 
window to automatically save the document and print tickets for all jobs. 

Notes:  The style of job ticket displayed is defined in Admin > Document Preferences. You have a 
choice of two default styles of job tickets, as well as a few other options. When using the 
Standard style of job ticket you also have the option to add a job tracking bar code and to 
show amounts on the job ticket.   With the optional Report Writer, you can create and use 
a custom job ticket. 

Shipping Ticket 
If shipping charges are attached to the document or job then printing a Job Ticket may result in a 
Shipping Ticket being printed.  
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Creating Carton Labels 
You can create Carton Labels to affix to the containers holding the finished job. It is roughly based 
on the Mailing Label command and, in fact, Carton Labels and Mailing Labels share the same label 
definitions. To create carton labels: 

1. Click the Carton Labels button or select the Carton Labels command from the 
hierarchical tree. The Carton Labels window opens.  

Figure 3.28: Carton Labels Window 

 

2. Enter the number of Labels to Skip if you have a partial sheet of labels and you need 
to skip over them to the first good label. 

3. Change the Label Format, if necessary. Carton Labels is automatically selected as 
the Label Format. Label Formats can be created and edited by clicking the Define 
Label Format button. 

4. Enter the Number of Boxes for which you want to print labels. Typically, this is the 
only number you will have to specify in this window. 

5. Enter the number of Items Per Box. 

6. Enter a Starting Number, if something other than 1. 

7. Enter a Total Count. 

8. Enter any additional information you would like printed on the label in the Label Text 
field. 

9. Check any additional content options that you would like printed on the label. Carton 
label content options include: Job Description, Today’s Date, and Estimated Weight.  

10. Click the OK button once all carton label information has been specified. The Carton 
Label window is closed and the active job window opens. 
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Defining Label Format 
Label formats can be created, edited, and deleted.  

1. Click the Define Label Format button in the Carton Labels window. The Define Label 
Format window opens. 

2. Select <new format> from the Existing Formats list to create a new label format. 

Figure 3.29: Define Label Format Window 

 
3. Enter a Format Name. 

4. Specify label details. 

5. Click the OK button. The newly defined carton label will be listed in the Existing 
Formats drop down list. 

 

To edit or delete an existing format: 

1. Click the Define Label Format button in the Carton Labels window. The Define Label 
Format window opens. 

2. Select the label format to be edited or deleted from the list of Existing Formats. 

Figure 3.30: Editing Existing Labels Example 
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Viewing Production Data 
The Production Data window was designed primarily for the Printing pricing method although it is 
sometimes useful for other pricing methods. You can use this to tailor production information on a 
specific job. The information displayed in this window varies somewhat depending on the pricing 
method. To view production data, click the Production icon in the Job window. 

Table 3.12: Production Data Window Field Definitions 
Field Name Definition 

  

Parent Size Size of the sheet you purchased. Taken from the parent size of the selected or from 
the run size for special order and customer stock. 

Run Size The size of the sheet you will be running on the press. 

Out The number of Run Size sheets that you can get out of a given Parent Size sheet. This 
number can be overridden, but if it is, PintSmith cannot generate a cutout diagram. 

Parent Costs Your price for the Parent Size sheet per the number of parent sheets you bought at the 
Parent Cost price. 

Markup This is used to mark up the stock component of the job price. You can consider this 
your gross profit on the stock. You can change this for the entire system using the 
Pricing Preferences command in the Admin menu, for an individual stock in the Stock 
Definitions, or change it here for a particular job.  

Note:    The Markup field is not available for Blank Pricing Method 
Production Data. 

Production 
Run 

The number of impressions for each run.  The same number as “Imp/Run” in the job 
window. 

Note:    The Production Run field is not available for Blank Pricing Method 
Production Data. 

Requires The total number of parent sheets you need to run this order. 

Sheets 
Purchased 

The number of sheets purchased for the job. If the stock definition specifies a minimum 
order quantity, this number may be higher than the actual sheets required for the job. 
The cost of this additional paper is included in the job if the stock is marked to charge 
the customer for the entire order; however, the extra stock is not included in the 
production charge. 

Price 
Breakdown 

Shows the stock and labor components of the price broken down into cost, markup 
and the resulting price. 

Itemized 
Markups 

Shows the total all markup charges attached to the job. Markups are calculated 
separately after all other charges are calculated so they are based on the most current 
prices. Excludes invoice level charges or customer discounts. 

Other Charges All charges attached to the job that are not markups are totaled and shown in this field. 

Production This shows the total charged for wash-up charges as well as any vendor cutting 
charge that is defined in the stock definition. You can override the production total by 
entering an amount in this box. It is added to the job price. 

Target Adjust If target pricing is enabled for the attached press definition, the amount of the 
adjustment is shown in this field. 
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Field Name Definition 
  

Setup Time This is the calculated time to set up the press based on the minimum labor and the 
number of heads indicated in the press definition. 

Note:     The Setup Time field is not available for Blank Pricing Method 
Production Data. 

Run Time This is the calculated run time of the job based on the labor, markup, speed table and 
or average impressions per hour designated in the press definition. 

Note:     The Run Time field is not available for Blank Pricing Method 
Production Data. 

Total Time This is both run and setup times combined. 

Note:     The Total Time field is not available for Blank Pricing Method 
Production Data. 

Job Price This is the job price, which is usually the total of all the prices shown in the window. It 
may differ from the itemized breakdown under the following conditions: The job price 
has been overridden; a “Plate Fee” was defined in the press definition used for the job. 

Due Date and 
Time Fields 

These new date and time fields were added for use with the Report Writer to create 
customized schedules by area. This information is added directly to the job and 
accessed via a Report Writer custom report. The 16 field titles can be changed in the 
Production Dates table in the Table Editor. All pricing methods support this type of 
scheduling: from Rubber Stamps to Outside Services. 

  

 

 

Printing Pricing Method Production Data 
Changing anything but the size of the stock is an override, this includes Setup Time, Run time and 
Out. The Show Cutout button generates a graphic display of how the Run Size sheets can be cut 
from the Parent Size. Most of the time, you can add up all the numbers under Price and they will 
equal the Job Price. There are some situations in which the Job Price is not the sum of these 
numbers: 

• If you have defined a Plate Fee in a press definition the plate fee is added to the job price. This 
is not the recommended way to add plates.  

• It is possible that stock and labor totals in the production data window will be different from job 
total due to rounding (differences of ±0.01). 
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Figure 3.31: Printing Job Production Data 

 

 

Table 3.13: Printing Production Data Window Field Definitions 
Field Name Definition 

  

Press The name of the selected press. This always matches the name of a press definition. You 
cannot change the press selection here, but you can modify the press production factors 
and the setup time. 

Press Speed The average impressions per hour at which you will be running the press for this job. It is 
taken from the press definition, but you can override it here. PrintSmith uses this to figure 
out how long it will take to run the job after it is set up. 
Note:       If you set up the press to use a variable speed table, the speed of the press 

changes with the length of the run. In this case, PrintSmith shows the 
impression rate for the current quantity taken from the table. Overriding the 
press speed disables this feature. 

Labor Rate This is the rate for labor used with this press. It should not include a profit margin, as the 
Labor Markup will do this for you. 

Labor Markup Your Labor Markup. Like the Stock Markup, you can consider this your gross profit 
margin. Please note that your actual profit for each job will vary considerably as these 
markups, the press speed and to some extent, the labor rate are generally little more 
than educated guesses or a statistical average. 
To generate a factor for a desired gross profit margin, the following formula may be 
useful: 1 ÷ (1 - desired markup) = markup factor 

  

 

Production 
Information Specific 

To Printing Pricing 
Method 
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Copier Pricing Method Production Data 
Because there are several different styles of copier pricing, many of the factors in this window do 
not apply to the job price unless you are using the Cost Plus style of copier pricing. You can 
change the stock cost and units in all pricing styles, but the stock markup shown in this window is 
the standard stock markup and is only used in the Cost Plus pricing style. 

The time and labor are calculated from the copier definition attached to the job. However, this is not 
used to generate the price. 

Note:  Generally, the information in this window is best used as a guide and you should avoid 
changing it. Depending on how the copier definition is set up, changing a value in this 
window may not affect the job price at all. 

Figure 3.32: Copier Job Production Data 

 
 

Production 
Information Specific 

To Copier Pricing 
Method 
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Blank Pricing Method Production Data 
The production data window is useful primarily for changing the stock cost and overriding the 
markup. 

Note:  Stock prices shown do not reflect blank pricing and markup. It shows the standard stock 
price and standard markup for reference. Changing the stock price or parent size forces 
PrintSmith to calculate the blank stock using the entered price and the blank stock 
markups defined in the Stocks and Sizes Preference panel. 

The Markup field on Blank stock is empty unless someone has entered an override. Once you have 
told PrintSmith to calculate the cost of the stock by specifying a markup, it continues to calculate 
the actual stock cost and the specified markup. Canceling the override on the markup replaces the 
markup you entered with the default blank stock markup. Most of the time, this is the same as the 
standard blank stock price. However, if the stock price or the default blank stock markups are 
changed without updating blank stock pricing, canceling the override will generate a different price. 

To summarize, there are three different types of blank stock price calculations: 

• Pricing from blank stock section of the stock definition - the normal case. 

• Using a user entered override to mark up actual stock cost. 

• Using default blank stock override to mark up actual stock cost. This is used when you cancel 
the override of the markup. 

Figure 3.33: Blank Job Production Data 

 
  

Does Not Include 
Copier/Press 

Information or 
Setup Information 
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List Pricing Method Production Data 
The Production Data window is almost identical to the Printing version. One difference is the 
addition of the Schedule field, which is the name of the price schedule used with the job. In the 
Estimator Behavior preference window, the setting Always Use Stock’s Parent Size can be set so 
that PrintSmith “locks” the parent size when it comes from a stock definition so that it cannot be 
changed in the window below. 

Because this pricing method is entirely based on a retail price list and quantity ordered, none of the 
factors in this window are used for pricing. Changing the press speed will change the time allotted 
for the job, but will not change the price. Even changing the parent size will not affect the price. 

Notes:  Until you enter a quantity, the schedule name will not be displayed.  
Figure 3.34: List Job Production Data 

 

Unlike the Printing 
Pricing Method, List 

Pricing Production 
Data Includes a 
Schedule Field 
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Table 3.14: List Production Data Window Field Definitions 
Field Name Definition 

  

Press The name of the selected press. This always matches the name of a press definition. You 
cannot change the press selection here, but you can modify the press production factors 
and the setup time. 

Press Speed The average impressions per hour at which you will be running the press for this job. It is 
taken from the press definition, but you can override it here. PrintSmith uses this to figure 
out how long it will take to run the job after it is set up. 
Note:       If you set up the press to use a variable speed table, the speed of the press 

changes with the length of the run. In this case, PrintSmith shows the impression 
rate for the current quantity taken from the table. Overriding the press speed 
disables this feature. 

Labor Rate This is the rate for labor used with this press. It should not include a profit margin, as the 
Labor Markup will do this for you. 

Labor 
Markup 

Your Labor Markup. Like Stock Markup, you can consider this your gross profit margin. 
Please note that your actual profit for each job will vary considerably as these markups, the 
press speed and to some extent, the labor rate are generally little more than educated 
guesses or a statistical average. 
To generate a factor for a desired gross profit margin, the following formula may be useful: 
1 ÷ (1 - desired markup) = markup factor 

  

 

Assigning Charges to Jobs 
Once you tab off of the last field in the Job window, the Charges window opens. To assign charges: 

1. Select the charge to be added from the hierarchal list and click the Add button. The 
Charge will be displayed indented in the Document Charges list. 

Figure 3.35: Job Charges 

 

2. Click the Close button once all job level charges have been added. In the Job window 
charge commands will be marked in green when charges have been added. 

Note:  Charges can also be added to a job using the Charge commands in the Task List. 
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Understanding Charges 
An important property of a job is the ability to add charges. You can attach any number of charges 
to a job. 

Charge

Charge

Charge

Job

Charge

Charge

Job

Multi-Part Job

Charge

Charge

Charge

Job

Charge

Charge

Job

Multi-Part Job

 

 

Charges can belong to a job or a document, but not to another charge. When charges are added to 
a document without being attached to a job, they are referred to as invoice level charges. Invoice 
level and job level charges (those belonging to a job) have a number of different properties. 

Table 3.15: Job Level versus Invoice Level Charges 
Job Level Charges Invoice Level Charges 

  

Shown indented below the job to which they belong Shown with an asterisk (*) in the job number column 
and are not indented. 

Kept in pre-press, bindery, and production lists in the 
job. The total of the each list is shown in the job 
window. 

Independent of any jobs in the document and is 
always shown at the end of the document. 

Can be hidden as a group using options in Invoice 
Preferences or hidden individually using the Hide 
Item command in the Edit menu. 

Cannot be hidden – these charges must be shown 
on the printed document unless they are invoice 
markups and the Hide Invoice Markups option is 
selected in the Invoice Preferences command in the 
Admin menu. 

Can be used to mark up or discount the job price, 
just pre-press or bindery, or the entire job. 

Can be used to mark up or discount the entire 
document (before any customer discount is applied). 

While not a property of a job, another type of charge 
is a pre-defined charge. These are charges, which 
are preset in stock, press, or copier definition. 
Selecting the stock, press, or copier also selects all 
of the preset charges and adds them to the job. 
Preset charges from a previous selection are always 
removed before the new ones are added. 

Almost any charge can be added to any job or 
document. The single exception is a charge defined 
as a markup. Invoice markups can only be added to 
documents as invoice level charges, while the other 
markup types can only be added to jobs. 

  

Job Level Charges 
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Understanding Job Costing 
The Job Costing System uses the costs built into the pricing system for jobs to help you analyze 
your profit margins. Cost is the amount you spend to produce the order, pricing is the amount you 
charged your customer.  

Costing information can be defined for a specific job while the invoice or estimate document is 
being created. Costing can also be set up (although it is not required) in conjunction with your 
pricing system and charge definitions.  

PrintSmith is also able to learn about costs on charges as they are used in the Estimator. 
PrintSmith remembers costs for charges; once you have entered them once. If you change the cost 
on a charge, PrintSmith remembers the new cost and discards the old one. 

Unlike pricing, cost information may be changed on a locked document, in case you did not have all 
of the information needed when the document was picked up. A preference setting can be set that 
tells PrintSmith to automatically cost a job when the invoice is picked up.  

Costing can always be updated or changed to reflect new conditions.  

Part of the cost for any job that uses paper is the cost of the stock. Similarly, if the job uses a 
Copier or Press definition, the cost is derived from labor rates, markups, and production speeds.  

To see costing details for any item while in the costing view, double click on it. If the document is 
not locked, job cost data can be edited although this will most likely change the price. Double 
clicking on a charge opens the costing detail window which can be dismissed by clicking anywhere 
in the window. Double clicking on a job opens the production data window where you can review 
and change specific cost data. 

Using the Job Costing System 
Disabling Job Production Data can bar an individual user from using the costing system in the 
Security Setup window. This also prevents you from opening the Production Data window. The 
Save command saves just the costing information. Clicking the Invoicing button will ask if you want 
to save costing information if you have not explicitly saved changes. 

You can print a costing summary for an open document using the print button or the Print 
command in the file menu. 

To enter cost on any item in a document, click on the cost and type the new cost information. 
Pressing the <return> or <tab> key enters the new data and updates all of the document 
information.  

If you have entered costs for a line item, you can go back to estimated costs by deleting the text in 
the costing window. 
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Costs and prices are color coded. 

Table 3.16: Pricing Methods 
Color Definition 

  

Blue Costs have been entered. 

Green Charges with a cost entered in an earlier document. 

Orange Costs from data collection (Tracker Module). 

Red Margin when actual cost exceeds the price. 
  

 

When costs for charges are manually entered, PrintSmith calculates a unit cost and remembers 
that cost so the next time that charge is used, the same unit cost can be used to generate an 
estimated cost. These charges are shown in green in the document window. 

Getting the Most out of the Costing System 
Although using the costing system is not required, properly designed pricing and costing systems 
will minimize effort to create documents, as well as provide you with a better understanding of your 
business’s profit margins.  

The following tips will help tune your pricing system for best results. You can also use the costing 
system to develop better cost information. 

• Copier Definitions should have the cost plus method filled out in order to cost copying 
accurately. Do this by selecting the copier definition, entering as much information as you can 
in the Cost Plus section, and saving the definition. 

• Make sure that you use a labor markup reflecting your desired profit. For example, a labor rate 
or $75 with a mark up of 1.0 could be changed to a rate of $50 with a markup of 1.5. The labor 
rate used for pricing is $75 in both cases but the cost of labor is much lower using the second 
method and the costing system will show this. 

• We often see pricing systems with very high stock markups. Usually this is because the 
printing labor rate is too low. Consider lowering stock markups and building most of your profit 
into labor. Using the Target Pricing System allows you to do this and still maintain retail prices 
as you wish. 

• Costing will go much quicker once commonly used charges have costs identified for them. Try 
to be as accurate as possible the first time you cost a charge (once costed, the costs will be 
either green or blue in color) to reduce or eliminate additional costing steps in the future. 

• Verify your costing reports produced during daily closeouts. You can always make changes to 
update costing as necessary. 

Filing/Saving Jobs 
Save the job by clicking the File icon. If the job was created from within a document, the job will be 
added as a line item within the document.  
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Copying Jobs 
You can copy and paste a job using the Edit menu commands or by pressing the <option> key on 
MAC or the <alt> key on Windows, pointing to the job to be copied, and dragging it to a new 
location in the document. This functionality is useful when a customer requests multiple variations 
of a quote (i.e. different stocks or bound in different ways). 

Since multiple documents can be opened at one time, Jobs can also be moved/copied from one 
document to another by dragging and dropping the item.  

Deleting Jobs 
The Delete icon deletes the job and all charges on that job. If you delete the multi-part control job, 
all of the jobs and charges belonging to the multi-part job are also deleted. 

Canceling Jobs 
The Cancel icon discards any changes you have made to the job. This does not include changes 
you have made to job charges - this is handled by the charge update window. 

Understanding Job Templates 
Job templates are complete specifications for a single job of any complexity. There are several 
ways in which you can use a job template to save time and reduce errors. Job templates can be 
used to predefine any job that comes through your shop. Templates can also be used to save 
complex orders that you expect to run repeatedly. 

Note:  Account History can also be used to copy orders. However, copying an old job involves 
copying the entire order. 

With job templates, you can save specific parts of an order including: 

Form Management – Multi-part forms can get complicated. If you run a lot of special forms, you 
may wish to set up a job template for each form and put it in a special folder for that customer in the 
Templates folder. When a customer orders the form, all you have to do is open the folder for that 
customer, add the appropriate form template to the order, and enter the quantity ordered. 

Carbonless Sets – PrintSmith has a carbonless section in the sock list, which is used for 
carbonless stock. Stock in this list is generally defined as complete sets. For many carbonless jobs 
this is adequate. However, when you have to use hand collated sets or when each sheet in the set 
is different, you can create a multi-part job where you specify each page in the set individually. 
Making a template can save lots of time on these jobs. 

Multi-part Jobs – Producing multi-part jobs often requires quite a few operations, especially when 
the multi-part job is marketing or sales material, which may have special scoring and perforating, 
several kinds of stock, process color, halftones, special inks and varnish coats. While these are 
easy to do in PrintSmith, it can still consume a lot of time making sure everything is correct. Use a 
template to define a framework for common multi-part job styles, or to save the complete 
specification of a multi-part job you may have to run again. 
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Creating a Job Template 
Job templates can be created from scratch or from an existing job. To create a job template: 

1. Open a job window (either a new job or an existing job). 

2. Save the job as a template by selecting File > Save As from the menu, specifying the 
file is a job template, and naming the template.   Job templates are stored in the 
Templates folder using the name you specified when saving it. 

Note:  MAC users can create a job template from an existing job by dragging the job to a folder in 
the Finder or to the Desktop. 

 

Using a Job Template 
To use a job template: 

1. Open an existing document or create a new one. 

2. Select File > Open Job Template, while the Invoice window is active. 

3. Select the job template to be used. The job window will be displayed. 

4. Enter the quantity ordered. 

5. Make any other necessary changes. 

6. Click the OK button. 

Note:  A special template file called Job Scrap is maintained in the Templates folder for use with 
the Edit menu commands. This file contains the last job that you cut or copied from a 
document. You can open the Job Scrap file just like any other template. 

 

Adding a Job Template to an Open Document 
You can add a job to an open document by dragging the icon for a job template from the Finder to 
the open document. This job is instantly added to the document. Simply click on the quantity and 
enter the desired quantity and the job is finished! 
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Charges 
The Charges window displays a hierarchical list of all available charges that can be applied to a 
document. Charges that have been assigned are displayed in the Document Charges table. Details 
of a selected charge are also displayed.  

Figure 3.36: Charges Window 

 

Assigning Charges to a Document 
Charges can be added by: double clicking the charge name in the hierarchical list or by selecting 
the item from the hierarchical list and clicking the Add button.  

Modifying Charges 
If modifications need to be made to the charge before assigning it, select the item from the 
hierarchical list, make the necessary modifications in the charge details section, and click the Add 
button. The charge will then be displayed in the Document Charges table and added to the total. 

Hiding Charges (Not Including In Document Printouts) 
Charges can be hidden, which means they will not be printed in documents. To hide a charge, 
check the Hidden box in the charge details section or use the Hide Item command in the Edit 
menu. 

Note:   To display the charge description and only hide the price, select the Hide Price option. 

Hierarchical List 
of Available 

Charges 

Hides Charges 

Charge Details 
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Deposit Entry 
Double click in the deposit entry area to enter up to two deposits on an invoice. Entering a check 
number turns off the cash button. Pressing <return> or clicking the “OK” button accepts the deposit. 

Figure 3.37: Deposit Entry Window 

 

You can change a deposit as often as you like until the invoice has been picked up. When the 
invoice is picked up it is locked to prevent any further modification. When entering a deposit, make 
sure the deposit amount is not larger than the total amount due. PrintSmith will not let you pick up 
an invoice with a credit balance. If you end up with a deposit total that is greater than the total on 
the invoice, there are several options: 

• You can remove an existing deposit by entering a zero in the deposit amount, pick up the 
document and use Post Payments to enter the deposit as a payment. This allows you to put 
the remainder “on account” or apply it to another open item. This is a recommended method. 

• You can remove the deposit from the document and pick up the document using the deposit as 
the payment in the Cash Register window. Anything remaining is returned to the customer as 
change. This is also a recommended method. 

• You can change the amount on the deposit so as not to exceed the total of the invoice. 

• You can make deposits with the optional credit card processor. 

This is not recommended since it leaves a terrible audit trail. Changing the deposit results in the 
deposit being removed and re-added. If the deposit was a check that has already been cleared 
during a daily closeout, the entire amount of the old deposit comes out of cash and is re-posted as 
a new deposit. When you perform the daily closeout, the check shown in PrintSmith will not match 
the real check and cash shown by PrintSmith may be incorrect. 

PrintSmith tracks deposits differently from other receipts. Because deposits are a prepayment for 
work not yet performed, they are placed in an “escrow” account called “Deposits Received”. They 
are tracked as receipts as far as cash in the drawer and your daily deposit, but they are not 
included when calculating taxable or nontaxable receipts until the document they are attached to is 
posted which is called Deposits Applied.  
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Document Totals 

Use this window to enter shipping charges, enter or change a customer discount percentage, set or 
remove the taxable flag and lock prices. Access the Document Totals window by double clicking 
the Totals box in the document window. You cannot change any prices directly except Shipping. 

Figure 3.38: Document Totals Window 

 

Clicking the OK button accepts all the changes you have made in the screen. The Cancel button 
discards all changes. 

Recalculate 

The Recalculate button updates each job and charge in the document with the latest pricing 
information and recalculates the totals. This is particularly useful if you change part of the pricing 
system and want to see the effect of that change in the document. Holding down the <option> key 
recalculates the document without reloading pricing data. 

Note:  The Cancel button does not throw away changes made during recalculation since these 
changes take place in the individual line items. You should always click the OK button 
after Recalculating. 

Sales Category Totals 

Each job and each charge has a sales category assigned to it. The first column in the Document 
Totals window shows a summary of each sales category. You can change the name of these sales 
categories using the Sales Categories Preference panel. 
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Tax Summary 

Tax Table - This field identifies the tax table in use on the document. The standard tax table has no 
ID, so this field is blank. If you assign a special tax table to a customer account, PrintSmith 
automatically selects that table. You can also select a table for the document from the drop down.  

Tax Code - Use tax codes to categorize sales for tax reporting purposes. Each tax code is shown in 
a separate line in the tax detail report within the same tax table. 

Tax Rate - This is the tax rate defined in the tax table. 

Tax Sub – The Tax Sub is the total of all taxable items in the document. Sales tax is calculated by 
multiplying this total by the Tax Rate. 

No Tax 

The No Tax button controls whether tax is calculated for the document. Turn it on to remove tax 
and off to add it. Its initial setting matches the “Tax Exempt” setting of the customer record. If no 
account is assigned to the document, it is off (the document is taxable). Any time an account is 
assigned to the document the taxable state is reset. 

Discount % 

This identifies the customer discount percentage. It is applied to the entire document after all other 
markups and discounts. Normally, the discount % is copied automatically from the customer 
account. You can override this and enter a specific discount percentage. A negative number is a 
markup and is perfectly acceptable. 

Note:  Changing the customer account assigned to the document or recalculating the document 
will change the discount to match the discount in the account unless it has been 
overridden. When the discount percent has been overridden you will be asked if you wish 
to retain the override or use the customer discount from the account. 

Dates 

The date and time for document events tracked by PrintSmith is displayed in the “Dates” area. 

Shipping Charges 

The total of all items assigned to the shipping sales category. This amount does not include the 
amount in the shipping text field. 

Note: Shipping Charges are taxed depending on the taxable state of each charge, while tax on 
Shipping is determined by the Tax Table assigned to the document. 

Discounts 

The discount amount is calculated by applying “Discount %” to the sub-total. The amount actually 
shown in Subtotal includes this discount. 

Subtotal 

The Sub Total is the total of all of the sales categories plus Discounts. 

Sales Tax 

This is calculated by multiplying “Tax Sub” by the tax rate. 
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Shipping 

Use this to manually enter an additional shipping charge for the document. Shipping may or may 
not be taxed depending on how you have set up the tax table. Charges assigned to the shipping 
sales category are totaled separately in “Shipping Charges”. Generally, it is better to add a 
separate charge for shipping than to manually enter a shipping amount here. 

Total 

Subtotal plus Sales Tax plus Shipping. 

Deposits 

Total of all deposits entered on the invoice. 

Total Due 

Total less deposits — the outstanding balance on the invoice. On invoices that have already been 
picked up (posted to AR), this is the balance due at the time of pickup. It does not include 
payments made after pickup. 

Note:  The current balance, including payments made after pickup, is shown in the main invoice 
window. 

 

Lock Prices 

Located in the Document Totals window, this feature allows you to create a document, lock all 
pricing, and change production specifics without affecting the locked price. On the document 
screen, a lock icon will display along the left price column. 

Figure 3.39: Locked Prices 

 

The Lock icon 
indicates that 
the item is 
locked. 
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There are a few exceptions to locked pricing when the invoice price will change. If you enter data 
into the Tax Rate field, Tax Table field, Shipping field or Discount field located in the Document 
Totals window and the document is locked, the correct amount for these items will be included. 

Historical documents also retain the locked prices setting. To reset pricing to allow the Estimator to 
calculate prices, simply deselect Lock Prices and click the OK button or the Recalculate button and 
the invoice will be recalculated. Once you recalculate or click the OK button, the previous locked 
price is replaced with current prices. 

Besides locking an entire document you can also lock and unlock elements in the Job and Charge 
windows. 

Note:  Security for Lock Prices allows locking and unlocking. If you cannot unlock an element, 
the settings for your user do not allow access to Lock Prices. 

Unlocking is temporary in the sense that when a price locked document is filed, all the elements get 
locked again. You can forcibly re-lock all elements by holding down the <option> key while clicking 
the Lock Prices button. 

When an item is unlocked by clicking the individual lock button, the price gets recalculated 
immediately. For a job, the job price will change but none of the prices on any locked charges will 
change. For a charge, only the charge price is affected. 

If you delete a preset charge on a price locked document, it gets logically deleted, but in this case, 
the price of the job is retained and although it's grayed out, the price is now shown with a line 
through it and is still included in the document totals. 

You can edit the quantity of a locked element without any effect on price. 

New jobs created on a locked document are initially locked. If the user can not unlock pricing then 
any new job will have a price of zero. For a price to be different than zero, the user must unlock the 
job or invoice. 

Note:  The goal is to absolutely maintain the TOTAL price of an order and ALSO, the sales 
breakdown although this is not always possible. The biggest problem in this area is with 
preset charges and recalculating the document because this causes all preset charges to 
be removed and re-added. Other issues are change press, stock and pricing methods as 
these frequently involve changes to preset charges. If this happens to you, remove lock 
prices, recalculate the job then lock prices again or simply do not save or file the 
document. 

You determine who is given access to lock prices. This is controlled by the Security Setup 
command in the Admin menu. Security for this feature is Lock Prices in the Invoice menu list. Use 
this feature with care! 

Note:  Estimator’s Note Pad information can now be changed on locked documents. You could 
use this area to make notes on why you locked prices on this document or any other 
special circumstance associated with this order. 
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Note Pad 
The Note Pad provides a simple method of recording the specifics of a customer order (especially 
while you are on the phone) for later use in creating a document. Note Pad information can be 
updated and changed on locked documents. Except for the date wanted by, none of the information 
is actually used in the document, but you can use this command to guide you in creating the job. 
This window prompts you for the basic information you will need to fill out the document later. This 
information is saved with the document so you can file it and get back to it later when you have 
time. Clicking the OK button saves the notes. The Cancel button discards any changes. 

1. Click the Notes  icon in the document window, or select Note Pad from the 
Invoice menu.  The Estimator’s Note Pad window opens. 

Note:  If the Note Pad was opened from a document, the window title will include the 
document type (Estimate or Invoice) and the document number, if filed. 

Figure 3.40: Estimator’s Note Pad Window 

 
 

2. Enter or modify the applicable notes fields including Who, Phone, What, How Many, 
What Size, Paper, Notes, and When. 

3. Check the Show Note Pad When Document Opens option, if desired. 

4. Click the OK button once all necessary information has been entered. 

 

Check the Show Note Pad 
option if you want to have 

the note pad displayed 
each time the document is 

opened. 
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Convert to Invoice 

This command converts an estimate into an invoice. The Estimate is filed in Estimate History and 
when you File the invoice, the conversion is recorded, the invoice is assigned an invoice number, 
and the Pending Invoice list is updated to reflect the document’s changed status. Estimates 
converted to Invoices in this manner are recorded a Win. To cancel the conversion on an existing 
estimate, click the No File button. On new documents, select Copy to New Estimate from the 
Invoice menu. 

File Document 

This command saves an estimate or an invoice and closes the document window. Use this when 
you are completely done with a document. Use the Save command in the File menu to save 
changes and keep the document window open. Until a document is filed, none of the changes you 
make are permanent. 

Cancel Document 

The Cancel Document command is used to cancel invoices and estimates. There are two types of 
cancellations: voids and deletions. Normally, when you cancel a document, it is voided. The 
document still exists and can be retrieved by number. This provides an audit trail and prevents you 
from reusing the number. Voided documents can still be opened and even printed to give you a 
paper audit trail. Voided documents can also be copied to a new document. 

Voided documents are locked and can be retrieved only by their document number using Review 
Any Document in the Invoice menu. Before voiding the document, we recommend that you open 
the customer info window and use special instructions to record why the document is being voided. 

If you want to reuse the number of a voided document, you first have to delete the document. To do 
this, open the voided document using the Review any Invoice command. Then select Cancel 
Invoice – this deletes all record of the document. When documents are voided or deleted, an entry 
is made in the register tape recording the fact, the dollar amount and the user who performed the 
action. 

Note:  Voiding a document with a deposit is a bit different. You have a choice of returning the 
deposit to the customer or treating the deposit as a forfeiture (you keep it). PrintSmith will 
ask if you want to return it during the cancellation process. 
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Create Customer from Document 

This command converts the customer information in a document assigned to the “<<< WALK - IN 
>>>” account into a new account and assigns the document to the new account. This greatly 
simplifies capturing customer information gathered at the time of the initial quote and allows you to 
set a higher level of security on the Customer Accounts command. 

The best way to use this command with a new customer is to create an invoice and assign it to the 
“<<< WALK - IN >>>” account. When you have collected all of the account information, select this 
command to create the account. The new account contains the name, address, phone, FAX, sales 
rep, resale number, and is a “Check” type account (no charges to AR are allowed). 

You can set a high security level on the Customer Account command in the AR menu because 
your counter people do not need access to the command to create accounts. A manager can go in 
later, if necessary, and make the account a charge account and set up a credit limit. 

Recreating Deleted Accounts 
If an account has been used to create an invoice or estimate it is possible to rebuild the account 
history and recover virtually all the customer information. The procedure is as follows: 

1. Open any invoice or estimate assigned to a deleted account. 

2. Select the Create Customer Acct fm Document or Create Prospect fm Document 
(estimates) command from the Invoice menu. This procedure can take several 
minutes depending on the size of your data-base. 

3. The account will be created using the name and address information in the document 
except that the account title will be “Recovered acct #xx” where “xx” is the account 
number. It will be placed at the beginning of the Customer or Prospect list, if restored 
from an estimate, in the Account Picker window. 

4. Select the account and set up the account type, credit limit, and correct the title. 

5. You can change a prospect to a customer by clicking on Customer in Marketing tab of 
that prospect. 

6. The recovered account will have its full history, account information, and sales 
statistics.  

Note:  This needs to be performed at the Master PrintSmith program. It should not be done 
at a workstation. 
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Generate Delivery Ticket 
It is possible to generate a delivery ticket for jobs within PrintSmith.  Multiple delivery tickets can be 
created for each job.  And, multiple jobs from multiple invoices can be included within one delivery 
ticket.  Use the Delivery Ticket Manager to review delivery ticket history, setup delivery ticket forms, 
and add delivery brokers.  See page 406 for additional information. 

Delivery Ticket information is added through five tabs:  Deliver What, Deliver Where, Deliver How, 
Printing, and Status.  The following information will display, regardless of the tab selected: 

• Functionality buttons:  Save, Close, Delete, and Cancel buttons appear at the top of the 
Delivery Ticket. 

• General Information:  Ticket Number, Delivery Date, and Description display above the tabs. 

Ticket Number – Added when the delivery ticket is saved. 

Delivery Date – The current date is populated by default, but can be modified by entering 
the date in mm/dd/yyyy format. 

Description – Enter a description of the delivery ticket in this field.  The delivery ticket will 
be referenced by the Inv/Job Description in Delivery Ticket Manager > History. 

• Previous/Next buttons:  Use to scroll between tabs, or just click on the tab name. 

Figure 3.41:  Delivery Ticket window 
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Adding Delivery Tickets 
Delivery tickets can be added in three ways: 

• From the Pending Documents window, select the invoice or estimate and click the Deliver 
button.  The Delivery Ticket window opens. 

• With the invoice or estimate open, select Invoice > Generate Delivery Ticket from the main 
PrintSmith menu. 

• From within the Delivery Ticket Manager > History tab, click the New Ticket button.  The 
Delivery Ticket opens and jobs can be dragged into the ticket. 

Note: Invoiced jobs can also be dragged into the delivery ticket from Account History. 
 

Deliver What 
In the Deliver What tab of the Delivery Ticket, the invoices and jobs to be shipped can be added, 
the Shipped Qty is entered, and the shipping weight is calculated. 

Figure 3.42:  Delivery Ticket window, Deliver What tab 
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Adding Invoices/Jobs to the Delivery Ticket 

If the Delivery Ticket is created from the Pending Documents window, by selecting the invoice and 
clicking the Deliver button, the selected Invoice/Job will appear in the Delivery ticket. 

Additional Jobs and Invoices can be added to the Delivery Ticket in two ways. 

Use the Add button: 

1. In the Deliver What tab, click the Add button.  The Pending Document dialog opens. 

2. Highlight the Invoice and click the Select button.  The invoice is added to the Delivery 
Ticket. 

 

Drag jobs into the delivery ticket: 

1. With the Delivery Ticket open, open the Invoice of the job to be added. 

2. Select the job in the invoice and drag it to the Delivery Ticket.  The job is added to the 
Delivery Ticket. 

 

Editing the Shipped Qty 

To edit the Shipped Qty: 

1. Click in the Shipped Qty field for an Inv/Job line item. 

2. Type in the Shipped Qty.  The Inv/Job line item Weight and the Total Weight are 
updated. 

Note:   To delete an Inv/Job from the Delivery Ticket, select the Inv/Job in the Deliver What 
tab.  Then, use the Del key on the keyboard.  The item is removed from the Delivery 
Ticket.   
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Deliver Where 
In the Deliver Where tab of the Delivery Ticket, select the From address, the To address, and direct 
to a particular contact’s attention (Attn). 

Figure 3.43:  Delivery Ticket window, Deliver Where tab 

 
From 

By default, the Company information as setup in the System > Company panel of the Preferences 
window is selected.  Other Brokers, as setup in the Delivery Ticket Manager > Brokers tab can 
be selected in the From dropdown list. 

To 

The Account(s) for invoices added to the delivery ticket will appear in the To dropdown list.  If 
invoices/jobs from multiple companies have been added to the Delivery Ticket, one ship to address 
needs to be selected. 

Attn 

Select a contact from the Attn dropdown.  This selection can also be left blank. 

Address 

Select an Address for the contact selected in the Attn dropdown. 

Other 

Selecting the Other option beneath the From, To, or Attn fields allows you to edit the information. 

Note:   Changes made to the address information in the Deliver Where tab will not affect the 
saved Company, Broker, Account, or Contact information. 

From Address 

To Address 

Contact Address 

Select Other to edit the address 
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Deliver How 
Use the Deliver How tab to set Shipping and Numbers options.   

Figure 3.44:  Delivery Ticket window, Delivery How tab 

 

Shipping 

• Ship Via:  Select from the dropdown list, populated from the Ship Via table 

• Cost:  Enter the shipping cost. 

• Tracking:  Enter the Tracking number supplied by the shipper. 

• COD:  Select this option if payment for the entire job is expected on delivery. 

Number 

Customer PO, Part No., and Reference:  Allow you to enter any additional reference numbers. 

Order No.:  Populated from the first line item Inv number that appears in the Deliver What tab. 

Comments 

Enter any Comments related to shipping. 

Enter Shipping 
information 

Reference 
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Enter shipping 
comments 
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Printing 
Use the Printing tab to select the Delivery Ticket format and a Label Format, enter Carton 
information, Label Control information, and send an email version of the delivery ticket. 

Figure 3.45:  Delivery Ticket, Printing tab 

 
Format 

Select the Format of the Delivery Ticket form.  Delivery Ticket formats are designated in the 
Delivery Ticket Manager > Form Preferences tab.  See page 408 for more information. 

Label 

Select a Label Format from the dropdown list, or define a new label format by clicking the Define 
Label Format button. 

Note:  Label formats can also be defined through the Mailing Labels window, accessible from the 
Reports main menu. 

Carton Count 

The total number of cartons to be shipped. 

Items Per Carton 

The total number of items to be packed in each carton. 

Total Items 

The total number of items to be shipped. 

Select Delivery Ticket Format 

Select Label Format 

Click to e-mail delivery ticket 
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Start Number 

Edit this field if the Start Number is something other than 1. 

Skip Count 

Enter a number here if you have a partial sheet of labels and need to skip over them to the first 
good label. 

 

E-mailing the Delivery Ticket 

If a contact with an e-mail address has been selected from the Attn dropdown in the Deliver Where 
tab, the e-mail address will appear in the Address field of the Printing tab.   Clicking the E-Mail 
button will launch your e-mail application, if not already open, and an e-mail version of the delivery 
ticket can be sent to the contact.  

 

Status 
Use the Status tab to enter Delivery Comments, update the item location, and mark deliveries as 
complete/delivered. 

Figure 3.46:  Delivery Ticket window, Status tab 
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Delivery Comments 

Enter any Delivery Comments in the text box. 

Changing Item Location 

To change an item’s location: 

1. Select the item(s) in the Change Locations list. 

2. Select the new location from the Location dropdown list. 

3. Click the Update location on selected items button.  The location is updated for the 
item(s). 

Marking Items Delivered 

To mark items as delivered: 

1. Click in the Delivered column to the right of the Inv/Job number of the item that has 
been delivered. 

2. Click the Save button. 

3. Once all items in the Change Locations area of the Status tab have been marked as 
Delivered, the Delivery Ticket will be marked as complete in the Delivery Ticket 
Manager > History tab. 

Note:   Completed deliveries are displayed in green within the Delivery Ticket Manager. 

Delivery Ticket in the Invoice 
Once the Delivery Ticket is created, it will appear in the invoice with quantity shipped, description, 
and ticket number.  If a delivery ticket is complete, (done) will appear to the right of the description. 

Figure 3.47:  Invoice window with Delivery Ticket information 
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Open Estimator Checklist(s) 
The Estimator Checklist allows a view of the entire job, from specification creation to production.  
The Estimator Checklist(s) can be opened by selecting Invoice > Open Estimator Checklist(s) 
from the main PrintSmith menu.  One checklist is opened for each job in the invoice.  The checklist 
can also be opened from within the Job window, by selecting Commands > Estimator Checklist 
in the hierarchical list. 

This view-only window allows verification of the entire job within one window.  Items underlined and 
in red indicate a conflict of information or information that has been overridden, and act as a 
warning for follow-up.  General job information is displayed in the top half of the window.  In the 
bottom half of the window, individual items for the job are displayed with the Quantity, Estimated 
Time and Cost, Markup percentage and Amount, and the Sell Price. 

Figure 3.48:  Estimator Checklist window 
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Chapter 4 Point of Sale 
In this chapter 

Cash Register 140 
Understanding the Pending Documents Window 149 
Status Window 155 
Transaction Window 155 
Open Tape 156 
Cash Drawer Status 158 

 

 

The POS (Point Of Sale) module is the interface between the Estimator and Accounts Receivable 
modules. It is used to post invoices to accounts receivable or mark them paid and put them in the 
customer’s account history. The POS module also performs the functions of a full function cash 
Register: entering transactions, tracking the contents of the cash drawer, opening a real cash 
drawer, printing receipts, maintaining a cash register tape, and voiding mistakes. 

The module consists of three main windows: the Cash Register window, the Pending Documents 
window, and the Status window. In addition to the main windows, the Open Tape command 
displays the current register tape, a sophisticated version of a standard cash register tape. 

Following are some of the tasks that can be completed with the POS module: 

• Entering cash register transactions and printing receipts. 

• Using the Estimator to generate prices without creating an invoice. 

• Checking on the status of a work order. 

• Notifying the customer when the job is complete. 

• Keeping track of the location of orders. 

• Open pending documents for editing. 

• Displaying the current Accounts Receivable balance. 

• Posting invoices to Accounts Receivable and the account history. 

• Voiding erroneous accounting transactions. 

• Checking the current balance of any invoice. 
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Cash Register 
The Open Cash Register menu command is used to open the two main POS windows, Cash 
Register and Pending Documents. 

Understanding the Cash Register Window 
The Cash Register window is opened by selecting POS > Cash Register Window or POS > Open 
Cash Register from the main menu.  

The Cash Register window is used to enter all POS transactions. This window forms the interface 
between the Estimator and Accounts Receivable. It can also be used to replace a Cash Register 
machine by adding the optional Cash Drawer and Receipt Printer. 

Figure 4.1: Cash Register Window 

 
 

Note:  The Cash Register window will vary slightly if integrated credit card approval has been 
implemented. 

 

Transaction Summary 

Credit Transaction 
Information 

Department 
Transaction Options 

Tax Status 

Selected Customer’s 
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Verifying and Modifying Customer Accounts in POS Transactions 
A customer should always be selected when the POS transaction is being charged to Accounts 
Receivable. When you enter an invoice, the customer is automatically selected for you. However, if 
there are no invoices and the entire transaction is being paid for with Cash, Check, or Credit Card, 
a customer does not need to be assigned. If the transaction is being paid for at the time of sale 
(without an invoice), the customer account information is recorded in the Register Tape, but does 
not affect sales statistics for that customer in any way. 

Selecting a Customer 
To select a customer, click the Cust Acct button. The selected customer’s account name, type, 
and status information are displayed to the right of the Cust Acct button in the Cash Register 
window.  

Figure 4.2: Select Customer In Cash Register Window Example 

 
 

Verifying the Correct Customer 
Verify that the correct customer has been assigned to the invoice. When the transaction includes 
invoices, the customer account of the invoice is automatically selected and cannot be changed.  

Note:  A common mistake is to assign the <<< WALK - IN >>> account to an invoice, manually 
enter account information, and then post it to the “<<< WALK -IN >>>” account.  

Assigning or Changing a Customer 
If invoices are not involved or a customer has not been assigned to an invoice, a customer can be 
assigned or changed at any time prior to entering a payment. 

The selected customer is 
displayed in the top of 
the window. 
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Completing a Transaction 
Entering data in the Cash Register window creates a transaction. A completed transaction is 
composed of credits and debits that balance, meaning that the total amount of debits must equal 
the total of all credits in a transaction.  

Debit Transactions Picking up invoices or entering the transaction data directly using the 
department buttons creates debit transactions.  

Credit Transactions Selecting a method of payment creates credit transactions. In this context, 
charging an amount to Accounts Receivable is considered a method of 
payment since it forms part of the credit side of a completed POS 
transaction.  

There are three types of sales related transactions: Invoice, Department, and Payments.  

Up to 50 different transaction types can be posted at one time. The only restriction is that total 
debits (invoice and department charges) must be less than or equal to credits (payments). For 
example, a complete transaction could consist of several invoice pickups, several department 
transactions, and payments by cash and check with part of the total being charged to a customer 
account. In short, anything that a customer does can be “rung up” and posted in a single 
transaction. The only rule is that the total of payments must equal the total of charges (charging an 
amount to a customer account is considered a method of payment in this context).  

Note:  Entering a payment amount in excess of the amount owed is allowed, but the remainder is 
always returned as change. To post a payment in excess of the amount owed in a 
transaction, you must use Post Payments (in the A/R menu). This is referred to as a 
“payment on account”. 

Entering Invoice Transactions  
Invoice Transactions are transactions involving invoices that were either created in the Estimator or 
manually within the Cash Register window.  

Selecting and Accepting Invoices from the Pending Documents Window 

Existing invoices can be selected from the Pending Document window. When you select an invoice 
or group of invoices from the same account in the Pending Documents Window and click the 
Pickup button, PrintSmith creates and accepts invoice transactions for each selected invoice. 

Selecting and Accepting Invoices from the Cash Register Window 

Invoices can be selected from within the Cash Register window by clicking the Invoice button, 
entering an invoice number, and pressing the <tab> key. PrintSmith searches the existing Invoices.  

If a match is found and the invoice has not been picked up, the invoice will be selected from the 
Pending Documents list, and the status and customer information will be displayed in the Cash 
Register window. However, invoices selected from within the Cash Register window are not 
automatically accepted. To accept the invoice into the current transaction, click the Accept button. 
Once the transaction is accepted, that part of the screen clears and transaction totals are updated.  

Note:  If the invoice cannot be picked up, a reason will be displayed. 
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When the account is a charge account, which is not frozen or over the credit limit, the full amount 
due is set up to be charged to AR. Note that Sub-Total and Tendered show current totals before 
transactions or payments are accepted.  

Canceling Invoice Pickup and Payment 

Cancel the invoice pickup by clicking the invoice button or a department button. 

Cancel the payment by clicking the Charge button or change the payment type by clicking a 
different payment method button. 

If a match is found but the invoice has already been picked up, it will display the date it was picked 
up, the amount paid, and any amount balance due. This invoice transaction will not be accepted. 
When the invoice has already been picked up, the task of locating the invoice is also referred to as 
Invoice Lookup.  

Printing the Invoice 

Enable this option to print the invoice with the cash register transaction.  Select the Format for the 
invoice from the dropdown list. 

Entering Department Transactions 
The department section of the Cash Register contains buttons for selecting the category of the 
sale. Clicking one of these buttons sets up a debit transaction.  

Note:  Department Labels and the associated Sales Categories can be customized in the Cash 
Register Preference Panel. Refer to the Admin > Preferences menu.  

 
 
 

Enter the Quantity and Unit Price. The Total will be calculated (Unit Price x Quantity) based on the 
values entered. However, a price can be entered directly into the Total field (without entering 
values in the quantity and unit price). Manually entering a total is treated as an override. Customer 
accounts are optional for this type of transaction. 

The name of the selected department is populated as the default description. An alternate 
description can be entered (up to 30 characters). 

Determining Which Items Are To Be Taxed In A POS Transaction 

Each item in a POS transaction can be taxed or non-taxed. Tax status is determined by whether 
the Non-Tax button is selected when the Accept button is clicked. When a debit transaction is set 
up, the customer account and the configuration of the department is checked to see if the 
department is taxable. If a customer account is assigned to the transaction and the account is tax 
exempt, the debit transaction is always set up as nontaxable. Otherwise, the configuration for the 
selected department is used.  

PrintSmith calculates taxable receipts based on what is being paid, not on whether the payment 
itself is taxable. The Register tape indicates that items are not taxable by displaying nontx next to 
the item price. Since the Estimator calculates tax, the Non-Tax button cannot be used with an 
invoice. 
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The status of the Non-Tax button is initially determined by the department button setup or the tax 
status of the customer account if one is assigned to the transaction.  

Click the Non-Tax button to make the item tax exempt. Each Department Transaction has its own 
tax status. 

For non-exempt items, select a Tax Table from the dropdown list, if one other than the default 
should be used. 

Accepting Department Transactions 

When the text cursor (a blinking bar) is in the Description text box, the Accept button is highlighted 
so you can press <return> to accept that part of the transaction. Accepting a debit transaction does 
not do anything until it is posted by clicking the Post button. 

Entering and Posting POS Charges 
If you wish to charge any part of a department transaction, you must identify the customer account 
to which the transaction is being charged. This type of transaction is called a “POS Charge” and it 
is given special handling.  

The typical conditions under which a POS charge is likely to occur is when a regular customer 
comes in and makes a small purchase and asks you to charge it to their account. It is generally 
neither cost effective nor efficient to create a standard invoice for a 50¢ transaction. 

Furthermore, you do not want the account history littered with tiny transactions – it would detract 
from the usefulness of the history. 

PrintSmith maintains a special balance in each account for just this type of transaction. It is called 
the Merchandise Charge balance. Instead of posting the transaction to accounts receivable, it is 
added to Merchandise Charges for the account and a special log is maintained for these charges in 
the Data... folder. The amount of an account’s merchandise charges is seen as Un-posted 
Merchandise Charges in the Post Payments window.  

Since these charges are not posted to Accounts Receivable, you cannot use Post Payments to pay 
them off and they do not appear on statements. At the end of the month, or some other suitable 
occasion, you use the Post POS Charges command in the AR menu to print a special statement 
composed of all these charges. As part of this process, PrintSmith makes a single entry in 
Accounts Receivable for the entire amount in the Merchandise Charge balance so it can be paid in 
Post Payments and will appear on statements. 

Entering Credit/Payment Transactions 
The payment method section is used to enter payments (credit transactions). Before a transaction 
can be posted, total payments must at least equal total charges. When you select a payment 
method, PrintSmith automatically fills in the amount due as the payment amount. If you select the 
Charge payment method and the amount due will exceed the account’s credit limit, only the amount 
remaining on their credit limit will be entered into the payment amount. 

You can enter any amount you like for payment. If the amount entered exceeds the amount due, 
PrintSmith will consider that amount as “Change” and will remove that amount from the cash 
balance in the cash drawer when the transaction is posted. The Charge payment method does not 
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allow you to exceed the amount due. If a Charge payment greater than the amount due was 
allowed, you would in effect, be loaning the customer any change on the transaction. 

Payment Transactions are used to enter payment information. In this context, charging items to a 
customer account is considered a method of payment. You can enter any number of payments in 
any order. Any payment in excess of the amount shown in “Total” is returned to the customer as 
change unless the payment type is “Charge” (you cannot give change on a charge). Change is 
taken from cash, either a cash payment that is part of the transaction or cash from the cash drawer. 
Typing the amount enters the payment amount. This is automatically set to the total amount due 
when the payment method is selected, so most of the time you will not have to type anything. 

Check and CR Card payments have an additional text box for a reference number. For checks, this 
is the check number and is required. For credit cards, it should be the validation number you get 
when you call the transaction in (the credit card number is too large) and is optional. 

To accept a payment, click the Payment button. You can also click the Post button if it is available 
and PrintSmith will select the Payment button for you (and the Accept button also, if necessary). 

Handling Credit Card Payments 

When the Credit Card payment method is selected, a credit card menu appears in the payment 
area, above the Ref # field. You can select the desired credit card from the menu using the mouse. 

Alternatively, you can select the credit card by typing the credit card “code”. If you look at the 
illustration of the credit card menu you will note after each card’s name there are two characters in 
brackets. For example, after Visa, the bracketed text is “VI”. This is the credit card code for Visa. If 
you type “VI” in the “Ref #” field followed by the authorization number for the transaction (e.g. 
VI12345), PrintSmith selects the Visa credit card and sets the “Ref ” field to “12345”. Often this is 
faster than making a menu selection. 

With integrated Credit Card processing you can just swipe the card and wait for approval.  

Overriding Credit Limits 

Normally, you cannot override a credit limit on an account and pick up more on the account than is 
allowed by the system. A user, typically a supervisor, can be given the authority to override a credit 
limit when posting items in the cash register. When such a user is posting, PrintSmith will ask you if 
you want to override the limit. To facilitate a supervisor logging in to override a credit limit, the User 
Log In window will not close all the open windows if the <shift> key is held down while the User Log 
In command is selected. If you sign in to override a credit limit, remember to select User Log In 
again (holding down the <shift> key) to reset security. 

Note:   See page 401 for additional information on User Definition security options. 
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Viewing the Transaction Summary 
In the lower, right section of the Cash Register window, PrintSmith displays the current transaction 
status. Whenever you enter a charge or a payment amount, these totals are immediately updated 
so you always know what the effect of the item will be on the total transaction before you do it.  

These amounts and their usage are as follow:  

Table 4.1: Transaction Summary Definitions 
Field Name Definition 

  

Sub-Total The total of invoice pick ups and department transactions.  
 

Tax The sales tax for the transaction, which is calculated by multiplying the taxable portion of the 
Sub-Total by the tax rate in the default tax table (unless an account is assigned which 
specifies a different tax table). This field does not include tax on invoices, which is handled by 
the Estimator and is already included in the invoice total. 

Total Sub-Total plus Tax. The Total is the amount owed by the customer.  

Tendered The total of all payments (including charges to AR). 

Change The amount to be returned to the customer as cash.  

  

 

Quick Est.  
You can use the estimator to calculate a price and run it through the Cash Register without creating 
an invoice. To use this feature, select the Cash Register window, then open a job template or 
select the Job command or one of the charge commands in the Invoice menu. Enter the 
appropriate data just as though you were adding the items to an invoice. When you click OK, the 
entire job and all charges are converted to individual line items in a Cash Register transaction and 
a payment method and amount are set up just like the Pickup process. These transactions use the 
same sales categories that would appear in an invoice, you are not restricted to the sales 
categories defined for the Cash Register departments. These transactions are shown in the 
Register Tape as Quick Est transactions. You can use charges defined as invoice level markups to 
apply a markup to the current transaction. The markup is calculated at the time it is added to the 
transaction and not recalculated. 
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Paid Outs  
You can directly record cash taken from the cash drawer as a Paid Out. Make sure there is no 
transaction pending, select the Cash payment method, enter a negative amount, and click the Post 
button. A window opens asking for a description to use in the Register Tape. Enter one and click 
the OK button. The transaction is recorded in the tape and also as part of the closeout in the Paid 
Outs category in the Miscellaneous section of the sale report. You can also void the transaction if 
you later replace the money. You must be able to override a credit limit to record a paid out. This is 
controlled by the User ID command in the Admin menu. 

Posting Transactions 
The posting process varies considerably with the type of transaction being posted. There are five 
types of posting functions: Department transactions, POS Charge transactions (department 
transactions charged to an account), Invoice transactions (pickups), Payments, and Charges. Each 
of these general types can be intermixed in a complete transaction. Department transactions can 
be taxable or nontaxable (for invoices, this is controlled from within the document). Although it is 
perfectly acceptable to have a transaction with all five transaction types, it usually provides a better 
audit trail if you split these transactions. If you are posting an invoice and ringing up lobby copies 
for the same customer, separate the transactions, especially if you plan to print a receipt on the 
receipt printer. PrintSmith applies payment transactions to POS and Invoice transactions in the 
order each one is entered. If you want complete control over how payments are applied in a 
complex transaction you must either break up the transaction so there is only one payment per 
trans-action or be careful of the order in which you enter each transaction. Creating mixed 
transactions where there are multiple payments and one of them charges the remainder to Account 
Receivable is not recommended. 

Not Allowed To Return Cash 
A User Security option called Not Allowed to Return Cash can prevent each user from returning 
cash to a customer in excess of the cash received in a transaction (cashing a check). If this is 
attempted a message is displayed informing the user that the transaction cannot be posted and to 
contact a supervisor. This message also displays on an attempt to post a POS charge when 
access to that command (“Post POS Charges”) is disabled for the user. 

Note:   See page 401 for additional information on User Definition security options. 

Canceling Transactions 
The Cancel button cancels the entire transaction. You can cancel a payment or charge item prior to 
accepting it by clicking on the selected department or payment method button. 

Keyboard Shortcuts 
Use keyboard shortcuts to enter all transactions from the numeric key pad or the keyboard without 
using the mouse.  

Each of the department buttons and payment types has a number (or symbol) in a small box next 
to the text description. Typing that number (or symbol) is the same as clicking the button, which 
opens the text boxes for that charge. You can then enter the quantity and unit price and use the 
<enter> key to go to the next field. When the cursor (a blinking bar) is in the Description field, 
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PrintSmith outlines the Accept button to indicate that pressing the <enter> key is the same as 
clicking the Accept button. The charge you entered is added to the transaction and the debit 
transaction area is cleared.  

Entering a payment is just as easy. Type the keyboard command to select the payment method. 
PrintSmith puts an outline around the payment button when the last field is selected. Other 
keyboard shortcuts for data entry are:  

Table 4.2: Keyboard Shortcuts 

Keystroke Button Selection 
  

“.” Or “N” Toggle (turn off or on) tax button 

“0” or “C” Select a customer account. This opens the customer account selection window. 

“+” Or “I” Select invoice. This opens a field where you can enter an invoice number. If the invoice is 
in the Pending Invoice list, PrintSmith will locate it for you, select the customer account it 
belongs to, and set up an invoice pick up. If the invoice has already been picked up, 
PrintSmith will give you the current balance. In either case, the document status will be 
displayed in the Status window. 

  

 

Note: Normally, when text boxes are open for data entry, anything typed on the keyboard goes 
into that text box. On Macintosh, hold down the <option> key and PrintSmith will treat the 
keystroke as a command shortcut. 

Customizing the Cash Register 
If you plan to use the Cash Register at the front counter and do a lot of business with walk in trade 
that does not require an invoice, you will want to customize the department buttons in the Cash 
Register window. Consider adding a cash drawer and receipt printer and “retiring” your old cash 
register. You determine the button label, the sales category each department transaction is posted 
to, the default Unit Cost for that sales department and whether the transaction is normally taxed.  

Understanding the difference between the button label and the sales category is important. There 
are nine cash register department keys or buttons. Each of the buttons is linked to one of the 40 
sales categories. The cash register buttons can be customized in the preferences panel.  

Note: See page 442 for more information on customizing the cash register. 
When a cash register transaction is posted, PrintSmith distributes the sales based on the sales 
category attached to each cash register button. This is where the Sales Category menu comes into 
play. When setting up PrintSmith you attach a sales category to each particular department key. 
You have complete freedom with respect to your selection of sales categories. You could have all 
nine department buttons pointing to a single sales category. 
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Understanding the Pending Documents Window 
The Pending Documents window is a powerful tool for managing documents. This is a list of “live” 
documents. In a multi-user environment, actions at all Work Stations will update this list as you look 
at it.  

Figure 4.3: Pending Documents Window 

 
 

The Pending Documents List contains all of the invoices in production or waiting to be picked up 
and all estimates that have not been cancelled, cleared, or converted to invoices. 

 

Table 4.3: Pending Document Color Key 
Color Definition 

  

Set in 
Preferences Ready For Pickup 

Blue Invoice 

Black Estimate 

Set in 
Preferences Past Due Wanted By Date 
  

Find Pending 
Documents Feature 

Status Quick Filters 

Action Buttons 

Document Type 
Quick Filters 

Pending 
Document List 
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Table 4.4: Pending Document Window Type Field Icon Key 

Icon Definition 
  

 Estimate item on the pending list 

 Invoice item on the pending list 

 
Invoice that is ready for pick up or 
delivery

  

 

Filtering the Pending List by Document Types 
The drop tabs let you select the type of documents to be displayed. For example, clicking the 
Invoice drop tab displays only invoices. Another drop tab is used to select documents based on 
their due date or completion status. For example, the Ready tab shows all documents marked 
ready for pickup or delivery. These two controls quickly fine tune the contents of the list. For a list of 
all estimates, which are overdue for a follow-up call, click the Estimates tab and Late in the bottom 
control. 

Note:  Web Orders and Web RFQs tabs are only displayed if PrintSmith Site is enabled. Web 
Orders and Web RFQ’s are denoted by a globe  icon to the left of the Account in the 
Pending Documents List. 

 

Customizing the Pending Document Lists 
The Pending Documents List can be customized in the  Admin > Preferences > Pending List panel. 
When you close the Pending Documents Window, PrintSmith remembers the column settings, drop 
tab states, the default action button as well as the size and location of the window. To return to the 
default settings, hold down the <option> key while opening the window. 

Note: See page 443 for more information on customizing the Pending Documents List. 
 

Finding Items in the Pending Documents List 
In addition to searching alphabetically, you can perform searches for text embedded in names, 
phone numbers, PO Numbers and other data using the search tool at the bottom of the window. 

Select the drop tab for the data you want to look for, enter the text in the text box, and click the Find 
button. The drop tab is used to select the data to search for, but can also be used to examine data 
for the selected item because it displays that data to the right of the search text entry field. When 
searching for data, PrintSmith looks for any instance that matches and it searches the list in its 
currently sorted order. Searching for “Inc.” in “Name” will find the first item with the letters “inc.” 
anywhere in the name. 
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Using the Action Buttons 
Select documents in the Pending List by pointing to them and clicking. To select a group of 
documents from the same account, shift-click (hold down the <shift> button while clicking with the 
mouse). When an item is selected in the Pending List, you can use the Action buttons along the left 
side of the window to perform actions on the selected item(s). 

Each of the action buttons: Pickup, Status, etc. is associated with a command in Security Setup. 
This gives you the ability to prevent individual users from picking up and posting invoices. Another 
useful command is the ability to restrict access to the “Location” button, which also affects bar code 
scanning.  

Note: See page 403 for additional information on setting up Pending List security. 
Except for Pick Up, repeatedly clicking the buttons will perform the requested function sequentially 
on each of the selected documents. For example, if you click on the first item in the list and then 
press the <shift> key while clicking the third item on the list, the first 3 items will be selected. 
Clicking the Status button will display the status of the first item; clicking Status again will show the 
second item and so on. The Pick Up action attempts to pick up the entire selected list as a group. 

If you click a different button, PrintSmith uses the same item. For example, clicking the Status 
button, then the Open button will display the status of the document and then open the same 
document. 

When you press <return> or double-click on an item, the default action is performed. You can 
change the default action button by clicking the radio button to the left of the desired default action. 
PrintSmith remembers your selection when you close the window. 

Pickup 
The terms “Pickup”, “Pick Up”, “picking up”, “picked up” are used frequently in this manual. It is an 
important concept that must be understood to use PrintSmith effectively. In general, “picking up” 
refers to the process of posting orders to accounts receivable as charges or paid invoices. 
PrintSmith considers the point at which a document is picked up to be the sale. It assumes that a 
document is picked up when the order or service is handed over to the customer. At this point, the 
work is done and the invoice is final. Prior to pickup, a pending invoice is considered a “Work 
Order” that is subject to change. Once the customer has the work, the invoice must accurately 
describe the work performed and the price charged for the work. Invoices that have been picked up 
are removed from the Pending List and added to the Account History. The invoice is locked and 
can no longer be changed although it can be copied to new invoice or estimate. 

The Pickup function is one of the most important functions in the POS module. Use the Pickup 
button to tell PrintSmith an order has been given to the customer. As far as the accounting system 
is concerned this is the point at which the customer is obligated to pay for the order. Only invoices 
can be “picked up”. You can select and pick up a group of invoices; but they must all be for the 
same customer account. 

All of the selected invoices are added to the current POS transaction (a new transaction is started if 
necessary) and the Cash Register window reflects the total of these invoices. The transaction is 
“Accepted” and the payment method and amount are entered (you have to click the Payment 
and/or Post button). Before any invoices are added to the current transaction, they should be 
checked thoroughly for the following: 
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• Only invoices can be picked up. 

• All invoices must be assigned to a valid account. 

• All invoices in a single transaction must be for the same account. 

• Invoices cannot have credit balances (deposits larger than the amount due). 

• Invoice must be marked complete if using the option to Only Post Invoices Marked Ready. 

When invoice pick ups are posted, those invoices are removed from the Pending Documents list 
and added to the end of the customer’s Account History. The invoice is locked at this point and may 
no longer be changed (you can still open it and make a copy of it).  

Note:  When an invoice is picked up, PrintSmith checks to see if the tax rate on the document is 
the current tax rate. If it has changed since the document was last opened it will warn you 
that the tax is incorrect. If you receive this warning, open the document, check the tax 
(which is recalculated when the document opens), and file it before picking it up. You can 
ignore the warning and pick up the document, but sales tax will be incorrectly tracked. 

Status 
This function lets you check any document in the Pending Invoice list to determine when it is due, 
how much it was for, if it is finished, and whether the customer has been notified of this.  

Location 
The location function is used to track the current location of a document or to review the location of 
individual jobs in a document. When an invoice is ready for pickup, use this function to mark it as 
finished and make a notation as to where to find the finished order. 

The location of individual jobs can also be tracked using the optional bar code system. When this 
system is in use, the last update of any job in the document is displayed in this window. 

Figure 4.4: Location Window 
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Clicking the OK button records the current location, the document completed state, and the date 
and time the location was last updated. The date and time that the OK button is clicked is saved 
with the invoice and displayed in the status window. This function is designed to track both finished 
work and the current location of work in progress. 

Hold State 

Hold State indicates the reason that production or quoting is delayed. This pull-down menu listing 
the hold options is updated through the location and Account Info screens. A Hold State column in 
the Pending Document Window displays this information. The Hold State table can be edited in the 
Table Editor. To deleted a hold entry, use the <delete> (Mac) or <back space> (PC) keys. 

Ready for Pickup/Delivery 

The button is used in the Pending display and the Work In Progress report to indicate which orders 
are completed. This button must also be turned on in order to pick up a document if Only Post 
Invoices Marked Ready item in the Admin > Preferences > System > Behavior preference panel is 
enabled.   

Open 
Use this as a quick way to open any document in the Pending Document list. This function can also 
be invoked by selecting the Open command in the File menu, which usually is a keyboard shortcut 
of <command>+<O>. 

Notify 
The Notify function opens a window displaying the person to contact and their phone number. If 
you enter any text for the customer account log, an entry is made in the log for this account. Use 
the AR Account command to review the log. 

Figure 4.5: Notify Customer Window 

 
 

Clicking the OK button in this window stores the date and time of notification in the invoice and 
saves it. This information is also shown in the status window. 
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Due Date 
Modify the date wanted on any invoice without opening the document. You can use this to adjust 
your production schedule. Select a group of pending invoices, by holding the <shift> key and 
selecting a range. Then select this command to cycle through each document in the group. 

Figure 4.6: Due Date Window 

 

When selected, a window showing the invoice number, title and customer account name is 
displayed as shown above. If there is already a date in the Wanted By field, this date will also be 
shown. Pressing <return> or clicking the OK button saves the date and time shown in the text 
boxes. You cannot update the due date with this command if the document is already open. 

Deliver 
The Deliver button allows you to create a Delivery Ticket for the invoice or estimate selected in the 
Pending Documents List.  For information on creating delivery tickets, see page 130. 

View / Print 
These optional buttons are present if Report Writer is enabled. See the Report Writer manual for 
details on how to use these buttons. 
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Status Window 
This view-only window shows the current cash drawer status, the totals for the last transaction and 
the status of any document in the PrintSmith database.  When you perform an operation in the 
Cash Register or Pending Documents window, which involves an invoice or estimate, the status of 
that document is displayed in the Status Window.  

Figure 4.7: Status Window 

 

When a transaction is posted, the status window is used to display a summary of the last 
transaction. This is a helpful reminder if you need to make changes on the transaction. 

Finally the window is used to display the cash drawer status when you select the Cash Drawer 
Status command in the POS menu. 

 

Transaction Window 
This window is used to manage transactions in progress. It displays a preview of the register tape 
entry that would be created if the transaction were posted and allows you to remove items without 
having to cancel the entire transaction. Unlike the other three status windows, this window does not 
open automatically when you select the Open Cash Register command; you have to open it using 
the menu command, POS > Transaction Window. 

You can remove any of the detail lines from the transaction except the first one, by selecting it and 
pressing the Void Transaction button. When the window is open, it will be continually updated 
whenever you make a change to the current transaction. 
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Open Tape 
PrintSmith keeps a detailed record of all transactions for each sales “day”. A sales day ends when 
you perform a closeout and a new tape is started. The tape records deposits, document voids, 
posted payments, finance charges, and journal entries. Selecting this command displays the 
current Register tape for review. 

Figure 4.8: Register Tape Window 

 

Events recorded in the register tape consist of a transaction header followed by one or more 
transaction details. The Show Account Name button displays the customer account name on the 
line following any entry with an account reference. On screen, two lines provide space for the 
account name empty lines are not printed. 

Note:   If the Register Tape ID# is set in Admin > Preferences > Cash Drawer, the register tape 
will include the workstation identification number. 

Void Transaction 
When voiding a transaction, the transaction is deleted but the history record is not deleted. A 
voided transaction has red lines running through it. You can print the tape by selecting the File > 
Print from the main menu. The Register Tape is used extensively throughout PrintSmith to record 
significant events, which are captured and summarized during the Closeout. 
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Voiding Tape Entries 
Occasionally, people make mistakes; they select the wrong invoice for posting, enter a check as 
cash, etc. Sometimes a customer might change his mind about a purchase or ask for a refund. 
When this happens you want to be able to quickly and intuitively correct the problem. In PrintSmith, 
there are two ways of adjusting your accounting records: you can make a journal entry using the 
Journal Entry command in the AR menu or you can void the transaction. When possible, voiding 
the transaction is preferable. 

A journal entry does not cancel the transaction; it creates a new transaction that counteracts or 
reverses the financial changes caused by the original transaction. A journal entry can sometimes 
be difficult to set up and it is subject to the same kind of errors as the original transaction. 

Voiding the transaction, on the other hand, does not create a new transaction except to record the 
fact that the void occurred, and leaves things just as they would have been if the transaction had 
never occurred. For example, if you void an invoice pickup transaction, the invoice is removed from 
the account history and replaced in the pending invoice list just as though it had never been picked 
up. Since it is back in the Pending Documents list, you can change it. 

Figure 4.9:  Register Tape window 

 
Voiding a transaction is also much simpler to perform than a Journal Entry.  To void a transaction: 

1. Select the POS > Open Tape from the main menu.  The Register Tape window 
opens. 

2. Click the transaction to be voided. 

3. Click the Void Transaction button. 

The transaction you voided is not removed from the tape; it is lined out in red so you can tell at a 
glance that a transaction was voided. An entry is made in the tape recording the void and who did 
it. 

Note:  When voiding a series of transactions, it is important that you start from the last 
transaction to be voided and work backwards. This avoids a situation where you are trying 
to void a transaction, which newer transactions are relying on. PrintSmith will detect these 
situations and refuse to void them. 

Voided 
transaction 

Workstation ID # 
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There are a few situations where voids are not allowed: 

• Your User ID is not authorized to void POS transactions. 

• Deposit entries. To remove a deposit, open the invoice and use the Deposit Entry command to 
zero out all the deposit information. 

• Invoice cancellations. Once an invoice has been cancelled, the data in the invoice is gone – 
there is no way to recover it, hence no way to void this operation. 

• Voided entries. You cannot void an entry that has already been voided or an entry that records 
a void. 

• Invoices or payments, which have been paid or applied in a later transaction. PrintSmith will 
notify you what the problem is and which entry is at fault. If, for example, you pick up an 
invoice and later go to Post Payments and pay it, you cannot void the invoice pickup until you 
void the payment. 

• POS charges posted using Post POS Charges cannot be voided. 

Warning: PrintSmith cannot always tell that this is the case. If, after using Post POS Charges, you 
charge more POS transactions to the same account on the same day, PrintSmith may try 
to void the new charges. 

Once you have performed a closeout, the Register Tape for that period is locked. You should 
review the tape to determine if any transactions need to be voided before finishing a Closeout. It is 
much easier to void the transaction before the closeout than to create a Journal Entry afterwards. 

Cash Drawer Status 
This is a special status display, which shows the current contents of the Cash Drawer as well as 
the current AR Balance. 

Figure 4.10: Cash Drawer Status Window 

 
The information in this window is strictly informational. PrintSmith does not use any of it during 
closeout. It is continually updated during the day and is reset whenever you do a Closeout. 
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Chapter 5 Accounts Receivable 
In this chapter 

Accounts 160 
Contacts 178 
Adding Contacts to Accounts 183 
Post Payments 183 
Closeout 191 
Monthly Closeout 202 
Generate Statements 204 
Verifying Accounts Receivable 222 
Account Aging 223 
Journal Entry 227 
Post POS Charges 237 

 

The AR menu contains commands, which manage the Accounts Receivable system in PrintSmith. 
It is tasked with keeping track of how much your customers owe, posting payments, generating 
statements, and reconciling daily sales activity. 

The Accounts list is the core of the Accounts Receivable module. Each account contains a 
description of the account, including name, address, account type, status and balance. It contains a 
list of all of the invoices posted to the account and all payments received – this is the Account 
History. Virtually every other part of Accounts Receivable uses accounts in one way or another. 

The AR module receives most of its information from the POS module. POS takes care of posting 
invoices when they are picked up – it passes the information you generate with the Estimator to 
Accounts Receivable, which generates sales statistics, keeps track of open invoices and manages 
the Account History. 

Note:  In a PrintSmith Portable installation, the only part of the account receivable system 
available is Accounts. This command, while normally used to manage customer accounts, 
is provided in PrintSmith Portable systems solely for the reviewing of account information. 
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Accounts 
This command is used to define accounts. Use accounts to identify your customers, prospects, and 
contacts, and manage sales and payments made by them. If you are regularly creating invoices for 
a particular customer, you should establish an account for them. You can create any number of 
accounts for a single customer, the only restriction is the name on the account must be unique - 
they can all have the same address (or no address at all). Account Histories are based on 
customer accounts, invoices are assigned and posted to, payments are made on, and sales 
statistics are kept for each account. 

Although not required, accounts should be created for all of your regular customers even if you do 
not plan to extend them credit. PrintSmith has a special account that is used for customers who do 
not have their own account. It is account number one in the Account Picker window and is named 
“<<< WALK - IN >>>”. This is designed for occasional or walk-in business, but you can use it any 
way you see fit. Although PrintSmith will let you, it is a bad idea to change the account type of the 
“<<< WALK - IN >>>” account to Charge. When-ever you extend credit to a customer, always set 
up an account and assign any existing documents for them in the pending list to the new account. It 
is a good idea to create a few special accounts: one for in-house printing and one for “junk” 
transactions (tax adjustments and so on that you do not want cluttering up other accounts). 

If all your work is for one major customer (in-plant operations), there are most likely a variety of 
departments or branch offices, which could be identified and tracked using separate accounts and 
then tied together with a master account. 

PrintSmith keeps track of a lot of information about your customers. This information is divided into 
logical panels you select using the tabs at the top of the window. Selecting the New command in 
the File menu selects the address panel and sets up the window to enter a new account. 

Account History for the selected account can be reviewed by selecting File > Open from the menu. 

Multiple users are allowed in accounts at the same time. However, selecting an account “locks” the 
account in the same manner as opening an invoice locks the invoice. If an account is locked, a 
message is displayed identifying the other user who is accessing the account. 
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Address  
This panel contains the customer’s name or title, external reference, invoice and statement 
addresses, and associated contact information. The Name field must have information entered to 
create an account. Virtually all the other information is optional. 

Figure 5.1: Address Customer Window 

 

 

Acct # 

The first item in the window is the account number. PrintSmith controls account numbers. The only 
place you might see account numbers without account names is in the Register Tape. You can 
generate a report showing the account number and name using the Customer List command in the 
Reports menu. 

Name 

This field is used to index the account and must be unique. This lets you index customers by their 
last name or for particular departments within a single entity and still show the correct name on the 
invoice. For a customer named Dr. John Smith, you might want to enter the account name as 
“Smith, Dr. John” so it will be easy to find in the account list, but show the address as “Dr. John 
Smith” as that is what Doctor Smith will see on invoices and statements you create with PrintSmith. 
You cannot change the name of account number one; it is always listed as “<<< WALK - IN >>>”. 
You can change the name of any other account at any-time. 

Resize this 
window by 
dragging the 
expander in the 
bottom right 
corner. 
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External Ref # 

The External Ref # is designed to be used as an account ID number for some system outside of 
PrintSmith such as a different accounting system. In practice it is simply a text field into which you 
can put anything you wish. You can search the customer list for a reference number when selecting 
customers. The number can be placed on documents, job tickets, and statements. 

External Accounting ID 

This field supports a future enhancement.  If a third party accounting package is used, enter the 
External Accounting ID.  This will allow synchronization between PrintSmith and the external 
accounting package. 

Invoice Address and Statement Address 

There are two separate addresses for each account: Invoice and Statement. The Invoice Address 
is copied to each document when the account is assigned. Documents can use either or both 
addresses when they are printed. Likewise, either address can be used when printing statements. 

The panel contains four “editor” fields, an address and a contact editor field for the invoice address 
and for the statement information. PrintSmith automatically copies the name when you tab from 
Name to the first line of the invoice address on a new account. 

If the invoice and statement address are identical, simply leave the statement address empty and 
PrintSmith will copy the Invoice address into the Statement address when the account is filed. 

Entering address and contact information is handled by two popup windows, which appear when 
you click in the invoice or statement address fields. 

When you create a new customer account, the information in the contact field is used to 
automatically create contacts assigned to the account. This is the only time you can create contacts 
from the Account window. Changing the contact data in this window also edits the information in 
the contact record. 

Note:  Enter the contact’s E-mail address in this field. One important requirement of our e-
commerce system is that for contacts to be web-enabled (able to use the E-Commerce 
system) they must have a valid e-mail address. 

The Statement Address is the billing address where statements will be mailed. This address 
information could optionally be shown on the invoice or estimate. 

Note:  If the statement address is the same as the invoice address, no further action is 
necessary. When the account is filed, the invoice address is copied to the statement 
address. 
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Contact List 

Once you have entered contact information, a Contact List pop up menu is found under each of the 
contact editor fields. This is used to select the default contact for each of the two types of contacts 
supported (Invoice and Statement). 

The last item in the contact menu in this window is always the Edit command. Selecting this 
command opens the Contact Manager window and displays the default contact for editing. Unless 
you need to modify marketing information for a contact, it is generally much easier to edit default 
contacts from the Customer Account window. Only one contact can be set up in the Accounts 
window, all other contacts must be set up under A/R contacts. 

Default Contacts 

It is possible to create a customer account without an assigned contact. In fact, the “Walk-In” 
account cannot have any contacts. We strongly recommend always creating a contact at the same 
time as you create the account so mailing lists, labels, reports and other marketing activities will 
have contact information. Once a contact has been assigned to an account, the assignment is fairly 
permanent in the sense that there must be an assigned contact. You can change the default 
contact and you can select the same contact for both the invoice and statement contacts. You 
cannot change an account so that it no longer has a contact assigned. The Contact Manager will 
not allow you to delete a default contact. 

 

Finding Accounts by Number 
The name field can also be used to find an account with a particular account number. To do this, 
type “/” or “?” followed by the desired account number and press the <tab> key. If an account with 
that number exists, it is displayed. 
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Credit Control 
The Credit Control panel contains the data used to set credit limits, finance charges, account type 
and account status. 

Figure 5.2: Credit Control Customer Window 

 

 

Credit Limit 

Enter a dollar amount representing the maximum a customer is allowed to charge to their account. 
If it is 0.00, the system credit limit is used (you set the system limit using the Credit Preference 
panel). The system credit limit will display immediately to the right of this field. If there is no default 
limit and the field is empty, Unlimited Credit will display to the right of the field because there is no 
system credit limit. This field will use the default limit unless another number is entered. If the 
preference default is zero then they have no credit limit. 

Due Days from Posting 

Although calculated and tracked, this feature is not fully implemented. Except for the history detail, 
no other direct use is made of the due date. This field is available for use with DownLoader and 
Report Writer. When an invoice is picked up, this field is used to calculate the number of days 
before the payment is due. If a date is not specified here, the Aging Periods Preference panel is 
used to calculate the account status based on the number of days indicated there. Avg. Days To 
Pay shows the customer’s average payment period. The history detail shows the due date on items 
posted. 
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Monthly Finance Charge Percentage 

The Monthly Finance Charge Percentage field is the percentage PrintSmith uses to calculate 
finance charges during statement generation. If zero%, the system default finance charge rate is 
used (defined in the Credit Preference panel). When the default rate is used, it is displayed to the 
right of this number as shown in the previous screen shot. This field will use the default rate unless 
another has been entered or Never Calculate Finance Charges is checked. 

Note:  This is the actual rate used each time you calculate finance charges when generating 
statements. It is not an annual rate. 

Finance Charges YTD 

Records the total amount of finance charges posted to the account in the current year. 

Never Calculate Finance Charges 

Used if you never want to generate a finance charge for this account. This button is only needed 
when there is a system finance charge and you never want to generate a finance charge for this 
particular account. 

Automatic Discount Percent 

Enter a percentage only if you want this customer to always be given a discount or a markup. To 
set up a markup, enter a negative percentage. Discount percentage will provide customers with a 
percentage (%) off each invoice. Additionally, a negative percentage (-%) can add money to each 
invoice created for that customer. 

Current Balance 

The total amount owed to you by this customer including Merchandise Charges. 

Account Status 

Provides a description of the current status of the account as of the last aging (although you can 
change it here on a case by case basis). Frequent reference is made to accounts being 30, 60, or 
90 days past due. There are three aging classifications whose standard values are 30, 60, and 90; 
they can be changed as needed in the Aging Periods Preference panel. 
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Table 5.1: Account Status 
Status Meaning 

  

New When an account is first created and has never been aged, it is considered a new account. 

Current The account is current if all amounts owed are within the allowable limits. 

Past Due The account has open items picked up more that 30 days ago. (Settings for aging are 
variable; your aging may be different.) See Accounting, System Defaults chapter for details. 

Delinquent The account has open items picked up more than 60 days ago. 

Inactive As of the last aging, the customer had not ordered anything within the inactive period 
specified in the “Credit” Preferences panel. The system checks to see if the customer has 
had any activity. Estimates, invoices or payments made will make the customer active. 

Frozen The account aging process can automatically freeze accounts with open items picked up 
more than 90 days ago. Once an account has been frozen, no more invoices can be 
created and no charges can be accepted. An account is normally unfrozen manually or 
automatically during the aging process. 

  

You can choose the account status or let PrintSmith update and maintain the account status. All 
customers will be new when first entered. PrintSmith will update this information when an account 
aging is performed. You will have choices to make in the account aging process. It is 
recommended that the status buttons are left alone as you set up the system. 

 

Account Type 

The account type determines what types of transactions are accepted for this account. 

Table 5.2: Account Type 
Type Meaning 

  

Full Deposit When an invoice is opened or filed with a balance due, a reminder notice is displayed to 
remind the user that this customer must pay in advance. This notice can seem obnoxious 
but serves as a warning to proceed with caution. In addition, cash register transactions 
(POS) must be paid in cash. Deposits can be paid with cash, checks, or credit cards. 

Cash Only Customer must pay with cash. Checks and credit cards are not accepted. Charges are 
not permitted to accounts receivable. 

Cash/Check/Cr
edit Card 

Customer must pay with cash, check, or credit card. They may not make any charges to 
accounts receivable. 

Charge 
Account 

Customer may make charges to their account. There are no restrictions on payment type. 

  

 

When entering a new account, the payment method automatically defaults to Checks. Once your 
customer has undergone your credit process and you have established a credit limit, the account 
can be changed to Charge status with the appropriate credit limit entered. 
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Settings 
The Settings panel contains settings that control or modify how the account is used in the system. 

Figure 5.3: Settings Customer Window 

 
Select Master Account 

The Master Account section is used to assign the account to a master account. Any account can be 
selected as a master account. There are two ways; click the Select Master Account button and 
select the customer account; or, type the account number into the edit field. 

Master accounts are useful for companies with multiple contacts. For example, you might have 
three departments at Xerox that do business with you, but payment comes from Xerox AP. Set up 4 
accounts in this scenario, the 3 departments all will have Xerox AP as the master billing account. 

Sales Rep 

Choose Sales Rep from the popup list. This list comes from the Sales Rep table in the Table Editor. 
This information is copied into the Sales Rep field in the Account Info window in the Estimator when 
the account is assigned to a document. 

Business Type 

Business type is a 4 character field for use in sorting your customer list. The Customer List report 
and Mailing Labels both provide options for sorting by business type. SIC codes work and ABC 
method of ranking are possible ways to sort. 

Name of master 
account would be 
shown here. 

The Import button is 
used to import 
customer information. 

This button creates the 
ImportProspectFormat.txt 
file. 
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Shipping Method (Ship Via) 

This popup list allows you to define the default shipping method for a customer using the same 
table in the Account Info window. Setting a default shipping method automatically defaults that 
method in a document when that customer account is assigned. The prompt on the shipping 
method field is the same as the title of the Table. Changing the table title 

Ship Via will change the prompt. This holds true on invoices as well, so you can use this for 
something entirely different if appropriate for your business. 

PO Required On Invoices 

If customers require a Purchase Order, you will need to check this box. When enabled, a reminder 
notice displays if no PO number has been entered on the invoice. It does not prevent the invoice 
from being created although it cannot be picked up. The notice also displays when an estimate is 
converted to an invoice and each time the document is opened until a PO number is entered. 

Do NOT Generate Statements 

When enabled, the statement generator will ignore the account when generating statements. You 
can still generate a statement for any account by specifically indicating that account. If a statement 
would offend a customer, check the Do NOT Generate Statements option for this customer. This 
option is useful for sub accounts of a master billing account that never responds to a statement. 

Account Is Commissioned 

The Account Is Commissioned option is used with the Report Writer to generate commission 
reports. Other than this function, PrintSmith does not use it. 

Always File Originals 

This setting resides in account set up. The user can change the default when an invoice is created. 

Selecting the Standard Document Preferences 

Some customers may have unique quoting and billing requirements. For these customers, you can 
specify the document preferences to use when creating invoices and estimates. For example, if you 
enter in a negative discount percentage (a markup) you might consider selecting a document 
preference that hides customer discount. 

Default Invoice and Default Estimate 

Select the document preference to use when creating invoices and estimates for this account. 

Tax Table ID 

A two character ID identifies the tax table when you require a different tax rate for a particular 
account. PrintSmith will not let you enter an ID unless there is already a tax table defined for that 
ID. Generally, you will find it much easier to select the desired tax table using the Tax Table menu. 

Tax Table Menu 

This menu provides a quick and easy way to select a defined tax table. Selecting a tax table from 
the menu automatically inserts the correct tax table ID in the field. 
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Tax Code 

Use tax codes to categorize sales tax information for tax reporting purposes. If a particular 
customer must be coded in a particular way, enter the tax code here and PrintSmith copies it to the 
document when this account is assigned to the document. 

Note:  There are no rules or requirements in using tax codes. The only function of a tax code is 
to create a separate line in the tax detail report within the same tax table. 

Resale 

Used to record the customer’s tax exemption ID or license number. Field entries record the tax or 
license number in the account and on documents created for this account. 

Note:  The only way to make an account tax exempt is to use the Tax Exempt button. 
Certificate Expires 

Enter the date the customer’s tax exempt certificate expires, if any. 

Tax Exempt 

When this option enabled, documents created for this account will not have sales tax. 

Security level on this account 

Account level security codes prevent access to employees who otherwise have access to the 
Account History, Customer Accounts, and Post Payments commands. These commands are only 
accessible by users whose access level is equal to or greater than the access level in the account. 

Note:  Accounts can be assigned to documents even if the user’s access code prevents them 
from viewing account history and the customer account. 

Import Prospects 

This function allows you to import a database of customers or prospects based on selected criteria.  

Import Prospect Template 

Creates a file showing the data expected order of data for the Import Prospects function. The 
expected order is: 

“Full Name”, “Street 1”, “Street 2”, “City”, “State”, “Zip”, “Contact Name”, “Phone Number”, “Fax 
Number”, “External Reference Number”, “Sales Rep. or Empty”, “Resale Number or Empty” 
<return> 

The file can use the comma delimited form shown above or a tab delimited form. 

Preset up to 10 charges 

Up to 10 preset charges can be applied to accounts for Invoices and Estimates and another 10 for 
Jobs.  Clicking the Add Charges button opens the Charge Selector window, where charges can be 
selected.  The number of charges added is displayed in the button. 

Notes:  Preset Charges can be viewed by clicking the Charges button. The Charge Select window 
opens. Charges can be added and removed from this window following the same 
processes as in previous versions of PrintSmith.  Invoice level charges cannot be hidden. 
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Sales Info 
The Sales Info panel contains sales statistics. Use this panel to change the sales representative 
(this can also be done in the Settings panel) and to perform an instant aging of the account. 

Figure 5.4: Sales Info Customer Window 

 

Account Aging 

Shows the account balances as of the last aging. These balances can be updated at any time by 
clicking the Age Now button. 

Account Status 

Show the current status of the account.  PrintSmith, as part of the aging or statement generation 
process, usually sets this automatically. This can be manually changed in the Credit Control panel. 

POS Charges 

The outstanding balance of Cash Register department transactions charged to the account. Use 
the Post POS Charges command from the POS menu to convert this balance into an open item. 

Current Balance 

The total amount owed to you by this customer. It also includes Merchandise Charges or POS 
Charges. 

Age Now 

Click this button to perform an instant aging of the account using the current date as the aging base 
date.  

Shows the 
relation between 
aging categories 
as of the last 
aging. 
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Sales Ranking 

The standing of this account’s sales volume in relation to other accounts the last time the Sales 
Ranking by Year report was run and saved. View the Customer List Report from the Reports menu. 

Sales Rep. 

This information is repeated in the Settings panel. This information is copied into the Sales Rep. 
field in the Account Info window in the Estimator when the account is assigned to a document. 

Sales Statistics 

Sales statistics include invoices picked up for this customer that do not include tax. 

Table 5.3: Sales Statistic 
Statistic Meaning 

  

Sales Total sales volume for this account in the current month, current year and prior year. 

# Orders The number of invoices for this account in the current month, current year, and prior year. 

Average 
Order 

The average amount of all invoices in this account in the current month, current year, and 
prior year. 

Quotes: 
Orders 

The ratio of estimates to orders. This helps to identify accounts for which you are continually 
entering estimates but rarely getting jobs. The number of estimates may not be exact. 
PrintSmith counts an estimate only when you are filing a new estimate. If the account is in 
use in another window or WorkStation, it won’t be counted. Changing the account on an 
existing estimate isn’t included either. 

  

Created 

The date the account was entered into PrintSmith. 

Total Orders 

Total number of orders for the account. 

Last Billed 

The date a statement was last generated for the account. 

Last Payment 

The date the last payment was received for the account and entered via the Post Payments 
command. 

Last Aged 

The date the account was last aged. 

Last Invoice 

The date the last invoice was created. 

Last Estimate 

The date the last estimate was created. 

First Invoice 

The date the first invoice was created. 
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First Estimate 

The date the first estimate was created. 

Estimates Won/Lost 

PrintSmith tracks this ratio automatically. Estimate History explains how estimates are won / lost. 
This information is recorded in the Sales Info panel of the Account or Prospect. It is stored in this 
area so you can restrict access to those who can view that information. 

This ratio is never reset by PrintSmith; however, you can change it yourself whenever appropriate 
on a case by case basis if you are a member of the System Admin security group. To change the 
ratio, enter the number of wins, a colon (:), and the number of losses. You can use the won/lost 
ratio with Report Writer to generate an automatic daily/ weekly/monthly success report. 

Log 
The Log panel provides access to the customer contact log.  

Figure 5.5: Log Customer Window 

 

Entering comments also records the date, time, user name, and comments in a log for the account. 
It can be used for anything you wish. Add a new entry by typing the text and clicking the Add 
button. Delete an existing entry by clicking on the entry and then clicking the Delete button. Log 
entries are automatically made when text is entered in the Notify Customer window, which resides 
within the Pending Document Window. These entries also contain the text Notified.  To print the 
customer’s log, click the Print Log button. 

Note:  Only the last 500 entries per customer account are shown in the log. 
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Notes 
Used for notes that will appear based on different functions. 

Figure 5.6: Notes Customer Window 

 

Account Selection Notice 

Notes, for specific customers, will be displayed when the customer account is selected while 
creating an estimate or invoice. Additionally, these notes can be placed on the invoice or estimate. 

This text block serves two purposes: 

• Notify the user of something special about the account whenever the account is assigned to a 
document. 

• Place these notes in the special instruction field of a document 

When you copy a document for an account or assign an account to a document, a window opens 
displaying this notice and asks if you wish the text copied in to the Special Instructions field. 

Note:  There is a limit of 2,000 characters in this text block. 
 

Notes To Insert In Each Job 

Any text in this text block is automatically copied to job ticket notes whenever a new job is created 
in a document to which the account is assigned. It is not copied to job ticket notes for existing jobs 
so assigning the account to a document that already has jobs will not insert this text in the job ticket 
notes of those jobs. 

Notes to insert in each job will be printed on all job tickets for this customer only. You can use these 
notes for accounts whose jobs are always handled in a certain way. For example, you might have a 
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customer for whom you won’t start production unless a proof has been signed, or to whom you 
always return the artwork. You can make note of this here and 

PrintSmith will automatically put this in job ticket notes, which are printed on the job ticket. 

Notice To Place On Statements 

The text in this block is placed on statements generated for this account (unless this feature is 
disabled in the Statement Generator). 

You can use this to customize collection notices for an account or to remind them of upcoming 
repeat orders. 

Notes to place on statements are one of three custom notes that can appear on statements. This 
note is specific to the customer account and appears ONLY on this account’s statement. 

Note:  These notes are all designed for small blocks of text for the specific purpose described. 
They should not be used for lengthy messages or as a record keeping repository – use 
the contact log for that. The maximum practical amount of any text block is 2,000 
characters. 

 

Marketing 
This window records all kinds of useful marketing information. 

Figure 5.7: Marketing Customer Window 

 
 

The Customer and Prospect buttons are used to control whether the account is a prospect or 
customer account. If a customer cannot be changed to a prospect, the buttons are disabled. 
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The rules governing this are as follows: 

• Account has a balance or an open item in history. 

• Account has Pending Invoices. 

• Account is a Master Account or a Sub-account. (Note: this relationship only works with 
customers). 

Personal Account 

The Personal Account option should be used to mark accounts that are a person rather than a 
company. 

For example, if you have an account for "Tom Jones" and Mr. Jones prints Christmas cards and 
personal stationery, the account should be a personal account. An account for a Dr. Jones would 
usually not be marked as a personal account as the relationship is probably a business to business 
relationship. This setting is used by the mailing label command to segregate personal accounts for 
targeted mailings. It is also available in the Report Writer. 

Do Not Mail 

This button is used by the Mailing Labels command. Enabling this feature removes the account 
from labels or mail merge files generated with the Mailing Labels command. This button may also 
be used with the Report Writer to control output. The rest of the information is data that you can 
use to design a marketing campaign in any way you see fit. This window, together with the Report 
Writer can generate some powerful reports. 

Number of Employees 

Enter the number of employees in the company. This is useful for targeting companies based on 
their size. 

Annual Revenue 

Enter the annual amount of revenue of the account or your annual budget target expected from 
them. This can help target companies based on their revenue stream. 

Business Type 

This information comes from the business type table. The information stored comes from the ID of 
the table element, not the text. This means that you can change the text in the table and 
immediately see this change reflected in all accounts. 

Marketing Dates 

This is a group of five dates that can be used for any customer related purpose. The first date is 
shown as “Follow-up”. This is just a suggested use to give you some ideas as to how it can be 
used. To make best use of the dates, they should be labeled properly. The label for each date is 
stored in the Marketing Date Labels table. 

Marketing Tags 

These ten fields that, like Business Type, store the ID of the associated table. The two Lead Source 
fields both use the same table - Lead Source. The remaining 8 fields each have their own 
dedicated table whose name matches the prompt on the field.  
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Rebuilding the Customer Index 
The customer account list can be rebuilt by holding down the <option> or <alt> and <shift> keys 
when selecting the Accounts command in the AR menu. You should always do a full back up 
before attempting to rebuild any indices. 

Using the Record Manager 
Each panel has a standard group of buttons to manage customer accounts as follows: 

Figure 5.8: Record Manager 

 

Last - Displays the entry prior to the currently displayed entry in the list. 

Next - Displays the item after the currently displayed item in the list. 

File - Saves any changes you have made to the customer account. After the account is filed, the 
window is set up to create a new account. 

Get - Opens the Account Selection window.  

Delete - Removes the account entry from the list. Prior to actually performing the deletion, 
PrintSmith will ask you to confirm the deletion. PrintSmith will not allow you to delete an account 
with open items, even if the account balance is 0. It will permit deleting accounts with pending 
documents, but you will not be able to pick up those invoices. A deleted account can be restored as 
long as you can open a document that was assigned to this account before it was deleted.  

Cancel - Clears any changes you have made to the account definition. On a new account, clears 
the entire entry. 

Close - Closes the Account window. 
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Finding Customers 
When the scrolling list is highlighted, anything you type is used to perform an instant alphabetical 
name search.  

Figure 5.9: Find in Account Picker window 

 

 

Example: To select KC Media, it is only necessary to type the letter “K”, and press the <return> 
key.  

To perform a search, select the data for which you want to search from the drop tab at the bottom 
of the window (either Name, Acct #, Ref #, Phone, or Master Billing), type the data you want to 
search for, and click the Find button.  

With the Search all accounts option selected, if the account is not found in the customer list, the 
prospect list will be searched. 

To find the next occurrence, press the Find button again. To find the previous occurrence, hold 
down <shift> and click the Find button. After each find, the item is selected and the Select button is 
highlighted.  

To open the item, click the Select button, double-click on the item, or press the <return> key.  

Note:  Find searches the selected list: Customers, Prospects, or Contacts.  
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Contacts 
This is a command used for managing contacts. Although default contact information can be 
effectively managed via the Customer Account command, you may wish to specify marketing 
information for default contacts or create additional contacts, perhaps with different addresses. 
Select Contacts from the AR menu.  

Address 
The Address panel is the main data entry area for all contact information. 

Figure 5.10: Address Contact Window 

 

ID# 

The ID Number is a unique identifier for the contact record. PrintSmith automatically assigns this 
number when the contact is created. 

Name 

The contact name is used to place the contact in alphabetical order in the contact list and to show 
the contact in the Contact List pop up menus. It is always derived from the last name and first name 
of the contact. You can change this name if you wish, but this is not generally recommended 
because if you change any of the contact data in the Contact Editor, the text in the Name field will 
be replaced by the last and first name of the contact. 
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Acct# 

The Account Number field is the customer account to which a contact is assigned. 

Account 

The Account field shows the name of the account to which the contact is assigned. Below the 
account name the status of the contact is displayed. If nothing is displayed, the contact is assigned 
to a customer but excluding the shipping and billing contact. It may also show <shipping contact>, 
<billing contact>, or <default contact>. “Default Contact” means that the contact serves as both the 
shipping and billing contact. If the contact is not yet assigned to a customer or prospect, it will show 
“--- not assigned---”. It is also possible that you may see “--MISSING CUSTOMER ACCOUNT ---” if 
the account to which the contact is assigned to was deleted. Contacts not assigned to accounts 
can’t be used in the Estimator. 

Sales Rep 

The Sales Rep field is the sales representative assigned to the contact. It is useful for report 
generation. This will override the sales rep assigned to the account. 

Created 

This is the date that the contact record was initially created. 

Last Used 

This is the date the contact was last used in the Estimator. 

Change Account 

This button is disabled when a default account is selected. PrintSmith always tries to ensure that 
each account has at least one contact, so that marketing activities that are centered on contacts 
don’t inadvertently leave out accounts because there is no contact. 

There is only one way to change a default contact assignment and that is by using the Customer 
Account command and selecting a different contact using the contact menu. Normally, when an 
account is created, the default contact is created at the same time. 

Use Contact Address 

When enabled, an address editor field becomes available where you can enter an address that is 
specific to this contact. If you select a contact with a separately defined address in the Estimator, 
the contact address is used instead of the account address. 

Default contacts always use the account address, even if you have set them up with a separate 
address. 

Shipping Address 

You can create up to 100 shipping addresses for each contact. When an invoice is created and a 
Contact is selected, all of that Contact’s shipping addresses are available in a pop up menu in 
shipping charges. 

To organize the Shipping Address list, simply drag and drop the items into the order you want. The 
buttons located below the Shipping Address list are used for controlling the content of the address 
list. 
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Marketing 
This panel is similar to the marketing panel in accounts; however this panel is for a contact. 

Figure 5.11: Marketing Contact Window 

 
You can use the information in this panel to design a marketing campaign. This panel, together with 
Report Writer can generate some powerful reports. 

Personal Account 

This button should be used to mark accounts, which are a person rather than a company. For 
example, if you have an account for “Tom Jones” and Mr. Jones prints Christmas cards and 
personal stationery, the account should be a personal account. An account for a Dr. Jones would 
usually not be marked as a personal account as the relationship is probably a business to business 
relationship. This setting is used by the mailing label command to segregate personal accounts for 
targeted mailings. It is also available in Report Writer. 

Do Not Mail 

This button is used by the Mailing Labels command. Enabling this button removes the account from 
labels or mail merge files generated with the Mailing Labels command. This button may also be 
used with the Report Writer to control output. 

Marketing Dates 

This is a group of five dates that can be used for any purpose. The first date, “Follow-up,” is just a 
suggested use to give you an idea as to how it can be used. To make best use of the dates, they 
should be labeled properly. The labels for each date are stored in the Marketing Date Labels table. 
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Marketing Tags 

These are ten fields that, like Business Type, store the ID of the associated table. Each of the ten 
fields has its own pull down menu for you to make or edit a selection. The two Lead Source fields 
both use the same table - Lead Source. The remaining 8 fields each have their own dedicated table 
whose name matches the prompt on the field. 

Campaigns 
Use the Campaigns tab to assign individual contacts to advertising campaigns that you have 
created.  Campaigns can be assigned individually, or a group of campaigns, called a grade, can be 
assigned to the contact. 

Figure 5.12:  Campaigns Contact window 

 
Note:   If a grade of campaigns is applied, individual campaigns within the grade can be removed 

by unselecting the Apply option.  This will not modify the grade, just the campaign 
selections for the contact. 

• To apply a campaign:  Click in the Apply column to the left of the campaign. 

• To apply a grade:  Click the Apply Grade button.  In the window that opens, highlight the 
grade and click the Select button.  The Apply checkmark will appear to the left of all campaigns 
included in the grade. 

• To view or edit campaigns and grades:  Click the Edit Campaigns button.  The Campaigns 
window opens. 

Note: For additional information on creating mailer campaigns, see page 395. 
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Credit Info 
Credit card information that is entered for a contact is retained for future use in a secure encrypted 
manner. Credit card numbers can be entered into this panel manually or by being swiped while this 
panel is open. Major credit cards are validated for card number length. When the payment type is 
Cash/Check/Credit Card, by default, the entered credit card information is used when posting 
payments to the account. 

Figure 5.13:  Credit Info Contact window 

 

Web 
This panel is available for the optional PrintSmith Site e-commerce product. The information in this 
window is used to manage your contact’s e-commerce account. 

Figure 5.14:  Web Contact window 
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Adding Contacts to Accounts 
Here are 3 ways to add contacts to any accounts. 

• While creating a document (invoice or estimate) - select the Account, while in the Account Info 
window - select New from the File menu or use the shortcut of Command N (Mac) Control N 
(windows) - when you execute this command you'll notice that most of the information in the 
Edit Contact window has been cleared - the phone numbers stay and are easy to modify. Add 
the contact information and close the window. The contact list now shows **NEW 
CONTACT***. Clicking the OK button will create a contact and add it to the account. Create a 
document, enter the information and then select Create Acct/Prospect under the Invoice menu 
to create a new account and new contact. 

• Select Accounts from the AR menu. Click on Cancel in the account picker. Enter in the 
Account and Default Contact information. File the account. If you want to add additional 
contacts to this account, click on Get, locate the Account and then select the Edit command in 
the Contact list. Then click on File and you are ready to enter new contact information that will 
be associated to the selected Account. 

• Select Contacts under the AR menu. Click on Cancel in the contact picker. Enter in the 
Contact information and click on Change account to assign the contact to the appropriate 
account. File the contact. 

Post Payments 
The Post Payments command is used to enter payments to Accounts Receivable. Payments 
entered using this command are treated as Accounts Receivable receipts. Payments entered in the 
Cash Register are treated as Point Of Sale (POS) receipts. 

Figure 5.15: Post Payments Window 
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The window can be adjusted by changing it is size and changing the column widths in the open 
item list. When the window is closed it remembers those positions. 

• Holding down the <shift> key when selecting an item allows selection of a continuous block of 
items. 

• Holding down the <option> or <alt> key when double clicking an item opens the History Detail 
window. 

Searching by Invoice Number 
You can select an invoice by number in the Post Payments window by typing the invoice number. If 
no payment method is selected, just start typing the invoice number. Otherwise, to clear any 
selected fields, click once on the list footer before typing the invoice number. 

When the invoice number is found, the invoice is selected and you can apply payment to that or 
other invoices. Entering multiple numbers this way will add to the selected items. This is helpful for 
accounts with many open invoices. 

Customer Acct 
There are a number of similarities in the appearance of the Cash Register window and the Post 
Payments window. The top part of the window is used to display information about the selected 
customer account. When you press the Cust Acct button, the customer account selection window is 
opened so you can select the account for the payment. Post Payments will not accept a payment 
unless a customer account has been selected.  

Note:  The selected account is locked, preventing anyone else from processing transactions 
against the account until the Post Payments window is closed or another account is 
selected. It is better to use the Account History report to view open items and payment 
history because the Account History command does not lock the customer record. 

Open Item List 
Once an account has been selected, PrintSmith displays the open items for the account in the 
scroll box below the customer account display. This list contains all open items with outstanding 
balances. It can differ significantly from the list displayed in Account History as the account history 
shows all transactions starting from the first open item and may include items that have already 
been paid. Post Payments only shows items with outstanding balances. 

Each open item displays the invoice number, posting date, PO number, invoice title and balance 
due. Payments on account and credit memos are shown with a negative amount due in red. A 
fourth column, “Pay”, is used to determine how much of the payment is applied to a particular item. 
PrintSmith will normally set the payment amount automatically. However, you can change this 
amount to an amount less than that actually due if you want to.  

Double-click on an open item to display the history detail window, which contains information about 
prior partial payments and other useful information. If the selected customer account is a master 
account and any of the sub-accounts have open items, the open item list will show each sub-
account after all the open items for the master account are shown. Within the list for each sub-
account, the open items are in chronological order.  
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Print Invoice 
With his option selected a zero balance invoice is printed automatically when the payment is 
applied.  The Format for the invoice can be selected from the dropdown list. 

Payment Method 
You must select a payment method in order to enter payments. When you enter a payment amount 
and press <tab>, PrintSmith automatically distributes the payments to all of the selected items. The 
supported payment types are: 

Table 5.4: Payment Methods 
Method Definition 

  

Cash For payments in cash. 

Check Requires a check number in addition to the amount. 

Credit Card In addition to an optional reference number, credit card payments can be one of 10 credit 
cards. The credit card list is controlled via the Credit Card Info Preference panel. 

Draft Payments made via direct bank transfers. The optional reference number can be used to 
identify the payment on a bank statement. 

  

 

If you change the amount of the payment, the payment distribution also changes to match the new 
amount. If there are open credits in the account (credit memos and payments left “on account”) you 
should select them before selecting any invoices or debit memos so they can be automatically 
applied to the invoices you select. You can reset the payment applied to an open debit item by 
clicking it off and then on. 

Remainder 
The Remainder menu tells PrintSmith what you want to do with any amount shown in the 
Remainder field. This is the amount not specifically applied to open items. After each transaction is 
posted, the Remainder menu is reset to “on account”. The Cash Register tape shows the amount 
returned in the transaction header line in parentheses “(Refund CASH: 2.57)”. This is the amount 
taken from cash in the cash drawer.  
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Transaction Summary 
The current transaction summary is displayed in the lower-right section of the window. When you 
enter a payment amount or select an open item, these totals are updated so you always see the 
effect of the item on the total transaction before you do it. The amounts and their usage are as 
follow:  

Table 5.5: Transaction Summary Amounts 
Amount Definition 

  

Balance Shows the account balance before posting the transaction. 

Total Due The total of all selected debit items (invoices, debit memos). 

Tendered Shows the payment amount plus any select credits. 

Remainder Total Due minus Tender. The amount of the payment that is not being applied to open 
invoices. This must always be a positive number or PrintSmith will not accept the 
transaction. See the description of the Apply Remainder button that follows. 

New Bal The customer account balance after posting the transaction is paid blank. You can 
change the amount to be applied to any open item by clicking in the Pay column and 
entering in a different amount. 

  

 

Post 
The Post button actually posts the transaction. 

Auto Apply 
Auto Apply is used when you want PrintSmith to figure out how to apply the payment. To use it, you 
enter the payment amount and click the button. PrintSmith selects all open payments and credit 
memos and starts with the oldest open item and pays it in its entirety (if possible) and continues on 
down the list until it runs out of money. Nothing actually gets posted at this point, so you can make 
as many changes as you want to the transaction after clicking Auto Apply. 

Calculate Payment 
A Calculate Payment button has been added to the Post Payments window. This makes tabulating 
due amounts when paying off multiple invoices much easier. To calculate payment, select the 
multiple items. Click the Calculate Payment button. The total due and the new balance for the 
selected items show in the payment totals box. If a payment method is selected, the payment 
amount is reflected here. 

Close 
The Close button cancels any pending transaction and closes the Post Payments window. 
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Using Post Payments 
The most efficient way to use Post Payments is also the simplest. The steps are: 

1. Select the account to which the payment will be posted. 

2. Select the payment method. Enter the payment amount. 

3. Click the items to be paid. If you wish to enter a specific partial payment, click the pay 
amount for that item and enter the partial payment amount. 

4. Click the Post button. 

If you enter the payment amount after you have selected the items to be paid, PrintSmith will adjust 
the payment amounts for all of the selected items to attempt to apply the entire payment amount. 

PrintSmith automatically applies any remaining unapplied amount to the selection. When it runs out 
of money to apply, selecting another item highlights it but leaves the amount to apply as zero. 

When you post a payment transaction, the debits and credit are applied in order. You control the 
amount of each payment, but not the order in which it is applied. Open credits selected for payment 
are applied to open debits (invoices) until all open credits are fully applied, then the new payment is 
applied.  

Note:  When payments are applied to the account instead of an open item, the payment is 
treated as a receipt, but will not be included in taxable receipts until it has actually been 
applied to an invoice or other open debit item. 

Partial Payments 
You can apply the part of a payment placed on account to an open invoice at a later date either by 
itself or as part of a different payment. Applying an “on account” credit to an open item changes the 
“on account” amount into a taxable receipt. You should be aware of this when you examine the 
daily sales analysis as this could possibly result in taxable receipts being greater than total receipts 
for a particular day. 

Handling Credit Card Payments 
When the Credit Card payment method is selected a credit card menu appears in the payment area 
right above the “Ref #” field. You can ignore the menu and a “generic” credit card transaction is 
created or you can select the desired credit card from the menu using the mouse. Alternatively, you 
can select the credit card from the keyboard by typing the credit card Code. If you look at the credit 
card menu you will note after each card’s name there are two characters in brackets. For example, 
after Visa, the bracketed text is “VI”. This is the credit card code for Visa. If you type “VI” in the “Ref 
#” field followed by the authorization number for the transaction (VI12345), PrintSmith selects the 
Visa credit card and sets the “Ref ” field to “12345”. Often this is faster than making a menu 
selection.  

Note:  The codes are assigned to each credit card via the Credit Card Info Preference panel. 
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Handling Master Account Payments 
In the Accounts command, Settings panel, you set up the account that will become a sub-account, 
and select the customer account to which it reports. Any account referenced by another account in 
this way is a Master Account. If you select a Master Account when posting payments, all the sub-
accounts will display. It is important to note that all sub-accounts as well as the master account are 
locked as long as the master account is selected in Post Payments. From time to time another user 
or another window in your computer will lock more of the sub-accounts. Rather than wait until all 
the sub-accounts are free, the list is modified to show that some of the items are not available. 

You can work with all of the other accounts to post payments and so on, but you cannot select any 
of the items under the sub-account in use somewhere else. If the other user releases the account, 
Post Payments will “grab” the account and lock it. When the account is locked it becomes available 
for posting and the display updates to show it. 

The other important issue to understand is the accounting that PrintSmith uses to handle payments 
across multiple accounts. If there are sub-accounts with open items (sub-accounts with no open 
items are not shown) and four items are an open credit on the master account itself, clicking the 
Auto Apply button in PrintSmith sets up a payment, which pays the highlighted reference numbers.   

The last three entries on this tape are what make master accounts work. Whenever a payment or 
credit transfer goes from one account to another, a TRANSFER takes place that moves just 
enough credit to handle the payment or refund. A transfer history entry is made in both account 
histories so there is a clear audit trail showing credits leaving one account en route to another and 
credits arriving in an account from another account. 
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Handling Refunds 
The Remainder menu contains the possible ways in which the remainder is handled. After each 
transaction is posted, the Remainder menu resets to “on account”. 

Table 5.6: Refund Types 
Type Definition 

  

On Account This is not a refund. Any overpayment is posted to the account as an un-applied credit. It 
will appear in the payment list after posting the transaction. In prior versions, this is the 
same as turning on the Apply Remainder button. 

Return Cash A cash refund is subtracted from the cash total of the PrintSmith Cash Drawer. 

Write Check Probably the most common type of refund is writing a check on a business checking 
account. Since PrintSmith does not handle this part of your business, it records only half the 
transaction. It adds the refunded amount to the account balance and the AR Balance but 
does not record a negative receipt. Instead, a special, Refund Check is shown during daily 
closeout and printed on the Deposit Ticket. There is a Refund Check category in the Daily 
Sales Report to showing the total amount of refund checks in the period. 

Credit Card 
Refund 

A credit card refund is typically only given on a credit card payment. However, PrintSmith 
does not enforce this. Issuing a credit card refund is the same as accepting a credit card 
payment in terms of accounting except it is a negative amount: it is added to the cash 
drawer credit card category and appears as a separate item in daily closeouts. The 
remaining items on the refund menu are credit card refunds for a specific card. Its content 
depends on which credit cards are set up in the Credit Card Info Preference panel.  

  

 

The following is a group of recommendations for handling certain accounting situations. 

Issuing a Refund for Overpayment 
Problem: You have received a check from a customer that pays a group of invoices, one of which 
has already been paid. You have agreed to send the customer a refund check. 

Solution: 

1. In Post Payments, enter the check as written. 

2. Select the items that are to be paid. 

3. Select the Write Check option in the Remainder menu. This refunds the amount of the 
overpayment via a check, which you must write later. 

4. Click the Post button. 

You can leave the overpayment on account and apply it to later sales if your customer permits, this 
is the recommended method as no special action is required. 
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Issuing a Refund on a Paid Invoice 
Problem: You receive a complaint from a customer about an order and agree to refund part or all of 
the order by sending them a business check. The order has already been paid. 

Solution: 

1. In Journal Entry, click Select Invoice and enter the number of the invoice you are 
refunding. 

2. Type an appropriate description and click the Post button to create a credit memo, 
which will be used to perform the refund. 

3. In Post Payments, select the credit memo, which was created in the previous step. 

4. Change the Remainder to Write Check and click the Post button. 

 

Post Payment Tips 
A common mistake when first getting started with PrintSmith is to enter payments without applying 
them to anything. While this is acceptable, it has some undesirable side effects: 

• The receipt is considered “on account” and is not included as a taxable cash receipt. 

• Invoices you intended to pay are still shown as open and may cause the account to become 
past due when it really is not. 

• Customers may not understand statements showing invoices they believe are paid. 

• The open payment list can get crowded making it more difficult to find the correct item to pay. 

If you have both credits and debits in the open item list, apply the credits (a negative amount) by 
selecting the credits first, then the debits. You can also use the Auto Apply button and click the 
Post button to let PrintSmith clean it up automatically. 

If you have entered the payment and selected the items you wish to pay, and the Post button is 
grayed out and cannot be selected, check the Remainder. If it is negative, you have over applied 
the available payments. Try clicking selected debit items off and then on so PrintSmith can adjust 
the Pay amounts for you or click on the payment amounts and type in the amount to be paid. 
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Keyboard Shortcuts 
Use the keyboard to select the Customer Account or Payment Method in the same manner as in 
the POS module. These shortcuts only work when there are no text boxes for data entry open in 
the window. 

Table 5.7: Post Payment Shortcuts 
Shortcut Action Performed 

  

C Cust Acct button selects a customer account. 

= Cash button - the payment is in cash. 

/ Check button - the payment is by check. A check number is required. 

* CR Card button - the payment is by credit card. An additional field for entering the credit 
card validation number is available, but is optional. 

+ Draft - the payment is by bank transfer. 
  

 

The best ways to use keyboard shortcuts is to first select the customer account, and then select the 
payment method. 

 

Closeout 
The Closeout command is used to summarize a day’s sales and estimating activity. You should 
perform a Closeout each day just before going to the bank. If for some reason you do not make a 
bank deposit, do not perform a closeout. This gives you a very good audit trail and will tend to catch 
most, if not all, accounting errors quickly. If you choose not to synchronize closeouts with bank 
deposits, perform a closeout at least once a week and on the last day of the month.  

PrintSmith generally treats each closeout as one day for accounting purposes. If, for example, you 
perform a closeout on the 25th of the month and another on the 5th of the next month, PrintSmith 
would treat the entire period as a single day with all of the activity being posted to the month in 
which the closeout was performed. This will distort your sales figures and should be avoided. 

When you first start PrintSmith, it checks the date of the last closeout and will remind you if more 
than one week has gone by since the last closeout. It also notifies you when you enter a new 
month, but have not yet done a closeout in that month. This helps to make sure that a single “day” 
does not span a month end. 

Before the closeout starts, PrintSmith will ask you to verify that you want to close out.  Multiple 
closeouts can occur within one day.  This allows for a shift closeout to occur mid-day, with another 
closeout at the end of the business day, or even on the following day. 
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When the Closeout command is selected, two options are presented: 

• To Append to (earlier) closeout, or 

• To create a New closeout for today (this is the default) 

With this feature, larger shops with multiple shifts can closeout and balance the cash drawer in-
between shifts and at the end of day.  It also allows a closeout for the previous day to be amended, 
if a sale is registered after the close of business. 

Note:   Use this feature with extreme care.  If the Append closeout option is selected, the previous 
day’s numbers are amended, reports must be reprinted, and new accounting link files for 
the new data may need to be created.  This has the potential to duplicate sales figures. 

Figure 5.16:  Closeout window 
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Productivity Data 
After the Register Tape has been closed out, you will be asked for information PrintSmith uses to 
calculate productivity statistics. 

Figure 5.17: Productivity Data Window 

 
 

PrintSmith remembers this information so on subsequent closeout. You only enter changes. This 
information is optional. You do not have to enter any statistics. 

Table 5.8: Productivity Data 
Field Definition 

  

Square Feet In Store Used to calculate sales per square feet. 

Number Of Workers Used to calculate sales per employee. 

Press Hours Worked Used to calculate what your return is for each press hour. 

Other Prod Hours Used to calculate your return for other direct labor hours not associated 
with printing, such as bindery hours. 

All Other Hours All other hours worked which are not press or production hours. This would 
normally include sales and supervisory hours. 

Total Hours Total of press hours, other production hours and all other hours. 
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Balancing the Cash Drawer 
The next step is balancing your cash drawer. PrintSmith uses this information to prepare a deposit 
ticket and check your receipts for discrepancies.  

Figure 5.18: Balance Cash Drawer Window 

 
Note:  Ensure that all the numbers in this window are correct; it is the single most important 

verification procedure you perform in PrintSmith. Never finish a closeout if there are 
unexplained discrepancies in this window. 

Counting Cash 
When you count up your cash on hand, count all the cash. This amount should match Cash In 
Drawer. PrintSmith automatically subtracts the amount in Change Fund from this amount and gives 
you the total cash to deposit in the Cash to Deposit total. This amount is also shown on the right 
side of the window so all the deposit totals are in line.  

One of the most common problems during Closeout is when you have less cash in the drawer than 
is required by the change fund. Closeout cannot continue until this situation is rectified because it 
results in a negative amount in Cash to Deposit.   Here are several ways to fix the problem: 

• Review the register tape to find the problem and correct it. Generally, entering a check, credit 
card, or draft payment that is larger than the actual payment and giving change in cash cause 
this problem. Look for Refund - CASH in transaction header records in the tape. Another cause 
may be returning deposits that were originally posted in a different day. 

• Change the Cash in Drawer amount so it at least equals the Change Fund. Usually, you do not 
want to do this because PrintSmith reports the difference as a cash shortage on the daily sales 
report. 

• Modify the Change Fund so that it is less than the Cash in Drawer. This has the effect of 
changing the Change Fund in all subsequent closeouts. The Deposit Ticket for this closeout 
will also show the modification to the change fund. If you understand how this situation 
occurred and are satisfied that no errors that need to be corrected exist, it is safe to continue. 
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Counting Checks and Drafts 
Checks and drafts are shown in the deposit item list in the same order they were posted. The 
easiest way to handle them is to verify that each item in the list exactly matches an actual check. 
An alternative method is to add up all the checks on hand and compare that total to PrintSmith’s. 

You may also have items on hold or on automatic release. You should pull all the items that are 
currently on hold and put them in a separate pile. 

Handling Refund Checks 
A refund can be issued in Post Payments by writing a check. When a refund check is used, only 
half of the transaction is completed in PrintSmith. The part that adjusts Cash in the General Ledger 
is performed outside of PrintSmith.  

The most important thing to remember about refund checks is that they are simply reminders to you 
that a check must be written outside of PrintSmith to complete the transaction. 

Counting Credit Cards 
Credit cards are slightly different from checks and drafts if you have an electronic card handling 
system. Typically, these systems issue summary reports with transaction counts and totals for each 
type of card. This is very easy to reconcile against PrintSmith’s totals using the credit card 
summary window. For a summary of charges for each credit card, click and hold the button to the 
right of the credit card total. A window displays each type of credit card, the total number and 
amount for all the transactions on that credit card.  

Note:  Credit Card transactions that are on hold are not included in this window. Make sure that 
they are pulled from the deposit items and kept in a separate pile. 

 

Modifying Deposit Items 
Add Check 

Use this window to add a check to the items being deposited. Added checks are placed at the end 
of the list with the word Add in the status column. 

Figure 5.19: Add Check Window 

 
Note:  Checks added in this way appear only on the Deposit Ticket and will almost always result 

in a variance on your daily sales report unless offset by a change in Cash. We strongly 
recommend you fix the transaction that caused the problem rather than adding a check. 
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Table 5.9: Add Check Deposit Items 
Item Definition 

  

Ref# Enter a reference number for the check. 

Amount Enter the amount of the check. 

Date Use this in conjunction with the Automatic Release button to specify a date on which 
you want the check to be deposited. 

Automatically 
Release On Date 

Enabling this button places the check on Auto Hold until the first closeout that occurs 
after Date when it is released automatically. 

  

 

Change Item 

This window allows you to change the reference number or amount on a deposit item. It also allows 
you to place a deposit item on hold with an automatic release data.  

Figure 5.20: Change Item Window 

 
Note:  Changing the amount on deposit items this way changes only the Deposit Ticket and will 

almost always result in a variance on your daily sales report unless offset by a change in 
Cash. We strongly recommend you fix the transaction that caused the problem rather than 
changing the amount on an item. 

Table 5.10: Change Deposit Items 
Item Definition 

  

Ref# Use this to change the reference number of the item. Changing the reference number 
here only changes how the check is shown in the Deposit Ticket. This is not 
recommended as it may confuse the audit trail. 

Amount Use this to change the amount of the item. 

Date Use this in conjunction with the Automatic Release button to specify a date on which 
you want the check to be deposited. 

Automatically 
Release On Date 

Enabling this button places the check on Auto Hold and it will be released on the first 
closeout that occurs after Date. 

  

 

Hold/Release Check 

Places the selected item on hold or releases the selected item so it will be included in the deposit. 
Items on hold are displayed with Hold in the Status column. They are not included in the deposit 
total on the deposit ticket. On subsequent closeouts, they appear as Items on Hold. 
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Handling Discrepancies 
If there are any discrepancies, it is important you identify them and fix the problem before 
completing the closeout. Click the Cancel button to cancel the closeout.  

Note:  One of the most important elements in maintaining an error free accounting system is 
verifying the Closeout does not contain any discrepancies. Fixing errors before completing 
a Closeout is essential.  

These are the situations to watch out for: 

• The Amount on a Deposit Item Differs from the Amount in PrintSmith - This situation 
should always be fixed. Find the transaction on the Register Tape and Void it. Then enter the 
transaction again with the correct amount. Although you can modify the reference number or 
amount of any transaction, this should be avoided because it almost always introduces errors 
in your accounting. 

• Payment Type Totals Do Not Match - If the total of all payment types in PrintSmith matches 
all of the payments in the Cash Drawer, the problem is most likely that payments of the wrong 
type were entered. For example, if Cash is over by $100 and Checks is under by $100 then a 
payment was probably entered as Cash when it should have been a Check. To fix this problem 
you must identify the faulty payment, void it, and re-enter it with the correct type of payment. 
We strongly recommend you always fix this to maintain a strong audit trail in the event of a 
customer inquiry. Another possibility is that a payment was made that should not have been. 
The remaining items show you how to identify and correct these problems. 

• Extra Check, Credit Card, or Draft in Hand - You probably forgot to post a payment in 
PrintSmith. It might also be a deposit on an invoice that was not entered. If one of the other 
payment types is too high, a payment or deposit might have been entered with the wrong 
payment type. Look for a transaction with a different payment type that matches the amount on 
the check or draft. Void the transaction and re-enter it with the correct payment information. If it 
is a deposit, open the affected invoice, change the type of the deposit and file the document. 

• Extra Check or Draft in PrintSmith - If all the other payment type totals are correct, a 
payment was made that should not have been. The data in the deposit item list will help to 
identify the erroneous transaction. Most of the time, this is a pickup or POS charge that was 
paid for in PrintSmith when it should have been charged to the customer’s account. The 
transaction should be voided. If it should have been charged to the customer account, enter it 
again and charge it to Accounts Receivable. 

• Cash in Hand Is Too High - Unless this is your first closeout and beginning cash has not 
been entered in Change Fund, you probably forgot to enter a payment or a deposit. 

• Cash in Hand Is Too Low - If cash or credit cards are OK, you probably entered a cash 
payment in POS that should have been a charge, or entered a cash deposit when there was 
not one. Another possibility is that you entered the wrong payment amount. If cash or credit 
cards do not match, find any mistakes first. If cash is still off, find the mistakes in entering cash 
transactions. 

• Cash In Drawer Is Negative Or Less Than Change Fund - Returning a deposit almost 
always causes this problem. If you return a deposit made with a check that was posted in a 
previous day, the check will no longer be in the cash drawer. When this happens, PrintSmith 
issues cash refund because it no longer has the check to return to the customer. Often you will 
have issued a business check for the refund and this is the cause of the discrepancy. 
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This can also happen if you enter a check or credit card in Post Payments for more than the total 
selected for payment and you turn off the Apply Remainder button. When this happens, PrintSmith 
issues cash refund to the customer instead of putting the remainder as a credit on the account. If 
this was a mistake, void the transaction and post it again.  

Note:  You cannot finish a Closeout if the Change Fund is larger than Cash in Drawer. Since the 
Change Fund is the amount of cash held out of the deposit it makes sense that you 
cannot keep more in the drawer than you actually have. One way or another you have to 
make sure the change fund does not exceed cash in the drawer. 

One solution is to change Cash in Drawer so that it matches the amount of cash you actually have 
in the drawer. This will result in a variance in your sales summary for the day. If you have verified 
that the discrepancy was caused by a cash refund that you actually issued with a business check 
this is the correct procedure to follow – make a manual notation on the daily sales report for audit 
purposes and identify the check number used to issue the refund. If the total receipts you enter 
differs from the total on the tape PrintSmith will record that difference as a variance. The amounts 
shown on the daily sales summary do not change as a result of changes you make here. However, 
the deposit ticket amounts will change. 

 

Correcting Mistakes 
If you find any data entry errors before you finish a closeout it is extremely easy to fix. 

1. Cancel the closeout. 

2. Select Open Tape in the POS menu. 

3. Find the erroneous transaction on the tape and click on it. 

4. Click the Void Transaction button. 

5. Re-enter the transaction correctly if necessary. 

After a closeout has been finished, transactions for that day are locked and you must use Journal 
Entries to make any adjustments. 

Note: You should always void the most recent transactions first. 
 

Finishing Cash Drawer Balance 
When you have finished counting out the cash drawer and making changes, click the OK button to 
continue the closeout, click the Cancel button to cancel the entire closeout. If there are unexplained 
discrepancies it is usually advisable to Cancel the closeout and find the problem. You should be 
able to answer yes to each of these questions before continuing: 

• Do the credit card receipts in hand match those shown in PrintSmith? 

• Does the amount of cash in the drawer match that shown in PrintSmith? 

• Is there a matching check in hand for each check listed in Checks on Tape? 

• Is the amount in Change Fund less than the amount in Cash in Drawer? 
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Setting the Change Fund for the First Time 

On your first closeout the amount in Cash in Drawer will be too low by the amount that you put in 
the drawer to start the day. Count all the cash in the drawer and enter this amount in Cash in 
Drawer, then enter the amount that you started with at the beginning of the day in Change Fund. If 
you start with $60.00 then the amount in Cash in Drawer will be $60.00 short. Increase Cash in 
Drawer so that it matches what you actually have. Enter 60 in Change Fund to indicate that you are 
leaving $60.00 in the cash drawer. Your sales report for this day should indicate that you were 
$60.00 over and from this day forward, PrintSmith will remember that you leave $60.00 in the 
drawer. 

Finishing Closeout 
At this point, PrintSmith has compiled all of the statistics for the day’s closeout, but has not saved 
any of it. Before proceeding, the day’s sales summary is displayed so you can review it before you 
actually do the closeout. 

If the total of cash, checks and credit cards does not match what is on the Register Tape, 
PrintSmith will record the difference as Cash Over/(Short). Large discrepancies should be tracked 
down before completing the closeout. The Register tape is the primary source of data for the close 
out. It can be reviewed or printed using the Open Tape command in the POS menu. Should you 
find there was a mistake in one of the transactions made during the day, void the transaction and 
re-enter it before completing the closeout. 

When you have finished reviewing this report, close the window or press <return>. The final 
window shows the reports available with the reports you chose during the last closeout selected. 

Figure 5.21: Closeout Report Window 
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This is your last chance to cancel the closeout – if there are any unexplained discrepancies you 
should not click the Finish Closeout button. The Finish Closeout button saves the information and 
prepares the reports you selected from the list shown on the right. You should retain these reports 
for future reference. The Trial Closeout button generates the reports without finishing the closeout. 
Use this button if you need the reports to track down a problem. The following reports are available 
for each closeout. 

Table 5.11: Closeout Reports 
Reports Description 

  

Register Tape Contains a detailed description of each financial transaction. 

Deposit Ticket Can be transcribed to the deposit ticket you will be using at the bank. 

Sales Summary Similar to the sales summary shown in the previous window. 

New Invoices Lists all invoices created since the last closeout. 

New Estimates Lists all the estimates created since the last closeout. 

Invoice Pickups Lists all the invoices shown as picked up on the Register Tape. 

Invoice Profitability List of all cost data for all invoices shown as being picked up on the Register Tape. 

Payments Lists all the payments posted since the last closeout. 

Journal Entries Lists all the journal entries posted since the last closeout.  

Tax Summary A report of sales tax by tax table and tax code for sales and receipts. 

Accounting Links This option generates a file, which you name, containing the information needed by 
the third party accounting system you selected in the GL Profiles Preference panel. 
A printed summary report is also included with the accounting links file. It is not an 
exact duplicate of the data generated in the file, simply a summarization of the 
accounting action and is loosely based on the MYOB export file format. 

  

 

While the closeout is being recorded and the reports generated, a status window keeps you 
informed of its progress. The entire process from start to clicking the Finish Closeout button can be 
completed in less than a minute. The amount of time it will take to print the reports varies with the 
length of the reports and the type of printer you are using. On a “normal” day, you should be able to 
finish the entire operation (including printing) in less than 10 minutes.  

These reports can be re-printed or reviewed using the Daily Sales command in the Report menu. 
Also, most of the lists can be sorted by Sales Rep by holding down the <option>/ <alt> key when 
generating the report. 

Note:  Closeout must be run on the PrintSmith Master. PrintSmith shuts down the network before 
proceeding with the closeout and turns it back on when the closeout is completed. 
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What Finishing Closeout Does 
• Makes an entry in the register tape indicating that closeout was performed. 

• Moves the current Register Tape from the Data folder to the History folder and renames it 
“Tape yymmdd” where “yymmdd” is the date of the closeout. The tape is then locked so it 
cannot be changed. A new Register Tape is created. 

• Resets the cash drawer. Cash is set to the amount in Change Fund. Checks are set to reflect 
any checks on hold. Credit Cards are zeroed. The AR Balance is unchanged. 

• Makes an entry in the sales journal recording the daily sales summary. This includes new 
invoices, invoice pickups, and tax detail information. 

• Saves a Deposit Ticket in the History folder in a file named “Deposit Ticket yymmdd” where 
“yymmdd” is the date of the closeout. 

• Moves the current Event log into History folder in a file named “Event Log yymmdd” where 
“yymmdd” is the date of the closeout. 

• Generates a set of reports, the most important being the Daily Sales Report. 
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Monthly Closeout 
Monthly Closeout prepares a summary of the daily Sales Journal records for a calendar month and 
updates customer sales statistics and account histories. PrintSmith figures out which month needs 
to be closed out next and tells you what it is going to do. You do not have to enter anything except 
the optional productivity data. 

You can perform a Monthly Closeout as often as you like. PrintSmith always checks to see if there 
is another Closeout for the same month, which was not included in the last month’s closeout. If this 
is the case, PrintSmith will update the monthly sales figures instead of starting a new month. 

Before starting the closeout, PrintSmith will tell you what period is being closed out. When you click 
the Continue button, PrintSmith sets up the Productivity data for the month. 

If you have entered productivity information, PrintSmith will summarize it and display it here so you 
can change it as needed.  

When you click the OK button, the monthly sales summary is displayed for review.  

After reviewing the data, close the window. At this point you can select the reports you want printed 
and decide if you want to finish the closeout. 

Figure 5.22: Monthly Closeout Reports Window 
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PrintSmith remembers the reports selected for the last monthly closeout. Available reports are as 
follows: 

Table 5.12: Monthly Close Out Reports 
Reports Definitions 

  

Sales Summary Contains the sales summary for the month. It has exactly the same format as a 
daily sales summary report. 

New Invoices Lists all invoices created in the period. 

New Estimates Lists all estimates created in the period. 

Invoice Pickups Lists all the invoices picked up (posted to Accounts Receivable) during the period. 

Invoice Profitability List of all cost data for all invoices posted during the period  

Payments Lists all payments posted during the period. 

Journal Entries Lists all journal entries created during the period. 

Tax Summary Displays a detailed report by tax table and tax code for tax on sales and taxable 
receipts. 

Accounting Links This option generates a file, which you name, containing the information needed by 
the third party accounting system you selected in the GL Profiles Preference panel. 
A printed summary report is also included with the accounting links file. It is not an 
exact duplicate of the data generated in the file, simply a summarization of the 
accounting action. 

  

 

While the closeout is being recorded and the reports generated, a status window is displayed to 
keep you informed of its progress. 

Final Closeout Processing 
When the closeout is finished, PrintSmith will ask if you want to update Account History. This can 
be a time consuming process. It goes through the customer list and updates all of the history 
bookmarks. It also adjusts each accounts sales statistics (sales per month, etc.). When performing 
a “final” monthly closeout you should always click the OK button. System performance may suffer if 
you do not perform this procedure periodically.  
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Generate Statements 
Generating statements is an entirely optional, but extremely important, function of the Accounts 
Receivable module of PrintSmith. The basic process of generating a statement consists of: 

1. Deciding which accounts need statements. 

2. Collecting the data that belongs on each statement. 

3. Calculating finance charges. 

4. Aging the account and changing the account status as needed. 

5. Writing the statement data out to a file. 

6. Printing statements from the collected data. 

7. Printing the statement summary report from the collected data. 

Since the data is first placed in the statement data file, it is relatively simple to handle situations like 
printer jams without having to go through the entire statement process again. Once the file has 
been created, the data can be saved permanently as files named “Statement yymmdd.STF” 
(yymmdd is the date of the statement run). Saved files can be opened in the Generate Statement 
window using the Open command in the File menu to reprint statements. In addition, the file can be 
used to print an aging report for that date using the Open command from the Account Aging 
window. 

Although you can generate statements from a Workstation, the process works best from the Master 
for several reasons: 

• Generating statements from the PrintSmith Master is much faster. 

• Statement settings are stored on the PrintSmith Master. Any changes made to those settings 
on a Workstation are made on the local machine and are temporary. They are replaced the 
next time the Workstation updates pricing. 

• The data used to create statements in a statement run can be saved. The saved data is stored 
on the machine where statements were run. You may wish to keep old statement data in a 
single location for security reasons. 

International Statement Generation 
PrintSmith will print statements in two currency denominations if the Use Alternate Currency setting 
is enabled. In addition to the optional settings in the panels, there are several buttons and edit 
fields that provide overall control of the process. 

Closing Date 

This is the date shown on the statement. The statement generator ignores all open debit items with 
posting dates after the closing date. Open credit items after the closing date are considered when 
calculating aging status and finance charges, because they are based on account balance, but do 
not appear on the statement. 
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Payment Date 

This optional date is shown on the statement as the date that payment is due by. When the window 
first opens, it is set to 30 days from the current date, but this can be changed to any date. 
Removing the date removes it from the statement output. 

Calculate Finance Charge 

Calculating Finance Charges has an optional setting, which limits finance charge calculation to 
once in any calendar month. If this option is enabled, PrintSmith will also remember the Calculate 
Finance Charge setting. Otherwise, the setting is off. The rate used for the finance charge is 
determined by looking first at the customer account. If Never Calculate Finance Charges in the 
customer account definition is enabled, no finance charge will be calculated for that account. If the 
account has a special rate, the rate from the account is used; otherwise the system default rate is 
used. You set the system default rate with the Credit Preference panel. When generating a master 
billing statement, sub-accounts settings for finance charges are ignored – only the master account 
settings are considered. 

Note:  When finance charges are actually posted, a Register Tape entry is made. If you discover 
an account was charged a finance charge and you want to remove it, simply void the 
transaction for that account before doing a closeout. 

Selecting Accounts 
There are three basic methods of selecting accounts: 

• All Accounts - Each and every account is aged and processed for statement generation. 

• Range of Accounts - Each and every account is aged and processed for statement 
generation except when an alphabetical subset is chosen. For example, type “b” in the “From” 
fields and “dog” in the “To” field will print statements from the first account whose name starts 
with “b” through the last account whose name starts with “dog”. Leaving “From” blank starts 
with the first account. Leaving “To” blank stops at the end of the list. Leaving both blank is the 
same as Step 1 and processes the entire customer list. 

• Selected Account - This method allows you to select the accounts you want processed by 
continually presenting the Customer Picker as long as an account is selected. You click the 
Cancel button in the Customer Picker to stop selecting accounts and continue the statement 
process. 

These methods are further refined by settings in the Output panel. If you specifically select an 
account, a statement is generated regardless of other option setting, which might otherwise cause 
the account to be skipped. 
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Message to Print on Each Statement 
This edit field is provided as an easy way to place seasonal or marketing messages on all 
statements. You must type a message for each statement run, as this text is not saved. 

Print 

Click this button to begin generating statements. 

Preview 

Click this button to begin previewing statements.  

Cancel 

Click this button to close the window without saving or generating statements. 

Note:  The Save command in the File menu can be used to save the current option settings. 

Previewing Statements 
This is an alternative to using the Print button and opens a preview window where you can review 
each statement and decide whether to actually generate a statement. 

Remove Finance Charge 

If a finance charge is indicated for an account, it is calculated and displayed in the item list in red. 
Disable button to remove the finance charge from the statement for this account. Once you have 
removed a finance charge, the button changes to Restore Finance Charge and enabling it restores 
the finance charge. When previewing, finance charges are not actually posted until you click the 
Print or Print Remaining button. 

Print Remaining 

This button continues printing statements without previewing. In effect, previewing is cancelled 
without stopping statement generation. 

Print 

Click this button to accept the statement. A statement is not immediately printed, instead, the 
statement data is added to the statement file and printed after all the statements have been 
previewed. 

Skip 

Click this button to cancel the statement for a single account. Statement generation continues with 
the next statement. 

Stop 

Click this button to stop previewing statements for any other accounts, stop generating statements 
and begin printing those statements already accepted. 
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Output 
The options in this panel control the accounts that get picked for statements and what actually goes 
on the statement. 

Figure 5.23: Output Generate Statements Window 

 



EFI PrintSmith 7.2 |  Reference Guide 

 
 

 
Page 208 

Table 5.13: Output General Statements Window 
Field Definition 

  

Skip accounts with current 
status 

If you wish to send statements only to those customers with past due 
balances and you age from the Posting Date, turn this option on. When you 
age from posting date, the account status is determined by the posting date 
of the oldest open item so skipping accounts whose status is current will 
ignore accounts that do not have old open items. 

Skip accounts with current 
balance 

If you wish to send statements only to those customers with past due 
balances and you age from the date of the last payment, turn this option 
on. When aging from the last payment date, an account may have open 
items that are several years old and still be current if they have recently 
sent a payment. Enabling this option skips only those customers whose 
oldest open item is current regardless of the account status.  

Create master billing 
statements 

Enabling this option will generate a consolidated statement containing the 
statement items for the account as well as statement items for all sub-
accounts that are “attached” to this account for billing purposes. 

Only Master Billing 
Accounts 

When Master Billing Statements are enabled, use this option to ignore all 
accounts except those that are used for master billing. This is useful if you 
do not normally generate statements at all, but you have set up master 
billing accounts and need to send statements only for those accounts.  

Skip Sub-accounts Normally, if you are generating Master Billing statements, you will want to 
enable this option so sub-accounts do not also receive a statement. If Only 
Master Billing Accounts is selected, sub-accounts will not get statements in 
this case as well. 

Additional Sub-Accounts Selecting this option generates statements for sub-accounts as well as 
Master Billing statements. Use this only if you want to send “informational” 
statements to sub-accounts and they understand the purpose of the 
statement. If a sub-account is specifically marked to not generate 
statements, this option is ignored and no statement is generated for that 
account.  

Show New payments When this option is selected, PrintSmith includes all payments made since 
the last statement as well as all open items. 

Show aging amounts When this option is selected, an aging summary is printed on the statement 
showing the totals for each of the four aging categories (current, 30 days, 
60 days, 90 days). 

Show aging titles When using pre-printed forms, you may elect to pre-print the aging 
category titles in which case this option should be turned off. The only 
advantage to printing the titles is that if you change aging periods 
(changing 30 days to 45 for the first period), these changes are reflected in 
the aging titles. 

Show reminders Enabling this option tells the statement generator to place the predefined 
reminder notices on the statement. You control the text in these reminders 
with the Aging Periods Preference panel. 

Show Customer Statement 
Notes 

Enabling this option tells the statement generator to place the statement 
note defined for this customer account on the statement. You control the 
contents of this text using the Notes panel in the Accounts window. 
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Accounting 
The Accounting panel is used to define how aging is performed, what to do about changing the 
customer account status as a result of aging and how to handle finance charges. 

Figure 5.24: Accounting Generate Statements Window 

 
 

The purpose of account aging is to determine the status of the account and warn you of accounts 
that may need collection action. An accurate gauge of the state of your AR is essential to running a 
healthy business. 

When PrintSmith ages an account, it looks at all of the open debits (money owed to you) as well as 
all open credits (money you owe to the customer or have not yet applied to a debit) to determine 
how long the customer has owed you money and when you last received a payment from the 
customer. Based on this information, PrintSmith will adjust the account status according to the rules 
that you set in this window and in the Aging Period preference panel. 

Status from Posting Date 

The date of the oldest open debit is used to determine the proposed account status. 

Status from Payment Date 

The date of the last payment received is used to determine the proposed account status. This also 
affects the aging report because a partial payment on an open item will age that item based on the 
payment date. 
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Handling Aging Status 

Once the proposed account status has been determined, what happens next depends on the 
selected action procedure. 

Table 5.14: Aging Status 
  

  

Always Change Account 
Status 

The account status is automatically changed to the proposed status. 

Ask Before Changing 
Status 

A summary window showing the aging totals, the old status, and the 
proposed status opens and asks you if you wish to update the account 
status. 

Never Change Account 
Status 

The account status remains unchanged. 

  

 

Additional Aging Options 

Freeze after 90 days 

Normally, the proposed account status is Current, Past Due, or Delinquent. If this option is enabled 
and there are open items older than the oldest aging period (by default this is 90 days) the 
proposed account status will be frozen. When an account is frozen, the only operation allowed on 
the account is to Post Payments. 

Unfreeze after 90 days 

Once an account is frozen it can be unfrozen manually by changing the account status in the 
Accounts window or by enabling this option that allows the aging process to automatically adjust an 
account status for frozen accounts. 

Mark Inactive Accounts 

An important feature of the aging process is the ability to identify accounts that have become 
inactive. Identifying inactive accounts alerts you to the possibility that you may have lost an account 
so that you can take remedial action such as scheduling a visit with the customer. An account is 
considered inactive if nothing has been posted to the account for the specified inactive period. 

Inactive Account to Prospect 

This button adds the ability to reclassify inactive accounts as prospects. The underlying concept is 
that once a customer has been listed as inactive for an entire billing cycle, they become prospects. 
When this button is enabled and you Generate Statements or perform an Account Aging, all 
inactive accounts are marked as prospects. You control the inactive period using the Credit 
preference panel.  

Note:  Use this function with care! Changes to account classification (Customer to Prospect) 
cannot be quickly reversed. Also, it does not consider how long a customer has been 
inactive; it simply changes all inactive customers to prospects. 
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Controlling Finance Charges 
The finance charge rate for the whole system is set in the Credit preference panel. Individual 
account settings that override the system settings are available in the Credit Control panel of the 
Customer Account window. These options give you added flexibility in calculating finance charges 

Only Apply To Items Past Due 

When this option is enabled, only past due items are subject to finance charges. Turn this option off 
and all open debits are subject to finance charges. 

Apply Outstanding Credits 

When this option is enabled, any outstanding credits are subtracted from the aging category totals 
starting with the oldest category. For example, if you post a payment for $100 dollars without 
applying it to a debit today and generate statements where the delinquent aging total is $50 and the 
past due is $25, the credit is applied to the delinquent amount reducing it to zero. The remaining 
amount of $50 in the credit is then applied to the past due aging total reducing it to zero. The end 
result is a proposed status of Current in this account. In the same example, if this option were 
turned off, the account would have a proposed status of Delinquent because the outstanding credit 
would not be used to adjust the old debit. Normally, you will want to leave this option enabled. 

Calculate Only Once Per Month 

When this button is enabled, the Statement Generator checks the date of the last finance charge 
posted on the account and will only generate a finance charge if the statement date is in a different 
calendar month. Since the Statement Generator has more intelligence about finance charges, 
when this button is enabled, the Calculate Finance Charge button will remember its setting.  

Note:  This option is based on a calendar month not on an elapsed month and that the Closing 
Date is used not the current date. Also note that the date a sub-account last had finance 
charges posted are ignored when generating a Master Billing statement. 
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Addressing 
The Addressing panel is used to determine what information appears on the statement outside of 
the accounting information and how the address is formatted. 

Figure 5.25: Addressing Generating Statements Window 

 
Use Statement Address 

The Statement Address defined in the Customer Account is printed on the statement. 

Use Invoice Address 

The Invoice Address defined in the Customer Account is printed on the statement. 

Attention 

Using this pop up menu, select whether the attention is placed at the beginning, end or omitted 
from the address block. 

Postal Bar Codes 

Use this pop up menu to select whether a postal bar code is placed above, below or omitted from 
the address block. 

Show Account Number 

Enabling this option prints the customer account number on the statement. On statements that use 
payment stubs at the top or bottom, the account number is placed in the billing summary section 
whose size is adjusted as needed to fit. If the reference number is also displayed, it is combined 
with the customer account number in the same block. On other statement forms you must specify 
the position of the account number. 
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Show Reference Number 

Enabling this option prints the customer’s external reference number on the statement. On 
statements that use payment stubs at the top or bottom, it is placed in the billing summary section 
whose size is adjusted as needed to fit. If the account number is also displayed, it is combined with 
the reference number in the same block. On other statement forms you must specify the position of 
the reference number. 

Show Sales Representative 

Enabling this option adds the sales representative’s name to the statement. On statement forms 
using payment stubs at the top or bottom, it is placed in the billing summary section whose size is 
adjusted as needed to fit. On other statement forms you must specify the position of the sales rep 
name. 

 

Reports 
After statements are printed, a statement summary report is generated. This panel allows you to 
control whether the report is printed, in what detail, and whether to save the report for future 
reference. 

Figure 5.26: Reports Generating Statements Window 
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Print Summary Report 

When this option is enabled, the statement generator waits for statements to finish printing so you 
can insert plain paper. It then generates a report containing, as a minimum, the name and aging 
totals for each account for which a statement was printed. 

Detailed Report 

Enabling this option prints a statement summary report containing the details of each open item on 
the statement. The data file that the Statement Generator creates to print statements from is the 
same file used to create the summary report. It always contains all the detail information even if a 
detailed report is not printed. 

Added Collection Information 

Enabling this option adds sales rep, contact name, phone number, last payment date and amount 
to the report. This information makes the report more valuable as a collection tool. 

Alternate Lines in Aging Columns 

If the amounts in a statement are very large (more than 999,999) some of the amounts may creep 
into adjoining columns rendering the report unreadable. Enabling this option prints every other 
amount on alternate lines. Use this only if needed because it makes the report much longer. 

Save Report 

The statement generator creates statements by writing all of the statement data to disk in a 
temporary file. This file is used both to generate statements and to print the statement summary 
report. When this option is enabled, the summary file is saved instead of being deleted. The file is 
named “Statement YYMMDD.STF” where “YYMMDD” is the date. You can use this file to generate 
statements again, perhaps with a different set of options, by selecting the Generate Statement 
command and then selecting the Open command in the File menu. Likewise, you can reprint the 
summary report using current options by opening the file from the Account Aging window using the 
Open command. 
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Form Layout 
Controlling the appearance of the statements you send out is an important part of projecting a 
professional image. PrintSmith offers unparalleled flexibility in controlling how your statements look 
by offering four completely different statement forms, each of which can be customized extensively. 
In addition, you can use a pre-printed form, a form image that is built into PrintSmith, a form that 
you have imported, or have PrintSmith draw the form. 

Figure 5.27: Form Layout Generating Statements Window 

 

Form Generation Options 

Use Pre-Printed Form 

Select this option if you have printed statement forms. We generally recommend you pre-print your 
statement forms for the best presentation and fastest printing. 

Print Custom Form Image 

PrintSmith comes with a set of built in form images. In addition, you can import your own form 
image.  

Generate Detailed Form 

PrintSmith is capable of drawing the statement form itself. While this method does not allow you to 
change the overall appearance of the statement and is only as good as the printer you are using, it 
does have the advantage of automatically adjusting itself to changes in the position of items that 
you make. When just getting started you may wish to experiment with the standard forms that 
PrintSmith draws until you have them as you like, then print your own forms. 
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Generate Basic Form 

This is almost exactly the same as Generate Detailed Form except that the form PrintSmith draws 
is a stripped down version that may be more suitable for some low resolution printers. It can also 
be useful for filling out a pre-printed shell. 

Print Logo 

In order to use this you must enable this option and select a logo or import one using the Images 
panel in the Change Form Layout window. You will also need to position the logo on the statement 
form.  

Selecting the Statement Form 

Standard Format 

This is a letter format, which may be suitable for printing on your standard letterhead.  

Remittance Advice on Right 

Similar to the standard format, it adds a tear off remittance advise down the right side of the form. 
Because of the more limited display area, line item information is more compressed than in the 
other statement forms. 

Payment Stub on Top 

This statement form is highly customizable. It features a tear off payment stub that is placed in a 
windowed remittance envelope for returning the check. 

Payment Stub on Bottom 

This statement form is identical to the Payment Stub On Top except the payment stub is on the 
bottom. 

Adjust Form & Image 

This function is used to adjust the overall position of the statement data and the position of the 
statement form image on the printed page.  

Figure 5.28: Adjust Statement Form Window 
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Data Offset 

These two fields adjust the position of the statement data on the page. Increasing the left number 
moves all of the data to the right on the page, decreasing it moves everything to the left. Likewise, 
changing the up/down number moves the data down on the page, decreasing it moves everything 
up on the page. 

Image Offset 

These two fields are similar to the data offset but adjust the position of a form image on the printed 
page. It has no effect unless the Print Custom Form Image option is turned on and a form image 
has been selected. 

Measurements 

Internally, all positions are stored as pixel values (1/72 inch). You can change the representation of 
this number to inches, centimeters, or millimeters, but it is important to understand that although 
you can enter a value such as 1.625 inches, it gets changed to the nearest whole pixel internally 
and then converted back to inches again for display to 1.62. The same holds true for all the other 
measurement selections. 

Print Sample 

Click this button to generate a sample form. This is useful for checking that the form image and the 
statement data are properly aligned before printing statements. 

OK 

Closes the window and accepts all changes. 

Cancel 

Closes the window without accepting any changes. 

Change Form Layout 

PrintSmith offers the ability to modify the entire form and control the position and font used for 
almost everything on the form. Since there are four significantly different forms, the contents of 
each panel change depending on the form selected in the Statement Generator window. 

The window is separated into panels. The Form Layout panel controls the overall position of 
elements on the page. Line Item Position controls the position of each element on a detail line in 
the statement. The Fonts panel lets you change the type specification of different elements in the 
statement, and the Images panel is used to import images and select the custom form and logo you 
want printed with each statement. 

Outside of the panel display area are several buttons common to all panels. 
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Form Layout 

This panel controls the overall position of elements on the page. In the illustration below, the form 
layout is for the payment stub on top. 

Figure 5.29: Form Layout Change Statement Layout Window 

 

To see how either of these sections fits on a page, print a sample page. 
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Line Item Positioning 

This panel controls the position of each element on a detail line. 

Figure 5.30: Line Item Positioning Change Statement Layout Window 

 
 

Each column has two elements, a margin and a width, which together comprise the width of the 
column. The margin is the amount from the edge of the column that the text will print. For amounts, 
the margin is an offset from the right of the column and for other elements it is the offset from the 
left.  

Note:  Setting the width of any column to zero removes that column from statements.  
The last field shows the total width of the defined elements. Check the Form Layout panel to make 
sure that if there is a Line Items specification, this number is less than the Width Across of the Line 
Items specification. 
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Fonts 

This panel lets you change the type specification of different elements in the statement.  

Figure 5.31: Fonts Change Statement Layout Window 

 
 

The current font selection is displayed to the right of each button. All should be self explanatory 
with the possible exception of the Form button. The Form specification is the font that PrintSmith 
uses when it draws the statement form itself. 
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Images 

This panel is used to import images and select the custom form and logo you want printed with 
each statement. 

Figure 5.32: Images Change Statement Layout Window 

 
 

The Form ID is the image to use for the statement form image. The Logo ID is the image to use 
when printing a logo image. In addition to entering the form ID directly, you can use the Image 
Picker to pick from the images built into PrintSmith or to add your own image. 
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Verifying Accounts Receivable 
There are three commands for verifying the accuracy of the Accounts Receivable system. 

They allow you to check account balances against open invoices and the receivable balance 
against customer accounts and provide a means by which you can affect repairs. 

Verify Receivable Balance 
This command compares the Accounts Receivable balance shown in the Cash Drawer to the total 
of all customer accounts. Since the statement generator can only bill the customer based on the 
account balance, any difference between the two amounts is an error. The Accounts receivable 
balance is strictly for your information and is not used by PrintSmith as the basis for any other 
calculations. 

Verify Customer Balance 
This command compares the balance shown in the account to any open items in the account 
history to make sure that they agree. The Balance in Account figure is taken from the customer 
account. The Total Open Invoices figure is calculated by adding up all the open documents. If there 
is a difference, use the Fix button to replace the account balance with the total of the open items. 
The total open items are the amount that can be billed. If there is a difference, you should try to 
ascertain why before fixing the account. 

The Age Now button is useful for updating the aging totals stored in a customer account so they 
match the balance in the account. Pressing the Age Now button displays results but those results 
are not saved. 

Verify All Balances 
This command is essentially the same as Verify Customer Balance except that it goes through 
every customer account and checks for discrepancies. While it is searching, it displays the name of 
the account being processed. If a discrepancy is found, the account is displayed. If, after executing 
this command, any discrepancies were found, check your receivable balance using the Verify 
Receivable Balance command. These commands are diagnostic in nature. If they locate a problem, 
you can fix it and continue operating as usual; however, if they point out a problem, which should 
be investigated. Someone may have shut down the PrintSmith Master while you were posting from 
a WorkStation; but it could be a problem with the software. If a particular account is showing a 
balance greater than accounted for by open items there must be a reason. Examine the Account 
History to see if an invoice was somehow not posted. If you believe the account history is in error, 
try rebuilding the history for the account. After completing this, check the balance again. 
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Account Aging 
Account Aging is the process PrintSmith uses to categorize all open items according to how long 
the item has been open. The process of aging uses the Statement Generator and mirrors the 
process of generating statements quite closely except, of course, that statements are not 
generated. Like the statement generator, the options are divided into panels with several fields and 
buttons common to all panels. 

Closing Date 

This is the date to use for determining the aging status of accounts. Open items with posting dates 
later than this are ignored (except for credits). 

OK 

Starts the aging process. Like the statement generator, data is first collected in a file that is used to 
create the aging report. 

Cancel 

Cancels aging and closes the window. 

Output 
This panel controls how the statement generator handles each account during the aging process. 

Figure 5.33: Output Account Aging Window 

 
Age Master Billing Accounts 

Enabling this option ages a master billing account and all its sub-accounts as a single account.  

Note:  The aging summary in the Account Sales Info panel will show aging amounts that can be 
considerably higher than the account balance because it includes the amounts for all the 
sub-accounts. This is normal. 

Skip Sub-accounts 

If you are aging Master Billing accounts, you will want to enable this option so sub-accounts are not 
aged, as the assumption is that the master account is responsible for payment. 
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Pause After Each 

When this option is selected, PrintSmith stops after each account so you can review the results. 

Include Zero Balance Accounts 

Enable this option to include all accounts, regardless of balance, in the aging report. 

Accounting 
The Accounting panel is used to define how aging is performed and what to do about changing 
customer account status as a result of aging.  

Figure 5.34: Accounting Account Aging Window 

 
 

The purpose of account aging is to determine the status of the account and warn you of accounts 
that may need collection action. An accurate gauge AR status is essential to running a healthy 
business.  

When PrintSmith ages an account, it looks at all of the open debits (money owed to you) as well as 
all open credits (money you owe to the customer or have not yet applied to a debit) to determine 
how long the customer has owed you money and when you last received a payment from the 
customer.   Based on this aging, PrintSmith will adjust the account status according to the rules that 
you set in this window and in the Aging Period preference panel as follows: 

Status from Posting Date 

When aging is performed, the date of the oldest open debit is used to determine the proposed 
account status. 

Status from Payment Date 

When aging is performed, the data of the last payment received is used to determine the account 
status as well as the status of each open item with a partial payment. 

Handling Aging Status 

Once the proposed account status has been determined, what happens next depends on the 
selected action procedure. 
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Table 5.15: Aging Status 
Value Definition 

  

Always Change Account 
Status 

The account status is changed to the proposed status. 

Ask Before Changing 
Status 

A summary window showing the aging totals, the old status, and the 
proposed status opens, and asks you if you wish to update the account 
status. 

Never Change Account 
Status 

The account status remains unchanged. 

  

 

Additional Aging Options 
Freeze After 90 Days 

Normally, the proposed account status is Current, Past Due, or Delinquent. If this option is turned 
on and there are open items older than the oldest aging period (by default this is 90 days) the 
proposed account status will be frozen. When an account is frozen, the only operation allowed on 
the account is to Post Payments. 

Unfreeze After 90 Days 

Turning this option on allows the aging process to propose a different account status on frozen 
accounts if they have made recent payments. 

Mark Inactive Accounts 

An important feature of the aging process is the ability to identify accounts that have become 
inactive. Identifying inactive accounts alerts you to the possibility that you may have lost an account 
so that you can take remedial action such as scheduling a visit with the customer. An account is 
considered inactive if nothing has been posted to the account for the specified inactive period. 

Inactive Account to Prospect 

This feature when selected, will convert inactive accounts to prospects. You control the length of 
the inactive period using the Credit preference panel. 
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Reports 
This panel allows you to control whether the report is printed, in what detail, and whether to save 
the report for future reference. 

Figure 5.35: Reports Account Aging Window 

 
 

Print Summary Report 
When this option is enabled, the statement generator prints a report containing, as a minimum, the 
name and aging totals for each account for which a statement was printed. 

Detailed Report 

Enable this option to print an aging summary report containing the details of each open item in the 
account within the aging period specified by the closing date. 

The data file that the Statement Generator creates to print the aging report always contains all the 
detail information even if a detailed report is not printed. 

Add Collection Information 

Enable this option to add sales rep, contact name, phone number, last payment date and amount 
to the report. Adding this information makes the report more valuable as a collection tool. 

Alternate Lines In Aging Columns 

If the amounts in a statement are very large (more than 999,999) some of the amounts may creep 
into adjoining columns rendering the report unreadable. Turning this option prints every other 
amount on alternate lines. Use this only if needed because it makes the report much longer. 

Save Report 
When this option is enabled, the summary file is saved, at that specific workstation, instead of 
being deleted after the statement generator is complete. The file is named “Aging YYMMDD. STF”.  

Note:  You can use this file to reprint the aging report using current report options by opening the 
file from the Account Aging window using the Open command. 
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The Aging Process 
When you click the OK button, the Aged Account window opens. This window is used to display the 
results of aging. If the Ask First button is enabled, and the account status is being changed, you will 
be notified of the contemplated change and asked to verify it. If you have Pause After Each 
selected, the account aging is displayed. 

Aging Report 
After aging is completed, the aging report is printed if the Print Report option is selected.  

 

Journal Entry 
In a perfect world, you would never need to create a journal entry. Typically, they are used to 
correct mistakes, either yours or your customer’s. In a few cases, like posting finance charges, 
PrintSmith will create journal entries automatically. This is one of the few places in PrintSmith 
where knowledge of accounting is really helpful.  

The first part of this section describes Journal Entries in general terms, how they are posted, and 
how the functions available in this command can make creating journal entries easy.  

Note:  Journal Entry Examples section provides step by step instructions for creating journal 
entries for the most common situations you are likely to encounter.  

The most difficult and tedious types of journal entries are those that correct mistakes made in 
posting. You can avoid this entirely if you catch the error before finishing a daily close-out. Virtually 
any mistake can be corrected by voiding the erroneous transaction from the register tape. Voiding 
transactions is a matter of clicking on the transaction in the tape and clicking the Void Transaction 
button. This is much easier than a journal entry. Also, if you make a mistake creating a Journal 
Entry, you can use the Void Transaction process to cancel the mistake.  

Once a daily closeout has been performed, the transactions on the register tape are locked and 
you must then use a journal entry to make adjustments. 

The Journal Entry command is used to create credit and debit memos. Memos are used to adjust 
the total due on an invoice, add or remove tax from an invoice after posting, write off bad debts, 
and to adjust account balances. 
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Figure 5.36: Journal Entry Window 

 

When a standard journal entry is created, it is added to accounts receivable charges for that day 
and adjusts sales totals. Debit memos (positive total) are much like invoices and, in fact, can be 
used as a way of entering beginning balances or old invoices.  

Credit memos have a negative total – this causes the memo to reduce the account balance, which 
is the amount, the customer owes you. Its effect is quite similar to that of entering a payment 
except that no money is involved. When a Credit memo is retired (applied) there will not be any 
changes to the sales summary unless you issue cash refund against the memo. If you intend the 
entry to be an adjustment on an invoice, be sure to pay it at the same time that you pay the invoice 
it adjusts. You can immediately apply it to the invoice (if it is a credit) without waiting for a payment. 

In certain unusual circumstances a special type of journal entry can be created which does not 
affect sales. This type of journal entry should be used only in very specific cases such as entering 
beginning balances when first starting up.  
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Setting up Journal Entries 
When the window is first opened, it set up as a standard journal entry. Use the buttons in the 
window to select the customer or invoice to be adjusted and other options affecting how the memo 
is posted. The minimum necessary to successfully create a journal entry is an account to post to 
and an amount to post. 

Select Customer 
Open the account selection window. Selecting an account displays the current status and balance 
of the account. A customer account must be selected before a journal entry can be posted. 

Note how this journal entry has the Affect Sales button turned off and the sales category fields are 
not shown. It is not necessary to select an account if you plan to select an invoice. PrintSmith will 
select the account assigned to the invoice when you select the invoice. 

Select Invoice 
Allow you to enter an invoice number. PrintSmith finds the invoice, selects the account, displays the 
account to which the invoice was posted, and automatically prepares a reversing entry for the 
invoice. If all you want to do is write off an invoice, just click the OK button. 

Print Document 
Controls whether the journal entry is printed when it is posted. Usually you will want to print the 
memo so that you have a hard copy. Disable this button when no printout is desired. Journal 
Entries are printed on an invoice form using the document preference selected in the Journal 
Entries Preference panel. Journal Entries are automatically given a serial number by PrintSmith; 
the user cannot change this number. Use a document preference, which does not print the number, 
to shut this off. 

Affect Sales 
This button is normally enabled. Disabling this button removes all of the data entry fields for sales 
categories so that when the memo is posted, sales are not affected. Journal entries that do not 
affect sales adjust the account balance and New Charges on the sales report. They do not show up 
in the sales totals at all.  

Warning: This type of entry can unbalance your books. The only time this button should be turned 
off is to enter beginning balances when first setting up the system. 

Update Customer Statistics 
Enabling this button tells PrintSmith to also adjust this customer’s sales statistics when posting the 
journal entry. This is intended primarily as a means of adjusting total sales when you write off an 
invoice. It will also adjust the document count used to calculate the average order and ratio of 
estimates to orders if you use the Select Invoice button to set up the entry and do not use the Only 
Tax or the Select Customer button. 
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To adjust customer sales totals and document count: 

1. Set up the journal entry using either Select Customer or Select Invoice. 

2. Make all adjustments needed to get the correct amounts. 

3. Enable the Update Customer Statistics option. 

4. Click the OK button. 

 

To adjust sales totals without changing the document count: 

1. Enable the Update Customer Statistics option. 

2. Set up the journal entry using Select Customer. 

3. Make all adjustments needed to get the correct amounts. 

4. Click the OK button. 

 

Tax Table 
Shows the tax table assigned to the customer account, or if an invoice was selected, the invoice. 

Sales Reps 
The Sales Rep field allows recording a sales representative name when a journal entry affects the 
commissions earned by that Sales Rep. 

Calc Adjustment 
This button and the adjustment percentage text field next to it are used for those times when you 
want to write off a percentage of some known amount. For example, to create a journal entry that 
can be used to write off 10% of an invoice, follow these simple steps: 

1. Click the Select Invoice button. 

2. Enter the invoice number you want to adjust and click the OK button. 

3. Click in the adjustment field and enter 10, press <tab>. 

4. Click the Calc Adjustment button and all the amounts will change to 10% of their 
original amounts. 

5. Click the OK button to post the journal entry. 

Calc Adjustment is also useful for net 10 minus 2% calculation. It creates a journal entry to record 
how the invoice was paid. 

Reverse 
Changes all positive numbers to negative and all negative numbers to positive. One use for this 
function is to re-post an invoice. When you select an invoice using the Select Invoice command 
PrintSmith prepares a reversing entry automatically. By clicking the Reverse button, you can 
quickly create a journal entry that re-posts the invoice. 



Chapter 5:  Accounts Receivable 

 
 

 
Page 231 

Only Tax 
This button is a short cut for zeroing all fields in a journal entry that have nothing to do with taxes. 
Typically, this button is used when adjusting (adding or removing) tax from an invoice. It zeroes 
everything except Tax Sub, Tax, and Total. Besides the various accounting categories, the Journal 
Entry window has several buttons used to assist in creating Journal entries. 

Taxable 
Indicates whether sales tax is to be applied to the journal entry. Turning this button off sets Tax to 
zero but does not change Tax Sub. Turning it back on adds the tax back in. 

OK  
Posts the Journal Entry to accounts receivable. 

Clear  
Clears the entire window and sets up a new, empty journal entry. 

Cancel  
Closes the journal entry window. 

Entering Journal Entry Amounts 
There are three areas of information entered in the Journal Entry window: the distribution amounts 
or Journal Entry Details, the memo totals, and the description. PrintSmith always enters a 
description for you but can be changed to anything you want (up to 30 characters).  

Each distribution amount is added to the Sub-Total and the Tax Sub unless you have overridden 
the Tax Sub amount. Sales tax is recalculated after each change.  

When Tax Sub does not equal Sub-Total, they are shown as overrides and changes that you make 
in the detail fields do not change tax sub. You can either remove the override from the Tax Sub 
field by deleting it (PrintSmith will then synchronize Tax Sub with Sub-Total) or you can manual 
adjust Tax or Tax Sub.  

You can ignore the distribution amounts and enter amounts in the total section directly. Entering an 
amount in Sub-Total, Total or New Balance causes PrintSmith to calculate the rest of the memo 
backwards. This is sometimes easier when you already know what you want the end results to be. 
For example, if you had a customer with a balance of 72.46 and you wanted write off the entire 
balance, you could enter “0” in New Balance and PrintSmith will generate the memo necessary to 
arrive at that balance. In this case the total amount of the memo is 72.46 (a credit memo). Since 
the taxable button is on, PrintSmith calculates the subtotal needed to generate a taxable amount 
that when taxed and added together will equal 72.46. The tax rate is 6%, so the subtotal is 68.36 
and the tax is 4.10. If the Taxable button had been turned off, the subtotal would have been the 
same as the total.  

Note:  Once you have changed Tax Sub so that it differs from Sub-Total, entering distribution 
amounts will update Sub-Total but will not change Tax Sub and both Tax Sub and Tax will 
be shown as overrides. This is useful when backward calculation will not generate exactly 
the amount you need or when only part of the journal entry is taxable. 
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Journal Entry Accounting 
The sales category fields are used to adjust daily sales totals. If there are no sales category fields, 
there is no adjustment to sales. When the entry is posted, it is posted as an open item and affects 
the balance on the account to which it is posted. This is shown in the sale summary in New 
Charges and in the AR Balance.  

Journal entries are not really “paid”; rather, they are “applied”. Credit memos (negative totals) and 
Debit memos (positive totals) are handled somewhat differently. Neither of them directly affects 
receipts. However, debit memos can be paid with cash (or checks or credits cards) and when that 
happens, the receipt is a “real” receipt and is added to receipts and taxable receipts. Credit memos 
on the other hand are not real receipts and cannot be paid with cash so they will never show up 
anywhere in receipts other than as changes to the AR balance. You can apply credit memos to 
existing invoices – since the credit memo is not a “cash” receipt it simply reduces the amount due 
on the item to which it is applied. You can also refund a credit memo - this will affect receipts 
depending on your choice of refund methods.  

This has some implications if you track sales tax on actual receipts (the “cash” basis of accounting). 
Since journal entries are not real receipts, they cannot be used to adjust taxable receipts. Any part 
of a balance due that is retired using a credit memo is not a receipt and is not included in taxable 
receipts. 

 

Journal Entry Examples 
This section provides guidance on how to use journal entries. Many of the examples shown below 
presuppose a familiarity with the Sales Summary report. In this report, sales information is on the 
left and receipt information is on the right. You can use journal entries to adjust them both, but it is 
important to know when and how these adjustments take place. When you create a journal entry, it 
immediately changes the sales information and the AR Balance. When the memo is paid or fully 
applied, depending on whether it is a credit or debit, it changes receipts only if it is combined with 
an actual cash receipt in Post Payments. Credit memos are closed when they have been fully 
applied to invoices or debit memos. Debit memos are closed when they are paid – they are paid 
just as if they were invoices. These following examples show how journal entries can solve some 
common problems. 
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Entering Beginning Balances 

Problem: In setting up PrintSmith you want to set up existing customer accounts with their current 
balances. You also want PrintSmith to track taxable receipts. 

Solution: For each account you wish to set up, determine their current balance and the amount of 
tax included in that amount. Create the account if needed, select the Journal Entry command, and 
then create a journal entry as follows: 

1. Click Select Account and select the account to be set up. 

2. Turn off the Affect Sales button. 

3. Enter amount in Total. If you want to track taxable receipts, you will have to calculate 
the pre-tax total and tax due and enter them in Sub-Total and Tax respectively or 
enter the current account balance in New Balance. PrintSmith will calculate the 
taxable part of the balance for you by assuming that the entire balance is either 
taxable or nontaxable based on the setting of the Taxable button. 

4. Click the OK button. PrintSmith creates a debit memo. For all practical purposes, 
accounts receivable treats a debit memo the same as an invoice. 

This kind of journal entry just increases the account balance and New Charges on the sales report. 
Since there is no balancing entry in sales you must be very careful creating journal entries that do 
not affect sales. 

 

Adjusting Sales Categories 

Problem: You discover that a charge was being posted to the “Prep” sales category and it should 
have been posted to “Typesetting”. In the example below, the amount to be moved is $100.00. 

Solution: Create a zero balance journal entry that moves the amount incorrectly posted into the 
correct sales categories. We recommend that you create an “In House” account to use for these 
types of transactions to avoid cluttering up customer histories with housekeeping journal entries. If 
you do not want to create a customer account for this type of transaction, you can use the “<<< 
WALK - IN >>>” account. 

1. Select the account to use for the transaction. It is best to use an “in house” or “junk” 
account for this type of transaction. 

2. In the Prep detail text box, enter -100 and press <tab>. 

3. In the Typeset detail text box, enter 100 and press <tab>. 

4. Click the OK button. PrintSmith generates a zero balance journal entry. Since there is 
no balance on the entry, it is not posted as an open item and will not show up in Post 
Payments. 

In the sales report, it is shown as a $100.00 decrease in the Prep sales category and a $100.00 
increase in the Typeset category with no other effect on sales. 
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Write Off An Invoice As Un-Collectable: 

1. Click the Select Invoice button – enter the number of the invoice to be cancelled. 
PrintSmith prepares a reversing entry for the invoice. 

2. Turn on Update Customer Statistics. 

3. Click the OK button. 

4. In Post Payments, select the account with the bad invoice. 

5. Select the memo, then select the invoice or, if these are the only two open items, click 
the Auto Apply button. 

6. Click the Post button. 

 

Write off an entire account balance as un-collectable: 

1. Select the account you want to write off. 

2. Enter 0 in New Balance. Press <tab>. PrintSmith prepares a credit memo that 
automatically puts the amount being written off, in the “No Sale 2” sales category. If 
the Taxable button is on, the entire amount due is treated as taxable sales. You will 
have to manually calculate the taxable amount if only part of the balance is taxable. 

3. Enable the Update Customer Statistics option. 

4. Enable the Affect Sales option. The only occasions when you should turn off Affect 
Sales are the following: when entering new customers and beginning balances, for a 
job the customer refuses at pickup, if a customer’s check does not clear, for a sale 
not yet accounted for when upgrading to a newer version of PrintSmith. If you are not 
sure whether or not to affect sales, you should consult with an accountant to learn if 
your sales need to be reduced or if a deduction should be taken at tax time. 

5. Enter an appropriate description and click the OK button. The Journal Entry is posted. 
At this point, sales have been adjusted, a negative adjustment to New Charges has 
been made, and the account balance is 0.00. However, it still has open items, which 
you should “pay” off with the journal entry you just created. 

6. Select Post Payments, and then select the account you are writing off. There may be 
several open items. The last open item will be a journal entry, the one you just 
created. 

7. Click the Auto Apply button. PrintSmith will select all of the open items. 

8. Click the Post button. The account balance is unchanged, but there are no longer any 
open items. 
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Removing Tax from a Posted Invoice 

1. Click Select Invoice and enter the number of the invoice to be adjusted and click OK. 
PrintSmith automatically prepares a reversing entry for the entire invoice. 

2. Click the Only Tax button. PrintSmith clears all of the details leaving only Tax Sub 
and the rest of the totals. Tax Sub is a special number used strictly for calculating tax. 
With Sub-Total set to 0.00, the only real amount is the tax. 

3. Click the OK button. PrintSmith creates the journal entry (a credit memo). The memo 
does not change the total in any sales category since all the details were zero. It 
shows up as a negative adjustment to Taxable Sales and Tax on Sales and a positive 
adjustment on Non-Tax sales. On the receipts side, it shows up as a negative 
adjustment to New Charges. 

4. Although it is not necessary, you can apply the credit memo to the invoice it adjusts 
(unless that invoice is already paid). Applying the credit memo has no effect on the 
daily sales report. 

 

Adding Tax to a Posted Invoice 

Problem: You wrote a tax exempt invoice for an account. After it is posted, you discover that it 
should have been taxable and you have done a daily closeout since you posted it. If you have not 
done a daily closeout (the invoice pickup is on the current tape) simply void the pickup, change the 
invoice and re-post it. 

Solution: This procedure assumes that the document was made tax exempt in the recommended 
way, by turning on the “No Tax” button in the Document Totals window of the document. If you 
marked each item in the invoice as not taxable, you will have to manually calculate the tax amount 
before using this procedure. 

1. Click Select Invoice and enter the number of the invoice to be adjusted and click the 
OK button. PrintSmith automatically prepares a reversing entry for the entire invoice. 

2. The invoice was not taxable, so the Taxable button should be off. If there were items 
in the invoice that are taxable, there will be an amount in Tax Sub. Turn the Taxable 
button on. PrintSmith calculates tax based on the document’s tax table. 

3. Click the Only Tax command. PrintSmith clears all of the details leaving only Tax Sub 
and Tax. Tax Sub is used strictly for calculating tax. With Sub-Total set to 0.00, the 
only real amount is the tax. 

4. Click the Reverse button. This changes the journal entry into a Debit memo. All the 
amounts will become positive. 

5. Click the OK button. Tax Sub is added to Taxable Sales. Tax is added to Tax on 
Sales and New Charges on the receipts side. 
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Issuing a Refund 

Problem: You overcharged a customer in a POS transaction that was paid. The customer returns 
the next day and you agree that a refund is due. You have already done a daily closeout. 

Solution: You must issue a credit memo and then refund the amount on the credit memo. 

1. Select the account to be used for issuing the credit. It is often useful to create an “In 
House” account to which you can post these types of transactions. 

2. Enter the amount of the refund as a negative number in Total and press <tab>. 
PrintSmith will calculate the “Tax Sub” and “Tax” if the Taxable button is on. It will 
place the calculated pre-tax total in “Sub-Total” and “No Sale 2”. 

3. If you wish to adjust a particular sales category, enter the appropriate amount in the 
sales category(s) to be adjusted, then enter a zero in “No Sale 2”. 

4. Click the OK button. PrintSmith will post a credit memo to the account. This takes 
care of adjusting sales and tax on sales, but cash is not yet affected. 

5. In Post Payments, select the account. The credit you just posted will be at the end of 
the list of open items. 

6. Select the credit memo. 

7. Select the type of refund in the Remainder popup menu (on account, return cash, 
write check, credit card refund, etc.). This tells PrintSmith that the entire credit memo 
is to be returned to the customer and the manner in which to return it. 

8. Click the Post button. PrintSmith removes the amount of the credit memo from the 
cash drawer. The only possibly undesirable side effect of this procedure is that 
Taxable/Non-Taxable receipts are not updated. 
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Post POS Charges 
When you charge merchandise to a customer account in the Cash Register using the department 
buttons (no invoice), the amount charged accumulates in the account’s Merchandise Charges 
balance. PrintSmith keeps track of these items in a special log to avoid cluttering up the account 
history with lots of tiny transactions. The Merchandise Charge balance is part of the account 
balance, but is not a normal receivable and cannot be paid until you run the Post POS Charges 
command. 

Once a month before generating regular statements, you should use the Post POS Charges 
command to post the entire balance to accounts receivable as a single entry and generate a 
detailed statement. Once posted, these items are billed on the next statement and can be paid just 
like a normal open item. 

Figure 5.37: Post POS Charges Window 

 
The Cancel button exits from the command. The OK button starts the posting process.  What 
happens next depends on the other buttons as follows: 

Table 5.16: Posting POS Charges 
Option Definition 

  

Preview Before Posting Stops after each account and displays the statement preview window showing 
the statement details. If the button is disabled, the account is automatically 
posted and PrintSmith proceeds to the next account without stopping. 

Print Statements Generates a statement for each account with an outstanding balance. This 
statement uses the same format and preprinted forms as Generate 
Statements.  This is only for itemized charges and cannot be rerun. 

Print Summary Report Generates a summary report very much like the statement summary report. 

If there is a difference between the details in the transaction log and the merchandise charges 
balance in the customer account, PrintSmith will use the merchandise charge balance and the treat 
the entire balance as a taxable receipt.  

Note:  This procedure does not change any account balance, does not show up on the sales 
report or in the Register Tape and therefore cannot be voided.  

A User Security option called Not Allowed To Return Cash for each user will display the following 
error message on an attempt to post a POS charge when access to that command is disabled for 
the user. This message is also displayed on an attempt to post a payment in the cash register 
when access to that command (Post POS Charges) is disabled for the user.
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Chapter 6 Pricing 
In this chapter 

Stock Definitions 238 
Press Definitions 253 
Copier Definitions 277 
List Price Schedules 295 
Stamp Schedule 297 
Charge Definitions 298 
Waste Chart 343 
Sales Tax or Value Added Tax (VAT) 344 
Generate Price Book 348 
Change Prices 349 
WorkStation Maintenance 352 
Import Stock Catalog 353 

 

The Pricing menu contains commands for setting up the pricing system for the Estimator. It is 
divided into four sections. The first section deals with paper and equipment. The second section 
handles definitions for charges, which you will use for pre press, bindery and other operations. The 
third section is used for system wide tables. The fourth section is used for global operations on 
pricing including the optional Extended Price Book Generator. 

Before setting up pricing, you should carefully review all of the Preferences in the Admin menu, 
especially the standard markups. Once that is complete, practice entering several stock definitions 
and work with the press and copier definitions to adjust pricing to your market. When production 
pricing is finished, set up bindery and prep charges as needed. 

The Extended Price Book Generator is an optional product, which may not be available on your 
system.  

Stock Definitions 
A stock definition controls the information regarding the papers used in your operation; how much 
they cost, what size you purchase, what size you normally run, and what equipment you normally 
run it on. 

In this section we will achieve the following objectives: 

• Searching the Stock Index 

• Changing Stock Prices 

• Testing Pricing 

• Printing Price Lists 



Chapter 6:  Pricing 

 
 

 
Page 239 

There are three areas you need to review in each stock definition: Stock Description, Specification 
& Pricing and Options.  Optionally, stock can be added as an inventory item. 

Select Stock Definitions from the Pricing menu.  When selected, the Stock Picker window opens 
allowing you to search for and select a stock. 

Searching the Stock Index 
The stock index can be expanded to search the fields in the top description area of the window. 
When data is entered, the list will narrow to just those selections that match. The list can also be 
filtered by inventory options.  The group designation is a table and can be customized. 

Figure 6.1: Stock Picker window 

 
Note:   In the Qty on Hand column, quantities displayed in green indicate there is enough stock 

on hand to fill current orders.  Quantities displayed in red indicate there is not enough 
stock on hand to fill current orders. 

Stock information is displayed in columns. Column information can be sorted and displayed by 
clicking on any column title. Scrolling up and down is much faster due to live updates. Dropdown 
menus are also available for most fields in the description area. These menus are controlled and 
customized in the Table Editor. 

Stock Definitions are available on WorkStations. Stock records are locked and unavailable to 
others when selected in the Stock Definition window. When you update the pricing folder in order 
for PrintSmith Portable to work properly, the file is copied into the portable system. 

To print a listing, select a particular stock. Select File > Print from the main menu. The stock list 
printed will be based upon the Group that stock belongs to. Paper is the default group. Select a 
stock from each group and print a listing. 

Inventoried 
items in bold 

Sort by 
column 
headers 

Filter by 
inventory 
options 
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Figure 6.2: Stock Definitions Report 

 

Review all stock definitions and either customize them with your information or delete them. 

Deleting All Stocks 
If you would like to delete all of the stocks entered and start over, quit PrintSmith and remove the 
Stocks file from the Prices folder. Restart PrintSmith. When you select Stock Definitions from the 
Pricing menu, you will receive an error message about the missing file: “The Stock file does not 
exist. Unless you are just getting started, this is a serious error indicating loss of the file and should 
be reported to your PrintSmith support center. Do you want to create a new stock file?”  Click the 
Yes button to continue and create a new stock list. 

Note:  This should never be done on a system that is being used - only during initial set up. 

Deleting Multiple Stocks 
It is possible to delete multiple stocks simultaneously from within the Stock Picker window.  The 
Delete Set button in the Stock Definitions window changes the Select button to a Delete button in 
the Stock Picker window.  Use the Shift key + mouse to select a contiguous range of stocks or the 
Cmd/Ctrl key + mouse to select a non-contiguous range of stocks, then delete. 
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Viewing Stock Definitions  
To view a stock definition, select the stock from the list and click the Select Stock button. The Stock 
Definitions window opens. 

Figure 6.3: Stock Definitions window, Specification & Pricing tab 

 

Stock Descriptions 

The top section of the window contains the following fields, which are visible at all times: 

Group 

This is a convenient way to group stocks by their overall attributes. There are five pre-defined stock 
groups: Paper, Envelopes, Carbonless, Rolls, and Other. Stock Group is controlled by the Stock 
Group Table in the Table Editor, making it possible to change the name of groups and add many 
more stock groups. We recommend that you refrain from changing the name and use of the first 
five groups as importing stocks from vendors relies on them to some degree. If you do change 
them, importing stocks from vendor catalogs will still work, but the group in which newly imported 
stocks are placed may not be what you expect. 

Class 

The new Stock Picker does not use this field. It has been retained solely for use with the original 
Stock Lister.  
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Metric 

The system used for measuring metric stocks is much simpler and straightforward than the system 
used in the US. The principal difference is a common basic size (A0). The effect of this difference is 
that there is no need to calculate M Weight and the Basic Size is always the same. Enabling the 
Metric option removes those fields from the stock definition and changes the thickness 
measurement to “Microns” (one millionth of a meter). 

Envelope 

Selecting the Envelope option makes the M Weight field editable.  Since envelopes are 
manufactured products, they will not have an M Weight from the manufacturer. 

Name 

As PrintSmith sorts the list alphabetically, it is important to pay attention to extra spaces and 
misspellings. Limit the name to a description. We have separated the fields for weight, color, finish 
and size. The Stocks and Sizes Preference panel allows you to decide how to combine the name, 
weight and finish in those cases where the stock description is presented as a singled data element 
(stock order, invoice window, job ticket, etc.) 

You may wish to modify the names of your existing stock definitions to remove text from the 
description that is tracked in other data fields. At a minimum, weight and finish should be removed. 

Finish 

This field contains a finish description such as wove, linen or laid. The text of each available finish 
is stored in the Stock Finish table in the table editor. You select the finish from a pop up list that 
appears when this field is selected. 

Weight 

This contains the basic weight of a stock. This field is used to calculate the M Weight, and Carton 
Weight of the stock. If you store the weight as part of the stock name, we strongly recommend 
removing it and storing the weight only in this field. 

Color 

If you plan to import stock catalogs from vendors or order stock electronically, you should add a 
color to each stock definition. Enter the full “mill” color for each stock. In other words, if the mill 
color is “Avon Brilliant White” use that color rather than simply “White”. 

Each color in the stock database is stored in a special Stock Color table in the table editor, which 
you control. In this table, each mill color (25,000 are supported) is associated with a Generic Color. 
For example, “Avon Brilliant White” would have a generic color of “White”. This allows you to find 
the stock using either the mill color or the generic color. 

Generic Color 

Each stock definition should have a generic color. This considerably enhances the power of the 
Stock Picker. When a stock is selected which does not have a generic color assigned, PrintSmith 
checks the Stock Color table to see if there is a generic color for that stock color. 

If it finds one, it automatically assigns it to the stock definition. If the stock color in the table does 
not have a generic color, it will ask you to select one and will update both the Stock Color table and 
the Stock Definition with your selection.  
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Grade 

This field is used to indicate the stock grade description (#1 Coated, #1, #2, #3, etc.). You select 
the grade from a pop up list that appears when this field is selected. This table is the Stock Grade 
in the Table Editor. 

Coated 

This field tracks whether or not a stock is coated and on how many sides. Enter a 1 for stock 
coated on one side or a 2 for stock coated on two sides. 

Last Updated 

This field displays the date of the last change to any part of the stock definition you are viewing. 

Last Price Change 

This field displays the date of the last change to the stock definition which changed the costs or 
prices of this stock. This could be the result of using the Change Prices function or changing blank 
pricing in the Stocks and Sizes preference panel, not just changing the price directly in this window. 

 

Specification and Pricing panel 
Vendor 

The stock vendor is used to identify the vendor of the stock. The Vendor Table in the Table Editor 
controls it. If you purchase the same stock from multiple vendors, you should create additional 
stock definitions for each vendor. 

Stock # 

Enter the stock number used to order this stock from the indicated vendor. You can enter letters 
and numbers, up to 31 characters. 

Note:  It is possible to search the stock file for a stock with a particular stock number. To do this 
type “/” or “?” followed by the stock number while in a blank stock record. 

Stock Type 

This identifies the type of paper: Business, Book, Cover, Index, and Tag. In non-metric stocks, this 
is a critical piece of information because it determines the basic size of the stock. The basic size 
determines the M Weight, the Carton Weight and the CWT (hundred weight) Price. The Basic Sizes 
Table controls the contents of this menu. Generally, you should not modify this table unless you are 
certain of the changes. This table is already set up with all the common stock types and their 
associated sizes. 

Basic Size 

Basic Size corresponds to the Stock Type selection. This field cannot be edited and simply shows 
the size associated with the selected Stock Type in the Basic Sizes table. This size is used to 
calculate both the M Weight and the CWT price. 
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Parent Size 

The size of the stock you purchase from the vendor. For envelopes, use the Sizes Table in the 
Table Editor to set up common text descriptions such as #10. This also applies to international 
sizes: A2, A4, A6, etc. 

A quick way to enter a size from the numeric keypad is “17/28”. PrintSmith automatically expands 
this to “17 x 28”. 

M Weight 

This is the scale weight in pounds of 1,000 sheets of paper of a given size. The given size in 
PrintSmith is the Parent size in each stock definition. That parent sheet is compared to the basic 
paper size to determine the comparative weight or estimated M weight. The calculation for stock 
with a basis weight of 20 pounds in a 17 x 22 parent sheet that has a basic size of 17 x 22 can be 
calculated as follows: 

 

 

Thickness 

This field defines the thickness of the paper in one of 4 measurements: caliper, points, plies, or 
microns. Microns is used exclusively for metric stocks while the other three types of measurements 
are interchangeable and are used for certain types of stocks as follows: 

Table 6.1: Thickness 
Measurement Definition 

  

Caliper Caliper is the thickness of a paper measured in thousandths of an inch, traditionally 
applied to most printing papers which are between 0.001 and 0.008 inch thick. 

Points Points one point is the equivalent of 0.001 inch, traditionally used to indicate heavy 
card stock such as coated covers. 12 point cover is 0.012 inch thick (12 points x 
0.001in.) 

Ply Ply is traditionally used to indicate thickness of card or chipboard. A sheet of 6-ply 
board is 0.024 inch thick (multiply the ply value by 3 and add 6 to that result). 

Micron Micron the standard unit of thickness measurement for metric stocks. A micron is one 
millionth of a meter. 

  

 

Sheets/Carton 

The Sheets per Carton field is the number of sheets of the Parent Size in a single carton. Can also 
be used to specify the number of parent sheets in a skid. 
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Carton Weight 

If the Stock Type is properly selected or the stock is a metric size, and the Basis Weight is known, 
PrintSmith is able to calculate the M Weight. The M Weight is used to determine the weight of a 
carton (or skid). The formula for calculating the carton weight is: 

 

These two fields define the order information for a particular stock. The carton weight for 1,000 
sheets equals the M weight. If the carton holds only 500 sheets, the carton weight is half that 
amount. 

Minimum Order 

For stocks that can be ordered in any quantity, enter a 1 in this field. If the stock has a minimum 
order such as ream wrapped stock that can only be ordered in sets of 500, enter a 500 in this field. 
This ensures that the stock order and job ticket properly reflect the amount of stock to be ordered. 
In addition, it allows you to pass on the cost for ordering more stock than absolutely needed to your 
customer. 

Example: In the Production Data window in the Estimator, if a job requires 200 sheets and the 
minimum order in the stock definition is 250, 250 will display in the Sheets Purchased 
field. Note that although the number of sheets purchased may be greater than needed for 
the job, production charges are based on the number of sheets used in the job, not the full 
quantity purchased. 

Charge Customer for Entire Order 

Enabling this button for a particular stock, tells the Estimator to add the cost of the entire stock 
order to the stock charge of the job. This cost is marked up in the usual manner, but the additional 
sheets are not included in the charge for printing or copying. Using the previous example, the job’s 
stock cost will reflect the 250 sheet minimum purchase. 

Costing Units 

This is the quantity in which the stock is priced. Usually this is 1,000 since most stocks are priced in 
lots of 1,000. Envelopes often come 500 to a box and priced in that way. You can also break roll 
stock into sheets to price rolls. For example, if a roll costs $300.00 and 25,000 sheets can be cut 
out of the roll, you would enter 25,000 here and $300.00 as the cost of the stock. 

# sheets/set 

Used to define carbonless stock in pre-collated sets. If you have a 3 part carbonless stock, for 
example, you would enter 3 in this field. The Estimator can then automatically make the correct 
calculations based on the number of sheets in a set. 
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Cost Is In Sets 

This feature is intended primarily to enhance carbonless pricing.  When enabled, it indicates that 
the cost entered is for sets, not individual sheets. Changing the setting of this button automatically 
changes the cost of the stock. For example, a 2 part carbonless set is priced at $200.00 per 1000 
sets with this button turned on. Turning it off will change the price to $100.00, because the price is 
now based on half as many sheets. The Estimator will handle pricing for this stock correctly 
regardless of which setting you choose. We recommend setting it to match how each of your 
vendors specify the stock. 

Qty Breaks 

This is the maximum quantity of parent sheets for each column in the price table. For example, 
entering 1000, 2000 and 3000 in the first three columns tells PrintSmith to use the first column for 
the stock cost and markup for quantities up to and including 1000. The second column is used for 
quantities between 1001 and 2000. The third column is used for quantities greater than 2000. Make 
sure there is a quantity in this field for any column you want to use or PrintSmith will assume that it 
is not used. 

Cost 

Cost of the stock and the number of pieces you can buy at that price. Normally this is the cost per 
1000. Envelopes usually come in boxes of 500. In that case, use 500 for the units. 

CWT 

CWT stands for Hundred Weight Price. This field contains the cost for 100 pounds of paper 
regardless of size. Hundred weight pricing is a convenient way to compare paper prices for 
different stocks in different sizes. Although there is some variation within a given stock family for 
different size stocks, the CWT price is generally similar. You have a choice of entering either the 
CWT price or the Cost. Entering one calculates the other providing there is sufficient information 
available in the stock definition to make the calculation. 

In order to calculate the CWT price, the Basic Size and Weight must be known and be correct. 

Markup 

The stock markup is used by the Estimator to mark up the cost of the stock. If the markup in the 
first column does not appear to be overridden (overrides are shown in the outline face on 
Macintosh and underlined italic on Windows), you are actually looking at the standard stock markup 
defined in the Stocks and Sizes Preference panel. 

Normally you will leave it alone. Change it if you want a particular stock to be marked up differently 
from the standard stock markup you specified in Pricing Preferences. Enter a markup rate in 
columns 2 through 6 when the markup you want to use is different from the first column. Leave the 
markup field empty across the row unless the rates in columns 2 through 6 are different from the 
first. 

Note:  If you change the system default stock markup in Pricing Preferences, you change the 
markup for all stock definitions except those, which have been overridden. 

List/M 

Used to specify an additional price per thousand sheets for use with the List pricing method 
because list pricing does not factor in the stock cost when generating a price. The amount (plus or 
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minus) entered in this field is divided by 1000 and multiplied by the quantity ordered and added to 
the price of the job. 

Example: A price schedule is used for a stock, which costs $10.00 per thousand. You want to use 
it for a stock that costs $11.00 per thousand. You could enter $1.00 in “List/M” and 
PrintSmith would add 1.00 to each thousand ordered. 

Price Expires 

This information is only provided as part of importing stock prices from a third party stock vendor. It 
tells you whether the price shown in the stock definition is valid. If the price has expired, you will 
receive a warning message that the price has expired, however, you can still use the stock. 

Although we have defined this field as part of the Generic Vendor stock import data format, we 
know of no paper vendors that have implemented it. Our intention with this field is to support the 
idea that the paper price quoted by the vendor will be honored until the expiration date of the price 
in the stock definition. If your paper vendor supports importing into PrintSmith, you may want to ask 
them when they’ll support this feature. 

Comments 

Use this to keep track of notes related to the stock and ordering process. 
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Pricing Options panel 
The Pricing Options panel is used to set up specifications used by the Estimator to price jobs using 
this stock definition. 

Figure 6.4: Stock Definitions window, Pricing Options tab 

 

 

Normal Run Size 

This specifies the most common run size when you create a job using this stock definition. It is also 
used as both the run and finish size when generating a price list with the Price List button or the 
Generate Price Book command in the Pricing Menu. PrintSmith automatically calculates the 
number of sheets that can be cut out of the selected parent sheet. If you do not specify a run size, 
PrintSmith will assume that it is the same size as the parent size. 
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Cut/100 

Cut charge for each 100 parent sheets. This charge is added to the stock cost and is useful when 
the vendor charges for cutting parent sheets to the size you have entered in Parent Size. The cut 
charge is calculated including estimated waste and is added to the cost of the stock after the stock 
has been marked up. The cut charge itself is not marked up. 

Note:  For best results, we recommend adding a Pre Press cutting charge instead of using 
Cut/100 since a charge is much more “intelligent” about how many cuts and lifts are 
needed. 

Min. Cut Chg 

Used in conjunction with “Cut/100” to specify a minimum charge for cutting. If there is no Cut 
charge specified, the minimum is added to the stock for all quantities. 

Select Press for Printing 

The Select Press for Printing allows you to preset a press definition for use with a particular stock. 
When you select a stock definition that has a preset press, PrintSmith assigns the press to that job 
and adds any charges that are preset in the press definition. Selecting a stock definition without a 
preset press will assign the “default” press, the first press in the definition list. 

PrintSmith is designed so that you can use the press definition as a way of defining a production 
environment. If you know a stock will always be used in a particular production environment, you 
can create a press definition and preset the press for each stock definition to which it applies. 
Some good examples are carbonless forms and envelopes. 

Use the press pop up menu to select a press. The first item in the press menu is “<use default>”. 
Select this if you do not want a preset press. The default press is set in Press Definitions. 

Schedule for List Pricing 

To use list pricing with more than one price schedule, you must tell PrintSmith which price schedule 
to use with each stock. To select a price schedule, click this button and select the schedule from 
the list of the currently defined price schedules, which is displayed. If you select a stock in the 
Estimator, which does not have a preset schedule, PrintSmith will warn you and will use the default 
price schedule, which is the default List price schedule. 

When a price schedule has been assigned to a stock, its name is displayed to the right of the 
button. To remove a preset schedule, click the Select Schedule button and then click the Cancel 
button when the schedule list is displayed. 

Pricing for Blank Sheets 

Blank pricing has six prices for six different quantity breaks, each of which can be based on the 
cost of the stock at a different markup. As shipped, these quantity breaks are 1, 10, 100, 500, 1000 
and 5000, but you can change the quantity breaks and markups to anything you like in each 
definition. 

You may also change the system default values using the “Stocks and Sizes” preference panel. 

PrintSmith calculates the price for blank stock at the defined quantities using the standard markups. 
If you change the quantities in the stock definition, PrintSmith will calculate the price using the 
quantities you entered with the markups from the Stocks Preference panel. 
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Auto Calculate Blank Stock 

The blank stock pricing style relies on pre-calculated prices that are based on the cost of the stock. 
This button turns automatic calculation on and off for the stock shown in the window. Turning this 
button off and then on causes auto-calculation to be performed for the current stock definition. 

The Auto-Calculate button allows you to specify, for each stock, whether or not you want PrintSmith 
to maintain these rates for you automatically. We recommend that you leave this button turned on 
unless you have very specific pricing targets for blank stock that do not depend on the stock cost. 

Any change to the stock price triggers automatic calculation. The price is calculated for the run size 
based on the parent size. 

Note:  Changing blank stock preferences do not recalculate blank sheet pricing. You can use the 
Change Prices command to update prices for all stocks. 

Adjust Copier Matrix and Select Default Copier 

PrintSmith supports several pricing models for copying. One of the important options in these 
pricing models is the ability to specify how stock is priced. In some models the price is taken 
directly from the cost of the stock. In others it may be necessary for each stock to have a stock 
price for copying that differs from its actual marked up cost. 

The Copier 1 and Copier 2 rates are provided to allow you to have different stock costs for copying 
on each stock definition. The rate that is used for pricing depends on the copier definition used for 
the job. Because each copier definition can use either of these fields you should decide how each 
is to be used. For example, a common method of using these fields is to use Copier 1 for black and 
white copies and Copier 2 for color copies. 

Note:   “Copier 1” and “Copier 2” are actually based on the name of the two copying pricing 
methods. These pricing method names can, and often are changed. This section may look 
somewhat different on your system. 

Each stock can have a preset copier for each of the two copier pricing methods. To preset a default 
copier, select the copier from the pop-up menu. When a stock with a preset copier definition is 
selected in a copier job, PrintSmith assigns the copier to that job and adds any charges that are 
attached to the copier definition. Select “<use default>” to remove a preset copier. 

Add Charges 

Each stock definition can have up to 10 preset charges. This button allows you to edit the preset 
charge list. When charges are already assigned to the stock definition, the number of charges is 
displayed as “(1) Charges…” the number in parentheses, indicates the number of preset charges.  

Import One Stock 

Use this button to import a single file containing a single stock definition, which will display in the 
window for immediate editing. The data file must contain a single stock record that was exported 
from the XPEDX Printer’s Product Guide or other paper vendor. The location of the file and file 
format must be set up in the Import Stock Catalog command.  
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Inventory panel 
The Inventory panel is used to set up stock as inventory items. 

Figure 6.5:  Stock Definitions window, Inventory tab 

 
 

Stock is standard inventory item 

Selecting this option activates the Inventory tab fields so that the stock can be entered as an 
inventory item. 

Stock on Hand 

The amount of stock that is currently in inventory. 

Committed 

The amount of stock committed to current jobs that have not yet been run. 

Note:   Committed stock can be manually entered or automatically calculated.  As stock is 
selected and assigned to a job, the committed number will increment.  Stock committed 
prior to the stock being defined as a standard inventory item will not affect the inventory 
count. 

Stock inventory 
information 

Recent 
inventory 
changes 

Show Entire History 
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Available 

The amount of stock that is available.  This field is not editable and is the difference between Stock 
on Hand and Committed. 

On Order 

The amount of stock currently ordered. 

Target Level 

The desired amount of stock to keep in inventory. 

Reorder Point 

The “trigger-point” at which new stock should be ordered. 

Min. Order Qty. 

The minimum amount that can be ordered at one time. 

Stock Expires 

Enter the expiration date of the stock, if applicable.  The default value is <never>. 

Bin Location 

An identifier for the stock storage location. 

Shell Item 

If this item is a shell item created by the shop for use in another job, check this box and optionally 
Assign Customer Account. 

10 Most Recent Inventory Changes 

A static list of the 10 most recent inventory changes.  Clicking the Show Entire History button 
opens the complete Inventory History window. 
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Press Definitions 
Press definitions are a key component of PrintSmith’s powerful estimating engine. In press 
definitions, you define key variables of your company’s pricing practices that influence profitability. 

Setting Up Press Definitions 
The Press Definition window is where you enter the types of presses you have and define their 
running characteristics. While you may only have a few presses in your shop you can define 
several presses to accommodate differing pricing characteristics of a given job. For example, tight 
registration, coated stock, carbonless forms, etc. can all run on the same press but one may run 
slower, or take longer to set up, or require more waste. You can define up to 100 press definitions. 

Select Press Definitions from the Pricing menu.  The Press Definition window opens. 

Figure 6.6: Press Definitions Window 
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To print a report of all press definitions, select the Print command from the File menu. 

Figure 6.7: Press Definitions Report 

 

The report lists each press definition, its labor rate, labor markup, set up times, speed table, waste 
chart, wash up charges, and attached charges. 

Review the press definitions in PrintSmith. The Machine ID field in PrintSmith allows you to group 
press definitions for reporting work in progress. For example, you may define four different press 
definitions for your Heidelberg Quick-Master but only have one actual press. Enter the same 
Machine ID in those four definitions and you will be able to view work in progress for all four 
presses even though there is one piece of equipment. 

The name of the press helps the user understand the specifics and assists them in selecting the 
correct press for the job. Name your presses to reflect the situations in which you will use them. 

Define the maximum paper size that can be run on this press. PrintSmith will warn you if the paper 
selected for a job exceeds the maximum paper size. 
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For each press, you can define average impressions per hour or attach a variable speed table. The 
speed table lets you adjust the speed of the press based upon quantity produced. You can also 
attach a waste chart to each press definition. If no waste chart is attached, the press definition uses 
the default waste chart. 

Note:  It is recommended that you title Speed tables and Waste charts with a name that matches 
their characteristics (i.e. High Waste, Slow Speed, A.B Dick 9870, etc.). 

PrintSmith allows you to attach up to 10 charges on each press. Whenever the press is selected, it 
will add those charges. For example, you could add Metal Plates, Ink, and Cutting to each press 
and they would be automatically included on all jobs estimated with that press definition. 

PrintSmith allows you to track the sales generated from each press into a specific sales category.  

Example:  The following window shows the assumptions for a press named Hamada H234. 
Figure 6.8: Press Definitions Hamada H234 example 

  

Verify the speed and waste tables by clicking on their respective buttons. Change the rates to meet 
your requirements. 

Click the Charges button to see which charges are attached. Add more, remove, or accept those 
assumptions. You can attach 10 charges to any one press. 

Developing Press Definitions should be a quick process. If you define the presses before you enter 
your stocks, you will be able to assign a press definition to the paper definition in the set up. 

A custom speed 
table and weight 

chart are 
assigned 

Three 
charges are 

attached. 

This information will 
be used as the 
basis for costing 
printing jobs. 
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Note:  Plate fees should be added by attaching a Pre press charge. 
PrintSmith uses press definitions to determine production costs for jobs using the Printing pricing 
method. Press Definitions are also used with List pricing to estimate the run time of a job for the 
Work in Progress report. 

You can define up to 100 different press definitions. A press definition defines how the job is run, 
the labor rate, press speed, waste, markups and preset charges. A press definition is not 
necessarily related to a single machine. You might have a special press definition for carbonless 
forms, envelopes, business cards, coated stock and so on.  

The buttons at the bottom of the window are used in conjunction with the selected press definition: 

Figure 6.9: Press Definitions buttons 

 
Add/Change  

This button is used to save the current contents of the window. If you are creating a new press 
definition, it will add it, if you are working with an existing definition, it will change it. 

Stock Price List  

The Stock Price List button allows you to generate a price list for any press definition. Before the 
price list is generated, you select the stock to be used with the press definition. It is particularly 
useful to tune your press definition for a particular stock without continually going back and forth 
between stock and press definitions. 

Press Price List  

The Press Price List button allows you to generate a price list for any press definition. This price list 
is exactly the same, as the one generated from Stock Definitions except it does not include a stock 
price. Use this to generate production price lists. These price lists can be useful for manually 
calculating an approximate price for a special order paper. 

Delete  

Deletes the selected press definition. 

Clear/Close  

If you have selected a definition, the Clear button erases the information leaving you with a blank 
window so you can create a new definition. The Close button closes the Press Definition window. 

Default Press Selection in the Estimator 
Set the Default Press by clicking in the Default column to the left of the press. This default is the 
press that PrintSmith uses when the stock definition does not have a preset press.   
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Managing Press Definitions 
When the window first opens, you are ready to create a new press definition. To create a definition, 
fill in the data and click the Add button. After saving the press definition, the window clears so you 
can add another definition. The new press definition resides at the bottom of the list. 

Selecting an Existing Press Definition 
The top part of the window contains a list of the existing press definitions. Clicking once on any 
item in the list displays the definition. The Add button now reads Change because an existing press 
definition is selected. To update the definition, click the Change button. 

When a press definition is displayed, there is a Clear button, selecting it clears the definition from 
the window and presents a blank record so you can add another press. The button label then 
changes to read Close. Selecting it closes the press definition window. 

Creating a New Press Definition 
When the Press Definitions command is first selected, the window opens with an empty press 
definition. You add a press definition by filling out the text boxes and clicking the Add button. If the 
button in the lower left hand corner is the Change button you must first click the Clear button to get 
a blank definition. You can also use the New command in the File menu. 

Changing an Existing Press Definition 
To change a press definition, first locate the press in the list of presses at the top of the window. 
When you find the press you wish to change, click on the name and PrintSmith will display the 
definition. After you have made your changes, click the Change button to save them. 

Copying an Existing Press Definition 
The easiest way to duplicate a press definition is to select it, hold down the Option/Alt key, and 
drag the press you want to copy to a new location in the list. When you release the mouse, the 
press is copied. Enter a new name and save the changes. 

Existing Press Definitions can also be copied by selecting a press definition and clicking the Clear 
button or select the New command in the File menu. This action sets up a new untitled definition 
using exactly the same parameters as the definition you want to copy. Type in a new name and 
click the Add button. 

You can also use Edit menu commands to copy and paste definitions. To do this, click on the 
definition to be copied, select Cut or Copy from the Edit menu. Click the Clear button, and then 
select the Paste command from the Edit menu. 

New Definitions are added to the end of the list. You can use drag and drop to reorder the list. 
Refer to the Organizing Press Definitions section, page 258, for more information. 
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Deleting Press Definitions 
Find the press definition in the list and select it. When the definition is displayed, click the Delete 
button. 

When first setting up your pricing system you can safely delete any press definition. After you are 
up and running, we recommend more caution when deleting definitions. You can still delete any 
press definition. But you may want to keep definitions that have been used as a preset press in a 
stock definition or by the estimator in a job. 

If you would like to retain a definition but no longer use it, we recommend moving it to the end of 
the list. When you create a press job, a press definition is selected. When the job is saved, the fact 
that this particular press was used is part of the job. When the job is copied to a new invoice or 
changed in any way, PrintSmith selects the press definition from the pricing system and uses it to 
adjust the price. PrintSmith can find the definition even if you have changed the name or location in 
the press list, but not if it was deleted. When this occurs, PrintSmith warns you that the definition is 
missing and that a press needs to be selected. 

If you preset a press selection in a Stock Definition and then delete that press definition, PrintSmith 
automatically selects the default press. The user may not recognize this and an incorrect price 
could be given to the customer. 

On the other hand, if you make major changes to the pricing system, you may want to call attention 
to the fact that deleting some press definitions changed pricing. When you use an old job that was 
priced with the “old” pricing system, the Estimator will warn you and recommend changing 
definitions. At this point, the user can select the proper press from a list. 

Organizing Press Definitions 
To change the position of a press definition in a list, click (and hold) on the press name and drag 
the entry to the desired position in the list.  Repeat this operation as often as you like until all of the 
presses are in the order you want.  
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Press Definitions Data 
The press data entered is used by PrintSmith to estimate the amount of time needed for the job 
and the labor rate to apply. It determines the amount of setup time, the speed of the press, etc. 

Name  

The Name field can hold up to 50 characters, identifying the press. 

Machine ID 

The Machine ID is a number from 1 to 255, identifying the machine. If you use more than one press 
definition for each real machine, you can identify the machine with a number. 

The Machine ID is used by Work In Progress to sort jobs by the machine the order will be run on, 
rather than the press definition name used to price the job. 

Machine Name 

Select the Machine Name from a dropdown list.  Machine names are defined in the Production 
Presses table.  The Machine Name displays on the Job Ticket. 

Integrated device 

A future enhancement will allow presses to integrate with third party devices. 

Output Description 

Enter a description for the type of output for this printing process.  The Output Description will 
appear on the Job Ticket. 

Production Location 

The Production Location field supports the Tracker Module.  Production Locations are defined in 
the Production Locations table. 

OEM Device ID 

The ID by which the device will be identified. 

Max Paper Size / Min. Paper Size 

These fields are used to indicate the larges/smallest size paper that can be run on the press. The 
Estimator uses this to check for an improper press specification. You can leave it blank if this is not 
important to you. The Estimator will still allow you to specify a press with a smaller/larger run size 
but will remind you that the run size is larger/smaller than that allowed by the press. 

Avg. Impressions  

The Average Impressions field defines the speed at which the press usually runs. The Estimator 
uses this value to determine how long it will take to run a job. You can override this value for a 
particular job in the job’s Production Data window. If you define a speed table for the press, the 
amount entered here is ignored, replaced with the word variable and the speed is taken from the 
table. 

Labor Rate  

The Labor Rate is the cost per hour to run the press. This value is used as the cost basis in the 
costing system. 
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Labor Markup  

The Labor Markup field is the mark up on the labor rate when generating the production component 
of a print job price. The markup is multiplied by the labor rate to determine the charge for labor. 
This value is used as profit in the costing system. 

Minimum Labor  

The Minimum Labor field indicates the minimum number of labor minutes assigned to a job. Use 
this field when you want to charge a penalty for short runs on a particular press or establish a 
minimum price for using this press. 

Fixed Waste  

Fixed Waste is the number of sheets of spoilage to add to all jobs that use this press. This value is 
in addition to waste calculated as a percentage of the run, which is determined by a waste chart. 

Setup  

Setup is the number of minutes usually required to prepare the press for the first run of a job. 

# Heads  

The Number of Heads field is the number of print heads (impression cylinders) on the press. This 
field determines the number of passes needed to print a number of colors specified in the job. 

Setup Add’l Head  

The Setup Additional Head field records the additional time needed to prepare each additional print 
head on multi-color runs. (PrintSmith ignores unneeded heads.) 

Setup Add’l Run  

The Setup Additional Run field records the additional time needed to prepare for an additional run. 
This value should include the time for a plate change and run up. The Estimator uses this value for 
all passes after the first one. 

Washup Fee  

The Washup Fee field records the dollar amount charged for each wash up. You specify the 
number of wash ups for each job.  

Work & Turn 2nd side setup 

The time it takes to turn stock over, reload it in the press, and register the 1st side to the 2nd side 
without changing a plate. 

Washup Minutes 

The time it takes to do the Washup of the press. 

Note: Do not use Washup Fee and Washup Minutes in the same Press Definition, as it will add 
both prices together in a job. 

Speed Table  

Generally, the longer the press run, the closer a machine gets to its rated speed. Because the 
press speed increases on long runs, it is more efficient and cheaper to produce each piece. You 
can use the speed table button to create a speed curve that adjusts the press speed for the length 
of the run. Refer to the Managing Speed Tables section, page 264, for additional information. 
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Waste Chart  

In addition to the system default waste chart, PrintSmith lets you define waste charts for each 
press. Refer to the Managing Waste Charts section, page 268, for additional information. 

Add Charges  

Each press definition can have up to 10 preset charges. The Add Charges button allows you to edit 
the preset charge list. If charges are already assigned to the press definition, the number of 
charges displays on the button as “(1) Charges…”. Refer to the Adding Charges to Press 
Definitions section, page 262, for additional information. 

Sales Cat  

You can assign each press definition to a different sales category. This assignment is useful if you 
want to separate certain types of jobs in your sales summary based on the press definition used for 
the job. Use the Sales Cat pop up menu to select a sales category. 

Roll Fed / Perfector  

Checking the Roll Fed / Perfector option changes the method PrintSmith uses to calculate the 
number of passes in a job. On a normal press, an additional pass is needed for each side. On a roll 
fed press (with more than one head) or a perfector, you can print on both sides of the stock in a 
single pass. If this button is enabled, PrintSmith will calculate additional passes only when the total 
number of passes exceeds the number of heads available. In this context, 1/1 (one color front and 
back) is the same as 2/0 (2 colors front, none on the back). Likewise, on a 4 head press, 4/0, 3/1 
and 2/2 all price the same way. Refer to the Setting up Perfectors and Roll Fed Presses section, 
page 272, for additional information. 

Gripper Edge 

The Gripper Edge value is the amount of space required on one feed edge of the run sheet for the 
press to pick up the paper. 

Target Pricing  

Each press definition has its own Target Pricing table. Target Pricing is a method of adjusting cost 
based pricing for market conditions at any quantity or job type. You can be as specific in adjusting a 
price for 1/1 pricing, a quantity of 1000, to exactly $15.15 while leaving all other prices unchanged. 
Then, when your costs change, the price is automatically adjusted while maintaining the same 
margins and market position. Refer to the Target Pricing section, page 272, for additional 
information. 
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Adding Charges to Press Definitions 
Charge definitions add a tremendous amount of flexibility to the PrintSmith Estimator. The charge 
definition commands (i.e. Pre Press, Bindery, Production, Merchandise, Mailing Services, and 
Miscellaneous) can hold up to 60,000 different charge definitions. You can select any 10 of those 
charges and attach them to a press definition. When you select a press, the preset charges are 
automatically loaded. If you change to a different press, the charges that are attached to the old 
press are discarded and the new set of charges attached to the new press is loaded. 

To add charges to the preset charge list, click the Add Charges button. The Charge Selector 
window opens. 

Figure 6.10: Charge Selector window Figure 6.11: Charge Selector window   
      with Assigned Charge 

          
 

The window is divided into two sections, the top section is used for making new selections and the 
bottom section displays the current selections and is used to remove preset charges from the list. 
The top part of the window presents a hierarchy. At the top level are the charge commands. Below 
each charge command is a list of the categories defined in the command window. Below each 
category are the charge definitions themselves.  

Double-clicking on one of the charge definitions adds it to the bottom of the list. You can preset up 
to 10 charges, which will display in the bottom of the window. You can remove a preset charge by 
selecting it and clicking the Remove button. When a charge is attached to a press, the charge itself 
is not copied. The press definition remembers where to find the charge. If you change a charge 
definition, PrintSmith uses the latest definition when the charge is added to a job. 

Click the Close button when you have finished attaching selections. 
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Strategies for Using Preset Charges 
The biggest advantage to using preset charges is that it gives you the ability to quickly generate 
complex quotes in a consistent manner. Often, this means that complex quotes can be delegated 
to less knowledgeable employees with a much greater degree of confidence. It also can serve as a 
tickler – preset all the most common charges to each press and when entering a job, the user can 
delete any that do not apply to a particular job. It is often easier to recognize elements in a job that 
should not be there, than it is to see what you have forgotten to add. 

For example, if you are producing many direct mail jobs, you could add a metering charge to a 
press definition set up for envelopes. This may even prompt the user to go back to the customer 
and ask if they want the envelopes metered which may increase the value of the order. There are 
many different strategies for defining press definitions and deciding what, if any, charges should be 
preset in the press. 

One of the most common uses for preset charges is to add plates. When a press definition is 
selected you already know what kind of plate the job requires. If you use both metal and paper 
plates on the same press, it is a simple matter of setting up press definitions to match your decision 
process. A press definition such as “AB Dick - Metal” or “AB Dick – Tight Registration” and another 
“AB Dick - Normal” might be all you need to separate jobs requiring metal plates from jobs requiring 
paper plates. If you have different presses, presetting a plate charge with the proper sized plate 
eliminates a step in the estimating process. 

Be consistent in your use of preset charges. If only some of your press definitions have negs and 
plates automatically attached, expect the person entering the job to experience some level of 
confusion. Preset plate charges on all press definitions. 

The key is to title the press definition as appropriately as possible and attach the basic charges that 
make sense to the user. Group similar press definitions together in a well organized manner so it 
makes sense and is easy for your staff to make a selection. 
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Managing Speed Tables 
Speed tables let you set up presses with realistic throughput based on the length of the job. 
Generally, the longer the press run, the closer the machine can come to its rated speed since there 
are fewer stops for adjustment on a long run once the job is running properly. 

PrintSmith allows you to define speed tables that you designate in a press definition. When you add 
a speed table, the press is termed a variable speed press because PrintSmith uses the speed table 
to look up the speed based on the length of the job. 

There are two steps to setting up a variable speed press: creating the speed table and assigning it 
to the press. 

Figure 6.12: Press Definitions Window Speed Table Example 

  
 

Once a speed table has been assigned to a press definition, the Speed Table name is displayed to 
the right of the Speed Table button. Clicking the Speed Table Name opens the table for editing. 

 

“Variable” means that 
speed is calculated 
based on job length. 

Speed Table button 
used to select tables 

to be assigned or 
edited. 

Name of Selected 
Speed Table 
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Creating a Speed Table 
If the press does not have a speed table, clicking the Speed Table button displays a list of all the 
speed tables. 

Figure 6.13: Speed Table List Window 

 
You can create an unlimited number of speed tables. However, you are probably able to operate 
with just a few since you can assign the same table to more than one press definition. The Save As 
command in the File menu can be used to copy a speed table and give it a new name. 

Note:  Changing a speed table in any press definition changes the base table, which may be 
attached to other press definitions using that table. 

Clicking the New button opens the table definition window. 

Figure 6.14: New Speed Table 

 
This window is used throughout the pricing system to set up price lists. It is also used for waste 
charts. In this context, the window is used to specify the name of the speed table. For speed tables, 
PrintSmith determines the button settings and only the Interpolate button can be changed. 

Usually this window is much smaller, use the zoom box to change the size of the window and show 
or hide these configuration details. 

Assign Table 

Clear Assignment 

Create New Table 

Delete Selected Table 

Closes Window Without Performing 
An Action 
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Interpolation 

Note the setting of the Interpolate button. Because it is enabled, PrintSmith calculates intermediate 
values if the quantity being looked up doesn’t exactly match a quantity in the table. For example, if 
you had a table with a quantity of 1000 and a speed of 4000 and the next entry in the table had a 
quantity of 2000 and a speed of 5000 and you wanted to find the speed for a run of 1500, 
PrintSmith would return a speed of 4500. Because 1500 is exactly in the middle of 1000 and 2000 
quantities, the speed, 4500, is half the difference between 4000 and 5000. You can, if you wish, 
disable this button. If it is disabled, the speed jumps to the next entry with no intermediate values. 
This setting can result in the price for 1100 being less than the price for 1000 - so we recommend 
you leave it enabled. 

Entering Data in Speed Tables 
After entering the name of the table, enter the quantities and speeds, click the OK button and the 
new speed table is created. 

Figure 6.15: New Speed Table example 

 
As the quantity increases, so should the press speed, reducing the unit labor cost on longer runs. 
The entire list need not be used. At least the first two lines must be defined. 

You can specify up to 15 different quantity/speed combinations. When you enter the quantities, 
they should be sequential with the smallest quantity at the top of the list and at least the first two 
quantities are specified. The maximum quantity does not need to be the largest quantity you will 
ever run. When the quantity in the job is larger than the largest value in the speed table, the last 
speed in the table is used. 

Normally, the press speed should increase at higher quantities, but it does not have to. You could, 
for example, reduce the effective speed when the quantity reaches the point where the press 
usually has to be reloaded. Higher press speeds result in shorter run times and a smaller labor 
charge. 

<tab> key changes column 

<return> key changes line  

arrow keys on keyboard 
change selection 

The first zero quantity 
denotes the end of the 

list. 
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Modifying a Speed Table 
Once a table has been assigned to a press, click the name of the assigned table to open. You can 
change the speed table and click the OK button to save the changes. 

Note:  Remember, the speed table may be used by other press definitions and any changes you 
make, affect those press definitions too. 

Changing the Selected Speed Table 
To use a different speed table, click the Speed Table button. PrintSmith opens the Speed Table list. 
Select a speed table, or click the Clear button to remove the existing speed table assignment. To 
see a graphical representation of a speed table, hold down the <option> key on Macintosh or the 
<alt> key on Windows and the <shift> key when you click on the Speed Table name. 

Changing the Name of a Speed Table 
In order to change the name of an existing speed table, you must open the speed table. If it is 
already assigned to a press, select the press definition and then click the speed table name. If it 
has not been assigned to any press yet, you must assign it to one at least temporarily.  

When the window is open, click the zoom box in the upper right had corner of the window title so 
the name of the table is visible in an edit field. Click the edit field and type in a new name. When 
you click the OK button, the name is changed. 

Note:  Changing the name of a speed table automatically changes the speed table name on all 
press definitions using that table. 

Deleting a Speed Table 
To delete a Speed Table, click the Speed Table button. When the Speed Table list opens, select 
the Speed Table and click the Delete button. 

Note:  Remember, the speed table may be used by other press definitions. Before deleting a 
speed table, make sure it is not being used by any other press definition. 
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Managing Waste Charts 
Even though there is a system wide waste chart, PrintSmith recognizes each type of press can 
have different spoilage characteristics. To support this, each press definition can have its own 
waste chart. 

The procedures for managing waste charts are nearly identical to those used for speed tables. 
There are two steps to setting up a waste chart for a press: creating the waste chart and assigning 
it to the press definition. Once a waste chart has been assigned to a press definition the name of 
the waste chart is displayed to the right of the Waste Chart button. 

Creating a Waste Chart 
If the press does not currently have a waste chart, clicking the Waste Chart button displays a list of 
all the waste charts in the system. 

Figure 6.16: Waste Chart List Window 

 
You can define a waste chart for each press; however, it is likely that you will be able to operate 
with just a few waste charts. You can assign the same waste chart to more than one press 
definition. 

Note:  Changing a waste chart in one press definition changes it in all the press definitions using 
that chart. 

 

Assign Selected Waste Chart 

Clear Assignment 

Create New Waste Chart 

Delete Selected Waste Chart 

Closes Window Without Performing 
An Action 
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Clicking the New button opens the Waste Chart definition window. 

Figure 6.17: New Waste Chart 

 

This window is used throughout the pricing system to set up price lists. It is also used for speed 
tables. For waste charts, the button settings are determined by PrintSmith, and cannot be changed. 

Note that the Interpolate button has been grayed out and cannot be changed. Because it is 
enabled, PrintSmith calculates intermediate values if the quantity being looked up does not exactly 
match a quantity in the table. The result is a smooth curve. 

Figure 6.18: New Waste Chart Example 

 
 



EFI PrintSmith 7.2 |  Reference Guide 

 
 

 
Page 270 

The entire list must be used. Run length must increase from top to bottom. As the quantity 
increases, the waste percentage should decrease in small enough increments. Avoid the number of 
wasted sheets becoming smaller on longer runs. 

A complete waste chart consists of 15 quantity/percentage combinations. The maximum quantity 
does not need to be the largest quantity you will ever run. When the quantity in the job is larger 
than the largest value in the waste chart, the last percentage in the chart is used. 

Use the Print command in the File menu to print a waste chart. 

Modifying a Waste Chart 
Once a chart has been assigned to a press, click the name of the waste chart to open it. You can 
change the waste chart and click the OK button to save the changes. 

Note:  Remember, the waste chart may be used by other press definitions and any changes you 
make, affect those press definitions too. 

Changing the Selected Waste Chart 
To use a different waste chart, click the Waste Chart button. PrintSmith opens the Waste Chart 
List. Select a new chart, or click the Clear button to remove the existing waste chart assignment. 

Changing the Name of a Waste Chart 
In order to change the name of an existing waste chart, you must open the waste chart. If it is 
already assigned to a press, select the press definition and then click the Waste Chart Name. If it 
has not been assigned to any press yet, you must assign it to one at least temporarily. 

When the window is open, click the zoom box in the upper right had corner of the window title so 
the name of the table is visible in an edit field. Select the edit field and enter a new name. When 
you click the OK button the name is changed. 

 

Overview of Press Definitions and Estimating 
The press definition is used in the Printing and List pricing methods in the Estimator. A press will 
always default in these jobs, but you have complete control over which press definition is used in 
any job and can change it at any time. When you select a stock from the stock list, if there is a 
press definition designated in that stock definition, that press is used in the job. If there is no press 
designated in the stock definition or the job is for customer stock or special order, the default press 
will be selected. 

One obvious use for press definitions is to describe the various machines in your shop. Perhaps 
less obvious is that the press definition is another way of describing how a particular stock or job is 
run – how hard it is to set up, how fast it can run, and so on. With this in mind, alternative uses for 
the press definition could be to describe classes of jobs such as business cards, carbonless, and 
so on. The press definition then is used to describe the running characteristics of a particular job. It 
is also possible to use press definitions to specify production characteristics of some copiers 
although copier definitions are usually better suited for this purpose. 
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Determining Press Production Values 
Your press definitions are very important, as labor is often the largest component in a printing job. If 
you use a price list from one of the commercial price list bureaus or from a franchise, you may not 
have a clear idea what your production values are. This section provides some guidelines for 
developing these factors. 

First let’s examine the formula that PrintSmith uses to calculate the labor component of several 
types of jobs. For readability, some of the factors will be abbreviated as follows: 

• aimp = 5000 Average Impressions/Hour 

• rate = 50.00 Labor Rate 

• markup = 1.5 Labor Markup 

• setup = 12 Initial set up time (minutes) 

• head = 5 Setup Add’l Head (minutes) 

• run = 8 Setup Add’l Run (minutes) 

• waste = 10% quantity x waste percent x number of passes (the waste percentage is taken 
from the waste chart) 

Calculating Your Labor Rate 
One way to calculate a reasonable labor rate is from your last 12 months income statement or 
budget if you are just starting out.  Add up all of your overhead items such as rent, utilities, phone, 
etc., adjusting them for any anticipated increases.  Then add up all your payroll expenses for non-
production employees, such as CSRs and accounting people, including a fair wage for you, and 
adjust the total for anticipated raises, taxes, benefits, and changes in work force. The markup on 
the base salary is usually between 20% and 40%.  This amount gives you a projected total for 
overhead and labor for the year.  Divide this number by the hours available in a year, which for one 
shift is usually 2,080 hours.  That gives you the overhead cost per hour.  You then need to assign a 
percentage of the hourly cost to each piece of billable equipment.  Usually prepress and bindery 
are by the department and press and copiers are by each piece of equipment.  You can either 
determine these numbers by percentage of sales or square footage of the equipment. 

Then, determine the hourly rate for each production employee, such as pressman, prepress and 
bindery personnel. Start with the base hourly rate for each employee. Add to that a markup 
percentage to account for vacations, holidays, sick leave FICA matching, etc.  The markup is 
usually between 20% and 40%. 

The next step is to figure the replacement cost for each piece of billable equipment you have, such 
as presses, copiers, and bindery equipment.  To do this, take the replacement cost divided by the 
depreciation years, divided by 2080.  It is recommended that you depreciate prepress equipment 
by 3 years, press by 7 years, and bindery by 10 years. 

Now, add up the overhead, labor, and equipment costs for each of the departments or pieces of 
equipment to get a total cost. 

The final step is to determine just how efficient your shop is, that is, how much of this time can 
actually be charged to customers. In a very well run, very busy shop you may be able to charge 
70% of these hours to customers. In a new or recently expanded business, it may be as low as 
40%. A good figure to use is 60%. Whatever percentage you decide on, divide the hourly cost rate 
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by the percentage (e.g. 25.00 /.60 = $41.66). This total is your Budgeted Hourly Rate and is what 
you should be using for hourly labor charges. 

Once you have this number, you should only have to review it when you are contemplating a price 
increase or if your business has changed significantly. This number is the only detailed calculation 
needed to set up press pricing in PrintSmith. PrintSmith will now tell you what your actual return is 
for each press and non-press hour. 

Note:  A quick way to find your labor rate is to multiply your average employee count by the 
number of hours you are open for business in a given period. Then divide your total 
expenses for this period by total hours and mark that up by your desired Gross Profit 
percentage. An even quicker way is to just take revenue for the period and divide by total 
hours. Neither method is foolproof, but both are useful ways of getting a “ball park” figure if 
you want to get started quickly. 

Setting up Perfectors and Roll Fed Presses 
As far as PrintSmith is concerned, the only difference between these presses and regular sheet fed 
presses is that they can print both sides of a sheet at the same time. The stock definitions for roll 
stock should be based on the sheet size as it comes out of the press. The stock price would be the 
price for a roll with units set to the approximate number of that size sheets you can get out of the 
roll (e.g. $350.00 in units of 25,000). Units is limited to a maximum of 32,000 - should that become 
a problem simply divide both by 10. In the previous example you would change the price to $35.00 
per 2,500. PrintSmith will generate exactly the same prices. 

In general, the only difference between 4/0 (4 colors front, none on the back), 3/1 and 2/2 on a 4 
color roll fed press is in how the press is set up. As far as the press definition is concerned, simply 
make sure that the Roll Fed button is enabled in the press definition so PrintSmith will not charge 
for an extra pass to print on the second side if there are enough heads to do it in one pass. 

PrintSmith does not fully support perfectors. In most cases, it will estimate correctly with the Roll 
Fed option enabled. A 1/1 job with 2 heads is OK, but a 2/0 may not be if your press is not capable 
of running it in one pass because PrintSmith will only estimate 1 pass which is always correct for 
roll fed. 

Target Pricing 
Over the past years, PrintSmith has worked with thousands of printers to adapt PrintSmith to many 
different pricing systems. What we have observed is that many printers have a good idea of their 
costs and a good idea of the value of the printing they produce in their market. Many times, the 
value (what your customer is willing to pay) of the printing has little or no relationship to your costs. 
Target Pricing was developed on the following assumptions: 

• Identifying and tracking costs for producing work is a good idea. 

• The price a customer is willing to pay for the work you produce may not reflect your costs 
to produce it. 

• Your pricing system should incorporate your costs and generate competitive prices at all 
quantities. 

• As your costs change, these costs should be reflected in your retail prices. 
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Target pricing allows you to set up a pricing system that recognizes actual costs, generates prices 
based on market value at any quantity and automatically adjusts prices for changes in costs while 
still retaining a competitive orientation. This is accomplished using a target pricing table shown 
below. 

Figure 6.19:  Target Pricing window 

         
 

 

The target pricing table gives you one place where you can look at an array of prices generated by 
PrintSmith using your specifications. You can review prices for single sided, multicolor, and process 
color work for up to 15 price points and adjust them. When reviewing these prices, it is also 
important to analyze the results to see how this changes your estimated profit. 

Note:  When reviewing these prices you must understand that what we show as profit is really 
just the difference between estimated costs and generated price. To the extent that you 
have identified all costs in your pricing system, it will be generally accurate, but actual 
profits can only be reasonably determined from a Profit and Loss Statement over a period 
such as a month, quarter, or year. 

If you think that the price PrintSmith generates for a particular quantity in any column is too high or 
too low, simply type in a new price. When you press <tab> or <return>, the table is recalculated 
and a new analysis showing your new margins is displayed. From now on, jobs that match those 
specifications will result in the price you entered. Refer to the How Target Pricing Works section, 
page 275, for a detailed explanation. It is very important you understand how this works. 

Graphs show pricing analysis for 
selected column.

Shows adjustments made 
from Estimated Costs. 

Estimated Cost Components 

Estimated Profit 

Factors used to generate 
target table 

Click on the graphic to show 
an alternative view. 
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Using Target Pricing 
To use Target Pricing, select a press definition. Add preset charges if you wish, and click the 
Target Pricing button. This option generates a target pricing table for the selected press. Before the 
table opens, you will be asked to select a stock definition.  

Selecting a stock is optional. A target table based solely on production values to which the 
Estimator adds marked up stock and other charges is a very different, but quite a valid approach. It 
is more difficult to determine pricing targets if all the necessary factors are not included in the price. 
One must also consider that the target pricing factor generated in this table will also be applied to 
the stock cost and any charges added to the job unless you select the Ignore Charges button. 
Ignoring charges is the safest way to set up a target table because the factor generated by Target 
Pricing will be smaller if charges are not included. If charges are included, the factor must be larger 
to account for the charge amounts because the target pricing adjustment does not include charges. 
Since only the job price is changed, reducing a $200 price by $50 requires a factor of 0.5 if $100 of 
the price is due to charges on the job. The factor is only 0.75 if there are no charges on the job. 
Either approach is correct, however, removing those charges from the job will result in much less 
profit or even a loss since the job price may have been reduced too much to account for the 
charges. For this reason, it is probably best to only include charges that are always added to every 
job using that press (or stock). 

When initially setting up the Target Pricing Table, the quantities used are the same as those in the 
system waste chart. You can change them. As long as at least the first two quantities in the table 
are non-zero it can be used for target pricing. You can shorten the table by entering a zero in any 
quantity. 

These quantities are used to calculate five columns of prices: 1/0, 1/1, 2/0, 2/2, 4/0. Since each 
column has 15 different prices there are a total of 75 prices calculated. Depending on the 
complexity of the press definition and the speed of the machine, it can take several seconds to 
complete all the calculations. Many of these calculations have to be redone whenever you change 
the table, so you will find this window to be one of the slowest in PrintSmith. On a faster machine 
there is virtually no delay; your mileage may vary. 

The target pricing table is part of the press definition and is copied when a press is copied. The 
New menu command resets the entire table to standard prices with no target adjustments. Revert 
restores the table to its last saved value. Click the Save button to save all changes. Saving the 
table is independent of saving changes to the Press Definition. In other words, when the target 
table is saved, the change is permanent, even if you do not save the press definition window it 
belongs to. 
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How Target Pricing Works 
Most of the time, you will probably be working in the Target view of the table. This view shows you 
the prices generated by PrintSmith. When you enter a desired price, you are actually telling 
PrintSmith your target price. This target is used to calculate a discount on the generated price, 
which is used by the Estimator. Using a discount accommodates changes to stock cost and using 
different stocks with the same press definition. 

For example, changing a default target table price of $16.73 to $15.00 might result in a target factor 
of 0.9. Should stock prices change or you use that press with a different stock PrintSmith will 
calculate the price and as a last step, multiply the job price by the factor for the proper row and 
column. If the labor rate and stock prices were changed so that same job yielded a price of 100.00, 
a target factor of 0.9 would be used to reduce the price to 90.00. 

In addition to prices, target pricing options are controlled with the following buttons. 

Interpolate  

When enabled, the factor used to adjust the price on quantities, which do not match those in the 
table, is interpolated. The result is a smooth transition from one row to the next. This button also 
governs how the variance and profit analysis graphs are presented to show how this changes 
profits. 

Disable  

The target pricing table is not used for generating prices. 

Ignore Charges  

Ignores any charges attached to the press or stock when calculating the target table. Use this 
option to adjust basic production prices without changing press or stock definitions. 

Use Press Count  

The Use Press Count option is a look up factor using the press count instead of ordered quantity. 

Ignore Wash Up Charges  

The Ignore Wash Up Charges option does not apply the target adjustment to wash up charges. 

Ignore Stock 

The Ignore Stock option does not apply the target adjustment to stock.
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The column selected for the discount factor is determined as follows: 

Table 6.2: Target Table Column Selection 
Column Description Criteria 

   

1 One Pass One Side One color on the front with nothing on the back. 

2 One Pass Both Sides One color on the front and one color on the back. 

3 Multi-Pass One Side More than one color on front and none on back. 

4 Multi-Pass Both Sides More than one color on front and at least one color on the back. 

5 Process Color 4 or more colors on the front 

   

 

The target factor is generated from the estimated price, which may include charges. Charges are 
not affected by the factor, only the job price. The more charges there are on a job, the larger the 
target pricing factor will have to be to adjust the entire price where you want it. The factor is 
calculated so that charges, when added to the price, equal the target price. 

Target pricing is an adjustment for market prices so that all calculations are based on the quantity 
ordered and on the number of colors, rather than passes. 

Note:  Be careful with preset charges, both on stocks and presses. These have a big impact on 
the target factor. Only use charges you are confident will be appropriate with all potential 
uses of the press definition. 

A target table must have at least 2 entries and the quantities must be in ascending orders. 

Target prices are color coded: 

• Blue indicates a price below standard but above cost 

• Red is a price below cost 

• Black is the standard price 

• Green is above standard 
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Copier Definitions 
Another major pricing method is defined using copier definitions. You may own only one copier but 
offer several differing pricing methods. Each definition can have its own formula, with a unique 
matrix and attached charges. Using this format, PrintSmith can handle any pricing situation. You 
have the ability to enter 100 copier pricing definitions. 

Select Copier Definitions from the Pricing menu.  The Copier Definition window opens. 

Figure 6.20: Copier Definitions window 

 
 

Like charges and press definitions, selecting the Print command from the File menu will print a 
listing of copier definitions.  
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Select Print from the File menu command. The following report will print. 

Figure 6.21: Copier Definitions Report 

 
 

Enter all of your copier costs into the cost plus method. 

Then select the pricing method you desire. This information will be used for costing all copier jobs. 

From the Cost Plus pricing method window, enter open hours, copier speeds, click costs and the 
Change button to save the copier definition. This informs PrintSmith of your copier costs which will 
be used in the costing system. 

A popular pricing method for copies is based on a matrix of copies and originals.  
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Figure 6.22: Copier Definitions window, 8.5 x 11 B&W Copy example 

 
 

In this example, this copier is named 8.5 x 11 B&W Copy, runs at 90 copies per minute, uses the 
pricing method of Copies and Originals and has an ID of 2 - for reporting work in progress. 

Sales from this copier definition are recorded in sales category HS Copy. No charges are attached 
to the Add Charges button. The matrix used is the copy cost method. 

The copy markup is set to 1 and the stock price comes from the Copier 1 field in the stock 
definition. The second side is priced by counting as more originals. 
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Click on Edit Matrix and the following table opens: 

Figure 6.23: Copier Definition Matrix 

 
Enter your base copier rate. This is usually the base 20# bond rate. PrintSmith can automatically 
add a retail paper up charge to this matrix by looking back at the stock definition. Another popular 
method is to enter the basic click charge in this matrix and have PrintSmith automatically add the 
actual cost of the stock. There are many options! 

PrintSmith uses copier and stock definitions to determine the price for copier jobs. You can create 
up to 100 copier definitions to describe the various kinds of copier pricing styles in your business. 
For example, high speed, convenience, color, contract, engineering, large format are all possible 
pricing styles that can be set up in a copier definition.  

Copier Definitions buttons 
The buttons at the bottom of the window are used with the currently selected copier definition. 

Figure 6.24: Copier Definitions Window Buttons 

 

Add/Change:  This button is used to save the current contents of the window, creates a new copier 
definition, or updates the selected definition. 

Stock Price List:  The Stock Price List button allows you to generate a price list for any copier 
definition with a particular paper attached. This is particularly useful in setting PrintSmith up as you 
can “tune” your copier pricing for a particular stock without continually going back and forth 
between stock and copier definitions. 

Copier Price List:  The Copier Price List button lets you generate a price list for any copier 
definition without considering stock cost. 

Delete:  Deletes the selected copier definition. 

Clear/Close:  If you have entered any data or selected a definition, the “Clear” button clears the 
name and sets up a new definition with the same pricing setup so you can create a new definition. 
The Close button closes the Copier Definitions window. 
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Default Copier Selection in the Estimator 
Set the default B&W and default Color copier by clicking in Default B&W or Default Color column to 
the left of the copiers.  The default copier will automatically be selected in the Copier dropdown list 
in the Job window.  When you enter a copy job, PrintSmith automatically assigns a default copier 
unless the selected stock has a preset copier selection. The user can change this default from the 
Change Copier Selection in the Job menu. 

Managing Copier Definitions 
Selecting Copier Definitions 
Clicking once on an item in the copier list displays the definition in the bottom section of the 
window. 

Creating a New Copier Definition 
When the Copier Definitions command is first selected, the window opens with a blank copier 
definition. Enter a name, enter the pricing information, and click the Add button. New definitions are 
added to the end of the list. You can move a new definition to a different position in the list by 
dragging it. Refer to the Organizing Copier Definitions section, page 282, for additional information. 

Copying an Existing Copier Definition 
The easiest way to duplicate a copier definition is to select it, hold down the <option> key (Mac) or 
<alt> key (Win), and drag the copier you want to copy to a new location in the list. When you 
release the mouse, the definition is copied. Enter a new name and save the changes. 

An alternative method is to select the copier and click the Clear button. This action sets up a new, 
untitled definition using exactly the same pricing set up as the definition you wanted to copy. Type 
in a new name and click the Add button. 

You can also use the Edit menu commands to copy and paste definitions. Make sure you click on 
the Change button before pasting in your new copier definition. Failure to do so results in pasting 
over whatever copier definition is highlighted. New definitions are added to the end of the list. You 
can move a new definition to a different position in the list by dragging. Refer to the Organizing 
Copier Definitions section, page 282, for additional information. 

Changing an Existing Copier Definition 
Selecting an item in the copier list displays the definition in the bottom section of the window. You 
can change any of the menu selections or data fields and click the Change button or the Save 
command in the File menu. 
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Deleting a Copier Definition 
To delete a copier definition, select the definition and click the Delete button. When first setting up 
your pricing system you can safely delete any copier definition. After you are up and running, use 
caution when deleting definitions. You can still delete any copier definition, but you should 
understand that if the definition has been used by other parts of the pricing system or by the 
estimator, you might wish to use an alternate strategy such as moving it to the end of the list and/or 
renaming it. 

When you create a copier job a copier definition is selected. When the job is saved, the fact that a 
particular copier was used is also saved. The copier definition itself does not become part of the 
job. When the job is copied to a new job or changed in any way, PrintSmith uses the copier 
definition in the pricing system to adjust the prices. PrintSmith can find the definition if you’ve 
changed the name or location in the copier list, but not if it was deleted. When this happens, 
PrintSmith warns you that the definition is missing and prompts you to select a new one. 

 

If you attach a copier definition to a stock definition and the copier definition has been or will be 
deleted, PrintSmith automatically selects the default copier. This may be confusing to the user and 
will generate a different price. 

If you make major changes to the pricing system, you may want to call attention to the fact that 
deleting a copier definition changed pricing. When you use an old job that was priced with the “old” 
pricing system the Estimator will warn you and recommend selecting a definition. 

Organizing Copier Definitions 
To change the position of a copier definition in a list, drag the listing to the desired position in the 
list. Repeat this operation as often as you like until all of the copiers are in the order you want. 
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Copier Pricing Methods and Styles 
Selecting a pricing method determines how copier jobs are priced for that definition.  

Figure 6.25: Copier Pricing Styles 

 

The seven available pricing methods represent three styles: Cost Plus, Flat Rate, and Matrix 
pricing. There are several variations possible with each style. The following guidelines will help you 
select the pricing style best suited for any pricing requirement. When you choose a pricing method, 
the definition window changes to display the pricing specifications for that method. It is important to 
remember that all this information can reside in the same definition simultaneously, even if it isn’t 
being used. For example, all copier definitions house machine specifications that are very useful in 
recording actual or estimated costs even if they aren’t used to generate prices. Job costing still 
uses the information. 

Note:  You can capture your costs for copying by entering machine specifications even if you 
decide not to use the cost plus pricing method. Job Costing uses this costing information 
and, when used with our optional DownLoader and Report Writer, you can perform even 
more extensive cost analysis on the resulting data. 

Cost Plus Pricing Style 
This pricing method is suited for two different kinds of pricing. The first and most obvious generates 
prices based on actual costs to purchase, maintain and run the machine. A mark up is applied to 
these actual costs plus stock to produce a retail price. 

The second is Copy Range Pricing style. This is similar to a matrix pricing style using the matrix as 
a step table. For example, you would use Copy Range pricing if you want: 

• the first 10 copies to be priced at 5¢ per copy and the rest at 3¢ 

• 20 copies would be 80¢; 50¢ for the first 10 and 30¢ for the last 10. 

• This can be an effective way of providing quantity based pricing as the unit price on the 
job is 4¢. 

It is easy to set up and is fairly safe because you clearly identify the lowest price you’re willing to 
charge and charge a premium for short run work. It is also very easy to explain to your customer 
and can give them the impression you are cheaper than the competition, even if that’s not the case. 

These two different ways of implementing pricing are actually complementary. You can use both 
together. For example, you could set up the cost plus specifications to cover your actual costs and 
use the copy range to provide desired profit levels on a job. 
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Flat Rate Pricing Style 
This pricing method is generally used for short run situations such as convenience copies or 
special purpose like engineering copies where you might charge by linear inches or square area 
instead of by clicks. 

Matrix Pricing Style 
This style encompasses the Copies And Originals, Copies Per Original, and Total Of All Copies 
methods. These methods are suitable any time you want the unit price to change based on the 
length of the job where the Copy Range method described in the Cost Plus Style is too limited. 
Each method differs in the way the matrix is used to derive the price. Each definition has its own 
unique matrix, which ranges in size from 1 to 20 columns depending on pricing specifications. 

Elements of Copier Definitions 
In the sections that follow, we examine each pricing style in detail and describe the purpose of each 
field and how it is used to generate pricing. But first, here are the parts of the definition window 
common to all copier definitions. 

Table 6.3: Elements of Copier Definitions 
Field Definition 

  

Name Up to 50 characters identifying the copier. 

Copies/Minute The number of copies per minute the machine is rated for, or your actual throughput, 
whichever is less. 

Machine Name Select the Machine Name from a dropdown list.  Machine names are defined in the 
Production Presses table.  The Machine Name displays on the Job Ticket. 

Machine ID A number, from 1 to 255, identifying the machine. If you use more than one copier 
definition for each actual machine, you should identify the machine with a number. The 
Work In Progress report uses this to sort jobs by the machine they will be produced on 
rather than the definition to price the job. 

Add Charges 
button 

You can add up to 10 charges to a copier definition. These charges are automatically 
added to the job when this copier is selected. 

Output 
Description 

Describe the output for this printing process.  This will appear on the Job Ticket. 

Integrated device 
option 

Select this option if the device is integrated with the Fiery. 

Production 
Location 

The Production Location field supports the Tracker Module.  Production Locations are 
defined in the Production Locations table. 

OEM Device ID For Fiery integration, the ID by which the device will be identified. 

Method Menu This is used to select the pricing method of the copier. 

Sales Cat Menu Select a sales category for tracking jobs revenue priced with this copier definition. 
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Cost Plus Pricing 
When the Cost Plus method is selected, the Copier Definition window is designed to directly enter 
your costs for copying, even if you are using complicated lease/purchase/maintenance contracts. 

Figure 6.26: Cost Plus Pricing Copier Definition example 

 

Table 6.4: Cost Plus Pricing Copier Definition Fields 

Field Definition 
  

Open Days/Year The number of days your business is open during the year. If you are normally 
open 5 days a week, the number is 5 x 52 or 260 days (minus any holidays). 

Open Hours/Day The number of regularly scheduled business hours. This should include 
scheduled overtime and second shifts. 

Monthly Payment Your monthly payment for the copier. If you own the copier, enter 0. 

Monthly Maintenance Your monthly maintenance charge. Most vendors have standard maintenance 
charges to which they may or may not add Click Charges. The basic maintenance 
charge goes here. If you do your own maintenance, enter a reasonable periodic 
charge for your costs in maintaining the machine. Don’t include toner or other 
consumables. Do include replacement parts if you’ve budgeted for them. 

% Time In Use Your estimate of the percentage of time the machine is usually in use. If you’re 
open for 8 hours a day and the machine is usually in use for 4 hours, enter 50%. 
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Field Definition 
  

Machine Cost Per 
Copy 

PrintSmith based on the previous factors calculates this figure. The formula is: 

 
Labor/copy Additional charge for labor for each copy. 

Toner/Copy Additional charge for toner for each copy. 

Developer/Copy Additional charge for developer and other consumables for each copy. 

Copy Markup Markup to be applied to the effective copy rate. The effective copy rate is the total 
of the machine cost per copy plus labor, toner and developer. If you’ve set up 
costing using the copy range, this is also added to the effective copy rate. 

Copy Range Three different quantities/cost combinations can be entered. This is useful for 
entering the different click cost schedules offered by copier vendors and for 
adjusting stock cost at different quantity levels. 
Stock cost is calculated from the stock definition and marked up using the 
standard stock markup in the stock definition. This may be marked up again if a 
markup is specified in the copy range table. Special order and customer stock 
use the default stock cost entered in the Stocks and Sizes Preference panel. 
Enter this information into all copier definitions regardless of the pricing method 
used since PrintSmith uses this data as the basis for calculating costs in the 
costing system. 

  

 

Modifying Stock Calculations and Second Side Pricing 
In all other pricing methods there are options for determining how stock is calculated and how the 
second side is priced. You can use these options and adjust second side pricing with the cost plus 
method by temporarily changing the pricing method to Copies and Originals, making your selection 
and returning to the Cost Plus pricing method. Only the Side 2 factor, the Price 2 sided by menu 
and the Stock Price Is menu are used, all other settings are ignored. It is important to designate the 
proper calculation of stock cost to avoid unexpected pricing. Normally, the marked up stock cost is 
used. 

Note:  Special Order and Customer Stock cannot use copier 1 and copier 2 because there is no 
stock definition. The stock cost entered in the job is used. An alternative is to create 
custom stock definitions for Special Order and Customer Stock and disable the customer 
stock and special order buttons in the Job Selection window.  

All side 2 pricing options are valid although Use First Side Rate and Use Second Side rate are 
identical because the rate is always the same. The click charge is doubled, but not the stock cost. 
All other selections affect both click charges and stock charges. 
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Flat Rate Pricing 
In this pricing method, the click charge is unaffected by quantity – one copy has the same unit price 
as a million, 100 copies of one original is the same as one copy of 100 originals. This may be 
useful for pricing on a convenience copier; however, it is difficult to be competitive with this type of 
pricing. 

Figure 6.27: Flat Rate Pricing Copier Definition Example 

 

 

Table 6.5: Flat Rate Field Definitions 
Field Definition 

  

Rate/Copy This is the flat amount charged for each copy. 

Stock Markup Override the Stock Markup by enabling “Use Copiers stock markup” –  this 
markup will be used. 

Side 2 Factor Used for pricing 2 sided copies with a factor for the second side. The price 
for single copies is determined, and then multiplied by this factor. 
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Calculating Stock Cost 
The stock selection and stock cost in the job are ignored when the stock price is “included in rate”. 
Only the copy rate is used for pricing. 

Marked Up Stock Cost adds the cost of the stock to the rate per copy. The stock cost is marked up 
using the markup in the stock definition unless Use Copier’s stock markup is turned on in which 
case it uses the Stock Markup shown to the left of the button to mark up the cost of the stock. For 
special order and customer stock, the stock markup or customer stock markup is used respectively. 

If stock price is From Copier 1 In Stock Definition or From Copier 2 In Stock Definition the rate is 
taken directly from the stock definition and is not marked up. If Use Copiers Stock Markup is turned 
on, the rate is marked up before it is used. 

Calculating 2 Sided Copying 
Side two can be calculated using: side 2 factor, which multiplies the side 1 price by the side 2 factor 
field not changing the price or by using the first side rate (which doesn’t add in stock a second 
time). 

Matrix Pricing 
Matrix pricing uses a matrix in the copier definition to generate a “click” charge, to determine a 
volume based discount, or for Copy Range (stepped) pricing. The three matrix based pricing 
methods differ primarily in the size of the matrix and how the quantities in the job are used to 
lookup the cost or discount factor in the matrix. 

To edit the matrix for a copier definition, click the Edit Matrix button. You determine what type of 
matrix by selecting the Matrix Is Copy Cost, Matrix Is Discount Table, or Matrix Is Step Table 
button. 

Figure 6.28: Copier Definition Matrix Pricing Options 

 

This area is used to edit the matrix and also determine whether the contents of the matrix are to be 
treated as click charges or discount factors. 
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Copier Matrix Types 
The type of copier matrix used depends on the pricing method selected in the definition. 

The examples below demonstrate the standards. 

 Figure 6.29: Figure 6.30: 

 Single Column  Use Side 2 Rate 

   

These two types of matrices can be used for Copies per Original and Total Of All Copies pricing 
methods. 

Figure 6.31: Copies and Originals 
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Figure 6.32: Copies and Originals Using Second Side Rate 

 

Copies per Original and Total of All Copies use the single column version, while the 10-column 
version is used for Copies and Originals. Both of these basics are available in a two sided version 
when you select Using Second Side Rate for 2 sided pricing. 

Note:  Changing the pricing method or matrix type does not change the data in the matrix. If you 
enter data for all 10 columns for one and two sided copying this information is retained 
even if it is no longer used. 

 

Table 6.6: Matrix Types 
Selected Method Matrix 

  

Copies And Originals The rate is located based on the number of copies row and the number of 
originals column. There are 10 columns (20 on a 2 sided matrix) available 
for pricing. The first column with a zero for the number of originals marks 
the last column in the matrix. 

Copies Per Originals This method uses a single column pricing matrix (which may have 1 or 2 
sides). The rate is looked up in the matrix using the number of copies. The 
Originals field is not used in the lookup. 

Total Of All Copies This method also uses a single column matrix. The total number of copies 
(ordered x sheets x sets) made determines the rate in either a 1 or 2 sided 
matrix. 

Square Area Of Originals This method is used to support large format pricing based on the square 
area of the original being copied. You would use this method if you develop 
a unit price for job based on the size of one piece and then multiply it by the 
number of pieces. This is a matrix pricing style. The matrix looks the same 
except that instead of Number of Copies it shows Total Square Area. 

Total Of Square Area This method supports large format pricing. A unit price based on the total 
square area of the job is multiplied by the number of units of area. For 
example, a job with 100 square units would look at 100 on the matrix and 
multiply the rate by 100 calculating the retail price. This is a “matrix” pricing 
style. The matrix looks the same except instead of “Number of Copies” it 
displays “Total Square Area”. 
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Matrix is Copy Cost 
Use this matrix if you price copies using a cost table which varies by quantity and/or number of 
originals, and choose to add a premium on certain types of stock.  The stock price is derived from 
the stock definition and is marked up using either the stock markup or the copier definition’s stock 
markup when Use Copier’s Stock Markup is selected. The click charge is marked up using the 
copier markup. The stock charge and click charge are added together resulting in a final price. 

Matrix is Discount Table 
Use this matrix if you price copies by setting a standard price for each stock, then discount based 
on the quantity and/or number of originals. The base rate in the copier definition is the basic click 
charge for a single copy of one original. 

Matrix is Step Table 
Use this step style of matrix if you price each range of copies separately and add them up.  
Example of a step table: If the first 3 entries in the table were 100 at.06, 200 at.05, and 300 at .04 
and the quantity to price was 250. It would be calculated as follows: 

100 x.06 = 6.00 

100 x.05 = 5.00 

50 x.04 = 2.00 

Total = 6.00+ 5.00 + 2.00 = 13.00 

This is similar to the copy range table available in the Cost Plus method except there are 14 ranges 
and many more options for handling multiple originals, stock pricing and two sided copying. The 
stock charge is calculated using the same rules as Copy Cost Matrix. 

Stock Price 
The stock component of the copy price is determined using the following rules: 

Table 6.7: Stock Price 
Stock Price Is Resulting Stock Charge 

  

included in rate No separate stock charge is calculated. 

marked up stock cost The cost for each sheet is marked up using the stock cost (or standard stock or 
customer markup for special order and customer stock). This can be 
overridden using “Use copiers stock markup”. 

from Copier 1 in stock 
definition 

Only works with “in stock” papers and adds the up charge listed in the copier 1 
field from the stock definition, otherwise it defaults to “marked up stock cost”. 
This value is only marked up when “Use Copiers stock markup” is selected. 

from Copier 2 in stock 
definition 

The same as copier 1 except for value taken from stock definition is from the 
copier 2 field in stock definition. 

  

 

The discount factor is looked up in the matrix and multiplied by the total of the base rate and the 
stock price. This is the click charge for this quantity. 
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Using Matrix Based Pricing 
If the matrix is a copy cost matrix, the price per copy is calculated: 

(cost x  markup) + (stock cost x markup) 

If the matrix is a discount table, the price per copy is calculated: 

(rate x discount factor) 

If the matrix is a step table, the price is calculated in a somewhat more complicated fashion. 

There can be as many as 15 rows and 10 columns in the matrix and may have separate columns 
for single and double sided copying. Any bottom row containing 0 in the Number of Copies column 
is the last row used in the lookup. In the Copies and Originals (10 column) matrix, the bottom 
column with a 0 in Number of Originals is the last column used. 

Table 6.8: Pricing For 2 Sided Copies 
 Definition 

  

Price 2 sided by not 
changing price 

Price 2 sided by counting as more originals there is no difference in price 
between one sided and two sided copying 

Price 2 sided by using first 
side rate 

Price 2 sided by counting as more originals doubles the price for clicks (but 
not for stock which is added only once) using a single sided rate matrix. 

Price 2 sided by using 
second side rate 

Price 2 sided by counting as more originals uses a 2 sided matrix. The rate 
looked up in the matrix is from the side 2 column on a two sided job. This 
click charge is doubled and added to the stock charge. 

Price 2 sided by counting 
as more originals 

Price 2 sided by counting as more originals has the effect of doubling the 
number of originals prior to performing the lookup. This does not affect the 
stock charge, which is not doubled. This is equivalent to pricing a single 
sided job as twice the amount ordered except for the stock charge. It would 
price 100 two sided the same as 200 one sided copies and add a stock 
charge for 100 sheets. 

Price 2 sided by using side 
2 factor 

Price 2 sided by using side 2 factor calculates the price for single sided 
copying and multiplies it by the factor specified in the definition. 
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Adding Charges to Copier Definitions 
Charge definitions offer much flexibility and can be attached to a copier definition. In order entry, 
when you select a copier, any preset charges are automatically added to the job. If you change to a 
different copier, the charges attached to the old copier are discarded. 

To add charges to a copier definition, click the Add Charges button. The Charge Selector window 
opens. 

Figure 6.33: Charge Selector Window  Figure 6.34: Charge Selector Window  
              with Charge Assigned 

          
 

The window is divided into two areas, the top section is used for making new selections, the bottom 
displays current selections and is used to remove preset charges from the list. The top part of the 
window presents a hierarchy. At the top level are the charge commands. Below each charge 
command is a list of the categories defined in the command window. Below each category are the 
charge definitions themselves.  

Up to 10 preset charges are displayed in the bottom of the window. You can remove a preset 
charge by selecting it and clicking the Remove button. If you change a charge definition that is 
preset in a copier definition, PrintSmith will use the latest definition when the charge is added to a 
job. 

Click the Close button when you have finished your selections. 
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Strategies for Using Preset Charges 
The biggest advantage in using preset charges is having ability to quickly generate complex quotes 
in a more consistent manner. Often, complex quotes can be delegated to less knowledgeable 
employees with a much greater degree of confidence. It also can serve as a tickler – the most 
common charges automatically add to each job and the user can delete any charges that don’t 
apply to the situation. It’s easier to remove unnecessary elements in a job than to anticipate what 
you might have forgotten. 

There are many different strategies for defining copier definitions and deciding which charges 
should be preset. Be consistent in your use of preset charges. Adding stapling should be attached 
to all copier definitions that are used for multiple originals. There are some operations you can 
easily add to a few select copiers. You could set up a Carbonless copier definition, which includes 
charges for padding. Another copier definition for hand-collated Carbonless jobs which include the 
charge for hand collating. Keep it simple and make it easy for your staff to use. 

Using Copy Range Pricing 
The copy range table can be used to generate a pricing curve, or to set up pricing for special click 
costs at various quantities. The following table shows how PrintSmith uses this to adjust prices: 

Table 6.9: Copy Range Pricing Example 
Qty Cost/Copy Effect 

   

1 .03 Starting at first copy and ending with Qty from next line (1-99 in this example), 
adds 3¢ per copy 

100 .02 Starting with 100th copy and ending with Qty from next line (100-499 in this 
example), adds 2¢ per copy. 

500 .01 Starting with 500th copy and any additional copies, adds 1¢ per copy. 

   

 

Using the above table with a copier definition with no other costs: 

1 copy would cost $0.03 

100 copies would cost $2.99. (99 x 0.03) + (1 x 0.02) 

1000 copies would cost $15.98. (99 x 0.03) + (400 x 0.02) + (501 x 0.01) 
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List Price Schedules 
The List pricing method is an alternative method for pricing printing jobs. You can create any 
number of price schedules for this pricing method. There must always be at least one predefined 
price schedule. You can change the contents of the schedules or delete them as long as at least 
one is left. 

Modifying List Price Schedules 
You are able to define how a list price schedule is used within the Estimator. By default, all prices 
are looked up by press sheets. To change how a list price schedule is used: 

1. Select List Price Schedules from the Pricing menu. The window displays all 
available List Price Schedules. 

Figure 6.35: Price Schedules List Window 

 
2. Select the applicable list. Selected items are highlighted. 

3. Click the Select button. The selected list pricing opens. 

Figure 6.36: Price Schedule Example 

 

Options for how the 
list schedule is used 
within the Estimator 
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4. Change how the list schedule is used in the Estimator by clicking the applicable 
option. Options are to: use ordered quantity, use press sheets, or use press sheets 
plus bindery. 

5. Click the OK button once all necessary changes have been made. PrintSmith will 
prompt you to update how all other price schedules are used within the Estimator to 
match the changes you made to the schedule you are saving.  

6. Click the Yes button to update the other schedules. 

 

Deleting a List Price Schedule 
You can delete any schedule. However, there must be at least one price schedule in the system so 
PrintSmith will not allow you to delete the last schedule in the list. 

1. Select List Price Schedules from the Pricing menu. The window displays all 
available List Price Schedules. 

2. Select the applicable list. Selected items are highlighted. 

3. Click the Delete button. A confirmation message is displayed.  

4. Click the Yes button. The selected list will be deleted. 

 

Creating a New List Price Schedule 
New List Price Schedules can be created by clicking the New button in the List Price Schedule 
window or by selecting the Save As command from the file menu, when a price list is open. 

 

Using Price Schedules 
You must tell PrintSmith when to use a particular schedule. This is done using the Stock Definition 
command. If a price schedule is not preset in the stock definition, PrintSmith will use the default 
price schedule, which is the first schedule in the list, PrintSmith will warn you that the stock needs a 
preset price schedule. 

In any job, you can change the selected schedule using Change Schedule Selection command in 
the Task List. The price schedule will have an option to use Crouser Schedules if you have 
purchased and received Crouser Pricing.  
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Stamp Schedule 
This price schedule is for jobs using the Lines & Inches pricing method. It is designed for pricing 
standard rubber stamps where the price is based on the width and number of lines in the stamp. 

Prices are taken from this schedule by finding the column for the number of inches specified (5.25 
inches would look in the 6 inch column) and the row for the number of lines specified in the job 
window. 

You can change any of the numbers (including the column and row labels) by clicking on the 
number and typing a new number. The <tab> key moves the selection from column to column while 
the <return> or <enter> key moves the selection from row to row. 

Figure 6.37: Stamp Schedule Window 
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Charge Definitions 
Charge definitions are an extremely important part of the pricing system. PrintSmith supports ten 
different charge definition commands. The number of charges within each category is essentially 
unlimited (4,000,000,000 charges and categories combined).  

When the system is first shipped, there are six defined commands: Pre Press, Bindery, Production, 
Merchandise, Mailing Services, and Miscellaneous. You may rename these commands as needed 
to better describe your business. There are also four user-defined commands available. 

The names of the commands give you an idea of their intended use. They can be used to price 
items such as plates, negatives, bindery, typesetting, special markups, rubber stamps, shipping 
charges; anything you sell in your business. Charges are defined as items usually associated with 
a printing or duplicating job, but can stand alone on their own if necessary. You can place any 
charge definition in any of the commands. We recommend you group them as follows: 

Pre Press - Any charge related to preparing a job for production should reside in Pre Press. Items 
like film, plates, typesetting, desk top publishing, and art work belong in this command. All charges 
relating to activities before the job goes to production. 

Bindery - Items associated with finishing a job, operations such as post press cutting, folding, 
scoring, drilling, stitching, padding, gathering, book assembly, packaging, even shipping. 

Production - Charges used while in production such as wash ups, extra plate burns, etc. can be 
grouped into this area. This is the newest charge area added to PrintSmith. Many users have 
included these charges in the Pre Press area. 

Merchandise - Work that is always brokered out, especially if you have price lists from the vendor. 
Examples: thermography, business cards, invitations, blueprints, letterpress work, color 
separations, office supplies, etc. 

Mailing Services - Mailing is becoming a greater portion of a printer’s business. This area is 
designed for charges related to mailing the final product(s). 

Miscellaneous - Anything else you regularly sell can be set up here. 

The most important and frequently used charge commands are Pre Press, Production and Bindery. 
They can be attached to jobs, or they can be used alone. The remaining commands are designed 
more for invoice level charges although they can be attached to jobs as well. 

PrintSmith handles Pre Press cutting charges differently than Bindery cutting charges. It assumes 
that pre press cutting affect the parent to the run size and bindery cutting is affects the run size to 
the finish size. In the Estimator, a cutting charge shows what size it is cutting from and to. 

Each of the possible charge definitions can be thought of as individual pricing formulas that you 
control and can plug into a job or quote. The formula for all charge definitions breaks down to: 

quantity x rate = price 
The power of charge definitions comes from the number of ways in which the quantity and the rate 
are derived and plugged into the formula. There are millions of different combinations possible.  

Charges are organized by command, category, and charge. This chapter defines how categories 
and charge definitions are managed, how to create them, and the ways in which they can be 
organized. Then, we will show you how to set up charge definitions to generate the correct price. 
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Understanding the Charge Definitions Window 
All charge commands are managed in one window: The Charge Definition Window. To open the 
Charge Definition window, select Charge Definition from the Pricing menu. 

The Charge Definitions Window contains all charge definitions (Pre Press, Bindery, Merchandise, 
Mailing Services, Miscellaneous, Production, and any custom definitions). Charges and categories 
are organized in a hierarchical display. This hierarchy can be expanded and collapsed to view the 
application information with which the users is working. Functionality icons are displayed across the 
top of each window. Additional information for the selected item is also displayed. 

Figure 6.38: Charge Definitions Window 

  
 

You control the categories in each menu command, the charges in each category, how each 
charge calculates a price, how it is presented to the user in the Estimator and even the name of the 
menu command. 
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Managing Commands 
Renaming Charge Menu Commands 
Charge Menu Commands can be renamed. To rename: 

1. From the Charge Definitions window, select the command to be renamed from the 
hierarchical list. The selected item will be highlighted and a Command field and Add 
To Job Task List checkbox are displayed. The current name is listed. 

2. Enter a new name in the text field. Changes made will be reflected in the hierarchical 
list. 

3. Click the Save icon. After renaming an item, you must save in order to continue 
working in the Charge Definitions window. If you elect not to save the new name, the 
hierarchical list will revert back to the original name. 

Notes:  Avoid using punctuation marks in the title. In particular don’t use “;”, “^”, “!”, “/”, or “(”. Do 
not start the menu command with a left parentheses or a hyphen. 

 We recommend not changing the name of the Pre Press or Bindery commands as the 
corresponding buttons in the job window can not change to match the new menu 
commands. This will be confusing. 

Determining Whether or not to Show a Charge Command in Job Task List 
You can decide whether or not to display a command in the task list. By default, all defined charge 
commands are displayed in the Job Task List.  

1. From the Charge Definition window, select the applicable charge command from the 
hierarchical list. The Command name and an Add Command To Job Task List check 
box are displayed. 

2. Check or uncheck the Add Command to Job Task List option, as appropriate. 

3. Click the Save icon. The charge command will be displayed in the Job window if the 
option was enabled or the command will be hidden if the option was unchecked. 

Defining a Custom Charge Command 
There are four user definable charge commands available. These custom charges labeled <Empty 
7>, <Empty 8>, <Empty 9>, and <Empty 10> can be used to create a charge command. By default, 
these commands are not displayed in the Task List. 

1. From the Charge Definitions window, select one of the four custom charge 
commands from the hierarchical list. The Command name and an Add Command To 
Job Task List check box are displayed. 

2. Rename the Command by entering a new name in the text field. 

3. Check the Add Command to Job Task List option if the command should be 
available within the Task List. 

4. Click the Save icon. The charge newly named command will be displayed in the 
hierarchical list. 

5. Add Categories. 
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Managing Categories 
When setting up your categories, make it as easy as possible to locate the charge you need. For 
example, have separate categories for cutting and folding but not for numbering and numbering 
with colored inks. 

When organizing categories for Pre Press and Bindery, list the categories in the same order as 
they are used (i.e. collating, binding, boxing, and delivery). Visually, the category list can serve as a 
mental checklist. Another option is to alphabetize the category list. 

In the other commands, frequently used categories could be placed at the top of the list so they are 
easier to select, especially from the keyboard. When you are selecting them in the Estimator, 
sixteen items are displayed at one time. For optimum results, make the most common categories to 
the first sixteen items in the list. 

Try to avoid many categories containing only one or two charges. It is much easier to list all folding 
charges together in one folding category than to have a category for each type of folding. 

Organizing Categories 
Organizing categories is quite simple. Move any category to its proper position in the list by 
dragging the item to the place you want it moved.  

Note:  Changes to the organization of the list will not be visible in the Estimator until you 
save/close the window. 

Creating a New Category 
To create a new category: 

1. From the Charge Definition window, select the command in which the category will be 
created. 

2. Click the New icon from the toolbar or select New from the File menu. The new item 
will be displayed last in the command’s list of categories with a right pointing arrow. 
An un-editable Command field listing the name of the command the category is part 
of and a Category Title text box are displayed. The category title listed is <untitled>. 

3. Enter a new name in the text field. Changes made will be reflected in the hierarchical 
list. 

4. Click the Save icon. 

5. Move the category into the applicable order with the other categories.  
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Renaming Charge Categories 
Charge Categories can be renamed. To rename: 

1. Select the category to be renamed from the hierarchical list in the Charge Definitions 
window. The selected item will be highlighted and an un-editable Command field 
listing the command name the category is part of and a Category Title text box are 
displayed. The current category name is listed. 

2. Enter a new name in the text field. Changes made will be reflected in the hierarchical 
list. 

3. Click the Save icon. After renaming an item, you must save in order to continue 
working in the Charge Definitions window. If you elect not to save the new name, the 
hierarchical list will revert back to the original name. 

Note:  Avoid using punctuation marks in the title. In particular don’t use “;”, “^”, “!”, “/”, or “(”. Do 
not start the menu command with a left parentheses or a hyphen. 

 

Duplicating Categories 
The easiest way to duplicate a category is to hold down the <option> or <alt> key and drag the 
category to a new location either in the same command or in a different command. Instead of using 
the drag and drop method of copying a category: 

1. Select the applicable item to be copied from the hierarchical list. 

2. Click the Duplicate  icon. A confirmation message is displayed.  

3. Click the Yes button to confirm duplication of the item. 

You can also use Cut, Copy, and Paste commands in the Edit menu. 

 

Deleting Categories 
Entire categories can be deleted. To delete a category: 

1. Select the applicable category to be deleted from the hierarchical list. 

2. Click the Delete  button. A confirmation message is displayed.  

3. Click the Yes button. A message is displayed identifying the number of charges that 
will be affected by this action. 

4. Click the OK button. The applicable category will be deleted (and no longer displayed 
in the hierarchical list of categories in the Charge Definitions window). 
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Managing Charge Definitions 
Charge definitions are the individual charges that reside in a particular Category. Charge definitions 
are used in pricing and contain additional information required for pricing, such as rates, price lists 
and minimum charges. 

There are three basic types of charge definitions; definitions that: contain all the information needed 
to generate a price, require additional information from the user, or use the job or document to 
which they are attached for pricing information. The latter type of charge is often referred to as Job 
Aware because it knows how to extract information from jobs for use in generating a price. 
Markups, Cutting Charges, and Ink Charge methods are Job Aware based methods. Generally, we 
recommend using Job Aware charges whenever possible because if you change the specifications 
on a job, all job aware charges immediately reflect this change, preventing many errors. 

Organizing Charges 
This procedure is identical to managing categories. Drag and drop the item to the desired position. 
Like categories, you can drag a charge definition in to a different command. Alternatively, drag it 
into the category list and drop it below the category you want the charge added to. In this case, the 
charge is added to the end of the list. 

Creating a New Charge 
Creating charges is easy. The following steps are the simplified process to create a charge. 
Additional information is available in subsequent sections, where noted.  

1. In the Charge Definition window, select an existing charge within the category in 
which the charge is to be displayed.  

2. Click the New icon. A copy is made of the selected charge. 

3. Enter a name for the newly created charge. 

4. Select a Production Location. 

Note: The Production Location field supports the Tracker module. 
5. Select a Method from the drop down menu. 

6. Select a Quantity. 

7. Select a Sales Category. 

8. Enter Pricing Data or select a Price List. 

9. Enter a Product Code. 

10. Enter Fixed Spoilage. 

11. Assign a Waste Chart, if applicable. 

12. Specify other charge definition information as needed based on the method selected. 

13. Define any relevant Preset Information. 

14. Click the Save icon. The newly created chart can be organized in the list accordingly. 
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Selecting Charge Method  
The pricing method attached to a charge has a tremendous impact on how the charge is used and 
affects all the other settings in the charge definition. It is best to select the method first. Use the 
Method menu to select the pricing method to use with a charge definition. Each method is designed 
to handle certain types of pricing situations. Most charge definitions in Pre Press and Bindery will 
use one of the job aware methods (Job Aware, Markup, Cutting Charge, Ink Charge). Most charge 
definitions in other commands will use Always Ask. 

Table 6.10: Charge Methods 
Method Definition 

  

Job Aware A Job Aware charge is strongly recommended for any item whose price is dependent 
on a quantity in the job to which it is attached. Job Aware charges ensure the price is 
always correct and when a quantity in the job changes, the prices for all job aware 
charges are automatically updated. 

Markup Markup charges are similar to Job Aware and can be used in situations where you 
want to mark up all or part of a job or an entire invoice. Anything you price by 
multiplying a total by a factor is a candidate for a markup charge. For example, to add 
a rush charge of 20% to the price of a job or invoice, a markup charge would be the 
ideal way to handle it. 

Flat Rate Flat Rate method is used for items where the price never varies. If you always charge 
$5 for delivery, you should set it up using the flat rate. 

Always Ask The Always Ask method can be used for any charge definition. It is best suited for 
charges where the quantity is not known beforehand, although you can preset a 
common quantity to make data entry a bit easier. 

Price List The Price List method is similar to Always Ask, except the price is always taken from a 
price list (which must be created and attached to the charge) based on a quantity you 
enter. 

Rate List Rate List method is identical to Price List except the rate for the charge is taken from 
an attached rate list. This rate is then multiplied by the quantity you entered to 
generate the price. 

Cutting Charge A Cutting Charge is a special purpose, Job Aware, charge, specifically intended to 
calculate cutting charges.  When a charge with this method is defined in the Pre Press 
command, it calculates Parent Size to Run Size. When the charge is in the Bindery 
command, it calculates Run Size to Finish Size.  It determines the price based on how 
many cuts are needed based, how many lifts, and multiplies it by a rate, which may 
come from an attached rate list. 

Ink Charge The Ink Charge method was developed to aid in estimating ink requirements and 
charging for ink. It is a Job Aware type of charge with special fields and capabilities 
best suited for calculating based on coverage for a particular job. It can be used for 
any charge that is based on square inches (or square feet). 

Shipping Charge The Shipping Charge method supports specifying shipping addresses of a job and for 
pricing based on the weight of a job. Job level charges use the weight of a single job 
and invoice level charges use the weight of all jobs on an invoice. Shipping charges 
attached to the control job in a multipart job includes the weight of all parts of the job in 
the calculation. You can override the weight in the actual shipping charge on a 
document if necessary. 
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Defining Job Aware Charges 
A Job Aware charge is priced using information from the job to which it is attached. There are many 
types of charges where the quantities in the job are important.  

Examples: A folding charge is dependent on the number of sheets to be folded. Sheet information 
is available from the job if the charge is attached to it. Other examples are Plates (number 
of colors and sheets), film, cutting, ink and so forth. 

Most pre press or bindery operation depends on one of the quantities in the job: folding, drilling, 
scoring, gathering, binding, and even boxing. With the notable exception of Typesetting, which 
rarely is directly dependent on the quantities in the job. If you have standard rates per page 
(especially if they vary with the quantity) then Job Aware could be used to define typesetting 
charges.  

Figure 6.39: Job Aware Charge Example 

 
 

Aside from entering Quantity, Sales Category, Product Code, Fixed Spoilage, and other criteria; 
Job Aware charges need you to define: which quantities and how the quantities will be used to 
calculate price, and whether or not the charge is a Bindery Operation. 
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Selecting Values to Be Used in Calculating Price 

• Select either Ordered or Press quantities. Only one should be selected. 

• Select either x Colors or x Sides multiplier.  

• Select either x Sheets (number of originals specified in the jobs) or x Signatures (the 
number of different run sheets or sheets / up). 

 

Marking as a Bindery Operation 

The Bindery Operation option provides an alternate calculation method that will generate better 
results for most bindery operations, especially when large numbers of originals and relatively small 
ordered quantities are involved. The difference in the price generated by PrintSmith can be 
significant. 

Examples: 

A folding operation where the price is specified as $1.00 for each cut in sets of 500 and there 
is 1 fold to each set. The first job it is being applied to is a copying job with 10 copies of 100 
originals. A second job with 500 copies of 100 originals is shown as well. 

With the Bindery Operation option enabled, the price would be calculated as: 

 

Note that the generated price was the same even though in the first case 1000 sheets were 
folded and the second was for 50,000 sheets. The price is the same because folding was first 
figured for the 10 copies and then multiplied by the number of originals. This means that 10 
copies was the actual size of the set because each original is priced separately. 

In the second version the number of copies and the number of sets were identical, still one set 
per original. Since the number of originals was identical – so was the price. Any number of 
copies up to 500 will generate the exact same price. At 501, the price would double because 
there would be two sets for each original. 
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Example Continued:  

With the Bindery Operation button on, the price would be calculated as: 

 

The two methods are identical when the quantity ordered (or impressions) is any multiple of 
the set size. The difference between the two methods is most apparent when the number 
ordered is less than the set size and there are multiple originals. If “In Sets of ” is 1 or not used, 
this button has no effect. 

Disable Bindery Operation for charges for calculating plates or any other operation where each 
original must be treated separately. In many bindery operations, like cutting or drilling, you can 
combine the entire job before performing the operation, and, in these cases, you should enable the 
Bindery Operation option for best results. 

In general, this option should not be enabled for pre press charges or any charge where the 
operation must be performed on each separate original. It should be enable for most bindery 
operations where more than one original can be processed at once (like folding or cutting). 
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Defining Markup Charges 
Markup is also a Job Aware charge since these charges use other parts of a document to generate 
their price. However, Quantity is always set to No Quantity because PrintSmith uses various 
document or job totals automatically based on the type of markup and the quantity is therefore not 
under direct user control. 

Figure 6.40: Markup Charge Example 

 
 

Markups use the same basic formula as all other charges. The quantity is the marked up amount. 
PrintSmith always supplies this quantity and multiplies it by the rate. You never see the rate listed 
and cannot change it. A rate of 0 does nothing, a rate of 0.1 is a 10% markup, and a rate of -0.1 is 
a 10% discount. 

When customizing a markup charge, only the rate is used. You can also use the Minimum field to 
define a minimum markup. The material rate and set up are ignored if selected. You should not use 
In Sets for markups. 
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You have a choice of four different types of markups from which to choose: Job Price, Charges, 
Entire Job, and Invoice. The type selected determines what amount is to be marked up using the 
rate contained in the charge definition (or an attached markup price list).  

Entire Job, Job Price, and Charges rely on information in the job and must be attached to a job in 
order to generate a price. Invoice markups must be attached to a document in order to generate a 
price. PrintSmith will not allow you attach a charge to a job if the charge is an invoice markup. 
Likewise, you will not be allowed to add job level markup charges as an invoice level charge. 

Job Price – Job Price marks up only the job price (which includes production charges, but not Pre 
Press or Bindery). 

Charges – Charges marks up only the charges on the job that belong to the same category (Pre 
Press or Bindery). This type of markup in Pre Press marks up all the Pre Press charges while a 
markup of this type in Bindery marks up all the Bindery charges. 

Entire Job – Entire Job type marks up the entire job price including all pre press and bindery 
charges. 

Invoice – Invoice marks up everything in a document including markups for individual jobs and 
charges, but not including other invoice level markups, the customer discount, or shipping charges 
entered in the Document Totals window. 

You can add more than one markup to a job or document. 

Example: You could add a Rush Charge markup and a Bid Discount to the same job or 
document. Multiple markups of the same type do not interfere with one another. They are 
independent. The Rush Charge and the Bid Discount both use the same amount. The Bid 
Discount does not discount the Rush Charge and the Rush Charge does not mark up the Bid 
Discount. 

Note:  In addition to or in place of the rate, you can set up a price list for a markup that acts as a 
variable discount. In this case, the amount being marked up is used to look up the markup 
rate in the price list - a dollar based variable discount.  
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Defining Flat Rate Charges 
Flat rate charges are useful for items where the rate always remains the same. 

Figure 6.41: Flat Rate Charge Example 

 
 

Flat rate charges are, by definition, fixed fees. If, for example, you charged a flat $5.00 for 
delivering an order, you could define it as a flat rate charge. Set up, Material rate and Minimum can 
be used. It is best to just enter the price in the rate. You should not use Sets with this pricing 
method as PrintSmith ignores it. 

By selecting the Adjustable Rate option, you can define a flat rate charge that allows you to change 
the rate instead of overriding the price. This method is preferred since overriding a price prevents 
PrintSmith from automatically updating the price if the document is recalculated and the rate is not 
updated on these charges when a document is recalculated. 

Note:  This method allows users who do not have authority to perform overrides to enter a price 
directly. 
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Defining Always Ask Charges 
Always Ask type of charge should be used for the majority of charges that do not require or cannot 
use job quantities. With this method, you supply the quantity when the charge is selected in the 
Estimator. 

Figure 6.42: Always Ask Charge Example 

 
If a charge does not need to be Job Aware, it can be set up using the Always Ask pricing method. 
As implied by the name, PrintSmith will ask for the quantity. Decide what type of quantity to use 
(Number of Sets, Quantity, Time, No Quantity, or No. Sets & Setup). We recommend selecting 
Quantity (asks for a quantity) or Time (asks for a time start and a time stop). If Time is selected and 
both a start and stop are supplied, the quantity is the difference between the two times. If just one 
time is entered, the quantity is that time.  

Defining Price List and Rate List Method Charges 
Price and Rate List methods are virtually identical. They both rely on an attached price list to 
generate a price. The only difference is how the attached price list is used. 

Price List Method - The attached price list is always treated as a price list regardless of the pricing 
options selected for the price list itself. 

Rate List Method - The price list is treated as a variable rate list. Instead of looking up the price in 
the price list, it looks up the rate and plugs it into the standard formula: quantity x rate = price 

The pricing method in the charge takes precedence over settings in the price list itself. If you use a 
rate list price list with this method, it is treated as a rate list. 
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Defining Cutting Charge Method Charges 
The Cutting Charge method is a special Job Aware pricing method designed strictly for cutting 
charges. It makes use of the parent, run, and finish sizes in the job to which it is attached and takes 
an intelligent count of the number of cuts. PrintSmith then records this count as the number of sets. 
This charge functions in all other respects just like a Job Aware charge. 

Figure 6.43: Cutting Charge Method Example 

 
To estimate cutting the Run from the Parent Size, the cutting charge must be placed in the Pre 
Press command. Since the Parent Size is the base size, PrintSmith also uses the number of parent 
sheets instead of “Press”. 

To estimate cutting the Finish from the Run Size, the charge must be placed in the Bindery 
command. When the charge is selected in the Estimator, the type of cut is indicated in the charge 
window so even if the charge is dragged to a different part of the job, it will still show what type of 
cutting charge it is. 

Note:  The number of cuts for any given size combination is an estimate and it may not be 
correct. There are a number of common situations PrintSmith does not consider when 
calculating cuts. Among them are stacking lifts on small jobs and restrictions due to the 
size of the cutter. Trimming bleeds can require twice as many cuts as normal. In addition, 
the cuts often require extreme precision. You might want to add a bleed cut charge by 
doubling the rate and setup, lowering the lift size somewhat, and accept what PrintSmith 
estimates for the number of cuts. 
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Defining Ink Charge Method Charges 
Ink Charge is a special pricing method designed to calculate the amount of ink used in a job. It 
uses the run size of the stock and a percent of coverage to estimate the number of pounds of ink 
required. 

Figure 6.44: Ink Charge Method Example 

  
 

Note that for this method, Press and x Signatures are preset and cannot be changed. A selection 
should still be made regarding x Colors or x Sides. Also note that the Rate field has changed to 
Price/lb. and the Sets field to Cover/lb. You enter the retail price for each pound of this ink and 
estimate the number of square inches, 100% covered, by that pound. 

Although shown in pounds and inches, other units of measurement can be used just as effectively. 
For example, the price could be deciliters and centimeters of coverage. This type of charge can 
also be used to estimate based on square inches by presetting the coverage to 100% and disabling 
Cover/lb. Square feet calculations are as simple as setting Cover/lb. to 144 (the number of square 
inches in a square foot). 

Note:  Stock sizes must be specified in the same unit of measure as Cover/lb for correct ink 
calculation. 

 

Press and x Signatures 
are automatically 
selected for Ink Charge 
and cannot be changed. 

The Rate field 
changes to Price/lb 

for Ink Charges. 

The Sets field 
changes to Cover/lb 
for Ink Charges. 
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The percent of coverage, and the run size of the sheet are used to determine the total number of 
square inches to be covered. When divided by the coverage per pound it gives the estimated 
quantity of ink that will be needed for the job. The formula used to calculate the charge is: 

 

The important fields in this pricing method are Price/lb. (selling price for one pound of ink) and 
Cover/lb. (the number of square inches solidly covered by a pound of ink). The following table 
shows some sample coverage estimates for common types of ink. Your mileage will vary with the 
type of stock, type of ink, and press. You can obtain mileage figures from your vendor or check the 
ink packaging. 

Table 6.11: Ink Mileage Samples 
Stock Type Enamel Offset 

   

Standard Black 425,000 275,000 

Rubber Based Black 435,000 225,000 

Transparent Dark Colors 330,000 225,000 

Transparent Light Colors 250,000 185,000 

Process Colors 350,000 225,000 

Varnish 400,000 N/A 

Tint Base  405,000 250,000 

Fluorescent 270,000 160,000 

Metallics 215,000 130,000 
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When the charge is added to a job, normally just the estimated percent of coverage on a page is 
entered. PrintSmith calculates the amount of ink. 

Figure 6.45: Preset Info Window 

 
 

You can also enter the number of pounds of ink directly and PrintSmith will calculate the percent of 
coverage. The number of pounds of ink determines the price of the job. 

The following table can be useful in estimating the amount of coverage on a page. 

Table 6.12: Ink Coverage Guidelines 

Type of Page Coverage 
% 

  

Light composition 15 

Normal composition 20 

Normal composition, bold paragraph heads 25 

Medium composition 35 

Heavy composition or halftones 50 

Solids 100 

Reverses 60-90 

Process Color 20-50 
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Defining Shipping Charge Method Charges 
The Shipping Charge method supports specifying the shipping address of a job and pricing based 
on the weight of a job. Job level charges use the weight of a single job and invoice level charges 
use the weight of all jobs on an invoice. Shipping charges attached to the control job in a multi- part 
job includes the weight of all parts of the job in the calculation. You can override the weight in the 
actual shipping charge on a document if necessary. 

Figure 6.46: Shipping Charge Method Example 

 
Shipping price is based on the weight multiplied by a rate. Pricing can be set up the following ways: 

• Use the rate to multiply the calculated shipping weight. 

• Use a mark up which multiplies the rate. 

Use Shipping Charges on a Document 

Adding the shipping charge to a document presents the option to select the Ship Via method, the 
Ship To shipping address as well as to override the shipping weight. 

Shipping Ticket 

When a document contains a shipping charge a shipping job ticket page is printed that details the 
shipping charge information. 
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Selecting Quantity 
There are a number of different quantity types available from which you select from the Quantity 
menu. Not all of the quantity types are available with each pricing method. 

Changing the quantity type affects how quantities are entered, but does not directly change the 
price. A quantity can be entered as Time or as Quantity and the same price would be generated. 
Two hours can be entered as time or as a quantity. It is more involved converting an hour and 
fifteen minutes (1:15 as time) to 1.25 hours, hence the time method of quantity entry. Each quantity 
type is illustrated using the Preset Info window to demonstrate what it looks like when the charge is 
actually used. 

Number of Sets 

Normally, the Number of Sets quantity type is only used with Job Aware charges. The price is 
based on basic totals from the job and then multiplied by a user entered quantity. 

Figure 6.47: Number of Sets Preset Info Example 

 

Example: The charge is 3¢ for each staple. A job aware charge is able to determine how many “sets” 
need to be stapled together, if there is a single staple in each set. To set up a charge that can be used for 
any number of staples, set the quantity type to Number of Sets. In this example, a single staple is being 
priced. If you change Qty/set to two, the price will be calculated for two staples by multiplying by two. 

PrintSmith figures out the standard quantity, which gets multiplied by a user-entered Qty/ set. If 
there is a setup charge in the definition, the setup is only added once.  

This is not normally used in Always Ask charges because it would be multiplying a user entered 
quantity by a quantity that is normally a user entered charge. Unfortunately, the standard quantity is 
not available for user entry with this quantity method so it would have to have already been preset 
in the definition to work. Set this up by starting with the definition set to use Quantity, using Preset 
Info to set the quantity, changing the quantity type to Number of Sets and using Preset Info to set 
the quantity to 1. We are unaware of any value to this type of setup; it’s almost always easier to just 
use Quantity on Always Ask charges. 

Note:  Always use Preset Info with this quantity type to ensure the default quantity is 1 or the 
most commonly used quantity so it generates a price when first selected. If left set to 0, no 
price is generated until you enter a quantity. 
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Quantity 

This is the most common quantity type. It is appropriate for any job aware charge except markups 
and flat rate.   You enter the quantity, which is multiplied by the rate for the price. If the method is 
set to Job Aware, the quantity automatically calculates. 

Figure 6.48: Quantity Preset Info Example 
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Time 

Time is useful for defining charges where price is based on hourly rates. 

Figure 6.49: Time Preset Info Example 

 
 

Instead of a single value, there is a start and stop time. Enter the time as HH:MM (hours and 
minutes). You can use a colon “:” or decimal point to separate hours and minutes. 1.3 is treated as 
1 hour and 3 minutes and 1.30 is 1 hours and 30 minutes. If both a start and stop time are entered, 
the quantity is the difference between the two. If only one time is entered, PrintSmith assumes this 
is the total time. The quantity displayed for the job is always in decimal hours (i.e. 1 hour 30 
minutes is shown as 1.5 hours). 

PrintSmith also understands that a 9:00 start time and a 4:00 stop time is 7 hours although you can 
also use AM and PM to further clarify things or use a 24 hour time. 
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No Quantity 

Selecting No Quantity is equivalent to using the Flat Rate pricing method. It is only appropriate for 
use with the Flat Rate or Always Ask methods. 

Figure 6.50: No Quantity Preset Info Example 

 
 

Number of Sets & Setup 

Number of Sets and Number Of Sets & Setup are used when you want to be able to enter a 
multiplier for the entire charge. Both function identically. The only difference is in how setup 
charges are handled. In Number of Sets, the setup charge is added only once. In Number Of Sets 
& Setup, it is added to each set. 

An example of this is for Drilling charges when you require a single charge that can be used for 
any number of holes and charge a set up for each hole. Enter the number of holes. PrintSmith 
calculates the normal quantity, adds setup, and then multiplies this by the quantity entered for 
the number of sets. Always use Preset Info to preset at least a 1 in the Qty/Set field. A zero will 
generate a price of 0.00 unless there is a set up charge. 
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Specifying Other Options 
There are a variety of additional options available for each charge for handling special 
circumstances and enforcing how a particular charge is used in the Estimator. 

Hide Price Only 

Selecting the Hide price only option will not display the price underlined (it will be hidden), but the 
charge description will still be displayed (not underlined) in the Invoice.  This is different from the 
Hide charge in printouts option, which hides the charge description and the price.  

Note: The Hide price option can also be set in the Update Charge window. 

Hiding Charges in Printouts 

Not all charges need to be included in the document (invoice and estimate) printouts. To hide a 
charge (not include it in a printed document), check the Hide Charge In Printouts option. Hidden 
charges are underlined. 

WARNING: If a charge definition marked as hidden is added to a document as an invoice level 
charge, it will be un-hidden (unless it is a markup). PrintSmith only allows job level 
charges and invoice level markups to be hidden and displays charges that are not allowed 
to be hidden because of how they are being used. When this happens, PrintSmith will 
warn you. 

No Overrides 

This option prevents anyone from overriding the quantity or price in the charge. Changing the 
quantity is treated as an override in job aware charges because PrintSmith generates the quantity 
automatically. 

Figure 6.51: No Overrides Preset Info Example 

 
 

Price cannot be edited if the 
No Overrides option is 
enabled. 
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Adjustable Sets 

When this button is enabled, you can change the set size on charges in the estimator. This allows 
you to enter the number of sheets per lift in a cutting charge on the estimate. This option should be 
turned off most of the time. 

Figure 6.52: Adjustable Sets Preset Info Example 

 

Adjustable Rate 

You want the flexibility of changing the rate on a charge. Enabling this option gives you this ability. 

Figure 6.53: Adjustable Rate Preset Info Example 

 
The adjustable rate button also affects how charges are handled when a document is recalculated 
or copied and prices are updated. PrintSmith assumes that this option is used for charges where 
you frequently change from the defined rate, and just use the rate in the charge as a starting point. 
When a charge with an adjustable rate is reloaded in the estimator, the rate is left unchanged. 

If No Overrides is also enabled, the rate is displayed, but you can not change it. 

The In Sets of Fields is 
displayed when the 
Adjustable Sets option is 
enabled. 

The Rate field is displayed 
when the Adjustable Rate 
option is enabled. 
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Adjustable Material 

This option is rarely used simply because a material rate is extremely rare. Like the Adjustable 
Rate option, it allows the user to change the material rate in the Estimator. 

Figure 6.54: Adjustable Material Preset Info Example 

 
The example above shows a charge with both a rate and a material rate.   A material rate should 
only be specified when you need more than one rate and more than one quantity. 

Enabling this does not guarantee the material rate can be changed because there is room for a 
limited number of fields and this option has the lowest priority. Always use Preset Info to make sure 
that the data field is present. 

Do Not Discount 

This setting allows for charges, such as postage or shipping charges, to not be affected by 
discounts. When enabled, the charge is excluded from customer and markup discount charges. 
This type of charge is shown in the Invoice Window with a “∆” next to the price. 

Ignore Global Price Changes 

This setting results in the charge not being affected by global pricing updates done via the Change 
Price window.  For example, a 10% markup charge will not be affected by a price increase, which 
could result in incorrect functionality. 

Excluded from Production 

With this option set, the charge will not be displayed in the Tracker windows. 

Tracker Pre-Production 

This setting allows work to be done on an Invoice before the job is released to production. 
 

The Material and Material 
Quantity fields are displayed 

if the Adjustable Material 
option is enabled.



EFI PrintSmith 7.2 |  Reference Guide 

 
 

 
Page 324 

Entering Pricing Data 
The pricing data entry portion of most charges is identical except for Cutting Charges and Ink 
Charges. In the Charge Definition window, there are six checkboxes with corresponding data fields 
in the pricing area. Each checkbox controls the field to the right. If the box is selected, the field is 
used for pricing. If the box is grayed out, it cannot be used.  

Figure 6.55: Pricing Data Fields 

 

Entering an amount in any field automatically enables the box associated with the field. Un-
checking a box will hide the contents of the associated field. This information is not deleted. 

Setup - A Setup charge is added in addition to the standard price. It modifies the basic formula as 
follows: (quantity x rate) + setup = price 

Minimum - Entering a Minimum amount guarantees that the price generated for this charge will 
never be below the minimum entered in this field. 

Rate – The Rate is the primary rate used for charges. This field is used in the majority of charge 
definitions. Alternatively, a rate list can be used to define a variable rate. 

In Sets - When the rate you enter is for a quantity other than 1, you need to specify the unit 
quantity. To enter a price such as 12.00 per thousand, you can enter 12 for the rate and 1000 for In 
Set. 

Example: When asked, many people communicate prices in sets (i.e., folding is 12.00 per 1000), 
but they actually charge for the service on a per piece basis (e.g., 0.012 each rather than 
12.00 per 1000). The difference is important. In the following table, 1001 folded would cost 
$24.00 (2 sets) if priced by the set, and 12.01 if priced per piece. You may wish to price in 
units of 10 or in some cases 100. 

Table 6.13: Choosing a Set Size for Charges Example 
 Prices Using Different Set Sizes 

Quantity Ordered $12.00 per 1000 $1.20 per 100 $0.12 per 10 $0.012 each 
     

100 12.00 1.20 1.20 1.20 

250 12.00 3.60 3.00 3.00 

275 12.00 3.60 3.36 3.30 

1000 12.00 12.00 12.00 12.00 

1001 24.00 12.12 12.12 12.01 

1100 24.00 13.20 13.20 13.20 

2000 24.00 24.00 24.00 24.00 
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Material - Occasionally, you may encounter a pricing situation where you need more than one rate 
to properly price an item. Normally this would only occur on a job aware charge where two different 
In Sets are needed. Otherwise, you should simply add the rates together and enter them in the 
Rate field. 

Note:  Material should be used in conjunction with Rate. If there is only one rate, it should always 
be Rate. Never use Material over Rate. 

When the rate you entered is for a quantity other than 1, you need to specify the unit quantity. 
Turning this button on adds a field to the definition where you can specify that quantity. To enter a 
price such as 12.00 per thousand, you need to enable the Material Sets button. In the definition, 
enter 12.00 for Material and 1000 for In Sets Of value. 

In Sets - In Sets for material works the same as In Sets for Rate; except, of course, that it applies 
to the Material rate. 

Using Price Lists for Added Flexibility 

Price Lists can add a lot of pricing flexibility to charges. You can add a price list to any charge, even 
if the pricing method does not require one. These price lists let you set up a job aware charge so 
that the rate it uses changes with the quantity. Price lists are controlled using the Price List button 
to attach, detach, delete, and create new price lists. It is not necessary to create a unique price list 
for each charge definition. Any price list can be shared by any number of charges. If you are 
creating a price list for use by a single charge definition, we recommend that you use the name of 
the charge as the name of the price list. It is also a good idea to avoid having price lists with 
duplicate names because it is very difficult to figure out which price list to use. 

 

Assigning Price Lists in the Charge Definitions Window 
Price Lists can be assigned to specific charges. To assign a Price List: 

1. Select the applicable charge from the hierarchical list. The selected item will be 
highlighted and the additional details are displayed. 

2. Click the Price List button. A List window displays the available price lists. 

3. Select the applicable price list. The selection will be highlighted. 

4. Click the Select button. The list window is closed and the selected Price List is 
displayed to the right of the Price List button. 

Note:  Remember to update the charge definition by clicking the Save button in the main 
definition window. 
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Creating a Price List 
If the charge does not have a price list, clicking the Price List button displays a list of all the price 
lists. 

Figure 6.56: Price List Window 

 
You can create an unlimited number of price lists. However, you are probably able to operate with 
just a few since you can assign the same table to more than one charge definition. The Save As 
command in the File menu can be used to copy a price list and give it a new name. 

Note:  Changing a price list in any charge definition changes the base table, which may be 
attached to other charge definitions using that table. 

Clicking the New button opens the table definition window. 

Figure 6.57: New Price List Window 

 
 

This window is used throughout the pricing system to set up price lists. It is also used for waste 
charts and speed tables. In this context, the window is used to specify the name of the price list.  

Usually this window is much smaller, use the zoom box to change the size of the window and show 
or hide these configuration details. 

Assign Selected Price List 

Clear Assignment 

Create New Price List 

Delete Selected Price List 

Closes Window Without Performing 
An Action 
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You must at least enter a name for the price list in the title field. It is best to use the same name for 
the price list as the charge definition it’s created for. It is easier to manage changes to a price list if 
it is only used once. There may be times when this is not appropriate. For example, if you are 
setting up a series of charges that price the same except a different setup or minimum is used on 
each charge, it makes sense to use the same price list. Similarly, if you are setting up a standard 
discount table that is to be applied to a class of charges such as book binding, a single price list is 
much easier to manage. 

You change how the price list is used and displayed by changing the set up options for the price 
list. 

Properties of Price Lists 

Amount Type 

Each price list consists of two columns. The first column always contains a quantity. The second 
column contains a price if the Amount is Currency button is selected and a percentage if Amount is 
Percent is enabled. 

Most of the time, the amount type you select only affects how the price list appears when it is 
opened. It does not have any effect on the generated price. 

Interpolation 

Interpolation is valid with all types and changes the returned value, not how it is used. 

Example: You set up a book binding charge and for each book, you want to charge $3.00 for 
10 or less books, $2.75 up to 50, $2.50 up to 100, and $2.00 after that. You would set up a 
rate list without interpolation as follows: 

 Quantity Price 

     10 3.00 

   50 2.75 

   100 2.50 

   101 2.00 

The Interpolate button will change the rate used for the price of booklet jobs between 10 and 
100 because PrintSmith will calculate intermediate rates or prices for quantities that fall 
between the quantities in the price list. For example, 75 books would use a rate of $2.875. 

Last Line Is Add’l Qty 

This option is used to determine pricing for quantities that exceed the final quantity listed. Use this 
button only with Amount is Currency. It adds an amount to the returned value to adjust the price for 
quantities that are greater than the last line in the charge. When enabled, the last line is used to 
generate a price when the quantity exceeds the last item on the list. If there’s no additional quantity 
on the price list and the quantity is larger than the last quantity listed, the last price on the list is 
used. This button should be off when the price list is being used as a rate list. 
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Types of Price Lists 

The following table defines the various types of price lists available.  

Table 6.14: Types of Price Lists 
Type Purpose Options To Be Selected 

   

A Add an amount to the price of the charge Amount Is Currency 
Last Line Is Add’l Qty 

 Determine the price of the charge Amount Is Currency 
Last Line Is Add’l Qty 
In the charge definition: turn off Rate button. 

B Determine the rate based on the quantity 
(e.g. 1 is $5, 10 is $4 apiece, 20 is $3.50 
apiece) and add it to the price of the 
charge. 

Amount Is Currency 
Use As Rate List 

 Determine the rate based on the quantity 
(e.g. 1 is $5, 10 is $4 apiece, 20 is $3.50 
apiece) 

Amount Is Currency 
Use As Rate List 
In the charge definition: turn off Rate button. 

C Function as a markup and/or discount 
table that modifies the price of the charge 
based on the quantity. 

Amount Is Percent 
Use As Rate List 

D Markup or discount the price of the job to 
which the charge is attached based on the 
quantity of the job. 
This should only be used on Job Aware 
charges because the quantities in the job 
are needed to look up the discount rate. 

Amount Is Percent 
Use As Rate List 
Production Discount 
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Entering Data in Price Lists 
After entering the name of the table, enter the quantities and prices, click the OK button and the 
new price list is created. 

Figure 6.58: New Price List Example 

 
 

As the quantity increases, so should the price. The entire list need not be used. At least the first two 
lines must be defined. 

You can specify up to 15 different quantity/price combinations. When you enter the quantities, they 
should be sequential with the smallest quantity at the top of the list and at least the first two 
quantities are specified. The maximum quantity does not need to be the largest quantity you will 
ever use. When the quantity in the job is larger than the largest value in the price list, the last price 
in the table is used. 

<tab> key changes column 

<return> key changes line  

arrow keys on keyboard 
change selection 

The first zero quantity 
denotes the end of the 

list. 
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Using Price Lists With Different Pricing Methods 

There are only two issues regarding price lists: the quantity used to look up the value, and what to 
do with the value that is returned. How each charge pricing method uses price lists is discussed 
below. 

Table 6.15: Price List Pricing Method 
Method Uses 

  

Job Aware Lookup quantity depends on charge specifications. If only material is used then the 
lookup quantity is sets x runs x originals, where sets is calculated using the material 
set count. If rate is also used the same calculation is performed using the rate set 
count and the material is ignored. If the quantity specified in the charge definition is 
Number Of Sets or Number Sets & Setup, the number of sets also multiplies this 
amount. The most important use of price lists with Job Aware charges is when you 
want the price to vary with the quantity, in effect, a quantity discount. Types A, B, C, 
and D are all recommended. 

Markups Lookup quantity is the job price, prep, bindery, production totals, the entire job or the 
entire amount of the invoice depending on what type of markup it is. Type B and C are 
recommended. Types A and D are not. 

Flat Rate This type of charge should not be used with a price list. 

Always Ask The lookup quantity is the number of sets. The quantity is calculated using the set 
count and the user entered quantity. Types A, B, and C are recommended as needed. 
Type D is not. 

Price List Forces the attached price list to type A. 

Rate List Forces attached price list to type B. 

Cutting Charge This method is calculated exactly the same as Job Aware charges. The only difference 
is that the Qty/Set: is set to the estimated number of cuts before processing as a 
standard “Job Aware” charge. If the charge definition is in the Pre Press command, it 
calculates cuts from the Parent Size to the Run Size. If it is in the Bindery command, it 
calculates cuts from the Run Size to the Finish Size. The lookup quantity is the number 
of lifts per cut. For example, if Sheets Per Lift was 500, quantity ordered was 1000 and 
number of cuts was 3 – the lookup quantity would be 2 (there are 2 lifts of 500 each). 
All types are valid; B is best for variable rate cutting. 

Ink Charge The number of pounds is used for lookup (rounded up for fractional pounds). All types 
are valid: B is normally recommended for variable ink charges. 

Shipping Charge The weight of the associated job or document. 
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Modifying a Price List 
Once a price list has been assigned to a charge, click the name of the assigned list to open. You 
can change the price list and click the OK button to save the changes. 

Note:  Remember, the price list may be used by other charge definitions and any changes you 
make, affect those charges too. 

 

Removing a Price List from a Charge 
To remove a price list from a charge, click the Price List button. When the list selection window 
opens, click the Clear button. Remember to update the charge definition by clicking the Change 
button in the main definition window. 

 

Changing the Selected Price List 
To use a different price list, click the Price List button. PrintSmith opens the Price List. Select a 
price list, or click the Clear button to remove the existing price list assignment. 

 

Changing the Name of a Price List 
In order to change the name of an existing price list, you must open the price list. If it is already 
assigned to a charge, select the charge definition and then click the price list name. If it has not 
been assigned to any charge yet, you must assign it to one at least temporarily.  

When the window is open, click the zoom box in the upper right had corner of the window title so 
the name of the table is visible in an edit field. Click the edit field and type in a new name. When 
you click the OK button, the name is changed. 

Note:  Changing the name of a price list automatically changes the price list name on all charge 
definitions using that table. 

 

Deleting a Price List 
To delete a Price List, click the Price List button. When the Price List opens, select the Price List 
and click the Delete button. 

Note:  Remember, the price list may be used by other charge definitions. Before deleting a price 
list, make sure it is not being used by any other charge definition. 
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Assigning Waste Charts to Charges 
Even though there is a system wide waste chart, PrintSmith recognizes each type of charge can 
have different spoilage characteristics. To support this, each charge definition can have its own 
waste chart. 

The procedures for managing waste charts are nearly identical to those used for price lists. There 
are two steps to setting up a waste chart for a charge: creating the waste chart and assigning it to 
the charge definition. Once a waste chart has been assigned to a charge definition, the name of the 
waste chart is displayed to the right of the Waste Chart button. 

Assigning Waste Charts in the Charge Definitions Window 
Waste Charges can be assigned to specific charges. To assign a Waste Chart: 

1. Select the applicable charge from the hierarchical list. The selected item will be 
highlighted and the additional details are displayed. 

2. Click the Waste Chart button. A List window displays available Waste Charts. 

3. Select the applicable Waste Chart. The selected item will be highlighted. 

4. Click the Select button. The list window is closed and the selected Waste Chart is 
displayed to the right of the Waste Chart button. 

Creating a Waste Chart 
If the charge does not currently have a waste chart, clicking the Waste Chart button displays a list 
of all the waste charts in the system. 

Figure 6.59: Waste Chart List Window 

 
 

Create as many waste charts, as you like. You can define a waste chart for each charge; however, 
it is likely that you will be able to operate with just a few waste charts. You can assign the same 
waste chart to more than one charge definition. 

Note:  Changing a waste chart in one charge definition changes it in all the definitions using that 
chart. 

 

Assign Selected Waste Chart 

Clear Assignment 

Create New Waste Chart 

Delete Selected Waste Chart 

Closes Window Without Performing 
An Action 
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Clicking the New button opens the Waste Chart definition window. 

Figure 6.60: New Waste Chart Window 

 
 

This window is used throughout the pricing system to set up price lists. It is also used for speed 
tables. For waste charts, the button settings are determined by PrintSmith, and cannot be changed. 

Note that the Interpolate button has been grayed out and cannot be changed. Because it is 
enabled, PrintSmith calculates intermediate values if the quantity being looked up does not exactly 
match a quantity in the table. The result is a smooth curve. 

Figure 6.61: New Waste Chart Example 
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The entire list must be used. Run length must increase from top to bottom. As the quantity 
increases, the waste percentage should decrease in small enough increments. Avoid the number of 
wasted sheets becoming smaller on longer runs. 

A complete waste chart consists of 15 quantity/percentage combinations. The maximum quantity 
does not need to be the largest quantity you will ever run. When the quantity in the job is larger 
than the largest value in the waste chart, the last percentage in the chart is used. 

Use the Print command in the File menu to print a waste chart. 

 

Modifying a Waste Chart 
Once a chart has been assigned to a charge, click the name of the waste chart to open it. You can 
change the waste chart and click the OK button to save the changes. 

Note:  Remember, the waste chart may be used by other charge definitions and any changes 
you make, affect those definitions too. 

 

Changing the Selected Waste Chart 
To use a different waste chart, click the Waste Chart button. PrintSmith opens the Waste Chart 
List. Select a new chart, or click the Clear button to remove the existing waste chart assignment. 

 

Changing the Name of a Waste Chart from the Charge Definitions Window 
In order to change the name of an existing waste chart, you must open the waste chart. If it is 
already assigned to a charge, select the charge and then click the Waste Chart Name. If it has not 
been assigned to any charge yet, you must assign it to one at least temporarily. 

When the window is open, click the zoom box in the upper right had corner of the window title so 
the name of the table is visible in an edit field. Select the edit field and enter a new name. When 
you click the OK button the name is changed. 

 



Chapter 6:  Pricing 

 
 

 
Page 335 

Defining Preset Information 
The Preset Info window is used for several functions: customizing the prompts to more clearly 
describe the data to be entered, pre-loading the most common quantity on charges that are not Job 
Aware, and testing pricing.  To open the Preset Info window, click the Preset Info icon. 

Note:  Do not use this window with job aware charges to test pricing. There is no job to pull 
information from and the charge has no source for the information needed to calculate a 
price. 

Figure 6.62: Preset Info Window 

 

Setting Options in Preset Info Window 
Use it to preset several important flags that indicate whether the item is taxable, if the quantity 
should be displayed, if the job is brokered and if pricing is finished. This window is the only place 
where the finished, taxable, brokered, and display quantity buttons can be preset. 

Finished - This button is used to mark charges whose pricing is not yet complete. When selected, 
a “?” displays in the document windows total column for the charge. 

Taxable - Each line item on a document can be marked as taxable or nontaxable. This button is 
used to preset the tax status of each charge. It should only be turned off for those items that are 
never taxed since it can easily be changed in the estimator. 

Brokered - When marked, a “B” displays in the document windows total column. It is normally used 
to mark jobs and charges that have been sent out for production. It is never printed on invoices or 
estimates. 

Display Qty - Disable when all you want on the invoice is the name of the charge and perhaps the 
price. This is usually enabled. 

Show Notes - Each charge definition has a Description and a Notes field. Turn on Show Notes if 
you want the contents of the Notes field added to the description in the document. Disable if the 
Notes field is used for instructions on how to use the charge or information intended for production 
personnel. 
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Customizing Labels in Preset Info Window 
Perhaps the most important use is it lets you customize the labels on the data entry fields so that 
they are more intuitive. PrintSmith supplies a set of generic labels for each data entry field. 
Because they are generic, they don’t necessarily describe the data that’s required of the user. 
Changing the labels can decrease the amount of time it takes to train people how to use charges in 
the Estimator. 

Changing the labels shown could make a big difference to the user. It is not immediately apparent 
what Qty/set: means. Staples clearly describe what the information represents. <Option>+<shift> or 
<alt>+<shift> causes any custom labels to be removed. Clicking the Change button saves, wiping 
out any custom labels you have set up. It is useful for resetting the labels to their default values. 

 

Previewing Preset Info As It Would Appear in the Estimator 
It previews how the charge will appear in the Estimator when it’s actually used. Holding down the 
<option> or <alt> key when clicking the Preset Info… icon opens the window in preview mode 
(which is exactly the same way the charge will be shown in the Estimator). In this mode, values 
cannot be edited. 

Since this window gives you a preview of the charge as it is used in the Estimator it can be used to 
test pricing. Enter a quantity and press <tab> to see the price. Make sure to restore the quantities 
to the values you want displayed when the charge is initially added to a job or document before 
clicking the Change button. 

Note:  If you use Preset Info to test the pricing on a job aware charge, it appears as though you 
are overriding the quantity. This override is temporary. When the charge is saved, the 
override is removed. There is no useful purpose served by overriding a job aware charge, 
it prevents the charge from doing its job. Use Always Ask charges if you need to preset a 
quantity on every job. 

 

Entering Quantities in Preset Info Window 
It lets you set up quantities for certain types of charges so that when selected, the most common 
quantity is already entered. 

Note:  Changes made in the Preset Info window are not permanent until the charge is saved in 
the main definition window. 
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Defining Costing Rules from Charge Definition Window 
Costing can be defined for a specific Charge. To define costing rules: 

1. Select the applicable item from the hierarchical list. The selected item will be 
highlighted and additional information displayed.  

2. Click the Costing  button. The application will determine the last time the charge 
was costed in the Estimator and populates that information, acting as a starting point 
for modification. 

Note:  If the charge has not been costed, a No Costing  icon is displayed to the left 
of the item name in the hierarchical list, No Cost is selected as the default 
Costing Method, and the Status reads ‘New’. 

3. Select the applicable Costing Method (No Cost, 100% Cost, Unit Cost, Time and 
Materials). Applicable fields and buttons will become active based on the Costing 
Method selection made. 

 

Defining Unit Cost Costing 

Unit Cost can be defined by:  

1. Enter a cost to Set Up (if any).  

2. Enter a Unit Cost, which is the cost of performing one unit of the charge.  
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Using a Rate Table to Define Unit Cost 

Unit Cost can also be defined using a Rate Table instead of Unit Cost. To use a rate table: 

Figure 6.63: Unit Cost and Rate Costing Method Example 

 
 

1. Click the Rate button. When Unit Cost is selected as the Costing Method the Rate 
button is activated. 

2. Select the applicable Rate table. The selected item will be highlighted. 

3. Click the Select button. The List window is closed and the selected Rate table is 
displayed to the right of the Rate button. Variable is automatically entered as the 
value for Unit Cost. 

 

The Rate button is 
activated when Unit Cost 

is selected.
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Creating a Costing Rate Table 

If a new rate table is needed when defining unit cost: 

1. Click the New button in the list of available rate tables window. 

Figure 6.64: New Price List Window 

 
2. Check the Use as rate list option. The Price column will be relabeled to Price. 

Figure 6.65: New Rate List Example 

 
3. Enter the Quantity and Rate information. 

4. Name the rate table. 

5. Click the OK button. The newly created rate table will be listed the next time you 
access the list of available tables. 
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Defining Time and Materials Costing 

To Define Time and Materials Costing: 

1. Enter Fixed Materials. 

2. Enter Unit Materials 

3. Enter Labor Rate. 

4. Enter Setup in minutes. 

5. Enter the number of Pieces/Hour. 

 

Using a Costing Speed Table to Define Time and Materials 

When Time and Materials is selected as the Costing Method, the Speed button becomes active 
and a Speed Table can be assigned.  

Figure 6.66: Time and Materials and Speed Costing Method Example 

 
 

To assign a Speed Table: 

1. Click the Speed button. A List window displays available Speed Tables. 

2. Select the applicable Speed Table. The selected item will be highlighted. 

3. Click the Select button. The List window is closed and the selected Speed Table 
name is displayed to the right of the Speed button. 

 

The Speed button is activated 
when Time and Materials is 
selected. 
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Modifying an Existing Charge 
To modify an existing charge: select it from the category, modify the definition, and click the Save 
icon. 

Note:  When you first get started, you may make frequent changes. Once PrintSmith is running, 
use caution when changing charge definitions. 

It is easier to create a new charge than to completely change how an existing charge is used. 
When PrintSmith updates charges to use current pricing in a document, it locates the charge 
definition using an internal serial number assigned to the charge when it was created. When the 
charge is located, its current definition is copied to the charge in a document. If you reuse an 
existing charge definition, PrintSmith will still update the charge using the current definition. This 
practice could cause confusion and should be avoided. 

Example: A Folding charge, originally defined at 1¢ per sheet is changed it to Die Cutting at 
$25.00 each. When PrintSmith updates the pricing on an invoice, it will change the pricing for 
the folding charge to die cutting. The problem is the original invoice text will still indicate a 
folding charge.  

When PrintSmith updates a document’s charges, it compares the name of the charge in the 
document to the name of the charge definition. If they do not match, PrintSmith will show both the 
old and new names ask if you still want to update the pricing on that charge. For this reason, you 
should try to name your charge definitions exactly as you want them to be printed on an invoice or 
job ticket. Where possible, use the Notes field to modify the charge description without changing 
the name. 

It is perfectly acceptable to change a charge definition because you have changed how the charge 
generates a price. Always add a new definition when a new charge is needed. Never reuse an 
existing definition. 

Duplicating Charges 
There are several ways to duplicate or copy charges. The easiest method is to hold down the 
<option> or <alt> key and drag the charge to a new location, a different category, or even a 
different command. Change the name of the charge and click the Save icon. 

When dragging a charge in to a different category, you must drag it below the category in the 
category list. If the category you are dragging to is in a different command, you can select the 
category in the destination command and then drag right into the charge list to place the charge 
exactly where you want. 

Deleting Charges 
To delete a charge, select it and click the Delete icon. Alternatively, you can select it and then 
select either the Cut or Clear commands from the Edit menu. The Cut command saves a copy of 
the charge to the Clipboard and you can Paste it back into another command or category. Selecting 
a charge and pressing the <delete> key is the same as using the Cut command. 
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Using Charge Definitions 
Using charges effectively can make a big difference in how well PrintSmith works for you. When 
working in the Estimator, you normally attach charges to either a job or a document (Estimate or 
Invoice). Charges attached to a job are referred to as Job Level Charges and those attached to a 
document are referred to as Invoice Level Charges. 

When a charge is attached to a job, it is included in the total job price when you generate a price 
list or multiple quantities on a quote. Markup charges that mark up part of a job must be attached to 
a job. Markup charges that mark up an entire invoice must be attached to a document. Except for 
the restriction on markup charges, any charge from any command can be attached to a job or a 
document. 

The level at which the charge is attached is determined by the window that is open when the 
command is selected. If a job window is open when a charge command is selected in the Invoice 
menu, the charge is attached to the job. If a document window is open and no job window is open, 
the charge is attached to the document. If the Cash Register window is open and selected, the 
charge is added to the current cash register transaction as a “Quick-Est” transaction. If neither a job 
nor a document window is open, the charge is not attached to anything. This feature is useful if you 
want to quickly check the price on a charge. 

On some charges, you may also want to customize the labels for the charge so that when the user 
sees the charge in the Estimator there will be no doubt what information is needed to price the job. 
An example might be a drilling charge where the user enters the number of holes. A normal setup 
for a drilling charge would show a field entitled “Qty/set:” for the number of holes. Changing the 
label to “# of Holes” would be much clearer. Labels can be changed within the Preset Info window.  

Overriding a price or rate should be avoided as that prevents PrintSmith from updating the prices if 
the document is used for a repeat order. When setting up a charge definition, set it up so it handles 
an entire range of situations without requiring you to override the price. 

Testing Pricing 
This is a key step before going on-line with PrintSmith. After you have entered your pricing 
definitions you should create estimates and generate price lists to ensure you are getting the prices 
you desire and the specifics entered work properly. A good way to verify your pricing is to take a 
sample of recent invoices and re-create them in PrintSmith. This process will verify your pricing is 
complete and will provide familiarity in using PrintSmith. 

When you are ready to go live you can reset your system to eliminate all test invoices, estimates, 
etc. When you are starting out you might give everyone the ability to override prices. As you 
continue to modify your pricing and are confident that your assumptions are complete, restrict the 
ability to override prices. 

Printing Price Lists 
Now that you have completed your pricing assumptions you will most likely want to test them by 
printing and reviewing printed price lists. PrintSmith provides several ways to print price lists. Price 
lists can be printed for all printing jobs, copy jobs, papers, etc. Use PrintSmith’s powerful price book 
generators to print price lists. 
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Waste Chart 
The percentage of spoilage you normally experience varies with the size of the job. PrintSmith uses 
a modifiable curve from which waste is calculated. 

Figure 6.67: Waste/Spoilage Chart Window 

 
 

Modify the curve by clicking on the square “handles” and dragging them around. You can also enter 
the data directly in a table by clicking on the Enter Data button. 

The curve is read as the waste percentage vertically and the run length horizontally. You can see 
what the actual waste count would be by pointing anywhere on the window and clicking the mouse 
or holding the mouse button down as you move around on the chart. You can print the chart at any 
time by selecting the Print command on the File menu. 

PrintSmith calculates the waste for each run based on the total number of impressions. When 
setting up this chart, it is generally best to start with reasonable figures for anticipated waste on 
most jobs. You can also use this chart to “fine tune” pricing – keep in mind that a change in waste 
also affects production time - a small change in a single pass job could result in a much larger 
change to a multi-color job. 

The Waste Chart command is used to define the system waste chart. In addition to this chart, you 
can define a waste chart for each press definition. This is often useful to fine tune pricing or to 
account for differences in the press being defined or a different production environment.  

Instead of modifying the curve by clicking on the square “handles” and dragging them around, you 
can enter the data directly in a table by clicking on the Enter Data button. 
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Figure 6.68: Waste Chart Data Window 

 
Note:  It is not necessary to make the last entry in table equal to your longest possible run. If the 

run length of a job exceeds the run length on the chart, PrintSmith will use the last 
percentage on the chart. 

 

Sales Tax or Value Added Tax (VAT) 
In order to properly calculate and report your sales taxes, you need to define your tax rates within 
PrintSmith. If you do not charge and collect sales tax, you should review the settings to ensure they 
are set to collect no tax (zero). 

This section covers defining standard/default sales tax set up, creating new tax tables to handle 
multiple tax jurisdictions, and addressing international and other tax issues. 

Defining Standard/Default Sales Tax 
The standard/default tax table can apply to everyone. Typically, the standard sales tax set up is all 
that you will need to complete. However, if your business uses multiple tax jurisdictions or is 
international, you will need to define these additional tax set ups. 

1. Select Sales Tax from the Pricing menu. 

The Sales Tax window opens. The table that appears when you select the Sales Tax 
command from the Pricing menu is the Default tax table. All taxable invoices and 
customers will use the Default table’s rate unless another tax table is assigned to an 
account, invoice, or estimate. 
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Figure 6.69: Sales Tax Window 

 
 

2. Verify that the Default tax table is selected in the Tax Table drop down in the Sales 
Tax window. The Default tax table has no ID. Since the Default tax table is selected 
when the window first opens, the Tax Table ID field will be empty. 

Note:  The default tax table is used whenever tax needs to be calculated and a special 
tax table is not specified. The default tax table will be the most commonly used 
tax rate. You attach special tax tables in a customer’s account record and in the 
Document Totals window of an open document.  

3. Check the Tax Shipping option if the shipping amount entered in the Document 
Totals command in the taxable subtotal should be taxed. This setting does not apply 
to charge definitions used for shipping charges. For these charges, you can indicate 
when they are taxable using the Taxable button in the charge definition screen. 

4. Check the Tax on Tax option if your tax district taxes other taxes. Normally, 
PrintSmith adds the rates in the tax table together to come up with the effective tax 
rate. If you check this option, PrintSmith will calculate each of the tax rates. For 
example if the first rate were 6% and the second rate were 5%, the effective rate 
would be 11.3% as PrintSmith would add 0.3% which is 5% of 6% (the first rate). 

5. Check the Build Tax In Price option if you want to hide tax in the price for items and 
never show it separately. Enabling this option is one part of this set up – it tells 
PrintSmith to calculate and include the sales tax in each price of a price list.  

6. Enter up to five line items that are used to calculate the Effective Tax Rate. You can 
breakdown each tax table into five line items, such as City, State, County, Special 
Assessment, etc. Each line item consists of a Description, Tax Rate, and whether or 
not to Show the item on the invoice or estimate. 

Note:  Consider adding a small charge for chemicals and materials used, the same way 
an automobile company charges for small miscellaneous materials. Consider 
collecting a charitable donation on each sale.  

The Tax Table ID field is a two 
character tax table identifier for 

the Tax Table selected in the 
Tax Table drop down field. 

The Description field is the 
explanation of tax items, which 

is displayed when the Show 
button is enabled.

A Minimum Taxable 
Amount can be defined. 

The Show checkboxes 
determine whether the line 
in the table is to be shown 
separately on an invoice or 
estimate. 

Total Effective Tax Rate 
for this table is calculated 
using the line items. 

The Tax Table drop down field 
provides a list of all defined tax 

tables. When the window is first 
opened, the Default tax table is 

selected. 
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7. Verify the Effective Tax Rate. This rate is calculated based on the line items defined. 
If this rate is not correct, adjustments must be made to the line items. 

8. Set the Minimum Taxable Amount. 

Note:  A tax details report is available for any time period. Enter each differing tax you 
want to track separately.  

 

Creating New Tax Tables to Handle Multiple Tax Jurisdictions 
If you have more than one tax structure, you will need to create additional tax tables. For each 
customer account with special tax requirements, a special tax table can be created and assigned to 
that account. You can also change the default tax table on any invoice or estimate to reflect special 
requirements.  

Note:  There is a practical limit of tax tables that is around 40 depending on other files added to 
the Prices folder. 

Example: A business in California has taxable and non taxable customers. Some of these 
taxable customers have differing tax rates due to their government status or other special 
circumstances. The business is based in Los Angeles and when it delivers jobs to customers 
in Orange County, a different rate must be charged. Using different tax rates can be 
accomplished by adding an OC (Orange County) tax table. This tax table can be assigned to 
customers in Orange County. This tax table will also be available to assign to an invoice or 
estimate for walk in customers who reside in Orange County. 

 

To add a new Tax Table: 

1. In the Sales Tax window, enter a two (2) character name in the Tax Table ID field for 
the Tax Table to be added. The name of a Tax Table must be unique. Therefore, the 
new name entered cannot match any of the other existing Tax Table names. 

2. Press the Enter key on the keyboard. The system will search for a Tax Table with the 
name entered. If no table exists, a prompt is displayed. 

3. Click the OK button. The new Tax Table will be created. 

4. Enter the necessary tax information. 

5. Click the OK button when complete. 

 

Once the new tax table is created, assign the tax table to each customer who uses this tax rate in 
the customer’s account record or in the actual document. To do this, select the Tax Table from the 
Tax Table drop down menu in the Accounts window and/or the Tax Table field in the Document 
Totals window. For information on how to assign a tax table to a customer account, see page 167. 
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Using Tax Codes to Track Differing Groups with Similar Rates 

If you have several taxes that are the same rate for differing institutions, counties or other 
organizations, consider assigning tax codes in customer accounts and documents to track the 
differing groups.  

Example: If you have three counties in your state that all collect 8% tax, you can create one 
tax table at 8% and enter differing tax codes for the three counties for each customer and or 
document. Using different codes presents a report showing the amount of sales tax collected 
for the 8% rate and sub total for each tax code.  

Addressing International and Other Tax Issues 
Because PrintSmith is used throughout the world, there are many different options as to how tax is 
calculated, reported, and displayed. International customers may require tax on tax and variable tax 
rates. Some Canadian customers need to calculate PST and then add GST on top of that tax. Chile 
also has special tax verification procedures. Currently, you must create a separate tax table for 
each different tax rate. 

Note:  In simple tax situations, all of the check boxes are disabled, which is the norm throughout 
most of the United States. 

Using a Tax Rate of Zero 
It is not recommended that you set up tax tables with tax rates of 0% to handle tax exempt 
accounts or documents. Instead, use the No Tax button in the document totals area of the 
document or enable the Tax Exempt feature in the customer’s account. However, if you want to 
track a certain category of sales, you can use a tax table or tax code, which is assigned in the 
customer account or on individual documents. 

Note:  If you set up a 0% tax rate, the amounts will still be considered taxable although no tax will 
be calculated. This approach complicates the figuring of sales tax, as these sales are 
considered taxable with a zero rate tax. 

Showing More Than One Tax Rate on a Document 
When indicating more than one tax rate on a document, check the Show button for each separate 
tax you wish to display. Electing this option also applies to receipts printed with the optional receipt 
printer. If there are additional taxes that are not marked as shown, they are grouped together in the 
standard tax amount. 

Multiple tax lines are computed for each document when the document is printed, and are not 
saved with the document, meaning that if you print an old locked document and the tax rate is 
different from when the document was last printed, the tax amounts for each line will not be correct 
although the total amount of tax will be. 

Showing Taxes With Different Names 
In Document Preferences, there is a Print Tax Name From Table button in the Page panel. This 
prints the table’s description name on the document where Tax is normally displayed. Enable this 
feature to print the descriptions from the tax table. 

Printing the Tax Rate on Documents 
To display the actual percentage on a document, type the tax rate in as part of the description. 
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Hiding Taxes in Prices 
If you decide to hide tax, make sure that you only have one tax table (PrintSmith has not been 
tested using multiple tax tables and hidden tax). You must enable the Build Tax In Price option so 
that prices are consistently shown with tax. In document preferences, you must: 

• Enable the Remove Tax Line option in the Page panel. 

• Enable the Hide Tax In Line Items option in the Body panel. 

In Preferences >POS>Receipts, you must also enable the Hide Tax In Line Items option so the 
receipt printer also hides tax in prices when it prints. 

Canadian Shipping Taxes 
Some provinces in Canada tax shipping differently. To support this, a special Canadian Shipping 
checkbox has been added to the tax table. Since it is somewhat unusual, it is only displayed if it is 
enabled in the Preferences panel, or if you hold down the <option> or <alt> key when selecting the 
Tax Table command. 

 

Generate Price Book 
The Generate Price Book command is used to automatically generate price lists with a title and 
page number suitable for binding as a counter price book. 

You can generate a price book for any or all of the stock groupings or for just the stock that you 
select. The price lists generated by this command use the Printing pricing method and have prices 
for 1 color on the front and 1 color on the front and back in separate columns. 

For each column, a unit price is also generated. PrintSmith will generate a price per thousand 
instead of a unit price if you hold down the <shift> key while clicking the Print button. 

Figure 6.70: Generate Price Book Window 

 
 

Add page number to bottom of each page of your Price Book. Then specify which stock definitions 
to generate the price list for. 
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Change Prices 
Occasionally you will want to adjust prices for changing market conditions and price changes from 
vendors. The Change Prices command makes changing your stock and other prices simple. 

Stock Definitions 
For example, if you wanted to increase all of your stock prices by 5%, all you have to do is enter “5” 
in the Auto Update By Percent, select the stock groups to update, decide if you want to confirm 
each step, and click the OK button. PrintSmith will go through each stock definition and increase 
the stock cost by 5%. By turning on Re-Calculate Blank Stock Prices and Auto Adjust Copier Prices 
your blank stock and copier pricing will also reflect these changes. 

Figure 6.71: Change Prices Window, Stock Definitions Tab 

 
Another important feature of this command is its ability to quickly recalculate stock prices after you 
change any of the basic pricing preferences. When a stock definition is changed PrintSmith re-
calculates blank and copier pricing as needed. If you change a preference that affects how these 
prices are generated, PrintSmith does not automatically modify the pricing in each stock definition. 
You can use the Change Prices command (except a markup of 0% instead of the 10% shown to 
have PrintSmith update all the stock definitions as needed). 

A typical use of this process is changing the quantity breaks or markups for blank stock in the 
Stocks and Sizes Preference panel. To adjust blank stock pricing to reflect those changes in all the 
stocks at once, enter a percentage of 0, turn the Re-Calculate Blank Stock Prices option on and 
click the OK button. The entire process should take less than a minute. 
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Selecting Stock Groups 
The first section, Stock Groups to Update is used to determine which groups of stock to update. If 
you wanted to update only the Envelopes from XPEDX you would enable Envelopes, disable other 
groups and enable Match Vendor Name and enter “XPEDX” in the edit field. 

Setting up Price Change 
The second section determines what action to take on each stock. There are three basic ways in 
which you can change a stock price: 

• Enter each stock price always stops after each stock so you can enter the new price. 
When this button is selected the Confirm Each Change is always on. 

• Auto update by percent allows you to increase or decrease the price on each stock by a 
given percentage. 

• Auto update by amount is used to add a fixed amount to each stock. You enter the 
amount by which you want to change the cost of each stock. 

There are three buttons that are used to modify the selected action. 

• Confirm each change stops before changing the stock definition so you can modify the 
price change, confirm it, or skip it. 

• Re-calculate blank stock prices cause the pricing for blank stock to be recalculated using 
the new price and the default blank stock markup from the Stocks and Sizes Preference 
panel. 

• Adjust copier prices adjusts the copier price, if any, by the same percentage that the stock 
price is changed. 

In addition to these basic options, you can also use the command to automatically assign charges 
to groups of stocks. 

Performing the Price Change 
The bottom section displays the stock, the old prices, the currently assigned charges, the new 
charges to add (if any), and has edit fields for the new costs. 
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Other Prices 
The Other Prices panel assists you in changing all other prices except stock definitions. 

Figure 6.72: Change Prices Window, Other Prices Tab 

 

Change Prices By 
A negative number decreases prices, a positive number increases them. 

Update All Press Definitions 

Selecting this option will adjust the Labor Rate, Plate Fee, and Wash Up fields by the given 
percentage for all Press Definitions. No other fields are affected. 

Update All Copier Definitions 

Selecting this option allows you to select two other options. If Skip Costing Data is turned off, the 
costing information for the copier is changed. This includes the following data: maintenance, 
payment, machine, labor, toner, developer, flat rate, and cost per copy in the Copy Range Table. 

Include Copier Matrix 

When checked, the change is applied to the copier matrix unless the matrix is a discount table type. 

Skip Costing Data 

When checked, the costing data in the copier definitions will remain as they were. 
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Update All List Price Schedules 

Selecting this option updates all price lists schedules used by the List Pricing method using the 
given percentage. 

Note:  Crouser price schedules are not affected by this command. 

Update All Charges 

Selecting this option updates the Set Up, Material, Rate, and Minimum fields in Charge Definitions 
using the given percentage. 

Include Price Lists 

When checked, the prices in all charge price lists are updated except for price lists being used as 
markup tables. 

Reversing the Price Change 
After the price change has been applied, a reversing percentage is calculated and inserted into the 
Change Prices By field. An explanatory alert describes the change. To reverse the change you just 
made, click the OK button to the message stating that the change percentage has been reversed. 
Do not close the Change Prices window; instead, click the OK button in the lower left corner of the 
Change Prices window to start another update cycle which will reverse the change you just made. 

Note:  The reversing percentage may not exactly reverse the original change due to rounding 
differences; however, they will be the same to a close approximation. You can restore 
Pricing from backups immediately if you wish to change everything back to original prices. 

WorkStation Maintenance 
Enhanced update pricing capability through the WS Maintenance window allows force pricing 
updates from the master to the workstation, either immediately or at the next login.  If the 
Immediately option is selected, workstation users are asked to exit PrintSmith and log back in.  The 
pricing update check occurs at the workstation after log in. 

Figure 6.73:  WS Maintenance window 

 
Note: The Last Done field displays the date and time of the last pricing update. 
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Import Stock Catalog 
The ability to import stock definitions and update prices from a vendor’s electronic price catalog is a 
powerful tool for managing stock. 

The Import Stock Catalog window has three panels. The first panel controls the overall process. 
The remaining panels are used to confirm the import process is in the correct format based on the 
selected interpreter. 

Settings 
Figure 6.74: Import Stock Catalog Window, Settings Tab 

 
 

Use xpedx Interpreter 
Select this option when importing data from the xpedx pricing catalog. Generally, this file must be 
created using the xpedx Export Utility that creates a file named “data.txt” in a location determined 
by their system. The program and documentation for the export utility should be available through 
an xpedx representative on both the Macintosh and Windows platform. 

Use Generic Interpreter 

Select this option when importing data from any other pricing catalog.  

Verify Each Stock 

Before adding or importing a stock definition a window is opened which asks if you wish to save 
changes either to a new definition or an existing one. 

Browse 

Use this button to find the file to be used for importing. 
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Adjust Bracket by Percent or Amount 

The bracket price being imported can be changed during the import process by either a percentage 
or a fixed dollar amount. Increase the price by entering a positive amount, decrease the price by 
entering a negative amount. Whether the adjustment is a fixed amount or percentage is determined 
by the button selection. 

Import Brackets 

The stock import supports up to five price brackets and different adjustments can be made to each. 
If you select just one bracket, bracket four for example, it will place the stock cost in the first price 
column in the stock definition. If you were to import bracket two and bracket four, for example, 
these brackets would import into the stock definition’s first and second price columns, respectively. 

No Broken Cartons 

When this button is selected, the Min. Order field in the stock definition is set to the value of “Lot 
Count” when importing using either the Generic or Xpedx interpreter. 

Metric 

This setting allows imported metric information and automatically turns the metric button on in the 
stock definition. 

Update Prices 

Click the Update Prices button to use the imported data to update existing stock definitions. Stock 
definitions are listed by vendor name and stock number (“Stock #” in stock definition window). 
Stocks in the import file, which are NOT in the stock definition, are not added. 

Import All 

Click here to use the imported data to create new stock definitions. This is identical to updating 
prices except that it will add stocks if unable to locate an existing one. 
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xpedx 
This panel is used to check the set up for an xpedx catalog import. 

Figure 6.75: Import Stock Catalog Window, xpedx Tab 

 
Default Vendor Name 

Enter the name by which xpedx is referred to in your stock definitions. It very important that this 
information is exactly correct although upper or lower case does not matter. Stocks are located for 
update during the import process using this name and the stock number. 

Record Data 

This shows the import record. If the location of the import data is not set to point to an existing, 
properly formatted import data file, this will be empty. Use the Next button to see the next record. 
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The Generic Interpreter 
The generic interpreter is based on a PrintSmith published specification. It is a comma delimited 
ASCII text file with each field surrounded by quotes and each record separated by a carriage 
return. 

Figure 6.76: Import Stock Catalog Window, Generic Tab 

 
 

Interpreter Formats  
PrintSmith imports a structured text file into stock definitions. The source of this file could be your 
excel spreadsheet or the output of a vendor specific paper catalog. The following describes how 
the files are structured and how the import process works. 

Should be a (Comma) “,” delimited text file with no header record in the first line. All character fields 
within the record need standard double quotes (ASCII 34) on either end of the character string. 
Each record should end with a return character (ASCII (13)). The record contains (26) fields, some 
of which are not used at this time, but should have valid information supplied if available. 
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xpedx Import Record Format 
This table illustrates what is essentially a proprietary (xpedx) record format and shows what data is 
imported. Some of the fields in the file are used internally or ignored; these fields have somewhat 
cryptic names and are all in capital letters. 

Table 6.16: xpedx Import Structure 

Database Name PrintSmith 
Field Description 

   

STOCK NUMBER Stock # Vendor stock number 

SHEET SIZE Sheet Size Sheet Size – grain is always second dimension 

STOCK NAME Stock Name Stock Name 

SALES_UOM SALES_UOM Sales unit of measure – smallest packing unit for an item – 
typically SH for sheet; RL for Roll; EN for Envelope. 

LOT COUNT Minimum Qty. Indicates minimum quantity for stock. 

CARTON CT Carton Count Number of sheets per carton 

COST UNITS Cost Unit Pricing unit of measure – typically 1000. 

M WEIGHT MWGT Item M Weight. 

WEIGHT Weight Item basis weight. 

CALIPER Caliper Caliper 

PRICE BRAKT 1, 2, 3, 4, 
5 

Bracket [x] 
Pricing 

Pricing Bracket table. Price is selected based on the bracket 
pricing table in the Setting’s panel. 

PRICE QUANT. 1, 2, 3, 
4, 5,  

Bracket [x] 
Qualifier 

Quantity breaks for pricing. 

SECT_NO SECT_NO Internal use. 

SECT-DESC SECT_DESC Internal use. 

COLOR Color Color of the stock. 

FINISH Finish Type of finish – this is added to the Finish field during import. 

# OF PARTS Number Parts Number of carbonless parts. 
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Generic Import Record Format 
This record format is a public format that PrintSmith has developed which can be used to prepare 
stock data for import into PrintSmith. 

Table 6.17: Generic Import Structure 
Display Name Documentation Type Data Type Usage 

    

VENDOR_NAME Vendor Name 20 Characters If not supplied, the default vendor 
name from the Generic panel is 

STOCK NUM. Unique Product ID 31 Characters A unique stock number. 

SHEET SIZE Parent Sheet Size Size ###.## x ###.## decimal sizes 
only, no fractions. 

STOCK NAME Product Name 50 Characters Name of the stock. 

UNIT_DESC Unit Description:  
S-Sheet 
R-Roll 
E-Envelope 
C-Carbonless 
O-Other 

1 Uppercase 
Letter 

If not supplied, the Other 
description in used. 

COST UNITS Cost Units Number Units cost 

WEIGHT Item Basis Weight Number Weight of the stock. 

M WEIGHT Item M Weight Number Weight of 1000 sheets of the 
stock. 

CALIPER Caliper Number Stock definition field. 

ENV. SIZE Envelope Size 10 Characters In order for a proper size to be 
entered, a size table entry must 

PRICE BRAKT 1, 2, 3, 4, 
5 

Bracket [x] Pricing Number Pricing Bracket table. Price is 
selected based on the bracket 

PRICE QUANT. 1, 2, 3, 
4, 5,  

Bracket [x] Qualifier Number Quantity breaks for pricing. 

COLOR Color 20 Characters Stock color. Either Color or 
Generic Color must be supplied. 

GENERIC COLOR Generic Color 20 Characters Stock color. Either Color or 
Generic Color must be supplied. 

FINISH Product Finish 20 Characters Finish (dull, Gloss, etc) is added to 
the product name. 

NUMBER PARTS Number of Carbonless 
Parts 

Number Number of carbonless parts. Only 
valid if unit description is C. 

PRICE EXPR. Price Expiration Date Date Price no longer valid after this 
date. 

INTERNAL Internal Internal Internal use only. 
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Display Name Documentation Type Data Type Usage 
    

LOT COUNT Number Number Indicates minimum quantity. 

CARTON CT. Number Number Number of sheets per carton. 

STOCK TYPE Stock Type 20 Characters Stock group description. 

BASIC SIZE Basic Size Number ###.## x ###.## decimal sizes 
only, no fractions. 

METRIC Metric T/F Metric sizes. 

COATED Product Coating Number Denotes stock coating. 

GRADE Grade 20 Characters Defines paper grade. 
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Chapter 7 Reports 
In this chapter 
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The Reports menu contains commands for extracting and reporting on the data collected by 
PrintSmith. Some of the reports are optional, like Report Writer. Others, like the Balance Summary 
report are part of the Accounts Receivable module. You may see these reports in the Reports 
menu even if you have not purchased the necessary software. However, PrintSmith will be unable 
to generate the report. 
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Account History 
The Account History report provides a historical record of all accounting activity for each customer 
account. It is a powerful tool for managing your business. You can review any history in 
chronological order or in reverse chronological order. You can choose to show only invoices, 
payments, journal entries, or finance charges. You can search through the history to find specific 
items. The window can be resized and the width of any column adjusted. 

Figure 7.1: Account History Report 

 
 

Use the history to answer specific questions about payments, determine when a particular order 
was placed, examine the unpaid (open) invoices on the account, annotate certain entries, print a 
detailed account activity report, and select an entry to be opened by the Estimator (to copy an old 
invoice for example). 

Scroll bar 

3 custom 
bookmarks 

Sort by any 
column 

Analyze 
selection 
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The columns in the report are used as follows: 

Table 7.1: Account History Report Columns 
Column 
Heading Data Displayed 

  

Posted The date that the entry was posted to the Account History, whether it was paid or 
charged. Entries are displayed in the order in which they were posted. This order can be 
reversed with a click. 

Invoice # The invoice number of invoices posted to the account. 

Description Describes the document. For Invoices, this is the PO number, if any, and the invoice title. 
For payments, PrintSmith generates it when the document is posted. <Shift>+double 
click allows you to change the description of an invoice. 

Total The amount of the document when it was originally posted. The total is underlined if there 
was a deposit on an invoice. 

Paid on On invoices and journal entries, it is the date a payment was last applied to that item. 
This date is blank on payments. 

Ref # Invoices and journal entries, shows the check number or credit card validation number for 
these types of payments. 

Balance Due The current balance due on the item. Negative amounts are credit balances that have not 
been applied to a debit (invoice or debit memos). Items with no balance due have been 
paid off or fully applied (payments and credit memos).  

  

 

Adjusting Display Order in the Account History Report 
The display order can be resorted by any column by clicking on the column header. 

Filtering in the Account History Report 
You can change history to show only Invoices, Payments, Journal Entries, or Finance Charges by 
changing the settings in the Show History Type menu. 

Resizing Columns in the Account History Report 
By placing the mouse pointer over the column separator it will change to an appropriate cursor, 
then by clicking-and-holding the mouse button, you can drag the separator left and right. These 
positions are saved on the current Workstation just like window positions and sizes. To return to the 
original settings, hold down the <option>/<alt> key while opening the window. 

All of the buttons can be selected from the keyboard by pressing the letter underlined on the button 
name. Likewise, the underlined character in the bookmark tabs will select that tab. 
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Using Bookmarks in the Account History Report 
The history bookmark drop tab control is to quickly navigate through any account history. Clicking 
on a tab that is already selected returns you to the beginning of that list. 

Table 7.2: Account History Bookmarks 
Bookmark Description 

  

First Open The display starts with the first open (unpaid) item and continues to the end of the list.  

Note:     The History shows all items after the first open item. This is generally 
more useful in checking on payment status that the Post Payments 
command which only show open items. 

This Month Starts with the first item in the current month. 

Prior Month Starts with the first item in the previous month. 

This Qtr Starts with the first item in the current quarter. 

This Year Starts with the first item in the current year. 

Last Year Starts with the first item last year. 

All Starts with the first item posted to the account. 

  

 

User-Defined Bookmarks in the Account History Report 
Up to three specific history records can be marked and returned to at anytime by performing the 
following steps: 

Locate the record of interest. 

1. Click on the record in the history window 

2. Click the Set button at the far right side on the bookmark drop tabs. 

A new tab will appear to the left of the Set button containing a description of the selected item. To 
remove the bookmark, hold down the Option/Alt key and click the Set button. 

Scrolling through History 
If a customer has more information than will fit on a single screen, use the scroll bar to move 
forward or backward through the history. From the keyboard, the Page Up and Page Down buttons 
may also be used to move through history. 

Selecting Customers 
Click the Get button to open the Account Picker, which allow you to select an account to review. 



EFI PrintSmith 7.2 |  Reference Guide 

 
 

 
Page 364 

Searching Account History 
The Find button is used to open the Find History tool. This powerful tool allows you to search 
through any account history to find items that match the criteria set up in the Find History window. 

Figure 7.2: Find History Window 

 
The information contained in the customer history record can be searched by clicking on the Find 
icon at the bottom of the window. First select the history column you wish to search by clicking on 
the appropriate drop tab, then type in the search text and click the Find button. You may also 
display a single record type by selecting it from the pop up menu in the find window. 

History Analysis 
Click the Analysis button to open a window containing an analysis of the history shown in the 
window. The report format is similar to the daily sales report. Only sales categories with activity are 
shown. 

When the analysis contains invoices that were not costed in the costing system, Total Cost and 
Total Margin show a “*” to indicate that this information is incomplete. 

Analyze Selection 
Use the Analyze Selection feature, to analyze a contiguous or non-contiguous selection of history.  
First, use Shift + click to select a contiguous range or Ctrl/Cmd + click to select a non-contiguous 
range of history items, then click the Analyze Selection button.  The History Analysis window for 
the selected items opens. 

Printing History Reports 
To print any Account History, select File > Print from the main menu. The printed report starts from 
the top of the current display and proceeds to the end of the history. 

Note:  A composite report showing all accounts can be printed when the Account History window 
is first opened by clicking the Cancel button instead of selecting an account. Select the 
button for the items you want (Open Items, All, etc.), and then select File > Print from the 
main menu. 
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Opening Source Documents 
One of the most useful features of the Account History is the ability to open any invoice in the 
history and copy it into an invoice or estimate. Once you have found the invoice, you can open it 
directly from the history by double-clicking on it. 

You can also open journal entries by double-clicking. The History Detail window can be opened for 
any item by <shift> double-clicking on the item. 

Rebuilding Account History 
The account history for any account can be rebuilt by holding down the <option>/ <alt> and <shift> 
keys when selecting the account. You can rebuild the account history for all accounts by closing all 
the PrintSmith windows and holding down the <option>/<alt> and <shift> keys when you select the 
Account History command. You must be a member of the system admin security group to perform 
this function. 

Rebuilding the history updates all the history pointers and customer account sales statistics and 
can take a very long time. You should not have to use this procedure except under most unusual 
circumstances. After performing a rebuild, you should also use the Verify All Balances and Verify 
Receivable Balance commands in the AR menu. 

Note:  Do not attempt this operation from Workstations, as it could cause a severe slowdown. 

History Entry Detail 
To get more details on a particular item, <shift> double-click on it. 

You may leave this window open and move it to the side of the history window, as you change 
selection in history this window is updated. While this window is open, use the disclosure triangle to 
view the details of jobs on posted invoices. You can change the description of any entry in the 
history by typing in a new description and clicking ok. 
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Estimate History 
Estimate History maintains a historical record of the estimate activity for each customer or 
prospect. Use Estimate History to answer specific questions about past estimates, easily access an 
old estimate for a new request, determine when a particular estimate was entered, whether the 
order was won or lost, or open the Estimate and copy it to new Estimate or Invoice. 

Figure 7.3: Estimate History Report 

 
 

Estimates are shown with the most recent Estimate first. Each entry shows the date it was created, 
the estimate number, description, total of the estimate, whether it has history notes and if it 
represents a win (it was converted to an invoice) or a loss (it was cleared from the Pending List with 
the Clear Estimate command). 

Table 7.3: Estimate History Paging Directions 
Direction Description 

  

Previous Shows the previous screen full of entries to display. Enabled when there is more of the 
history to display. 

Next Page Shows the next screen full of entries to display. Enabled when there is more of the history 
to display. 

  

 

Get 

The Get button presents the Account Picker window from where you can select the customer or 
prospect whose history you wish to view. 
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Find  

Clicking the Find icon opens the History Search window that allows you to search through the 
estimate history by creation date, estimate number, or title. 

Figure 7.4: Estimate History Find Window 

 
Select the history column you wish to search by clicking on the appropriate drop tab, then type in 
the search text and click the Find button. 

Notes  

Clicking the Notes button opens the Estimate Notes window. This window is used to add notes to 
an estimate such as why it was won or lost or if an estimate contains anything extraordinary you 
would want to be reminded of in the future. 

Figure 7.5: Estimate Notes Window 

 
To review the notes, simply select the estimate and then click on the notes button. 
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Estimate Win/Loss Status 

Tracking accurate win/loss ratios is easy if you follow a few simple rules: 

• When you convert an Estimate to an Invoice, the original Estimate is placed in history and 
considered a Win. Copying an Estimate to an Invoice simply copies the document and does 
not put it into the Estimate History. 

• If you convert a previously lost Estimate to an invoice, it will be updated to a Win in Estimate 
History. You can only convert it to a win one time. 

• The Clear Estimates command removes estimates from the Pending List and can record the 
estimate with a loss or neutral status.  

• When you copy an Estimate to an Invoice, the original Estimate remains in the Pending List 
and is not considered a Win or a Loss. For this reason we suggest you use the Convert to 
Invoice command and not Copy to New Invoice when appropriate. 

• A cancelled Estimate is voided. Generally, you should use this only for mistakes. It does not 
affect the Win/Loss ratio and is not recorded in Estimate History. 

• When an Estimate is converted to an Invoice the winning Invoice number is recorded in the 
historical Estimate and shows in history. Opening a historical Estimate that was a “Win” shows, 
in the deposit block on the document window, the Invoice number that the estimate was 
converted to. 

 

Off Pending 

This date identifies when the document was removed from the pending list. This is useful for 
calculation of win / loss ratios. 
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History Detail 

Double clicking on an Estimate History item while holding down the shift key opens up the detail 
window. 

Figure 7.6: History Detail Window 

 
 

You can view all jobs on a document and change the document description for future reference. 
Move the detail window so that you can view both Estimate History and History Detail. Click on a 
document in Estimate History and using the arrow keys on your keyboard move up or down the list 
to see the detail of jobs in each document.  
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Work In Progress 
Work in Progress provides a variety of reports useful in controlling the orders being worked on, 
assisting with production scheduling, and managing your outstanding quotes. 

Figure 7.7: Work In Progress Report 

 
 

• You select the report you want by selecting the report type from the Report Type menu. Each 
report has a different format. You select the order in which you want the report from the Sort 
By menu. You indicate whether you want just Invoices, just Estimates, or both. As you 
change the report type, sorting order, and content buttons, the report is immediately updated to 
show the change. To see the entire report, use the scroll bar at the side of the window. Report 
columns are resizable. 

• An asterisk next to the invoice number indicates the job is marked Ready for Pickup or 
Delivery. Control the presence of completed documents by enabling the Completed button. 
Use the Location button in the Pending Document window to mark individual items as 
completed. 

• Documents that have an On Hold status display in red. Use this to track invoices that are 
holding and not actually in production. Use the Location button in the Pending Document 
window to update the Hold State. 

Firm Wanted By 
Dates Option 

Count (displayed 
when the Show 
Totals option is 
selected) 

No Pricing Option 
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• Selecting the Show Totals option will show subtotals, a grand total, and a count. The subtotals 
depend on the Sort By selection. For example, sorting by Due Date generates a report with a 
subtotal for each day. Sorting by customer or invoice number does not generate any subtotals. 
In addition to the subtotal, PrintSmith separates each subtotal group by a double line across 
the page. The grand total has a bold double line. The Date & Time report does not have 
document totals so although a line is drawn across the page, there are no subtotal amounts 
and there is no grand total. In the Weekly Schedule, only a grand total is displayed. The Show 
Totals button is ignored in the Press Schedule report. 

• Selecting the No Pricing option will hide pricing information in the WIP Report. 

• Selecting the Firm dates only option will only show those documents that have the Firm 
wanted by date option checked in the Invoice Account Info window. 

Note:  Double-click on any line in the report to open the document. 
 

To print the report, select the Print command in the File menu. The printed report is identical to the 
displayed version. The last report viewed on screen is remembered. The next time this report is 
opened, that report type and sort by will display. 

Report Type 
Standard 
This report shows the basic information about an order. The options in the Sort By menu are:  
Customer, Due Date, Location, Invoice #, Order Date, Proof Date, Sales Rep, Taken By, and Title. 
The Location option sorts the list according to the location of the order. You enter the location using 
the Location button in the Pending Document Window of the POS module or the job tracking bar 
code system. 

Date & Time 
This report is essentially the same as the standard report except that instead of showing the 
amount due of the document, it displays time in addition to the date. 

Location 
The location report is often used to track the current location of each order. The location is entered 
using the Location function in the Pending Document Window, or is the last Location scanned. 

Weekly Schedule 
The weekly schedule report is best used as a way to get a quick idea of the number and type of 
orders due for the week. PrintSmith automatically selects the next Monday as the starting point of 
the report. Holding down the <shift> key will generate a report starting from today’s date. 
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Press Schedule 
The press schedule report breaks each Invoice down into individual jobs. It is extremely useful for 
determining your work load for each copier and press according the date and time wanted and the 
machine it will be run on. 

This report includes only invoices (regardless of the buttons selected in the Work In Progress 
window). It can be sorted by press name, press name and ink color, by the machine ID in each 
definition, or by location. When sorting by press & ink, the jobs are sorted by the press first, then by 
the day, then by the ink color. 

Often, it is necessary to create more than one definition for a single machine. By assigning these 
definitions the same machine ID, you tell PrintSmith that they are the same machine even though 
they have a different definition. The machine ID method of sorting lets you group work by the actual 
machine being used. You set this up when using the copier definition command and press 
definition command in the pricing menu. 

Note:  Changes made to machine definitions and jobs will not appear in the report while the 
report window is open. If you change a machine ID for a particular machine, you must 
close the work in progress report window and open it again in order to see those changes. 

Job Location Schedule 
This report is used in conjunction with the bar code tracking system to generate a list of all jobs in 
progress and their current location in your shop. As in all the other work in progress reports, 
changes made to jobs after the report has been generated are not reflected in the sorted order of 
the items in the report. To update the report, just close the window and open it again. 

Sorting by Location is used with the bar code Job Tracking system to generate up to the minute 
reports showing each job's location.  

Integrated Schedule 
This report is used in conjunction with integrated devices.  When viewing this report type, a Submit 
button is displayed, which allows submission of the job to the Fiery. 

Figure 7.8:  Integrated Schedule Report 

 
 

 

 

Submit button Device ID 
Integrated 
Schedule 
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Mailing Labels 
PrintSmith’s mailing label generator is extremely powerful. You can use it to generate mailing labels 
and/or mail merge files for any subset of your customer, prospect list, or contact list.  

Figure 7.9: Mailing Labels 

 
 

Account options 
You determine which accounts are to be included in the list by selecting one of the buttons in the 
Account Selection Methods section. 
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Table 7.4: Mailing Labels Report Account Selection Methods 
Method Description 

  

All Selects all customer accounts. 

From Selects an alphabetical range of customer accounts. You are not limited to a single 
letter in the “From:” and “To:” text boxes; any number of letters can be used. 
Leaving either box empty will start at the beginning or go to the end of the list 
respectively. For example, if you wanted all customers starting with the “Miller” 
account, type “Miller” in the “From:” box and leave the “To:” box empty. To get all 
accounts beginning with “A” put “a” in the “From:” box and “b” in the “To:” box. 

Selected Accounts Selects individual accounts. PrintSmith keeps opening the account selection window 
as long as you keep selecting accounts. To stop selecting accounts, click the 
Cancel button instead of selecting an account and the labels will be generated. 

By Status Selects accounts by their account status. You limit the search to accounts with the 
desired status by selecting the buttons representing the account status to be 
included in the report. Selecting Account Source By Status does not support 
contacts 

Only Personal 
Accounts 

Only includes those accounts or contacts that are marked as Personal Accounts. 
You will find this setting in the Marketing panel in the account and contact windows. 
May not be used when Exclude Personal Accounts is selected. 

Exclude Personal 
Accounts 

Excludes any account or contact that is marked as a Personal Account. May not be 
used when Only Personal Accounts is selected. 

 

Only Personal Accounts / Exclude Personal Accounts 
You can select either one or neither one, but not both. If you leave them both off, all accounts are 
included - in effect, the setting is ignored. If you select “Only Personal Accounts” the mailing will go 
only to accounts marked as personal accounts. If you select “Exclude Personal Accounts”, the 
mailing will go to accounts that are NOT marked as personal accounts (i.e. business accounts). 

Choosing the Correct Account Source 
The account source you choose makes a big difference in the resulting mail merge or label run. If 
you select Accounts, only one label is printed for each account. Additional contacts in the same 
account are ignored and only the default contact on the selected address is used. 

Generating labels or mail merge files for contacts will create an entry for each contact in the index 
using the contact address if available, or the selected address in the account, even if the contact is 
the default account. For example, if you are using the Statement Address, it is used for all contacts 
that do not have their own address, even if the contact is the default invoice contact. 

For this reason, we recommend you mark contacts that are strictly billing contacts with the Do Not 
Mail button so they are always ignored by the Mailing Label command when the Account Source is 
Contacts. You can still generate labels and mail merge files for billing contacts via the Customer 
Account Source. If a contact does not have it’s own address, you can choose which address in the 
customer record to use. 



Chapter 7:  Reports 
 

 
Page 375 

Mailing Labels for Prospects 
Selecting Use Prospects from the menu uses the prospect list instead of the customer list and 
changes the type of account status that is available. 

For prospects, account status is quite different from customer status as follows: 

Table 7.5: Prospect Account Status 
Account Status Definition 

  

Never a customer The account was created as a prospect and has never been a customer 
account. 

Former Inactive Customer The account used to be a customer account, but nothing was ever posted 
to account history. 

Former Active Customer The account used to be a customer account and has history. 

  

 

Mail Merge File 
Selecting Create Mail Merge prepares a text file designed for use with the form letter generation 
facilities available in many word processing programs. The file can also be used to load your 
customer list into other data base programs and spreadsheets. 

The file format menu allows you to select the format that works best with your database or mailing 
list management software. Normal (comma delimited) files is the default and work well with the Mail 
Merge function of Microsoft Word, Normal (tab delimited) works best for spread sheets and data 
base programs where separating out city, state and zip is not critical. You can generate either 
Macintosh or Windows files. 

Formatting options 
Selecting Label Formats 
PrintSmith comes with several predefined sample label formats. You can modify the formats or 
create as many additional formats as you need using the Define Label Format button. The currently 
selected label format is used to control how and where address data is placed on the page when 
Print Mailing Labels is turned on and the OK button is clicked. 

Sorting Labels 
It is often convenient to sort the labels in a particular order before printing them. To do this, you use 
the sort menu. 
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Controlling the Appearance of Labels 
In addition to the font, PrintSmith allows you to specify the location of an attention line and postal 
bar code through the pop up menu at the left. “Print Attn. line” pertains only to mailing labels, not 
the mail merge file. The “Attn.” line can be printed on the top, the bottom, or not at all based on 
which, if any, item is selected. 

Similarly, postal bar codes can go on top, on bottom or not at all. If shown, the bar code is above or 
below all other items in the label. Currently, the US Post Office recommends that bar codes be 
placed on top of the label. This provides a more stable position for the bar code because the length 
of the address does not affect it. 

Printing Mailing Labels 
You have complete control of the format, placement and to some degree, the content of labels. If 
the predefined labels do not suit your requirements, you can design your own format using the 
Define Label Format button. If you plan to generate form letters and labels, you should select both 
the Create Mail Merge File and Print Mailing Labels buttons to ensure that the address list for the 
form letters matches the labels and are in the same order. 

Labels per Account 
If you use the label function to print shipping labels or box tags you may need more than one label 
for each account. Enter the number of labels you need for each account in this field. 

Note:  To print a different number of labels for each account, print each account separately 
because PrintSmith uses this as the number of duplicates for all selected accounts. 

Labels to Skip 
Sometimes, you will have a sheet of labels where some of the labels have been used. Rather than 
throw away the sheet, you can tell PrintSmith to skip a certain number of labels. This only applies 
to the first sheet, the rest of the sheets are assumed to be complete. 

Address to Use 
Since each customer account has two different addresses, you should select the address you wish 
to use on the labels. 
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Defining Label Formats 
You can change an existing label format or create a new one using the Define Label Format button. 
This opens the Label Format definition window. 

Figure 7.10: Define Label Format Window 

 
 

To see how the labels will line up when printed, use the Print Sample button. You should print this 
on regular blank paper to avoid wasting labels. It prints an outline of the address area of each label. 

To create a new format, make sure that “<new format>” is selected. Type in a name for the new 
format and click the OK button. The new format will be appended to the end of the format menu. 
The next time you start PrintSmith the list of formats will be sorted alphabetically. 

Measurements 
It is often easier to work with dimensions other than screen pixels when laying out labels. The 
Measurements menu lets you select pixels, inches, centimeters, or millimeters for measuring label 
layouts. 

Internally, labels are still defined in pixels. If you use a different measurement system, the 
displayed measurement will be converted to the nearest pixels and converted back into the 
selected method of measurements. This will cause some of the dimensions you enter to change 
slightly. 

Delete 
This button deletes the currently selected label format. 
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Built-in Label Layouts 
You can define as many labels formats as you need. PrintSmith is shipped with the following 
standard label formats. These formats are available for Carton Labels also. 

Table 7.6: Mailing Label Formats 

 Carton 
Labels 

Image 
Writer 
3x10 

Laser   
2x3 

Laser 
Avery 

5160 3x10 
Laser   
3x10 

Shipping 
Labels 

       

Labels Across 2 3 2 3 3 2 

Labels Down 3 10 3 10 10 4 

Label Width 252 190 185 165 185 260 

Label Height 216 72 85 62 72 170 

Left Margin 1 5 69 2 2 10 

Top Margin 36 12 160 18 12 10 

Space On Right 1 0 123 30 10 10 

Space On Bottom 18 0 154 10 0 10 
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Customer List 
The customer list command is used to prepare a variety of reports. You select the report type you 
wish from the Report Type menu and the order you want the customer accounts displayed using 
the Sort By menu. Choose the Customer list or the Prospect list or a combined report by enabling 
either or both check boxes. As you change these selections, the report is immediately updated to 
reflect the changes. Double clicking on a line opens the account history in most of the report types. 

Figure 7.11: Customer List Report 

 
 

Table 7.7: Sort By Options 
Options Definition 

  

Account Name The name of the account. 

Account Number The account number. 

Account Status Account status (current, past due, etc.). 

Business Type The business type is a 4 character code you can enter in the customer account 
definition to categorize accounts and generate reports sorted by account type. 

Account Type The type of account 

Sales per Month Sales for each customer by month. It is best to only sort by these fields after running 
a monthly closeout otherwise the monthly sales figures may not be correct. 

Sales per Year Sales for each customer by year. PrintSmith will ask if you want to save this ranking 
in the customer record if it is the first selection from either menu. 

Sales Rep Each account is sorted by the sales rep. 

Balance Their current balance, with the highest balance shown first, will sort accounts. 
  

 

Note:  Double-click on any account in the report to open the account history for that account. 
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Report Types 
Balance Summary Report 
The Balance Summary report generates a summary of the current account balances for all 
customers. For a very useful version of this report, select the Balance sorting method in the Sort By 
menu. This generates a report showing all the balances starting with the highest balance. 

Sales Summary 
This report shows the sales amounts for each account in a summary format. You can use Account 
History to determine the details of each account’s activity. 

Address List 
This report shows the account number, name and both of the addresses for each account. 

Posting Dates 
There are several dates, which PrintSmith uses to track how each account is being used. This 
report shows them. Each of the dates in the report is also shown in the customer account window. 

Account Profile 
This report shows a profile of each accounts’ special features. You control these features with the 
Customer Accounts command in the AR menu. 

Table 7.8: Account Profile 
Profile Definition 

  

Resale Accounts with a resale ID are not charged sales tax by the Estimator. This has no effect on 
Cash Register transactions where you would use the No Sale button to control tax. 

Table If a special tax table is assigned to the account, the two character tax table ID is show here. 
See Sales Tax in Pricing for details on setting up Tax Tables and Customer Accounts for 
assigning these tables to accounts. 

Type The type of the account (Cash, Check, Charge, Full Deposit). 

PO Req Indicates whether a PO is required on invoices assigned to this account. If the PO Required 
button in the customer account is turned on, a “yes” is displayed. 

Bill Indicates whether a statement is generated for this account. If the Do not generate 
statements button in the customer account is turned on, a “no” is displayed. 

CR Limit If a credit limit has been specifically set on this account (in the customer account window), 
the amount, in dollars, of that limit is shown in this account. “Default” in this column means 
that the system wide credit limit is used. 

Disc% Shows any “Automatic Discount Percent” for this account. 

Interest Shows the rate used by the statement generator to calculate finance charges. “Default” 
means that the system wide rate is used. “None” means that the Don’t Apply button in the 
customer account has been turned on and that no finance charge is ever calculated on the 
account. A percentage in this column shows a special rate for the account. 
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Sales Rank Month 
Shows the sales volume for each account for the current month. Monthly closeout updates these 
statistics. 

Note:  This report works best when sorted by Sales per Month. 

Sales Rank Year 
Shows the sales volume and relative standing of each account. The Yearly sales ranking, in 
addition to generating the report, allows you to save the ranking in each customer record. 

Note:  This report works best when sorted by Sales per Year. 

Collection Follow-up 
Shows information that is useful for calling customers about their outstanding balance. Double-
clicking on any line in the report opens the history for that account. 
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Daily Sales 
When you do a daily closeout, PrintSmith makes a permanent record of that closeout in the daily 
sales file. This report lets you examine this data and print a variety of reports. 

Figure 7.12: Daily Sales Report 

 
 

The Daily Sales reports are usually printed after each daily closeout. You can, if you wish, reprint 
any day or group of days using this report. When it first opens, a summary of all daily sales reports 
is listed. Document number sorts invoice Pickup, New Invoices, and other sales reports showing 
invoices or estimates. In the Sales Report and Work In Progress, totals in the miscellaneous 
section do not include tax. The Print command in the File menu prints a list of all the daily closeouts 
in the system with totals for each column. 
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Sorting by Sales Rep 
New Invoices, New Estimates, Invoice Pickups, and Invoice Profitability can be sorted and totaled 
by the Sales Rep in the document by holding down the <option>/<alt> key when clicking the Select 
button. 

Generating Composite Sales Reports 
You can generate a composite report for any group of closeouts by selecting the first date and 
holding down the <shift> key while selecting the last date. 

Note:  Use some care in generating composite reports. For example, printing a report of all 
payments or invoices picked up for the last 7 years is possible. If you generate such a 
report from a Workstation (multi-user systems) you will be waiting a long time because 
PrintSmith first reads all the records in the history for that period to build an index of the 
records before showing anything. For normal reports (a year or two) the report is quite 
fast. 

Report Format 
Sales Summary 
The daily sales report shows a detailed breakdown of sales and receipts for the period. 

New Invoices 
You can use this to reprint the New Invoices report generated during the Closeout. 

New Estimates 
This report shows all the estimates created during the period. 

Invoice Pickups 
You can use this to reprint the Invoice Pickups report generated during the Closeout. 

Invoice Profitability 
This report lists all invoices picked up for the period and shows their costs. Any Invoice that has not 
been costed is shown in italics. 

Payment Journal 
This report lists all payments posted during the requested period. 

Journal Entries 
This report lists all journal entries posted during the requested period. 

Tax Summary 
This report provides a breakdown of sales tax for both sales and receipts by tax table and tax code.  
In most cases you will be able to use this report to complete your sales tax reports. 

Tax Details 
This tax report includes invoice information.  It can be used to verify Tax Details against the 
Register Tape. 
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Accounting Links 
This is not a report in the sense that it prints information on paper. This report generates a file, 
which you name, containing the sales information needed by third party accounting general ledger 
packages. You select the “target” system in the GL Profiles Preference panel. The generated file 
may also be printed as a summary report.  

Print All Reports 
This option reprints all the reports for a particular day in the event of a printer malfunction during 
report printing or the reports for a particular day are misplaced. When this format is selected and 
you click the Select button PrintSmith prints each of the reports in the Report Format menu – 
nothing is displayed. 

All of the reports in menu are printed regardless of the standard reports you use during closeout. 
The Register Tape and Deposit Ticket are not printed. Use Open Old Tape and Deposit Ticket in 
the report menu to select and print these reports. This can only be done from the master. 

Note: Count information is included in several of the Daily Sales reports. 
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Account Ranking 
Account Ranking allows account to be ranked by different methods, within specified date ranges, 
and the rankings can be saved. 

Figure 7.13:  Account Ranking window 

 

Rank accounts by 
Select a method to Rank accounts by from the dropdown.  Account ranking methods include:  
Balance, Sales Current Month, Sales Current Year, Sales Prior Year, Number orders, Sales by 
sales category, Sales by date range, Sales by category and date. 

Run Ranking 
Once all ranking criteria has been set, click this button to generate the ranking results. 

Include Accounts 
Select which accounts to include in the account ranking, either Customer, Prospect, or both. 

Limit to Sales Category 
This option is only active if the Sales by sales category or Sales by category and date ranking 
methods are selected.  Sales category options in the dropdown list are populated from 
Preferences > Accounting > Sales Categories. 

Click to run 
ranking 

Items in red 
indicate change 
from last run 
ranking 

Select storage 
option 
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Ranking Storage 
Select a Ranking Storage option.  Up to seven different custom rankings with different criteria can 
be saved. 

Note:   Account Rankings are saved in the customer database to be used in conjunction with the 
Report Writer. 

Date Range 
This option is only active if the Sales by date or Sales by category and date ranking methods are 
selected.  Provide a date range by entering a From and To date. 

Sorting Account Ranking Results 
Account ranking results can be sorted by clicking on the column headers in the bottom half of the 
Account Ranking window.  Results can be sorted by:  Ranking, Old Ranking, Acct #, Acct Name, 
Amount. 

Monthly Sales 
This report is functionally identical to Daily Sales; the only difference is that the report reflects 
Monthly Sales rather than Daily Sales. 

Figure 7.14: Monthly Sales Report 

 

Generating Composite Sales Reports 
To get a detailed report for any month you simply double-click on the desired date then select Print 
from the File menu. You can generate a composite report for any group of close-outs by selecting 
the first date and holding down the <shift> key while selecting the last date. This includes invoice 
and tax reports. 
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Understanding Sales Reports 
The Sales Summary report uses the same format for daily and monthly sales. The report is divided 
into four sections: Sales Breakdown, Receipts Summary, Production Data and Miscellaneous. 

Sales Breakdown 
This section provides a detailed analysis of your sales compiled from invoices, journal entries, and 
POS (Cash Register) transactions. 

Total Sales 
Lines 1 – 16 and 22 – 40 in the sales report are summaries of sales categories 1 – 16 and 22 - 40. 
You have complete control over what goes in each of these categories using sales category menus 
for charges, press definitions, copier definition, the Configure Cash Register command for the Cash 
Register and the Pricing Method Setup command. 

• Discounts - Customer discount total. This is calculated from the discount field in the Invoice 
Totals window. 

• Markups - PrintSmith does not use this category. It is retained for compatibility with version 
3.0. 

• Total Sales - Total of all the above.  The amount does not include any tax due on sales. 

Other Sales 
The first four lines in this section are summaries of the “Non Sales” sales categories. 

• Interest - This is the last sales category. It may be renamed. However, PrintSmith uses this 
category to summarize finance charges. 

• Shipping - Total shipping charges are directly entered in the Invoice Totals window plus 
charges and jobs assigned to the Shipping sales category. Shipping is not included in the 
tax/no tax button unless shipping is taxed. Interest is not included either. 

• Total Other - Total of No Sale and Shipping. 

• Taxable Sales - The part of Total Sales that is taxable. This amount will always be less than or 
equal to Total Sales. If any of the Other Sales, such as shipping, are taxable, they will appear 
here. 

• Tax on Sales - The amount of tax on taxable sales. If your tax district has only one tax rate, 
this amount can be verified by multiplying Taxable Sales by the tax rate. 

• Non-Tax Sales - The amount of Total Sales that is not taxable. If you report your sales tax 
based on sales (the accrual method) you can use Total Sales, Taxable Sales and Tax on 
Sales to generate the tax figures for reporting purposes. We recommend that you use the 
accrual basis for reporting. 

• Total Memos - The total of all journal entries. 

• Non-Sales Memos – This field is the total of journal entries that do not affect sales. 
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Receipts Summary 
This section contains an analysis of cash receipts for the period. It is further divided into two 
sections: Receipts on sales (POS) and receipts on Accounts Receivable (AR). 

• Cash - Total cash receipts. 

• Checks - Total checks receipts. 

• Credit Card - Total credit card receipts. 

• Deposits Applied - Total deposits on invoices picked up. This is the point at which deposits 
are receipts for tax purposes.  

• Deposits Rcvd - Deposits entered on invoices during the period. 

• Deposits Returned - Total deposits refunded to customers. 

• Total - Total of cash, checks and credit card receipts for POS and AR. AR total is the amount 
received which was credited against items already posted. POS Receipts value is the total that 
was paid for at the time of the sale. 

• Total Receipts - Total of cash, checks, credit cards, and deposits received. Total receipts –
deposit applied + deposit received - deposit returned = actual deposit -over/ short. 

• New Charges - Total of all charges made to accounts receivable during the period. 

• On Account - The total of payments, which were posted to an account, without actually being 
applied to an open item. The sales report shows the amount placed on account (payments 
received but not applied to any open items) as well as amounts applied to open items from 
previously posted payments. In other words, if you post a $100 payment without applying it to 
anything, it would show in “On Account” as $100. When you later apply this to an open item it 
would show in “On Account” as -$100. Usually, the report will be positive because most 
payments are immediately applied to open items. If a payment is entered but is not applied to 
an open item, it is possible for this number to be negative when it is later applied to open 
items.  This does not indicate a problem. 

• AR Balance - The current Accounts Receivable balance, at the close of the period. Taking the 
Accounts Receivable balance from the previous period, subtracting AR receipts and adding 
New Charges can verify this balance.  

Note:  The AR Balance field does not take the Refund Checks field into consideration 
• Taxable Receipts - The amount (for POS and AR) of total receipts that was taxable (this 

figure does not include tax just taxable amounts). 

• Tax on Rcpts - The amount of tax due and collected on Taxable Receipts. If your tax district 
has only 1 tax rate, this amount can be verified by multiplying Taxable Receipts by the tax rate 
although it may be off a few cents due to rounding. 

• Non-Tax Rcpts - The amount of receipts, which were not taxable. This amount does not 
include deposits, as they are not true receipts until the document with the deposit is posted. 

• Deposit Forfeit - Total deposits forfeited because the invoice was cancelled and the deposit 
was not returned to the customer. 
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• Deposit Balance - Total deposits on all pending invoices. It represents money, which you 
have received for work not yet delivered to the customer. 

Note:  It is possible, and NOT an error that the total of taxable receipts, tax on receipts, non-
taxable receipts and “on account” will not match “Total Receipts”. This is due to 
accumulated rounding of sales tax and should only amount to a couple of cents. 

 

Miscellaneous 
• Actual Deposit - The total amount of the deposit tickets for the period. 

• Over/Short - The total amount that PrintSmith’s cash drawer totals differed from the actual 
amount that you entered at the daily close out. A positive amount means that you deposited 
more in the bank than PrintSmith thought you should, a negative amount means you deposited 
less money than PrintSmith thought you should. 

• Paid Out - The amount of cash taken from the cash drawer. 

• WIP Total Invoices - The total of all invoices in the pending list that are not completed. 

• WIP Total Complete - The total of all invoices in the pending list marked as completed. 

• WIP Total Estimates - The total of all estimates in the pending list. 

 

Production Data 
This section shows a variety of statistics about the sales for the period of the report. On a daily 
basis, many of these statistics are not very meaningful. For example “Sales/Press-Hour” gives you 
the dollar amount in sales for every press hour and on any given day it is quite likely that none of 
the press hours were performed on invoices picked up that day. This type of information is more 
useful over a longer baseline such as a month or a year. Record this information daily and 
PrintSmith will summarize it for you at the end of the month. 
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Deposits in PrintSmith 
PrintSmith places the deposits you enter on invoices in an escrow account. When you put a deposit 
on an invoice, it is tracked in Deposits Received. When you change or remove a deposit, the old 
deposit is put in Deposits Returned and the new deposit, if any, is put in Deposits Received. 

When an invoice with a deposit is picked up, the deposit is put in Deposits Applied and is also 
included in Taxable Receipts because it is being recognized as a receipt at this point. 

PrintSmith actually apportions the deposit between taxable receipts and tax on receipts according 
to the tax rate when the invoice was filed and the total of taxable items on the invoice.  It will not 
over count the taxable amount so you need not worry about invoices where only part of the items 
are taxable. 

Deposits and Receipts 

When you put a deposit on an invoice, it is tracked as a POS receipt in cash or check as 
appropriate. However, it is not considered an actual receipt until the invoice is picked up (posted). 
This is why “Deposits Rcvd” is subtracted from “Total Receipts” – to back out deposits received 
from total receipts. 

Deposits Returned is added back in when a deposit is returned to reverse the effect of subtracting 
deposits received. When the invoice is picked up, the deposit amount is then recorded in “Deposits 
Applied” so it can be included in “Total Receipts” and taxable receipts. When these transactions 
occur over several days - the resulting receipt totals can differ from your actual dollar count. 
However, when considered along with the “Deposit Balance”, your receipts total with respect to 
taxable receipts is balanced.  
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Open Old Tape 
This command allows you to open register tapes from previous close outs. These tapes are located 
in the History folder within the PrintSmith Folder. While this command gives you the ability to review 
and print any tape – you cannot void entries in old tapes because they are locked during Daily 
Closeout. You can only void entries in the current Register tape when you open it with the Open 
Tape command in the POS menu. Note that old tapes are locked and cannot be changed. The files 
themselves are named “Tape yymmdd” where “yymmdd” is the date of the closeout that created it. 

Figure 7.15: Register Tape 

 
 

Note:  Some Register Tapes created using older versions and printed during a daily closeout 
may not be visible in the list. If you think you may have tapes exhibiting this problem, hold 
down the <option> key when selecting this command and all the files in the history folder 
will be displayed. You must be careful to only open a tape file. Selecting a tape that 
cannot be opened in any other way will open it and fix the file so it will display normally in 
the future. 
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Deposit Ticket 
You can use this to display and print the Deposit Ticket normally generated during Daily Closeout. 
The files are located in the History folder in the PrintSmith Folder. The files themselves are named 
“Deposit Ticket yymmdd” where “yymmdd” is the date of the close-out that created it. 

Figure 7.16: Deposit Ticket 
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Stock Order 
This report window shows all the stocks ordered with the Order Stock command in the Job window 
and the Order Stock command on the Admin menu.  This Stock Order window can also be used to 
log Received and Partially Received Orders of inventoried stock. 

Figure 7.17: Stock Order Window 

 

Sorting the Report 
The report can be sorted by any column, including the Date of entry into the report (the default), 
Invoice #, Job, Vendor, Stock Description, Stock Number, Parent Size, Quantity, Cost, Received, 
and Filled. Entries made from the Stock Order command have no invoice number unless you 
specify an invoice and job number when you order the stock. Selecting any of the column titles will 
sort the report by that column. To change the sorted order, click one of the headers. Each vendor 
has a separate report and each stock number has a total of the sheets to be ordered for that stock. 
It is, by far, the most useful format for this report. 

Printing the Report 
To print the report with each vendor on a separate page, the report must first be sorted by Stock 
Description, then enable Print separate page for each vendor before printing. To print the report, 
select File > Print from the main menu. When you have finished with the report and are ready to 
start accumulating new entries, click the “Erase” button to clean out the report. Once erased, the 
items will not appear again. On a multi-user system, Stock Order report items can now be erased 
from Workstations. To exit from the report, click on the OK button. 

Modifying the Stock Order Report  
To remove an item on the report, select it and select the Cut or Clear command in the Edit menu. 

You can change an entry by double-clicking it. The Order Stock window opens displaying the item 
from the report. Make the necessary changes, click the Order button and the report will be updated. 
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Updating received stock orders 
Received orders can be updated for stock that is marked as inventory in its Stock Definition.  
Inventoried stock items appear in bold in the Stock Order Report. 

If the entire stock order has been received, click the Order Received button.  The Received 
quantity will equal the Ordered quantity, and an X will appear in the Filled column.  Within the Stock 
Definitions window, the On Order quantity will be reduced and the Stock On Hand quantity will be 
increased by the amount of the order. 

If part of the stock order has been received, click the Partial Order Received button.  The Stock 
Received dialog opens.  Enter the Quantity Received and click OK.  The quantity received is 
displayed in the Received column and the Stock on Hand Quantity is increased by the amount of 
the order. 

Figure 7.18:  Stock Received window 

 
Note:   For more information regarding inventoried stock, see page 251. 

Re-Order List 
A re-order date can be entered into the Account Info window of any document. This report 
searches the invoice file for invoices that are marked for reorder during the period of time that you 
specify and generates a report. 

Figure 7.19: Re-Order List Window 

 
 

To use the report, enter the starting date and the ending date and click the OK button. If any 
documents are found, it opens a window listing the documents due for reorder. 

The report can be printed using the Print command in the File menu. Reorder dates can 
automatically be calculated on orders copied from history. 
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Mailer Campaigns 
Mailer Campaigns, a tool for Report Writer owners, allows the creation of mailings that can be 
grouped together into grades and assigned to contacts.    

Adding Campaigns 
Thirty Global Campaigns and ten Local Campaigns can be added.  Example campaigns might be 
Holidays or Top 10 Clients. 

Campaigns are added in the Campaign tab by clicking in the Title field to the right of the applicable 
Slot and entering a name for the campaign 

Figure 7.20:  Campaigns window, Campaigns tab 

 
 

30 Slots for Global 
campaigns 

10 Slots for Local 
campaigns 



EFI PrintSmith 7.2 |  Reference Guide 

 
 

 
Page 396 

Adding Grades and Assigning Campaigns 
Grades are a group of campaigns that can be used as a template to assign one or more campaigns 
to multiple contacts.  All campaigns created within the Campaign tab will appear in the right column 
of the Grades tab.  A total of forty campaigns can be created, but an unlimited number of grades 
can be created.  Campaigns can be assigned to multiple grades. 

Adding Grades 
Grades are added in the Grades tab by clicking the Add button.  An Untitled Grade field is added in 
the Grade column. Double-click in this field to edit the grade name. 

Figure 7.21:  Campaigns window, Grades tab 

 

Assigning Campaigns to Grades 
To assign campaigns to a grade, select the Grade in the Grades column.  Then, select the 
Campaign in the Campaigns column and click the left arrow button, or double-click the campaign.   

Note: Use the right arrow button to remove Campaigns from Grades. 

Assigning Campaigns to Contacts 
Multiple campaigns or grades can be assigned to individual contacts through the new Campaigns 
tab in the Contacts window.  For more information, see page 181. 

Click the disclosure 
triangle to display the 
campaigns assigned to 
the grade 

Use the arrow buttons to 
add campaigns to or 
remove campaigns from 
grades 
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Exporting and Importing Campaigns 
Use the Export and Import buttons to share campaigns.  Campaigns are exported into an xml file, 
called Campaign.xml by default. 

Exporting a campaign 
To export a campaign, click the Export button in the Campaigns window.  In the Export Campaigns 
window that opens, enter Options and Slots. 

Options 

Select to export Grades and/or Campaigns 

Slots 

If Campaigns are selected, choose which campaign slots to export.  Slots 1 – 30 are the Global 
campaigns, and slots 31 – 40 are the local campaigns.  Enter a Start slot and an End slot. 

Figure 7.22:  Export Campaigns dialog 

 
 

Importing a Campaign 
Campaigns that have been exported from another shop can be imported into your shop.  In the 
Campaigns window, click the Import button, browse to the Campaign.xml file, and click Open.  The 
Grades and Campaigns are imported and displayed in the Campaign window. 

Note: Imported Grades are added to the current list of Grades.  There is no maximum to the 
number of grades that can be added.  However, since only 40 campaigns can be stored, 
campaigns in the import file will replace campaigns in the current list if the total number of 
campaigns exceeds 40. 

 

Report Manager / Writer 
The Report Manager is part of the Report Writer product. The Report Manager and the Report 
Writer are optional products that are defined in the Report Writer Guide.

Global campaigns 1 – 
15 will be exported 
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Chapter 8 System Administration 
In this chapter 

Change Password 399 
User Log 400 
User Definitions 401 
Security Setup 403 
Keyboard Shortcuts 405 
Delivery Ticket Manager 406 
System Monitor 418 
Show / Hide Help Bar 420 
Preferences 420 
Document Preferences 467 
Table Editor 496 
Clear Estimates 503 
Paper Calculator 505 
Order Stock 508 
Batch Print Documents 510 
Network Chat 511 
Send File 512 
Network Administration 513 

 

The Admin menu contains commands for performing administrative functions such as managing 
the security system, web site, credit card authorization, document preferences, and all preference 
settings.  

The first two commands, Change Password and User Log In on are user level commands for using 
the security system.  

If you intend to set up the security system, be sure to read about User Definitions and Security 
Setup. All users should have access to Change Password and User Log In, but access to the other 
commands can be restricted. Only the System Administrator should have access to User 
Definitions and Security Setup. The rest of the commands can be set as best suits your needs.  

The third section of the menu contains commands used to set basic parameters for PrintSmith. 
Except for Document Preferences, most of these commands will be used relatively infrequently 
once PrintSmith is operational. The final section contains commands that are used to perform 
housekeeping functions like removing old estimates and ordering stock.  

The security system on PrintSmith Portable installations is only used when operating in Portable 
“mode”. When the system is connected to a PrintSmith network, the security system from the 
PrintSmith Master is used and any security settings from the PrintSmith Portable system security 
are ignored. 
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Change Password 
From the average user’s point of view, the security system in PrintSmith consists of their User ID 
and password. By design, passwords are private – only the owner of the User ID should know their 
password. Initially, the System Administrator assigns a password to a user ID when the ID is 
created. This command gives each user control of their password. 

Figure 8.1: Change Password Window 

 
 

Before the new password is accepted, you must type in the old password so PrintSmith knows you 
are authorized to use that User ID. After entering a new password, you must verify the new 
password to make sure there were no typo’s entering it the first time.  

You must type in the password exactly the same both times or PrintSmith will reject the new 
password. In either event, you will be notified whether the new password was accepted or rejected.  

Once a password has been changed with this command, only the person who changed the 
password knows what it is. There is no way for anyone, including the System Administrator and 
PrintSmith support, to find out what the password is.  

PrintSmith is shipped with several predefined user definitions. This includes a blank User ID with 
admin level and the system administrator ID. If you decide to implement the security system, you 
should either remove the blank ID or assign it to a different access group. Then you should change 
the password of the system administrator ID here. 

Note:  When you change the system password, we recommend that you write it down and put it 
in a sealed envelope. Put the sealed envelope in a safe deposit box or somewhere safe. 
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User Log In 
The User Log In command identifies a user to PrintSmith.  

Figure 8.2: PrintSmith Log In Window 

 
 

In order for a user to enter PrintSmith, a user ID and Password must be typed in. We call this 
Logging in – the function is called User Log In and it is automatically invoked when you start 
PrintSmith. If you are security minded you will want to invoke this command whenever you are 
done using PrintSmith, but do not want to shut down entirely. 

Note:  When you first install PrintSmith, there is a blank user ID set up with full system access so 
you can just click the OK button to get into the system with no restrictions. 

When the user successfully signs on, the access group assigned to the ID determines the menu 
commands, which he or she can use. Each User can change his or her own password using the 
Change Password command in the Admin Menu. The System Administrator can change the User 
ID, password, and access group for any user and the access group of each menu command. 

Note:  There may be times when you want to change user definitions without interrupting your 
work. Normally, all windows are closed when this command is selected. However, if you 
hold down the <shift> key, the command will be invoked without closing windows. Bear in 
mind that anyone signing on will have access to all open windows regardless of their 
access level. 

The system administrator ID is SYSTEM and the password is MANAGER. You should, of course, 
change the password as part of implementing the security system since anyone with access to this 
manual can find out what it is. Also, the system administrator ID cannot be deleted and always has 
full access to all commands. 

Note:  Changing the System password is especially critical if your PrintSmith system is available 
on the Internet or a WAN. 
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User Definitions 
This command is to control the User Definitions during User Log In. 

Figure 8.3: User Definition Window 

 
 

User Name - The name of the user profile. It is typed in during log in to introduce the person to 
PrintSmith. By leaving a user ID blank (password too), you can simply click the OK button during 
User Log In to get access to the system. PrintSmith is originally shipped this way with a blank ID 
belonging to the admin group. This effectively disables the security system. 

Set User’s Password – Click this button to set a password on a new user ID or change the 
password of an existing ID. A password verifies that the person signing on is authorized access to 
the User ID. Passwords are never displayed.  

Access Group - This pop up menu lists all the access groups you have configured in PrintSmith. 
Users can be moved from one access group to another access group using this pop up menu. (For 
more information, see “Document Images 

Access Level - This number, which must be between 0 and 99, is used by PrintSmith to determine 
what level of access on customer accounts this particular user is allowed to have. 

The user definition of the system administrator (there can be only one) is shown in red with a 
symbol before it. The list is in alphabetical order.  

You can set up user definitions with no name. The user definitions window contains one blank user 
ID. The “<NO NAME>” text is a place holder indicating that the user name is left empty. It is not the 
name of the user.  
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Although any user can be given access to the user definition command, only the system 
administrator has full use of the command. Specifically, only the system administrator can change 
user definitions that belong to the “System Admin” access group and only the system administrator 
can assign user definitions to the “System Admin” access group. Except for the system 
administrator, you cannot change anything in your own user ID. 

Create a new user ID by selecting the new command in the file menu. The save command saves 
changes to the user ID being edited and the Revert command restores an existing user ID to its last 
saved state. 

The system administrator password can only be changed using the change password command. 
This absolutely ensures that you know the old system password before you change it to a new one. 

 

Additional Security Settings 
Not Allowed To Override - Prevents the user from changing anything that would be considered an 
override or from removing an existing override. 

Not Allowed To Return Cash - This setting prevents the user from cashing checks in the Cash 
Register. These transactions are rejected if the amount of change exceeds the total amount of 
cash. 

Can Override Credit Limit - Turn this on to allow this user to override the credit limit when 
charging items to Accounts Receivable in the Cash Register and to change the credit limit and 
discount percentage on the accounting page in the Customer Account window. This setting also 
allows the user to post “Paid Outs” in POS, change customer credit limits and automatic discounts, 
and discount invoices. It should be restricted to managers for best results. 

Show user name on Log In window – Turn this on to display the user’s name in the Log In 
window’s dropdown list of users. 

Lock Sales Rep Names - This setting is particularly useful in situations where you must ensure 
that the sales representative name assigned to account and/ or document is under management 
control. If this button is turned on, that user can assign a Sales Rep to accounts and documents 
only if the field is empty and cannot change the assignment thereafter. It also disables use of a 
contact sales rep being assigned to an account. 

Can refund on credit cards – Turn this on to allow the user to perform refunds on credit card 
transactions. 

Note:  If your network is accessible from the Internet and you allow Workstations to connect via 
TCP/IP it is strongly recommended that you change the password on the System ID, 
delete the blank user ID, and ensure that all user definitions have a password. 
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Security Setup 
This command is used to define access groups. The groups are assigned to user IDs to control the 
commands available to a user. 

The Security Setup command is an editor for access groups. Access Groups are lists of commands 
that members of the group are allowed to perform. Although most of these commands directly 
correspond to menu commands, there are many commands with no direct menu equivalents such 
as preference windows. 

Figure 8.4: Security Setup Window 

 

 

Note:  This command is not available on Workstations. Security Setup can only be changed on 
the PrintSmith Master. 

 

Sorted by menu. 

Checked items are in 
the access group 

and available to 
members of the 

group. 

The access group 
shown in list 

Item is locked 
and can’t be 

changed. 

Indent shows 
commands that 
are not menu 
commands. 
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Access Groups 
An access group is a list of PrintSmith commands available to users who are members of that 
group. When you view an access group you can see the list of commands that members of the 
group are allowed to use. Although most of these commands directly correspond to menu 
commands, there are many commands with no direct menu equivalents such as preference panels.  

There are two pre-defined groups: “System” which always has all commands and “Minimum” which 
only has those commands needed to get in and out of PrintSmith (quit and log in). These groups 
cannot be changed in any way.  

You select the access group you wish to edit from the pop up menu and add or remove check 
marks from the individual commands. Those commands without check marks are not available to 
members of the group. As you make changes, the items that you change are shown in italics. 
When you save those changes using the save command in the file menu, the italics are removed.  

Items, which cannot be changed, show a “Locked” icon. Note that all items in the System and 
Minimum group are locked. These two groups are pre-defined in PrintSmith and cannot be 
changed.  

Column widths are adjusted by dragging the separators in the list header. The list can be sorted in 
different ways by clicking on the column by which you want it sorted. Most of the time it is easiest to 
work with the list when it is sorted by menu. 

Any access group can be copied using the save as command. Since this includes the System 
group, we strongly recommend restricting this command to members of that group. 

Rename - Click this button to rename an access group. 

Save As - Using the Save As command under the file menu copies the Access group allowing you 
to rename it prior to filing. This is an easy way to add access groups. 

Delete - You may find that you have more groups that you really need. This button deletes the 
selected access group. Any user definitions that are members of a deleted access group are 
automatically assigned to the Minimum group, which effectively renders that user definition 
unusable. To see the command names that an access group is permitted to use, you need to select 
an access group from the access groups pop up menu. Once an access group has been selected, 
you can change command names that the access group has enabled. 

 



Chapter 8:  System Administration 

 
 

 
Page 405 

Keyboard Shortcuts 
The Keyboard Shortcuts command allows users to customize keyboard shortcuts. 

Figure 8.5: Keyboard Shortcuts Window 

 
 

 

 

Functionally, this is very similar to Security Setup. You can sort the list by clicking one of the 
header columns. You assign a keyboard short cut by clicking in the key column next to the 
command you want to modify and type the single character shortcut you wish to use. There are 
some shortcut keys that are system defined and cannot be changed. These are indicated with a 
small lock icon. 

Items that have been changed but not yet saved are shown in italics. When you select the Save 
command, these changes are immediately applied. 

Since most characters are already used, it is often useful to sort the list by the key values as shown 
below. For your reference and convenience, print out the window by selecting Print from the File 
menu. 

Note:  Keyboard shortcuts can only be defined at the Master on a multi-user system. They are 
read from the Master when the workstation initially launches. 

Unsorted List 

Sorted By Key 
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Delivery Ticket Manager 
The Delivery Ticket Manager allows delivery ticket history to be reviewed (History tab), delivery 
ticket forms to be created and modified (Form Preferences tab), and new brokers to be created or 
added from the customer list (Brokers tab).  

To access the Delivery Ticket Manager: 

Select Admin > Delivery Ticket Manager from the PrintSmith Menu.  The Delivery Ticket Manager 
window opens and the History, Form Preferences, and Brokers tabs are displayed. 

History 
The History tab displays a list of all delivery tickets within the system.  Completed deliveries are 
displayed in green and deliveries still in process are displayed in black.  New tickets can be added 
from within the history tab, tickets can be deleted, and search functionality is available. 

Figure 8.6:  Delivery Ticket Manager, History tab 

 
 

Viewing delivery tickets 
To view a delivery ticket, double-click the delivery ticket in the History tab listing. 

Hiding completed deliveries from the view 
Once a delivery is completed, it is marked as Delivered in the Status tab of the Delivery Ticket and 
the Delivery Ticket appears in green within the History tab listing.  To hide completed deliveries 
from the History tab view and only show those deliveries that are still in process, select the Hide 
completed deliveries option at the bottom of the History tab. 

Hide completed 
deliveries 

Completed 
deliveries 
displayed in green
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Adding new tickets 
New delivery tickets can be added from within the Delivery Ticket Manager. 

To add a new ticket: 

1. Click the New Ticket button.  A blank Delivery Ticket window opens. 

2. Drag a job into the Delivery Ticket or click the Add button. 

3. Enter a Description the Shipped Qty, and complete the Delivery Ticket information 
as described beginning on page 131. 

4. Click the Save button.  Changes to the new delivery ticket are saved and a Ticket 
Number is assigned. 

5. Click the Close button.  The new delivery ticket appears in the ticket listing of the 
History tab. 

Deleting tickets 
To delete a delivery ticket: 

1. Select the delivery ticket in the History tab listing. 

2. Click the Delete button.  A confirmation dialog opens. 

3. Click Yes to confirm deletion.  The delivery ticket is deleted from the list. 

Searching for tickets 
Delivery tickets can be searched for by Ticket No, Inv/Est, Description, Date, and Account. 

To search for a delivery ticket: 

1. Click the Search button.  The Delivery Ticket Search dialog opens. 

Figure 8.7:  Delivery Ticket Search window 

 
2. Select the field to search by, either Ticket No, Inv/Est, Description, Date, or 

Account. 

3. Enter search text in the field to the right of the Find button. 

4. Click the Find button.  The first record in the History tab that matches the search 
criteria will be highlighted.  Click Find again to move to the next record that meets the 
search criteria. 
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Form Preferences 
The Form Preferences tab of the Delivery Ticket Manager allows the creation of multiple delivery 
ticket forms that can be selected when creating a delivery ticket. 

Note:   Designing a Delivery Ticket form is similar to changing statement layout. 
Figure 8.8:  Delivery Ticket Manager, Form Preferences tab 

 
 

To add a new delivery ticket form: 

1. Click the Add button.  The Delivery Ticket Layout window opens. 

2. Enter a Title for the new delivery ticket. 

3. Enter settings for the delivery ticket in the Show, Form Layout, Line Items, Fonts, 
Images, and Form Adjust tabs, as described in the following pages. 

4. When the delivery ticket form is complete, click OK to save changes and close the 
Delivery Ticket Layout window.  The new form will appear in the Form Preferences 
listing and will be available for selection in the Delivery Ticket > Printing tab. 

 

To change a delivery ticket form: 

1. Select the delivery ticket in the Form Preferences tab. 

2. Click the Change button.  The Delivery Ticket Layout window opens. 

3. After changes have been made, click OK to save the changes and close the Delivery 
Ticket Layout window. 

Click to set Default 
form 

Available forms 
are listed by Title 
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To set a default form: 

Click in the Default column to the left of the delivery ticket form that should be set as the default.  A 
check mark appears in the column, and the form will automatically be selected in the Delivery 
Ticket > Printing tab. 

Note:   Even though one form is set as the default, users have the option to select other forms. 
 

Show 
In the Show tab of the Delivery Ticket Layout window a Style option can be selected and the 
elements to be shown can be set. 

Figure 8.9:  Delivery Ticket Layout window, Show tab 

 
 

Select Style 

Select elements to 
show 



EFI PrintSmith 7.2 |  Reference Guide 

 
 

 
Page 410 

Style 

There are three possible style options.  Only one can be selected. 

• Use Pre-Printed Form:  Select this option if you have printed statement/delivery ticket forms. 

• Print Custom Form Image:  PrintSmith comes with a set of built in form images.  In addition, 
you can import your own form image. 

• Generate Form Image:  PrintSmith is capable of drawing the statement form itself. While this 
method does not allow you to change the overall appearance of the statement and is only as 
good as the printer you are using, it does have the advantage of automatically adjusting itself 
to changes in the position of items that you make.  

 

Show options 

The following elements can be selected to be shown/printed within the form: 

From Address 

To Address 

Attn 

Ship Via 

Delivery Date 

Customer PO 

Order Number 

Part Number 

Tracking Number 

Reference 

Description 

Comment 

Signature Line 

Barcodes 

Logo 

Delivery Number  
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Form Layout 
The Form Layout tab allows position setting of the fields selected in the Show tab.   

Figure 8.10:  Delivery Ticket Layout window, Form Layout tab 

 
 

Position 

Position must be set for all elements selected in the Show tab and for Line Items.  Position is 
determined by the elements’ unit of measurement from the Left and Top of the form. 

Width 

The Width Across and the Width Down can be set for the first six elements:  Logo, From Address, 
To Address, Attn. Block, Line Items, and Comment Block. 

Show Title 

The option to show the element’s title can be turned off/on by checking the Show Title option to the 
right of the following fields:  Delivery Date, Reference, Ship Via, Customer PO, Order Number, Part 
Number, Tracking Number, and Delivery Number. 

Set Position 

Set Width 

Show Title 

Select measurement 
display
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Measurements in 

Select how the measurements for Position and Width will be displayed from the Measurements in 
dropdown list.  Options are:  pixels, inches, millimeters, or centimeters. 

Line Items 
In the Line Items tab, set the Margin and Width for these line items in the delivery ticket form:  
Inv/Job Number, Ordered Qty, Shipped Qty, Description, and Weight.  The total width of all items is 
automatically calculated.  Measurements for margin and width can be displayed by pixels, inches, 
millimeters and centimeters. 

Figure 8.11:  Delivery Ticket Layout window, Line Items tab 

 
 

Set Margin and Width 

Select measurement 
display 

Total width 
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Fonts 
Fonts can be set for the Address, Date, Body Text, and Form in the Form tab. 

Figure 8.12:  Delivery Ticket Layout window, Fonts tab 

 
To set the font for a form element: 

1. Click the Address, Date, Body Text, or Form button.  The Change Font dialog 
opens. 

2. Select the Font from the dropdown list. 

3. Select the Size from the dropdown list. 

4. Select any Style options. 

5. Font selections will be reflected in the box at the bottom of the dialog.  Click OK to 
save changes and close the Change Font dialog. 

Figure 8.13:  Change Font window 
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Change Font dialog 
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Images 
The image of the form and the logo to be printed with the delivery ticket form can be designated in 
the Images tab. 

Figure 8.14:  Delivery Ticket Layout window, Images tab 

 
 

The form and logo can both be set by entering the respective Form ID and Logo ID.  The form and 
logo can also be set using the Image Viewer.  
 

To open the Image Viewer and select a form or logo: 

1. Click the button to the right of the Form ID or the Logo ID.  The Image Viewer opens. 

2. Use the right and left arrow buttons to scroll through the available images. 

3. Click the Select button.  The Image Viewer closes and the selected image is 
displayed in the Form or Logo preview area. 
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Form Adjust 
The Data Offset and the Image Offset can be set in the Form Adjust tab. 

Figure 8.15:  Delivery Ticket Layout window, Form Adjust tab 

 
 

• Data Offset:  These two fields adjust the position of the statement data on the page. 
Increasing the left number moves all of the data to the right on the page, decreasing it moves 
everything to the left. Likewise, changing the up/down number moves the data down on the 
page, decreasing it moves everything up on the page. 

• Image Offset:  These two fields are similar to the data offset but adjust the position of a form 
image on the printed page. It has no effect unless the Print Custom Form Image option is 
turned on and a form image has been selected. 
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Brokers 
Use the Brokers tab to set up optional brokers that can appear in the From field for deliveries.  New 
brokers can be created, or brokers can be added from the existing customer list. 

Note:   Brokers are selected in the From dropdown list of the Delivery Ticket > Deliver Where tab. 
Figure 8.16:  Delivery Ticket Manager, Brokers tab 

 
 

Adding new brokers 
To add a new broker: 

1. Click the Add button.  The Edit Address dialog opens. 

Figure 8.17:  Edit Address window 

 
2. Enter a Company name and address information. 

3. Close the Edit Address dialog.  The Broker will be added to the Broker listing and the 
Address information will appear in the Address box when the Broker is selected. 
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To add a broker contact: 

1. Select a Broker in the Broker tab. 

2. Click in the Contact box.  The Edit Contact dialog opens. 

Figure 8.18:  Edit Contact window 

 
3. Enter Name, Address, Phone, and Email information. 

4. Close the Edit Contact dialog.  The Contact will be added to the broker’s record. 

 

Adding new brokers from the customer list 
To add current customers as brokers: 

1. Click the From Customer button.  The Account Picker dialog opens. 

2. Highlight a customer in the list and click the Select button.  The Account Picker dialog 
closes and the Edit Address dialog opens. 

3. Make any necessary changes the address information and then close the Address 
dialog.  The customer is added to the Brokers listing. 

Note:   The Statement Contact for the account will automatically be added as the broker 
contact. 

 

Modifying brokers 
The broker’s address and contact information can be modified.  To modify broker information: 

1. Select the broker in the Broker tab. 

2. Click in the Address box to edit address information. 

3. Click in the Contact box to edit contact information. 

Note:   Changes made to the Customer information in AR > Accounts will not be updated 
to the Broker listing.  Likewise, changes to customer’s information in the broker 
list will not be updated in AR > Accounts. 



EFI PrintSmith 7.2 |  Reference Guide 

 
 

 
Page 418 

Deleting brokers 
To delete a broker: 

1. Select the broker in the Brokers listing of the Brokers tab. 

2. Click the Delete button.  The broker is removed from the list. 

Note:   Deleting a customer in the Brokers tab will only remove the customer from the 
Broker listing.  This will not delete the customer’s account. 

System Monitor 
This command is used to view the current state of your PrintSmith system and to control access to 
the PrintSmith Master in a multi-user system. Most of the displays are diagnostic in nature and 
designed primarily for PrintSmith support. 

Figure 8.19: System Monitor Window 

 
 

The system monitor is updated continuously, even while PrintSmith is in the background. It can be 
used to watch what’s going on in a multi-user system.  

Probably the most useful day-to-day functions are “Record Locks” and “Sessions”. The Record 
Locks view describes individual records such as customer accounts and invoices that are locked by 
one of the Workstations or the PrintSmith Master. Sessions shows the name of each computer 
registered in the PrintSmith network. Using these two functions you can quickly determine who is 
on the system and which users have records locked.  

The session list can be printed to give you a snapshot of your network. This can be quite helpful in 
diagnosing problems. 
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Controlling Network Access 
When the System Monitor window is selected, you can shut down or enable the PrintSmith network 
using the File menu. The File menu commands Close Network and Open Network are available 
when the System Monitor window is selected. When you select the Close Network or the Quit 
command, the PrintSmith Master immediately stops accepting connections and if any users are 
connected, a special version of the Network Chat window opens.  

Usually you will want to send a message to everyone warning other users to exit the application. 
This gives them an opportunity to exit gracefully without losing any data. Recipients of the shut 
down message can send a reply back, such as asking to delay shutting down while they complete 
an important task. 

As long as users are connected, this window will remain open. If you close the window while users 
are connected, they are allowed to remain connected and no further action is taken although the 
PrintSmith Master will still refuse to accept new connection attempts. When the last user 
disconnects, the network is shut down and the window closes automatically. If it opened as a result 
of the Quit command, PrintSmith finishes shutting down and exits the application.  

When a user disconnects, they are removed from the list. At any time, you can force all users off 
the system by clicking the Disconnect All button.  

To turn the network back on, select the System Monitor command in the Admin menu, then Open 
Network from the File menu.  

To abort closing the network, close the Network Messaging Service window and select Yes in the 
window below. 

Connected Users - The list of connected users is automatically updated on the PrintSmith Master. 
It shows the name of the user who last logged on to each connected computer (they may have 
since logged off and the Workstation may be idle with the Log In window open) as well as the name 
of the computer. 

Message Text - This is an area where you can type a fairly long message (up to 250 characters) to 
be transmitted to one or more connected user. 

Message Log - When messages are sent or received, the originator of the message and the 
message text are displayed in the log. This is just a temporary log; it goes away when the window 
is closed. 

Send to Selected - This button is enabled if you clicked on one or more of the users in the user 
list. Clicking this button sends the text in the message text field to those users. 

Send to All - Clicking this button sends the message text to all connected users. 

Disconnect Selected - Click on this button to force the selected user off the system. 

Disconnect All - This button immediately forces all the users to disconnect from the PrintSmith 
Master. 
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Show / Hide Help Bar 
The help bar incorporates navigation icons, on line help and links to PrintSmith supported web 
sites. When opened it remains open at all times and is usually positioned near the bottom of the 
screen. You can move the window but not resize it.  

The window has navigation buttons on it that allow the user to open the Customer Account, POS 
and Clock In/Clock Out windows as well as the PrintSmith update page if connected to the internet. 

Probably the most important feature of the Help Bar is that it shows a description of any button or 
edit field simply by pointing to it. If you are tabbing through edit fields in a window, as soon as you 
tab to a new field, help text for the selected data field is displayed.  

Clicking on the Globe/Hammer icon will launch your default browser and attempt to connect to the 
PrintSmith.com page where you can sign on and download upgrades to PrintSmith. The help icon 
on the far right opens the PrintSmith on-line documentation if available. 

Preferences 
The Preference Manager manages a list of preferences grouped according to their overall 
classifications: System, POS, Estimator, and Accounting. Each panel has its own security setting 
which you control using the settings defined in Security Setup.  

Holding down the <command> key on Mac and <control> key on Windows, while clicking on a 
disclosure button will collapse all categories.  

In a stand alone system or on the PrintSmith Master station of a multi-user system, all preferences 
are “local”. They affect the operation of the system on that computer. Generally, when a 
Workstation starts it loads some preferences, such as security settings from the PrintSmith Master. 
Most other preferences are copied whenever the pricing system is updated.  

Some preference settings, such the Cash Drawer settings, really only apply to an individual 
Workstation and should not be changed when the pricing system is updated. To solve this problem, 
some preferences are “Local” to each workstation.  

A local preference affects only that Workstation and is not changed when the pricing system is 
updated. A few preference settings give you the option of whether or not you want them to be 
“Local” via a setting on the panel such as “Keep settings local”. Each preference that is always 
local will be documented as such in the pages that follow.  

You save the settings in each Preference Panel by clicking the OK button. You can return to the 
previously saved state by clicking the Cancel button. 
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Defining System Preferences 
These system defaults establish rules about behavior, networking, company information, numbers, 
alternate currency, and international settings. 

Appearance 
The Appearance preference panel controls font usage and other aspects of PrintSmith’s overall 
appearance. 

Figure 8.20: System Appearance Preference Panel 

 
Some customization of the general appearance of PrintSmith is possible by selecting the fonts and 
colors that PrintSmith uses. In some countries, it is desirable to use fonts other than the standards 
in order to provide characters or alphabets that are not supported by the underlying operating 
system. To reset the appearance window to its initial settings, hold down the <alt/option> and 
<shift> keys when clicking on the Appearance item. 

What you can do safely within this window: 

• Change the prompts on some edit fields to a different color. 

• Change any of the fonts to a different font of the same size. 

What you should not do: 

• Change a small font so it is bigger than a larger one. (Same size is OK.) 

• Change fonts to much larger sizes, (e.g. changing the Small Font to 18 points). 

• Make dramatic changes to fonts while other windows are open. 
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Behavior 
In the Behavior panel, you can automatically invoke the User Log In command to sign people off 
the system in either a timed increment or upon execution of a Post command (cash register 
posting). Elimination of some warning messages is suggested after you have used PrintSmith for a 
while and no longer need these messages. Having PrintSmith quit at a certain time, ensures that a 
complete backup is performed on a Windows master. 

Figure 8.21: System Behavior Preferences Panel 

 
 

Eliminate Some Warning Messages 

Warning messages that are useful and necessary when you first start using PrintSmith may 
become irritating as time goes on. Enabling this feature eliminates the most common warnings. 
Messages eliminated are: 

• Warnings at start-up about dates and doing daily closeouts. 

• Warning that documents and job tickets have already been printed. 

• Warning that the document is locked. 

• Asking if you want to print job tickets for invoice level charges (it always prints them). 
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Only Post Invoices Marked Ready 

When this option is selected, only invoices that are marked “ready for pick up or delivery” in the 
location window on the Pending List can be picked up. 

Initialize printer before each use 

This option resets the printer settings between items to be printed.  If it is not enabled the printer 
setting will remain from the last item printed.   

Note: This option applies to PC only. 
Enable Automatic Log In 

The Enable Automatic Log In ensures that everyone is signing in and that only the appropriate 
people have access to Admin functions (based on user security set up). When enabled, there are 
two features: 

• Seconds Of Inactivity To Trigger - This option sets an inactivity timer. You enter the number of 
seconds that the timer will run. If the timer expires without any activity (even moving the 
mouse), the log in window displays. The standard value is 300, giving 5 minutes of inactivity. 
You can change it to anything greater than 4 seconds. 

• Trigger After Posting - This option opens the log in window after a transaction is posted in the 
cash register. This option is useful for ensuring counter people log in with his/her own user ID 
for each transaction. 

Show invoices with firm due date of “today” at login 

If this option is selected, the Work In Progress report is displayed upon login when there are 
pending items that have firm due dates that are the same as the date you are logging into 
PrintSmith.   All pending items with Firm Due Dates will be displayed in chronological order.   

Enable Automatic Quit 

The Enable Automatic Quit option is useful as a safety feature to prevent access to the system 
after business hours and ensures that backups are always complete. We have found that on 
Windows, many backup programs are unable to back up all files if PrintSmith is running. Enabling 
automatic quit with a shut down time solves this problem. 

Time Of Day To Quit 

Enter the time of day that the system will shut down. Prior to shutting down, all users are notified of 
the impending shut down and given time to save their work. 

Shut Down Notification Message 

Enter the text of the message you want to send when PrintSmith will be shut down. The standard 
text contains two characters “^0” which are replaced by the shut down time you entered in the Time 
Of Day To Quit field. You can put these characters in as many times as necessary or leave them 
out entirely. 

Note:  Shut Down Notification is a local preference. 
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Company 
The Company panel is used to enter your company information. PrintSmith uses some of this 
information as the remittance address in the statement generator.  It is also used as the From 
address in the Delivery Ticket. 

Figure 8.22: System Company Preferences Panel 

 
Note:  Company is a global preference that is established at the master only. 
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Business Calendar 
The Business Calendar panel allows for a fiscal year or a calendar year.  Additionally, work days 
can be set. 

Figure 8.23:  Business Calendar Preferences Panel 

 
 

Fiscal year starts first day of 

Select a month from the dropdown list.  This will set the current range of the fiscal year.   

Current Range 

Based on the month selected, the range for the fiscal year is displayed. 

Work Days 

Select work days by clicking on the days of the week.  Selected work days are displayed in black. 

Future dates exclude days that company is Closed 

Select this option to have job time estimates calculated based only on work days. 
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Network Setup 
The Network Setup panel determines how your WorkStations will communicate over the network. 
See the Installation Guide on networking for more detail on which protocol would be best for your 
operation. In a stand alone environment, select the Disable Networking option. 

Figure 8.24: System Network Setup Preferences Panel 

 
Note:  Network Setup is a local preference. 

Macintosh Networking 

On a Macintosh PrintSmith Master, you have several choices, which select a particular type of 
networking as follows: 

Disable Networking - No PrintSmith Workstations can connect. 

Classic AppleTalk - Starts the PrintSmith Master using the networking model in use prior to the 
availability of Open Transport on the Macintosh. It can be selected for any Macintosh (other than 
OSX) and Windows machines with PC MACLAN installed. Not recommended for Macintosh 
computers with Open Transport 1.1.1 or greater installed. PrintSmith Workstations can connect to 
this PrintSmith Master using Classic AppleTalk or Open Transport AppleTalk. 

Open Transport AppleTalk - Starts the PrintSmith Master using Open Transport. It can be 
selected for any Macintosh (other than OSX) with Open Transport 1.1.1 or greater. If available on 
any computer, we strongly recommend using this instead of Classic AppleTalk. Workstations can 
connect to this PrintSmith Master using Classic AppleTalk or Open Transport AppleTalk.  
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TCP/IP - Starts the PrintSmith Master using TCP/IP exclusively. Any Macintosh with Open 
Transport 1.1.1 or greater can use this type of connection. Note that MacTCP is not compatible 
with this and is not supported. Any Windows machine with TCP/IP set up properly can use this 
method of connection.  

AppleTalk and TCP/IP - If you have TCP/IP set up we recommend using this setting for the 
PrintSmith Master. It allows any Mac or Windows machine to connect to the PrintSmith Master 
using any option available in the Workstation Network Setup panel. 

Windows Networking 

The Network Setup window on Windows is identical to the Macintosh except that on Windows you 
have a choice of Classic AppleTalk or TCP/IP. 

Note:  Classic AppleTalk requires the installation of PC MACLAN 6.1 or greater. This software is 
a product of Miramar Systems, Inc. We have tested and support this product on Windows 
NT and 2000. 

Serial Number 

On the PrintSmith Master, the Serial Number displayed in this window comes from the hardware 
security device (key) attached to the computer. On Workstations, the PrintSmith Master you want to 
connect with has the serial number. 

TCP/IP Address 

When using TCP/IP networking, an address must be specified for the PrintSmith Master. This is 
discussed more fully in “Network Administration.” 
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Numbers 
The numbers panel controls the formatting and rounding precision of all numerical amounts in the 
system. 

Figure 8.25:  Numbers Preferences Panel 

 
Number Formats 

The first group of fields are the number format themselves. Although difficult to specify exactly, 
number formats are used following these general rules:   

• Integers - Used for numbers without decimal places.  

• Percentages - Most percentages use this except for the costing system, which uses “Short 
Percent” (see below).  

• Amount - Used for currency amounts. 

• Rate - Used for rates specified as currency. 

• Factor - Used for multipliers such as markup rates. 

• Invoice - Used for currency amounts in documents. 

• Short Percent - Used in the costing system for displaying percentages. 

 

Round To  

Used to determine the number of decimal places to round. 

Generally, the 
Always Round 
Down and Round 
Tax Up settings 
are off. 
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Each number has up to 3 parts, which describe how numbers are formatted. The first part is for 
positive numbers, the second for negative numbers and the third for zero. You need only specify 
the negative number format and zero format if you want some special formatting not provided by 
the positive number. For example, if you wanted PrintSmith to display “free” or “no charge” instead 
of a zero, you would need to specify a negative number format and a zero format. Many times it is 
sufficient to specify only a positive number and let PrintSmith handle negative numbers and zero 
using the same format. In this example, you could leave out the Negative and Zero portions of the 
format because it is essentially the same (the only difference is the placement of the negative size 
and that is in the “standard” position for the US).  

###,###,###.00;-###,###,###.00;0.00 

How Number Formats Work 

Basically, each format on this page contains instructions telling PrintSmith how to display a 
number. Each character of the format is a symbol representing some part of a number. The most 
important symbols are those representing the digits in a number. These are represented by “#” or 
“0”. Specifying “#” tells PrintSmith to put a digit in that position if it is not a leading or trailing zero. 
Specifying “0” tells PrintSmith to always place a digit in that position and to put a zero if there is no 
other digit. For example, the format “000.000” would show 1.5 as “001.500” while “###.###” would 
show it as “1.5”.  

The next item of interest is the decimal point. If a decimal place is present in the format it is always 
displayed with at least one digit before and after the decimal point.  

There are a number of additional characters that you can use to modify how numbers are 
formatted. Adding “%” to the format makes it display the number as a percentage. For example, 
“##.###” would show 0.15 as “0.15” while “##.###%” would show the number as “15.0%”. 

To place commas in a number as a thousands marker, you insert a comma in the appropriate place 
in the format.  

You can move the minus sign on a negative number to the end of the negative format to show 
negative numbers with a trailing minus sign. Some sample formats for negative numbers are: 

The last format illustrates the ability to add text to a number format. You can add text any-where in 
a number format by enclosing the text in single quotes. To add a dollar sign to a number format you 
would specify it like this: '$'###.### 

It is possible to change these number formats in such a way as to prevent PrintSmith from doing its 
job as they are used to understand your input as well as to format out-put. In particular, make sure 
there are enough digits to display all the digits in the largest number you will encounter. There is no 
harm in putting in more digits than you will ever use. 

Round To 

This is used to determine the number of decimal places to round and how rounding is to be 
performed. In most countries, the proper setting of this is 2 decimal places. In some countries you 
may wish to round to the nearest 10 or even 100. Placing a negative number will round left of the 
decimal place. For example, to round “2,345” to “2350” enter “-1”. Note that this affects almost all 
numbers, including tax calculations. 
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Always Round Down 

Turning this on causes PrintSmith to always throw away fractional results. For example, 1.259 
would be changed to 1.25. This method should only be used when the accepted business practice 
is to always round down. 

Round Tax Up 

Generally, this button should remain off. The only case where we can recommend it is in the state 
of Florida where they have actually implemented a sales taxing system that cannot be calculated 
by a formula but must use a table to look up actual tax amounts. The closest we could get to 
exactly matching their system by formula (based on the State of Florida tax departments “unofficial” 
recommendation) is to round all taxes up. 

Popular Currency Symbols 

Buttons for Dollar, Pound, Yen, and Euro allow usage of popular currency symbols.  Click to select. 

 

Alternate Currency 
The Alternate Currency panel allows you to set up and use another currency system. It was created 
primarily to support the European Common Market currency standard: the Euro. The following 
screen shot displays the alternate currency system, which affects invoices, estimates, statements 
and receipts printed with the receipt printer. 

Unless you are in the European Community, you will most likely not need to make any changes to 
the default variables. 

Figure 8.26: Alternate Currency Preferences Panel 

 

You will need to 
enter the conversion 
factor to ensure your 
system is reporting 
published conversion 
rates. 
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Use Alternate Currency System 

When enabled, all receipts and amounts on invoices, estimates, and statements will display the 
base currency amount and the alternate currency amount. For receipts, the alternate amount is 
always printed below the base currency. For documents, you can place the alternate currency in to 
a separate column or use the same method as the receipt printer. 

Format 

In order for the alternate currency to make sense, it must be formatted properly. In the example 
above, the Euro dollar sign (e) was added to the beginning of the format. Note that the Euro sign is 
surrounded by single quotes. As long as the symbol is surrounded by single quotes, it can be 
placed any where in the format text. 

Conversion Factor 

The conversion factor is a simple multiplier. The base currency amount is multiplied by this 
exchange rate to generate the alternate currency amount. 

Round To 

If the base currency is wildly different than the alternate currency (a very large exchange rate), you 
may wish to change rounding for the alternate currency. To change rounding for the alternate 
currency, enter the number of decimal places to round to. A negative number will round up from the 
decimal point. For example, “-2” rounds to the nearest 100 units.  

Always Round Down 

Enable this feature if you always round down (throw away excess digits and replace them with 
zero). For example, if rounding to 2 decimal places with this option on, 1.991 and 1.999 will both 
round to 1.99. Whereas if the option off, they would round to 1.99 and 2.00. 

Note:  Alternate Currency is a global preference that is established at the master only. 
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International 
The International panel is used for countries other than the United States of America. International 
sorting is used in rare instances. Copy Resale # to PO# automatically copies the information 
entered in the customer account resale field, or the resale field from customer info in a document, 
to the PO field on invoices and estimates. This feature is handy if you would like to show the 
Resale number on the printed document. 

Figure 8.27: System International Preferences Panel 

 
 

Use International Text Sorting 

The Use International Text Sorting option enables a sorting method that considers diacritical marks 
and other language specific constructs and glyphs when sorting. Although more accurate, it is 
much slower and should only be enabled when needed. 

Copy Resale # to PO# in Invoice 

The Copy Resale Number to Purchase Order Number in Invoice feature could be useful as a tool 
for storing contract numbers or long standing purchase orders in the customer account and 
automatically displaying them on invoices and estimates. 
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Use Chile Tax ID Verification 

In order for PrintSmith to be used in Chile, it must verify tax numbers, which are required on all 
invoices. When the Use Chile Tax ID Verification is enabled, PrintSmith enforces a specific format 
for the Resale ID and performs a special Modulo verification. PrintSmith reports the results of the 
Resale number entry as a good or bad Modulo. 

Note:  Use Chile Tax ID Verification is a global preference that is established at the master only. 
Disable Text Styles 

In order to support languages such as Portuguese, Polish, Japanese, Chinese, and Korean, where 
text styles such as bold and italics can render text unreadable (especially in smaller fonts), an 
international preferences panel is available. This preference panel will disable all text styling in 
PrintSmith. When enabled, all text styling instructions are ignored. This includes user definable font 
settings. Select the Disable Text Styles option to disable styles such as bold and italics. 

Note:  The Disable Text Style is a global preference that is established at the master only. 
Disable non-taxable options for invoices, jobs and charges 

Selecting this preference disables the taxable checkbox in the Invoice, Estimate, and Charge 
windows.  This option is not intended for domestic use. 

 

Product Activation 
The Product Activation panel is used to activate optional PrintSmith products like Integrated Credit 
Card Processing and the Tracker Module. 

Figure 8.28: System Product Activation Preferences Panel 
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Fiery Connector  
The Fiery Connector panel supports the Fiery integration. 

Figure 8.29:  Fiery Connector Preferences Panel 

 
 

PrintNet Integrator IP Address 

This is the IP address of the machine on which the PrintNet Integrator has been installed for your 
shop. 

Note:   Do not include the port # in the field. 
Fiery Connector URL 

This is the address to which all Fiery messages will be sent.  Use this format:  
http://##.##.##.##:9200/jdfConnector/jdfConnector  

Note:   PrintSmith must be restarted for the Fiery Connector settings to take effect. Verify 
communication with the PNI in EFPLA_Log.txt in the root or archive directory.  
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Palm Tracker 
The Palm Tracker panel supports the Symbol Palm Pilot with integrated bar code scanner in 
PrintSmith for updating the locations of jobs. To use it, you should install the Palm Desktop (or at 
least the HotSync manager portion) on a computer with either the PrintSmith Master or 
WorkStation. It could also be installed on a machine without PrintSmith as long as this location is 
available on the desktop of a machine with PrintSmith. 

Figure 8.30: System Palm Tracker Preferences Panel 

 
 

This window specifies the location of the HotSync files and the frequency with which you want 
PrintSmith to check for changes. Once a schedule has been set, it is automatic; any time you 
perform a HotSync, the scan data is loaded into the location you specify, PrintSmith reads it 
automatically and updates the pending list with the new location information. 

Use Palm Pilot Tracking 

This checkbox has no direct affect on whether you can use your Palm units. What it does control is 
whether PrintSmith will be checking for any HotSync data. 

Palm User Path 

The Palm User Path field shows the location that PrintSmith checks for HotSync Data. It must be 
set after you have installed the Palm Desktop software. 

Browse 

Use the Browse button to locate the HotSync Application. PrintSmith uses this location to find 
HotSync data used to update job locations. 
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Polling Interval 

This value is the time (in seconds) that PrintSmith should wait before checking for HotSync data. 
We recommend a minute as the minimum value. Setting it too low can seriously degrade network 
responsiveness and overall system performance. 

Create Location File 

If you want your Palm units to display the location of the job, you need to transfer the location 
information to each of them. This button prepares a file and sets it up to be transferred to each 
Palm unit the next time a HotSync is performed. 

Check for Palm Data 

PrintSmith will check for Palm data at the polling interval you have specified. Clicking this button 
immediately checks for new data regardless of polling interval. 

Location Log 

When a location is updated, a log entry is now made which records the new location along with the 
date and time of the change. Report Writer is required to generate reports using the information in 
this file. 

 

Address Formatting 
The Address Formatting panel is used to control the format of addresses. 

Figure 8.31: System Address Formatting Preferences Panel 

 

List of all defined 
Countries 

Country used when 
the Country field is 

empty Sample of how 
the selected 
Format looks 

For Adding, 
Changing, and 
Deleting Countries 
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The data in this window is stored in the Country table and can be modified to some degree in the 
Table Editor. Since this is based on a table, there can be at least 100 separate country definitions. 
Each country has an address layout, which is controlled using this layout editor. 

Figure 8.32:  Address Layout window 

 
 

Each row represents a possible address line. Each column represents address elements that can 
be placed on each line. Between each column is an edit field where you can enter up to 2 
characters of separator text such as a space or a comma with a space. If you do not enter any 
separator between address elements on the same line, there will not be any separation. 

All of the toggle switches have the same pop up menu containing an empty entry, followed by 
entries for all the possible address elements: Street1, Street2, City, State, Zip, and Country. All 
fields are optional. You need only specify the ones you want used in the address format. 
Separators are only used when there is at least one adjacent element being used. Each address 
element can be specified only once - if you choose an element that has already been selected, the 
new selection is accepted. The rest of the layout will display only one of each address element. 
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Defining Point of Sale (POS) Preferences 
POS or Point of Sale functions are controlled by the following preferences. 

Receipt 
The Receipt panel defines the message text and numbering sequence for the optional receipt 
printer. Enter your specific customer information if you are planning on using PrintSmith’s optional 
receipt printer. This panel is used to set the header and footer messages and where you set up 
receipt numbering and tax options. 

Figure 8.33: POS Receipt Preferences Panel 

 
 

Header 

Enter the text you wish printed at the beginning of each receipt. 

Footer 

Enter the text to print at the end of each receipt. 

Serial Numbers on Receipts Starting At 

Enabling this feature will print a serial number on the receipt. The edit field at the end of this 
function shows the serial number last used to print a receipt. Changing it will start a new sequence. 

Hide Tax in Line Items 

Enable the Hide Tax in Line Items option only if you are setting up the entire system to include tax 
as part of the price instead of showing tax separately. 

Note:  The Hide Tax in Line Items is a global preference that is established at the master only. 
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Cash Drawer 
If you have the optional receipt printer and/or cash drawer, the Cash Drawer panel is where they 
are enabled. Additionally, you can set these options locally at each computer enabling local 
preferences as necessary. 

Figure 8.34: POS Cash Drawer Preferences Panel 

 
 

If you have a cash drawer and receipt printer attached to a computer, you must check the Enable 
Receipt Printer and the Enable Cash Drawer options. Selecting the Print Receipts and Print 
Invoices options sets the default in the cash register to print either document. 

If these devices are connected to a workstation, select the Keep Settings Local option because the 
settings may change during a pricing update. 

All other options should work as set by default. See the Setting Up Cash Drawer and Impact 
Receipt Printer section for more information on setting up this optional device. 

Note:  This is a local preference established at each workstation, if the option is enabled. If a 
Cash Drawer and Receipt Printer are connected to the workstation then the Keep Settings 
Local option is recommended. 

Enable Cash Drawer 

Turn this on to tell PrintSmith that a Cash Drawer is connected to the receipt printer or computer. If 
the receipt printer setting is also turned on, PrintSmith assumes that the cash drawer is plugged 
into the receipt printer and that the receipt printer has the necessary circuitry to supply power and 
open the cash drawer. 

If you have a stand-alone Cash Drawer, it must be plugged into an electrical outlet. Your computer 
usually cannot supply any electrical power to it. This type of cash drawer is called an “intelligent” 
drawer because it opens in response to a simple ASCII code. It is quite different (and usually more 
expensive) than drawers that plug into a receipt printer. 
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If you do not want the Cash Drawer to open or do not have one installed, you can shut off the 
Enable Cash Drawer button. Unlike the receipt printer, which can also be disabled from the Cash 
Register window, this is the only place where you can disable the cash drawer. 

Print Receipts 

If you normally want to print a receipt, select this option. As receipt printers are local devices this is 
a local setting and can be maintained by enabling Keep Settings Local. Be sure to disable both 
buttons if there is not a receipt printer or cash drawer connected to the computer. If a different type 
of device is connected to the port, your computer could get stuck waiting for the drawer or the 
receipt printer to respond. 

Print (2) Copies of Receipts 

When enabled, 2 copies of receipts are printed; one for the customer and one for your records.  

Print Invoices 

This button matches a similar button in the Cash Register window. If you normally want to print the 
invoice when you pick up an invoice, turn this button on. 

Lock Settings 

Prevents the user from changing the settings of Print Receipt and Print Invoices from the Cash 
Register window. They are set to match the preference panel settings and cannot be changed. 

Use Master’s Drawer 

Turning this button on in a Workstation tells PrintSmith to open a cash drawer connected to the 
PrintSmith Master. Any locally installed cash drawer is ignored. This has no effect on receipt 
printers. A receipt printer must be connected to a computer to generate receipts, it cannot be 
shared, even if using a master cash drawer. It is possible to have a cash drawer on one 
Workstation and have other Workstations use the drawer attached to the PrintSmith Master by 
turning off this option in the computers with their own Cash Drawer. 

Keep Settings Local 

Cash register settings can be saved and used locally by Workstations without having them change 
each time the Update Pricing command is run. 

Note:  When using a master drawer, make sure to turn this setting on so you do not have to 
change the settings each time you update prices. 

ASCII Code to Open Drawer 

PrintSmith sends a code to open the cash drawer. For most cash drawers it is the BELL character, 
which is ASCII, code 7. Change this only if you know that your cash drawer needs a different code. 

Blanks Lines on Receipts 

You can, if you wish, modify the number of blank lines printed before and after the receipt. The 
Blank line settings minimize wasting paper on our standard receipt printer without forcing you to 
manually feed the receipt before tearing it off. Other receipt printers may need different settings. 



Chapter 8:  System Administration 

 
 

 
Page 441 

Receipt Start Code 

Codes in this field are sent to the receipt printer at the start of each receipt before anything is 
printed. 

Receipt End Code 

This code is sent at the very end of printing the receipt. This code and the Receipt Start Code affect 
printers that have built-in receipt cutters. Unless you totally understand what these changes will do 
to your receipt printer, do not change these settings. Support for a thermal receipt printer with an 
automatic cutter is available in a Mac ADV, Mac USB, Win USB, and Win Serial. 

In addition to being very fast, the printer has several options for paper advancement and cutting as 
defined by the following cut codes to be placed in the Receipt End Code field if using the new 
thermal printer. Enter one of the following codes only if you have a thermal receipt printer.  

1B6400 - Cuts the paper fully. 

1B6401 - Cuts the paper leaving one point uncut. 

1B6402 - Cuts the paper fully after feeding the paper to the cutting position. When print start 
position detect is ON, feeds the paper to the next print start position first, feeds the paper to the 
cutting position, then cuts the paper fully. 

1B6403 - Cuts the paper fully after feeding the paper to the cutting position. When print start 
position detect is ON, feeds the paper to the next print start position first, feeds the paper to the 
cutting position, then cuts the paper leaving one point uncut. 

Register Tape ID# 

Allows users to see which workstation a particular transaction came from on the Register Tape.   

Note:  The Register Tape ID Number should be unique for each workstation.  This uniqueness 
needs to be maintained by the Administrator since PrintSmith does not monitor this field. 

Communication Settings 

For standard cash drawers and receipt printers, the default communication settings that PrintSmith 
ships with are correct and should be left alone. If you purchased cash drawer and receipt printer on 
your own, you may need to change some of these settings. Consult the documentation that came 
with the hardware to find the correct values and use the Test button to make sure they work. 

Note:  These settings are ignored with USB printer selection. 
Test 

Anytime you change settings in this panel, click on the Test button to print a sample receipt. If the 
Cash Drawer is enabled, it will open. If both a Cash Drawer and a Receipt Printer are attached, 
both must be enabled or the cash drawer will not open. On a Workstation, if the Master Drawer 
button is turned on, it will open the drawer on the PrintSmith Master. A sample receipt will only be 
printed if the receipt printer is enabled and the Print Receipt button is on. 

Note:  The Print Invoice button cannot be tested in this window. 
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Cash Register 
This panel controls the labels, taxable state, sales category, and default rate for each button in the 
Cash Register window. If your business does a lot of small transactions, you should configure the 
cash register to match the types of transactions for which you do not need to create an invoice. 

Figure 8.35: POS Cash Register Preferences Panel 

 
Tax 

Use the tax button to indicate whether transactions in a department are taxable. You still have the 
ability to decide, on a case by case basis, which transactions are taxable. 

Title 

The title is what you see in the Cash Register window for each department label. While it is a good 
idea to use a title that is similar to the sales category, you do not have to. You should keep the 
department titles as short as possible as there is very little room in the buttons for text. 

Sales Category 

The sales category tells PrintSmith where in the Sales Summary to put any Cash Register 
transactions created for that department.  

Rate 

Each department can have a default Rate. When you select a department in the Cash Register 
window, PrintSmith automatically sets the Unit Price to this rate.  
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Pending List 
The Pending List panel is used to customize the appearance of the pending list as it displays in the 
Pending Document window. You can experiment with these settings as much as you want; 
however, they are only updated when the Pending Document window is re-opened. Before 
changing these settings, be sure to close the Pending Document window. 

Figure 8.36: POS Pending List Preferences Panel 

 
 

Column Setup 

You can change the order in which the pending list columns display: 

• Change the column order in the list by drag and dropping the items 

• Double-click to change items from visible to not visible 

Show Document type in number 

Enabling this option will include “E#” as part of the document number for Estimates. This is the 
behavior used in prior releases. If this option is disabled, the only way to determine the document 
type is to show the Type icon or note the color of the item. Invoices are shown in blue unless Past 
Due coloring is on and the invoice displays in the set color. 

Always include past due documents in filter 

Enabling this option shows past due jobs in varying filters. 

Drag the 
items to 
change 

the display 
order 
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Color past due entries 

Enabling this option will display all late documents in the selected color. Those are documents 
where the Wanted By date and time have expired, unless marked ready for pick up or delivery in 
the Location function. 

Past Due Color 

Change the color for displaying past due items. 

Ready for Pickup Color 

Change the color for displaying items ready for pickup. 

List Font 

Change the font specification for the pending list display here. 

Header Font 

Change the font specification of the column titles in the pending list window here. 

Note:  The Pending List is a local preference, meaning every computer could have a different 
looking pending list on a multi user system. 
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Defining Estimator Preferences 
This group of preferences focuses on how the Estimating engine manages sizes, defines product 
codes, organizes stock listings, and displays quantities. 

Estimator Behavior 
The Estimator Behavior panel determines such things as whether or not to close the source 
document after copying, and whether or not the paper calculator will open prior to the job menu on 
all printing, copying, and blank jobs. 

Figure 8.37: Estimator Behavior Preferences Panel 

 
 

Close source document after copying 

Since multiple document windows can be opened at one time, you have the option to have the 
original document close after is has been copied, allowing you to work with the newly created 
document. To enable this option, check the Close Source Document After Copying box. 

Enter Stock Cost in Estimator 

When enabled, the job window will display fields for the stock cost and units when using the 
Special Order and Customer Stock pricing methods. If the option is turned off, the stock cost and 
units fields are not shown in the Special Order job window. 
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Can change address on ALL documents 

When you select the account, the customer name and address field is editable in order to enter the 
customer’s information. This option allows you to change the customer name and address on all 
documents. When the document is filed, the pending list displays the actual company name from 
the selected account. When it is printed the invoice address will display the information you have 
entered or changed. 

To use this effectively, set up your documents to display 2 addresses, the Invoice and Statement 
addresses. In effect, the Invoice address in the document becomes a shipping address and the 
Statement address in the customer account is used as the billing address. If statements are sent to 
a third address, create another customer account with the correct statement address and use it as 
a Master Billing account for statement generation and posting payments. 

Auto show Paper Calculator on new jobs 

When checked, the Paper Calculator opens after the stock is selected if the job method is printing, 
copying, blank stock, or list. 

Always use Stock’s Parent Size 

When this setting is enabled, the Parent Size field is locked on jobs where stock is selected from 
the stock database. Generally, we recommend enabling this setting to prevent the changing of the 
stock’s parent size without changing the cost of the stock. 

Although PrintSmith handles changing the Parent Size as an override, it makes sense to use the 
defined stock size if one is available for stock ordering. Otherwise, you could end up with a stock 
order report with multiple sizes for the same stock number. 

Calculate Re-Order date on invoice copy 

When this setting is enabled, PrintSmith looks for an invoice from history that is identical to the new 
invoice and calculates a date based upon the time elapsed between the new invoice and the 
invoice from history. This date is placed in the reorder field on the new invoice. Typically, this date 
is used to reorder every thirty days, sixty days, or ninety days, and so on. 

Validate sales rep 

When enabled, this setting notifies the user when a document, which contains a sales rep that has 
been removed from the system, is copied to a new document. You are prompted to select a Taken 
By name. 

Leave Folded size empty on new jobs 

When enabled the folded size is not entered in a job. When disabled, the folded size defaults to the 
finish size. 

Do not perform Costing during invoice POST 

Generally, this option is disabled to provide for automatic costing at pickup. If enabled, then only 
documents costed will have costing information. Costing can always be updated or changed on any 
document. 



Chapter 8:  System Administration 

 
 

 
Page 447 

Auto show Charges on new jobs 

Auto Show Charges option allows you to have the Charges window automatically displayed to the 
user after they tab off of the description field the second time. This feature is designed for new 
users who may forget to view the charges. 

Show (pre 7.1) single pass work and turn option 

Enable this option to show the single pass work and turn option. 

Never use preset press on stock changes 

Enable this option to never use preset press in Stock Definitions on stock changes. 

Add fixed waste for each pass (Affects historic documents) 

Enabling this option adds fixed waste for each pass. 

Add fixed waste for each color (Affects historic documents) 

Enabling this option adds fixed waste for each color. 

Calculate INK by Impressions, includes waste. (Affects history) 

When enabled, ink is calculated by impressions with waste included. 

Note: Please be aware that any changes to the previous three options will affect historical 
documents. 

Normal due date (days) 

PrintSmith will calculate an automatic due date if the number of future days from the date of the 
order is entered in this field. This feature is also valuable as an automatic follow-up date for 
estimates. If you add 5 days in this field and the 5th day lands on Saturday, PrintSmith will set the 
due date to the following Monday. 

Note:  The Normal Due Date is a global preference. 
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Estimator Printing 
The Estimator Printing panel determines if the invoice will be closed after the job tickets are printed, 
what the default invoice and estimate will be, and how the payment due date should be calculated. 

Figure 8.38:  Estimator Printing Preferences Panel 

 
Close Invoice after printing job tickets 

Check this box to close the invoice window after the Tickets button has been selected to print job 
tickets. 

Close Invoices and Estimates after printing 

This setting determines whether or not an invoice or estimate will remain open after printing. If you 
want a document to remain open after printing it, uncheck this box. 

Default Invoice 

Select a document format to use when printing an invoice. If the customer account assigned to the 
document has a default format selection, the customer setting will override the system setting. 

Default Estimate 

Select a document format to use when printing an estimate. If the customer assigned to the 
document has a default format selection, the customer setting will override the system setting. 

Note:  Default Invoice and Default Estimate are local preferences to accommodate differing print 
drivers, printers, and platforms. 

Payment Due Date 

Set the default Payment Due Date to be from a number of days before due, from notified date, from 
completed date, from pickup date, from ordered date, from printed date.  The Payment Due Date 
appears at the bottom of the Invoice under the Total. 
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Paper Calculator 
The Paper Calculator is used in conjunction with pricing methods that require stock. The Paper 
Calculator panel allows you to enter your default settings for using the paper calculator. These 
defaults can be overridden when working in the paper calculator itself. 

Figure 8.39: Estimator Paper Calculator Preferences Panel 

 
Gripper Edge 

The Gripper Edge value is the amount of space required on one feed edge of the run sheet for the 
press to pick up the paper. It may be possible to ignore this due to the placement of the image on 
the page. So, this option should be enabled whenever needed. The size of the gripper edge 
normally comes from the Press Definition. If not specified there, the Paper Calculator preference 
panel is used. This amount can be changed on an individual job in the paper calculator window 
itself. 

Folio Edge 

This is the amount of space reserved on an edge of the run sheet for a booklet maker. It is used 
when folding signatures to offset the imposed image so as to leave one edge of the folded 
signature overhanging the other. 

The standard size of this edge is specified in this preference panel but can be changed for any job 
in the actual paper calculator. 

Gutter 

The Gutter is the space between multiple images on a sheet. The first value is the vertical gutter; 
the second is the horizontal value. A gutter is most often used to add space in a folded piece. 
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Bleed 

A bleed is a specification that requires an oversize run sheet so that the ink can run off the edge of 
the final sheet. It generally increases the number of cuts, since the bleed must be trimmed off each 
finished sheet in addition to cuts needed to separate each image. You can specify the required 
bleed differently for each edge. 

Note:  Bleed is a global preference that is established at the master only. 
White Space 

The White Space field allows you to define the unused part of the run sheet when the image area is 
smaller than the run size.  

Always Attach Cut Diagram To Job Ticket 

This option attaches the cut diagram to the job ticket. This preference default can be changed in 
the paper calculator. After a job is filed, the settings return to the default from the paper calculator 
preferences panel. Double clicking on the diagram opens an expanded view of the cut diagram. 

The gray area showing waste is an approximation and may not be accurate for large numbers of 
sheets out due to rounding of the sheet dimensions for display. 

Color Bar Width 

A color bar can be added to the to the cut diagram. The Color Bar Width field is used to specify the 
width to use for the color bar. Note that this is the only place this value is set; it cannot be adjusted 
in the paper calculator. You can control the edge used for the color bar even if you do not need or 
want to change the space for a gripper edge. After a job is filed, the settings default back to the 
paper calculator preferences panel. 

Back Trim, Parent 

If you plan to trim the edges from all four sizes of the parent sheet, enable the Back Trim, Parent 
option. It effectively adds four cuts to the parent cut and centers the run sheet in the parent sheet. 

Trim 4 Sides 

The Trim 4 Sides option is similar to a back trim, except that it is applied to the run sheet. 
Frequently on large format presses, the entire image is centered on the plate in order to obtain the 
best ink coverage. After printing, the press sheet is trimmed down to remove the edges and 
ensures that the sheet is square before any other finishing is performed. 

Work and Tumble 

Enabling the Work and Tumble option changes the cut out diagram for tumbling by showing two 
gripper edges and by changing the title of the Work & Turn option in the job window to read Work & 
Tumble. Should the other job specifications support Work & Tumble, that feature is manually 
selected in the job window. 

Except for a possible change in the number of sheets out due to the additional gripper edge, no 
other change to pricing is made as a result of this. If the other job specifications support Work & 
Turn, the option can be enabled in the job window to change the way the job is estimated from 
Sheetwise to Work & Tumble (or Work & Turn if this button is disabled.) 
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Grain Direction Options 

Grain Direction Options 
Options Effect 

  

Neither Grain direction is ignored and a best fit strategy is utilized without considering 
the possibility of rotating any sheets. 

Match Grain Grain direction is matched by forcing the calculation to base the sheets out on 
the order in which length and width are specified. Sheets are never rotated to 
improve the number of sheets out. 

Swing / Combination This uses a best fit strategy where sheets may be rotated in differing alignments 
to maximize the number of sheets that may be cut out. 

  

 

While the accuracy of the diagram and the number of cuts for each sheet is generally quite high, it 
may not be exactly correct in all circumstances. It is often possible to cut a particular sheet in many 
different ways to obtain the same results. The paper calculator shows only one way for each 
combination of sheet sizes and option settings. No allowance is made for the size and capability of 
the cutter, the operator, the length of the job, or the required precision. Therefore, the number of 
cuts for the run and finish size sheets should be considered proposals. If you wish, you can change 
the number of cuts for each sheet by overriding the number of cuts in this window. 

Note:  The number of cuts calculated in the paper calculator is used for both pre-press and 
bindery cutting charges. Overriding the number of cuts will affect the cutting charges. 

Crouser or List Pricing 

When the Crouser or List pricing method is used, the paper calculator will display when you pick a 
stock. The Auto Show Paper Calculator On New Jobs option must be enabled in the Estimator 
Behavior preference panel for paper calculator to automatically display. 
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Job Ticket 
The Job Ticket panel allows you select your job ticket preferences. You can use either the old style, 
the standard style, or customize your job ticket. 

In order to customize your job ticket, the optional Report Writer must be purchased. Report Writer 
is the tool used to perform the customizing, as well as to print the custom ticket. 

Determine if you want prices to show on your job tickets. You can use the optional bar code 
tracking system if you have purchased a bar code reader and set a special font. 

Figure 8.40: Estimator Job Ticket Preferences Panel 

 
 

Custom Style 

This window assumes that a custom ticket has already been developed. One of the standard 
Report Writer reports is a customizable job ticket that is almost exactly the same as the current 
Standard Style ticket. To use this format as your job ticket, select the Custom Style option, and 
then select the applicable report. 
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A list of registered reports opens.  Select the Job Ticket report (Job Ticket.rpt). 

Figure 8.41: Select Report Group Window 

 
 

Be sure to select the Job Ticket report. PrintSmith has no way to check that the report to use for job 
tickets is appropriate. Selecting an incorrect report will eventually be discovered during the printing 
process when the data you have selected does not work. 

Show Amounts On Tickets 

When enabled, this feature will print the dollar amounts on the job ticket. When disabled, no prices 
are shown on the standard job ticket. 

Add Tracking Bar Codes 

If using the optional bar code reader, you need to enable this option to print the bar code on the 
standard job ticket. You also need to specify the font in Set Bar Code Font. The optional bar code 
tracking system allows you to update the status / location of every job in your shop. 

Show Customer External Reference Number 

This option displays the external reference number in the job ticket header. An external reference 
number might be an artwork file, an old account number, or any number entered in the customer 
account. 

Job Ticket.rpt 
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Charge Description 

Charge Description Options 
Option Meaning 

  

Show Name When enabled shows the Name of the charge on the job ticket. 

Show Description When enabled shows the description of the charge on the job ticket. Users can 
easily change the description. 

Show Both If Different Shows both name and description if they are different. 

  

Note:  Charge Description is a global preference that is established at the master only.  This 
feature only works with the Old Style and Standard Style ticket formats. 

 

Quantity Breaks 
Quantity breaks are a great marketing tool. The quantities entered are used in generating price lists 
on screen and for printing. You can generate a price list, for any job, with up to 40 quantities. The 
price list can be presented with price per each or price per thousand. Either way, it is a great tool to 
up-sell the customer by quoting a lower price per unit. Enter in your favorite quantities. Numbers 
preceded by a (-) minus sign will have a divisional line above them in the price list. A zero in any 
field ends the list. 

Figure 8.42: Estimator Quantity Breaks Preferences Panel 

 
Note:  Quantity Breaks is a global preference that is established at the master only. 
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Tracking Locations 
Information previously specified in the Tracking Locations panel is now specified within the Admin > 
Table Editor window, in the Production Locations table. 

Figure 8.43: Estimator Tracking Locations Preferences Panel 

 
 

Markups 
Markups are variables used in the estimating system. The Outside Services and Merchandise 
markups are used when in the respective pricing methods.  Markups are based on stepped cost 
amounts.  The first amount covers from zero to the specified cost, and the last amount covers 
anything above the last set cost. 

Figure 8.44: Estimator Markups Preferences Panel 

 
Note:  Markups is a global preference that is established at the master only. 
 

In this 
example, field 
1 markup 
applies to 
Total Cost 

In this 
example, field 
6 markup 
applies to 
Total Cost 
above $800. 



EFI PrintSmith 7.2 |  Reference Guide 

 
 

 
Page 456 

Stocks and Sizes 
The Stocks and Sizes panel contains the settings for In Stock, Special Order, and Customer Stock, 
as well as blank stock markup and formatting instructions. 

Figure 8.45: Estimator Stocks and Sizes Preferences Panel 

 
 

Stock Markup 

The Stock Markup is the default markup used for all stocks unless you specifically override the 
markup in an individual stock definition. A markup has a greater effect on high priced stocks than 
low priced stocks.  

Stock Weight, Name & Finish 

The Stock Weight, Name, and Finish field allows you to format and display the stock name and 
weight. This field is based on a concept of a block of text with placeholders for name, weight, and 
finish. These placeholders are replaced with actual weight, name, or finish when stock is displayed. 

Placeholder Meaning When Used In Stock Weight, Name, And Finish Field 
  

^0 Weight of the stock 

^1 Name of the stock 

^2 Finish of the stock 
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You have complete control over the contents of the text block. Clicking the question mark button at 
the end of the field pops up a list of sample formats. Selecting one of the samples inserts the 
format text into the field. 

Example 

For 50 pound offset stock, using a weight, pound sign and name format, enter the following: 

Format:  ^0# ^1 
Result:  50# Offset 
 
Other possibilities: 
Format:  ^1 ^0# ^2 
Result:  Offset 50# Vellum 

OR Format:  ^0gsm ^1 
Result:  50gsm Offset 

 

The resulting format will appear on invoices, estimates, and stock order reports. 

 

Stock Points, Name & Finish 

The Stock Points, Name, and Finish field allows you to format and display the stock name and 
weight differently for stocks defined by points. This field is based on a concept of a block of text 
with place-holders for name, weight, and finish. These placeholders are replaced with actual 
weight, name, or finish when stock is displayed. 

Placeholder Meaning When Used In Stock Points, Name, And Finish Field 
  

^0 Point Size of the stock 

^1 Name of the stock 

^2 Finish of the stock 

  

 

You have complete control over the contents of the text block. Clicking the question mark button at 
the end of the field pops up a list of sample formats. Selecting one of the samples inserts the 
format text into the field. 

Blank Stock Pricing 

Set your markups for selling blank stock using the Blank pricing method. These quantities will 
display in each new stock definition. However, changing them here will only effect new stock 
definitions and not existing definitions. Existing definitions can be updated manually in each record 
to reflect new defaults entered or globally using Change prices under the pricing menu. This 
command will update the markup and reset the quantity breaks when the Re-Calculate Blank 
Prices option is enabled in Change Prices and Auto Calculate Blank stock is enabled in the 
respective stock definitions. 
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Customer Stock 

Enter in default stock cost, stock markup, and in units of for customer provided stock. These 
defaults can be overridden when entering a job in the estimator. 

Size Table to Use 

This drop down lists size tables that can be customized in the Table Editor under the Admin menu. 
These options include metric and conversion tables. 

Note:  This is a global preference that is established at the master only. 
 

Pricing Method 
The Pricing Method panel allows you to change the name and default sales category of the job 
pricing method. However, the way the pricing method calculates remains the same. For example 
you could change the title of the first method to “whatever” and set the sales category to “other” but 
the method will still calculate based on a combination of press and stock definitions, which is 
unchangeable. 

Figure 8.46: Estimator Pricing Method Preferences Panel 

 
 

Note:  Pricing Method is a global preference established at the master only. 

Pricing 
Method 
descriptions 
displayed in 
the Estimator 
column

Options 
can be 
turned 
off/on 
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Use 

You can enable or disable any pricing method by turning the Use button associated with the 
method on or off. 

The last 5 pricing methods are labeled Merch. They are designed, as user definable methods, to be 
used for special pricing situations and use the same data entry methods as Merchandise pricing. 
These methods are useful if you want to set up a special sales category for some types of brokered 
work or other types of services like Mailing. 

Title 

The title of each pricing method is used as the button label in the Pricing Method selection window. 
The actual width of the button title in that window varies somewhat so you should check the Pricing 
Method window for legibility any time you change one of these labels. 

B T F N 

Enable or disable the Brokered, Taxable, Finished, and Show Notes option for each pricing 
method. 

Sales Category 

The sales categories in this window are largely ignored by the Estimator except for Outside 
Services, Merchandise, Lines & Inches, and the last 5 “user defined” pricing methods. 

You can set up sales categories for Printing, Copying, and List pricing, but the actual sales 
category is determined by the press or copier definition used in the job. The sales category for 
Multipart jobs is used only when you specify Overs/Unders on the entire multipart job. 

Estimator 

This uneditable column displays the pricing method description or functionality. 
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Defining Accounting Preferences 
The following six preferences establish accounting sales categories, general ledger profiles, aging 
periods, customer default credit limits, credit card info, and journal entry defaults. 

Credit/Defaults 
The credit limit field sets a default limit for ALL customers. Set this limit to your standard, most often 
used, lower credit limit. A credit limit of zero provides unlimited credit. Each customer account can 
have its own unique credit limit. 

Figure 8.47: Accounting Credit Preferences Panel 

 
 

Credit Limit 

The maximum amount any customer can charge to their account. A value of 0 indicates there is no 
system wide credit limit. A customer’s credit limit takes precedence over the system limit. 

Generally, you should set the credit limit to your standard credit limit for a typical customer and put 
a differing credit limit on the accounts that need them. 

Finance Charge 

This is the rate the Statement Generator uses to calculate finance charges if the account does not 
have its own finance charge rate. 

Inactive Period 

The number of days of inactivity you want PrintSmith to use when checking for inactive accounts. 
Account activity in this context includes entering a payment, posting an invoice, or creating an 
invoice or estimate. 
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Remove Drafts from Deposit Ticket 

You can exclude bank drafts from printing on the Deposit Ticket by enabling this setting. This does 
not alter the data that is stored. Information on drafts is still recorded and saved. Disabling this 
feature and re-printing a Deposit Ticket will restore the Draft data to the report. As drafts are not 
usually deposited, enabling this feature will create a more accurate and useful deposit ticket. 

Default sales rep for new accounts 

Select the default sales rep for new accounts from the dropdown list. 

Default shipping for new accounts 

Select the default shipping method for new accounts from the dropdown list. 

 

Aging Periods 
This panel is used to set the standard aging periods and the notices placed on statements by the 
Statement Generator for accounts that are past due. 

Figure 8.48: Accounting Aging Periods Preferences Panel 

 
You can set up aging periods that differ from the standard 30, 60, 90 day aging period to better suit 
your business. A common change is 45, 60, 90 which provides a bit more time for your customers 
to pay without unduly delaying action on slow paying accounts. Add appropriate messages to 
optionally display on statements.  

Note:  Make sure that Past Due, Delinquent, and Frozen are sequential. Delinquent must be 
greater than Past Due, Frozen greater than Delinquent. 
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Sales Categories 
There are forty sales categories available in PrintSmith. Charges, copier and press definitions as 
well as other pricing methods use them. The information is used on a daily closeout to break all 
transactions down by category. Use this panel to change the name PrintSmith uses for these 
categories, and to set up the General Ledger account numbers used by Accounting Links. 

Figure 8.49: Accounting Sales Categories Preferences Panel 

 
Name 

Customize PrintSmith by setting up sales categories to suit your business. You can define the sales 
category for each cash register button, pricing method, press, copier and each charge definition. 

Sales categories 17 through 20 are shown as Other Sales in the daily sales report. Sales category 
20, labeled Interest, is used by the statement generator to separately track finance charges. 

The final sales category, Shipping, is a built in sales category that cannot be changed. The 
Estimator uses it when shipping charges are manually entered and can also be used by you on any 
charges used to add shipping charges to a document. 

The following characters are not allowed as part of the name of a sales category name: “;(^/!”. You 
should avoid using a hyphen as the first character because it disables the item, preventing it from 
being selected. 

GL Acct 

If you plan to connect PrintSmith to an external general ledger package using the DownLoader or 
the built in Accounting Links option in Daily Closeout, you will want to enter the general ledger 
account number of each sales category.  
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GL Profiles 
This panel is used to enter general ledger control account numbers to facilitate communication with 
other accounting packages. Select the accounting system to connect to using the Link to: menu. 
This determines the format of the file created with the Accounting Links sales report option that is 
part of the Daily Closeout report suite. 

Figure 8.50: Accounting GL Profiles Preferences Panel 

 
 

Cash Over/Short and Paid Out are special cases that will most likely be posted to an expense 
account or income account. In either case they are automatically reversed to the Receipts account. 

Link to: 

Currently, the packages supported are: MultiLedger, MYOB, Peachtree Accounting, Quickbooks, 
MultiLedger, Sage Accounting, Simply Accounting, BusinessWorks, Great Plains Import Manager 
and Sage Line 50. The exported information comes from the following fields in PrintSmith: 

Shipping Collected 

This total comes from any revenue coded to the Shipping Sales Category. A separate Shipping line 
item displays on the Daily Sales Report in the Sales Breakdown section. 

Actual Bank Deposit 

This total comes from the Actual Deposit field in the Miscellaneous section of the Daily Sales 
Report. You enter this total into PrintSmith during the Daily Closeout. 

Un-deposited Receipts 

This total comes from the On Hold field in the Balance Cash Drawer window that is part of the Daily 
Closeout. An item on hold could be a customer check you put on hold for 24 hours. 

Select your 
accounting 
system from a list 
of supported 
packages. 
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Discounts 

This total comes from revenue coded to the Discounts Sales Category. A Discount/Markups line 
item displays on the Daily Sales Report in the Sales Breakdown section. 

Sales Tax 

This consists of the Taxable Sales and Tax on Sales totals in the Sales Breakdown section of the 
Daily Sales Summary report. 

Total AR Receipts 

The total for the A/R column in the Receipts Summary section of the Daily Sales Summary report. 

Deposits on Invoices 

This total comes from the Deposits Received line in the Receipts Summary section of the Daily 
Sales Summary report. 

New Charges to AR 

This number comes from the New Charges line in the Receipts Summary section of the Daily Sales 
Summary report. 

Cash Over/(Short) 

Listed in the Miscellaneous section of the Daily Sales Summary report, it is the difference between 
what PrintSmith tells you the deposit should be and the actual total you have entered. 

Paid Out 

This total is listed in the Miscellaneous section of the Daily Sales Summary report and reflects cash 
paid out of the cash drawer, usually for miscellaneous items such as gas, postage, etc. 

Refund Checks 

This reflects any refund checks indicated in the Post Payment window. A control account was 
added to handle refund checks. This account is necessary in order to maintain proper balances in 
external accounting systems. When a refund check is issued in PrintSmith, it increases the AR 
Balance and customer account balance by the amount of the refund, but it does not adjust the 
“Cash” account in the balance sheet because this adjustment should take place when the check is 
actually written. It balances in PrintSmith and in the journal entry created by Accounting Links 
because the refund is offset against receipts. 

The problem is that when you actually write the check in the external accounting system, it typically 
would reduce the cash balance in the checking account and the refund check has already done this 
- the result is a double posting to cash in the external system. 

Using the “Refund Checks” control account, specify an asset account to use as a clearing account. 
Accounting links will add the amount of refund checks back into cash and offset it against the 
clearing account. When you actually write the refund check, post it against the clearing account and 
everything will be in balance. There are other ways that this problem can be solved, so if you do not 
want to use the clearing account method, you can set the “Refund Checks” control account to be 
the same as the “Actual Bank Deposit” account and they will cancel each other out. 
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Credit Card Info 
The Credit Card Info panel is used to set up credit cards for use as a payment type in both the cash 
register and posting payments. Define each card you accept; as a result your daily closeout figures 
will match your credit card system batch report. 

Figure 8.51: Accounting Credit Card Info Preferences Panel 

 
 

There are 10 possible credit card definitions. The first four are pre-defined and can only be 
changed in a limited way. 

Use 

Check this column to recognize the card in PrintSmith. Only those card definitions, which have 
been enabled, are included in the Credit Card menu used to enter payments. 

Card Title 

The full name of the credit card. You cannot change the name of the first four cards. 

Abbrev. 

This field is the abbreviation of the credit card. It is used to identify the type of card. 

Code 

The Code field is a 2 character code used in the reference number field in Post Payments and the 
Cash Register to select the card in the credit card menu without using the mouse. It should be 
unique for each card. 
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ID 

The ID field is a number from 1 to 99 that must be unique for each card. It is used internally to 
identify the card type. It should always be the same number used by electronic credit card systems 
to identify the card. The first four ID’s cannot be changed and are set to the correct value for the 
cards listed. 

Activate Credit Card Approval Processing 

When this product is activated, this option enables the credit card integration features in PrintSmith. 

Note:  Credit Card Info is a global preference that is established at the master only. 
 

Journal Entries 
Journal entries use a document preference to define their appearance. Select the document format 
that best fits your needs or create a unique one for Memos. Enabling the Print Document option will 
set the default option to print a copy of the memo, which is recommended. Refer to the Document 
Preferences section for more information on document formats. 

Figure 8.52: Accounting Journal Entries Preferences Panel 

 
Note:  Journal Entries is a global preference that is established at the master only. 
Print Document 

The state of this button is used to set the Print Document button in the Journal Entry window when 
the window is first opened. 

Default Journal 

Select the document preference you wish to use for printing journal entries. 



Chapter 8:  System Administration 

 
 

 
Page 467 

Document Preferences 
Document Preferences control the format, content and placement of the data on printed invoices 
and estimates. Document Preferences are divided into pages accessed either from the keyboard 
(by pressing the button number) or by clicking buttons. When the window first opens, the page on 
which a setting was last changed is selected. 

A series of buttons down the left side of the window displays a series of option pages, which are 
used to control the printed output of Invoices, Estimates, and Journal Entries. This section 
describes each of the panels and all of the elements in each panel. 

Click the Adjust Document button to fine tune the position of the document on the printed page and 
select the placement of the document number. Click on the Customize Form button to open the 
Customize Document window.  

Managing Multiple Formats 
You create a new document form using the Save As command. The menu itself is sorted 
alphabetically. You can change the name of an existing form using <option>-Save. 

You can also import and export document preferences enabling Workstations, Portable and other 
PrintSmith users to share document formats. 

You can delete a document preference by clicking on the Delete button. 

When you create a new document form, you make a copy of the currently selected form. This copy 
includes everything connected with generating a hard copy of a document, the layout on the page, 
form image selections, the preferences used for formatting the data, and the fonts to use during 
printing. 

Note:  If you create additional formats on PrintSmith Workstation and Portable systems you 
should export them and send them to the master for importing because they are replaced 
when you update the pricing data from the PrintSmith Master.  

Each document format has a name. A list of all defined formats is placed in the Format pop up 
menu. An identical format menu is also shown in the document window and is used to select the 
form used to print the document. You can change the selection at any time using the Format menu. 
Each customer account also can have custom Invoice and Estimate format selections. 

Default Values 
PrintSmith has a built-in form definition that can be used to reset any form definition to the original 
state that PrintSmith is shipped with. You can reset any form to the default settings by holding 
down <shift> <control> <option> and clicking on Adjust Document. Use extreme care with this 
option as there is no way to undo it. 
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Making Temporary Changes 
It is easy to make a temporary change to Document Preferences for a single document. Say for 
example, you wanted to hide the customer discount on a particular document. While the document 
is open, select Document Preferences and change that particular preference. Without closing the 
Document Preference window, select the document and print (or preview) the document. It will use 
the current, temporary changes when it prints. Select the Document Preferences window and click 
the Cancel button and the window will be closed without saving any changes. 

The ability to make temporary changes is a very handy tool when setting or changing document 
preferences. Make a change and then preview a document to see the new change.  

Page 
This page controls the options that change the layout or contents of the entire page. 

Figure 8.53: Page Document Preferences Window 

 
Print Form Image 

Prints an image of a form in addition to the data that fills out the form. Usually you will want to pre-
print your document forms. However, PrintSmith has several built in images of the forms we supply 
as part of the system. Turning this button on tells PrintSmith to print the picture of the form as well 
as the document data. It is recommended only for laser printers or FAX printers. Printing the form 
image on a dot matrix printer can be very slow and hideously ugly - probably not the image you 
want to project. 

Print Logo Image 

The Print Logo Image option controls printing of logo images. Logos must be pasted into PrintSmith 
using the Image Picker. Turning this button on tells PrintSmith to print the picture of the logo. It is 
recommended only for laser printers or FAX printers. Printing logo’s in dot matrix printers generally 
results in an extremely poor image. 
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Print Document Type 

Prints “Invoice”, “Estimate”, “Memo” or “Template” in the document eliminating the need for 
different forms. When also using a form image, you should use be sure to pick an image that does 
not contain a document type to avoid double printing the document type. You can also substitute 
the preference name for document type as discussed in “Format name is document type”. 

Print Store Address 

Uses the store address text defined on the “Text” page. The standard position of the text is in the 
center of the form at about the same height on the page as the document number. This standard 
text is part of the form definition. Set a unique text string for each document preference. e.g. “This 
estimate is good for 30 days from the date of the estimate, Thank you for your order, etc.” 

Add Amount Due Line 

Prints the amount due less deposits and payments after the invoice total. PrintSmith normally puts 
the deposit information in the remarks block. 

Remove Shipping Line 

Removes the shipping line from the document totals block. Charge Definitions that use the shipping 
sales category and pricing method in the sales category menu are often more flexible and useful 
than manually entering shipping in each document. The shipping amount defined in the “Document 
Totals” window is no longer needed in this case so you can reclaim the wasted space on the form 
by selecting this option. 

Note:  The shipping line is removed even if you have added shipping to the document in the 
Document Totals window. It will not show up anywhere except in the document total – an 
undesirable situation. 

Remove Tax Line 

Removes the tax line from the document totals. This should only be turned on if you are setting up 
the system to hide the tax in individual line items. 

Print Tax Name From Table 

Determines the descriptive text for taxes shown on the document. A Tax Table defines 5 different 
tax rates that can each have a separate title. Turning this button on prints this title in the same 
space where tax would be printed on a pre-printed form. This is usually used in conjunction with 
“Print Total Descriptions” in the Footer page when you remove all pre-printed text in the total block. 

Another important use for this feature is conditions in which you must show more than one tax. You 
can define up to 5 tax lines in the document footer. When multiple tax lines are defined for the 
document and multiple tax lines are defined for the tax table, PrintSmith tries to put all of the tax 
lines in the footer. If there are not enough lines available, it puts the extra lines in the body of the 
invoice just above the subtotal along with the descriptive text from the tax table. 

Print Standard Text In Remarks 

Prints the remarks text defined on the Text page of preferences. The text is placed in the remarks 
block after all other text. One excellent use for this text is to place marketing or seasonal messages 
on all documents. This standard text is unique to each Document Preference. 

Print Phrase(s) 

Turn this option on to use the Quote Letter Generator.  
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Hide Alternate Currency 

When using the alternate currency system, this option may be used to ignore alternate currencies 
for a particular document preference. 

Not For Use As Invoice 

This option setting tells PrintSmith to use the default invoice document preference when copying an 
Estimate or converting an Estimate to an Invoice. 

Note:  A format can still be used on an invoice when this option is turned on, but only by 
specifically selecting it. 

Format Name Is Document Type 

This option allows you to create a document preference and print the name of the document on the 
form without having to build and import a form image. For example, you can set up a document 
preference called Packing List, use a built in form image that has no name in the image, then turn 
on this option and Print Document Type. When documents are printed using this format, Packing 
List is printed instead of Invoice or Estimate. 

Make Quote Letter 

There are a lot of standard settings that should be changed to generate a pleasing, properly 
formatted Quote Letter. Clicking this button creates a new Document Preference with a good set of 
starting values that you can then modify. It leaves the currently selected Document Preference 
unchanged.  

Note:  Generally, it is a good idea to use this function or copy a document preference that was 
originally created using this function in order to set up a quote letter. 
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Header 
The settings on this page control the contents of the top of the form. 

Figure 8.54: Header Document Preferences Window 

 
 

Use Invoice/Statement Address 

Used to specify which address to print on the document. Select the address information entered in 
the document by turning on Use Invoice Address. Use Statement Address uses the Statement 
address from the customer account that the document has been assigned to. 

If only one address option is selected, it is placed in the address section on the left side of the 
document (the first address block). 

“Attn.” First/Last Line 

Directs the placement of the name of the contact person or department at the top or bottom of each 
address block. To remove the Attn. line entirely, click on the button that is currently selected to 
deselect the item. The attention name can be moved from the address block to a specific location.  

Postal Bar Code Top/Bottom 

Generates a Postal Bar Code from the zip code of the address at the top or the bottom of each 
address block. To be a “Post Office Friendly” person, make sure that all addresses have the correct 
ZIP+4 codes and put the bar code at the top of the address block. 

Use Order Date 

All documents must have a date. When this option is selected, the date the document was 
“ordered” is always printed on the document. The order date can be changed in a document. 
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Use Today’s or Pickup Date 

This option generally works better than “Use Today’s date”. When this option is turned on, and you 
are printing a document that has already been posted (picked up), the posting date is used instead 
of today’s date. 

Use Today’s Date 

This option always uses the current date when printing a document. 

Note:  Most of the time it make little sense to print an invoice date that is later than the date of 
the sale. For this reason, “Using Today’s or Pickup Date” is the preferred choice. 

Show Phone Number 

Prints the phone number at the bottom of each address block. The position of the phone number 
can be moved from the address block to a specific location.  

Show FAX Number 

The same as the phone number except it applies to the FAX number. The position of the FAX 
number can be moved from the address block to a specific location.  

Show PO Number 

Places the PO number in the location specified in the form definition. Normally, this should be 
turned on. 

Show Reprint Number 

Each time a document is printed a count is kept by PrintSmith of the number of times the document 
has been printed. If this is turned on, the number of times that the document has been printed will 
be shown just below the document number. 

Show Account Number 

Prints the customer account number on the document. 

Show External Ref. No. 

Prints the customer’s external reference number on the document. 
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Body 
These options control how individual line items are shown in the body of the document. 

Figure 8.55: Body Document Preference Window 

 
Show Description 

Normally, this option is turned on in all preferences. It controls whether or not job descriptions and 
notes are printed. 

Show Stock 

Turning on this option displays a description of the stock and some production values such as the 
number of originals, the number up, the number of colors, and the folded size.  

When turned on, four additional settings become available which change the stock description. For 
the purpose of this example, a job is specified that has 6 sheets printed 4 up with two colors on the 
front and one color on the back. The stock description would be something like this: 20# Bond 
White, 6 originals, printed 12 up 2 colors front in black and red ink 1 color back in black ink 

Hide Original Count 

Turning this option on will remove originals from the description. The following example shows the 
text that is removed with a line through it.  

Hide Number Up 

Turning this option on will remove the up count from the description. The following example shows 
the text that is removed with a line through it. 

Hide Color Count 

Turning this option on will all references to colors from the description.  

If all three options are turned on, only the stock name is printed. 

Add Folded Size 

Turning on this option will add the folded size to the job data displayed. 
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Show Prices 

Prints the total for all line items that would otherwise show a price. If turned off, no prices are 
printed for any line items. Only totals for the entire document are shown. 

Note:  You can use this option and the No Totals option in the Footer page to set up a preference 
for printing packing lists that contain only descriptive information without any prices. 

Hide Multi Part Jobs 

Automatically hides all jobs that are part of a multi-part job, except for the control job, so they do 
not print. The prices of all hidden jobs are included in the control job price. 

Note:  The jobs can also be hidden individually using the Hide Item command in the Edit menu. 
Hide Multi Part Job Prices 

Hides the prices on multi part jobs and shows the entire total in the control job. Use this to show all 
the parts of a multi part job without breaking out the prices for each part. 

Show M Price In Unit Column 

If a unit price column is defined in document preferences, turning this option on will print the unit 
price multiplied by 1000 in the unit column. Otherwise it will print the unit price. 

Hide Charges 

Hides all job level charges. Invoice level charges (charges that are not part of a job) are handled 
differently – they can only be hidden if they are markups. The price for each hidden charge is 
added to the job price. 

Note:  Charges can also be hidden individually using ‘Hide Item” in the Edit menu. 
Hide Charge Prices 

This option hides the prices, but not the quantity and description of all job level charges. The price 
is added to the price shown for the job to which the charge belongs. If the charge would otherwise 
be hidden because it has been manually hidden or the Hide Charges button is turned on, the 
charge is hidden. 

Hide Job Markups 

Charges attached to a job that are markups (use the Markup pricing method) are hidden. The total 
of the hidden charges is added to the job price. 

Hide Invoice Markup 

Hides all invoice level charges that are markups. The markup amount is added proportionally to all 
prices that are printed. 

Hide Cust Discount 

Hides the customer discount by adding it proportionately to each line item that shows a price. 

Hide Tax in Line Items 

Add the tax to the price of each line item that has a price. Use this as part of a system-wide setup 
that adds the tax to all calculated prices. 

Note:  This feature is intended primarily for international use. 
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Adjust Qty for Overs 

The Overs & Unders feature in the Job menu allows you to enter an amount by which the delivered 
quantity differs from the amount originally ordered and adjusts the price accordingly. If this feature 
is turned on, the quantity shown on the printed document will match the quantity actually delivered 
to the customer. 

Note:  Irrespective of this setting, Overs and Unders is calculated on the unit price for the 
quantity ordered. This setting in no way alters the specifications of jobs. 

Hide Quantity 

Turn this option on to remove all quantities from the document. 

Hiding Discounts and Prices 

When hiding customer discounts you may wish to consider not showing detailed prices to avoid 
problems with accumulated rounding errors. The following table illustrates a document with 10 line 
items and a 10% customer markup (entered as -10% in customer discount) and the effect of hiding 
customer discounts. 

Table 8.1: Rounding and Hiding Discounts 

Actual Amount Amount With 10% 
Markup 

Amount Rounded To 
Nearest Cent 

Amount Shown In 
PrintSmith 

    

1.65 1.815 1.82 1.81 

1.65 1.815 1.82 1.82 

1.65 1.815 1.82 1.81 

1.65 1.815 1.82 1.82 

1.65 1.815 1.82 1.81 

1.65 1.815 1.82 1.82 

1.65 1.815 1.82 1.81 

1.65 1.815 1.82 1.82 

1.65 1.815 1.82 1.81 

1.65 1.815 1.82 1.82 

16.50 18.15 18.20 18.15 
    

 

Notice that in order to maintain the correct total, PrintSmith adjusts every other item to account for 
the rounding error. The alternating amounts are necessary because the invoice total must remain 
the same regardless of which prices are shown or hidden; otherwise, the invoice amount could 
change simply by changing the document preference used to print it. 

This example emphasizes the condition and in most cases, you will not notice such a problem. 
However, whenever you hide markups or taxes in line items, the potential for this type of problem 
exists. 
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Footer 
These options control the contents of the bottom of the form. 

Figure 8.56: Footer Document Preferences 

 
Show Notify Type 

Shows the type of notification or shipping requested (Call, Will Call Deliver, etc.) 

Show Date Notified 

Shows the date the customer was contacted. This date is updated via the Notify button of the 
Pending Documents window. 

Show Date Wanted 

Shows the date the customer wanted the order. 

Show Proof Date 

Shows the proof date. 

Show File Originals 

If the File Originals button is turned on in the Customer Info window and this option is turned on, 
File Originals is printed in the remarks block. 

Show COD/Charge 

Shows whether the account is allowed to charge the document to Accounts Receivable or paid for 
upon delivery. Either COD or Charge is printed in remarks block. 
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Show Sales Rep 

Prints the name of the sales rep assigned to the document. 

Show Title 

Prints the title of the document. This is the same title that is shown in the account history. 

Show Remarks 

If remarks are entered in the Account Info window, this option controls whether they are printed on 
the document. 

Subtotal Multi-Page 

Prints the subtotal of each page in a multiple page document at the bottom in the total block. 

No Totals 

This option is useful if you are doing multiple quotes for the same job by duplicating them on the 
document or if using the preference as a quote letter. It prevents any totals from being printed on 
the document. Generally, this should only be used for Estimates. 

Print Total Descriptions 

This option allows a more flexible approach to document totals than pre-printing them on the form. 
When it is turned on, PrintSmith supplies the text for Sub-Total, Tax, Total, and so on so that text 
can be removed from the pre-printed form. 

If you use this option we recommend that you design your form so the total section at the bottom is 
simply an empty box. There are built-in forms without rules between each line. This type of form 
image should be used if PrintSmith prints both the description and the total to make it easier to 
have different formats and fonts in the total block without worrying about alignment. 

Show Taken By 

Shows the name of the order taker, or the person logged onto PrintSmith when the order was 
written. 

Line Item Bar Codes 

Adds a bar code after each line item in the document. The bar code contains the quantity, price and 
product code. Product codes for jobs are based on the product selected in the Product pop up list. 
You enter the product code associated with each product in the “key” column of the Product table in 
the Table Editor. Product codes for charges are entered directly in the charge definition in the “Prod 
Code:” field. 

Add Deposit Total 

When enabled, this adds a deposit line in the Document totals box instead of displaying the 
information in the Deposit box. 

Print Tax Ledger 

Print tax table names/codes, tax rates, and/or tax references. 
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Fonts 
Each group of elements in the document has a controlling font specification. This panel is used to 
review and change those font specifications. 

Figure 8.57: Fonts Document Preferences Window 

 
 

This page allows you to set the fonts used for various parts of printed documents. When you click 
on one of the font selection buttons a type specification window opens: 

Figure 8.58: Change Font Window 

 
 

It shows the current font setting with an example of the text. To change the type specification you 
change the Font, Size and Style settings and click OK when the results are satisfactory. You still 
need to click the OK button in the Invoice Preference window to make the changes permanent. 
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Text 
There are two text blocks that can be defined. 

Figure 8.59: Text Document Preferences Window 

 
 

Store Name to Print on Invoice 

Defines the text that is printed on the top of the document when the Print Store Address option is 
turned on. If this text block is empty, the text is taken from the Company preference panel. Text 
entered here is center justified. Text drawn from Company preference panel is left justified within 
the address block. 

Note:  This text is not part of the form definition. It is shared by all form definitions so any change 
you make to this text will be reflected on all forms where the option to print that text is 
turned on. 

Standard Text to Put in Remarks Block 

This text is printed in the bottom of the remarks block of the document when the “Print standard text 
in remarks” option is turned on. 
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Phrases 
The Phrases panel is used to set up the text phrases for the Quote Letter Generator. The print 
sample of the Quote Letter prints placement boxes for layout and positioning. 

Figure 8.60: Phrases Document Preferences Window 

 
 

There are four phrases used in quote letters that are selected for editing via a drop tab. The header 
phrase is first, the footer phrase is second and the body phrases are repeated for each job on the 
document. The drop tab has a Get Starters button, which will fill in an empty phrase with the 
standard phrase, built into PrintSmith. In addition, there is a Fields menu, which you use to insert 
place holders that are filled in by the quote letter generator with data from the document. It is these 
place holders that make the quote letter generator such a powerful tool. 

 

Make Quote Letter 
In order to use the phrases to create a good looking quote letter it is important that the entire 
preference has the proper settings. Generally, we recommend that you use the Make Quote Letter 
button in the Page panel to create a new document preference that is correctly configured to 
generate a quote letter. This is the preferred method when creating a Quote Letter. You can also 
choose an existing Quote Letter you are happy with and perform a Save As or export it and import 
the format you desire. 
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How Quote Letters Work 
The Quote Letter generator uses the four phrases to construct a quote letter. It is important to 
understand that the generator serves a strictly limited purpose, creating quote letters containing 
data from the Estimator. It is not a word processor. The four phrases almost always contain place 
holders that are replaced by data from the document (invoice in this context) and jobs. 

The header and footer are designed to use invoice information – addresses, sales rep names and 
so on. The body phrases actually repeat once for each job. Charges can be included in quote 
letters using the Body - Charges panel. 

When a document is printed, the normal header and footer are still printed if the options in the 
document preference contain instructions to do so. Most letters are set up so only the address is 
printed in the header and nothing is printed in the footer. The header phrase starts printing where 
the first line item is normally printed. It continues by printing body phrases for each job until the “last 
line item” position is reached whereupon it starts a new page. After all the jobs have been printed, it 
concludes with the footer phrase. Finally, it prints any of the footer data that is still turned on – 
usually nothing. 

The formatting options available to you are limited. The header and footer phrases have their own 
font specifications – otherwise the text wraps between two margins. The body phrases has two 
styles: one which word wraps between two margins and one that performs special alignment and 
word wrapping based on a few “tab stops”. The presence of a tab marker anywhere in the body 
phrase tells PrintSmith which style to use.  

The four phrases are typically constructed using text with embedded place holders for the variable 
data. The “Fields” pop up menu is used to insert these place holders that are replaced with invoice 
and job data when the document is printed. 

Header Phrase 

The standard header phrase is a fairly formal introduction that does not include a salutation, but 
one can very easily be added by inserting Dear «inv.attention», in the first line of the phrase. Only 
“Dear” and “,” need to be typed, the “Fields” menu can be used to insert the place holder. 

The first line in the example above shows a place holder that is replaced with the document 
number when printed. Also note that there is a blank line at the end of the phrase to separate the 
header from the body text. 

Note:  The Header phrase will only print fields that have the prefix of “inv.”. 

Footer Phrase 

This is the end of the letter. The most interesting aspect of the standard footer text is the place 
holder for the signature. This particular field has a default specification (see the table that follows 
for a complete description) that is set up, in this case, to sign off with “John Doe” if the “taken by” 
field in the invoice is empty. It could also be the name of the company or a title such as “Account 
Executive”. 

Note:  The Footer phrase will only print fields that have the prefix of “inv.”. 
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Body Jobs and Charges 

This is the body of the letter. This is usually the most complex phrase. The “Body- Jobs” and “Body-
Charges” panels allow charges to be added to Quote Letters. 

The standard body phrase contains far more than most people would ever want to put into a quote 
letter. Much of this is provided as an example of what is possible more than what is recommended. 
It uses the “tab” version of the body text. Tabs are represented by “\t” and there are two tab stops 
supported. The first tab is separated into two tabs. The second tab is a right tab that is almost 
always used for prices and which matches the right margin of the letter. I 

The Body-Charges panel is where you format charge information to be displayed. There are three 
fields you can use in quote letters: charge quantity, charge description and charge price. 

 

Using Place Holders 
Proper use and understanding of place holders is crucial to getting good results from the Quote 
Letter Generator. A place holder is composed of a keyword surrounded by international quotes 
“«»”. On Macintosh, these characters are generated from the keyboard by <option> and 
<option>+<shift> respectively. 

When the Quote Letter generator finds a place holder, it looks up the keyword in a defined list and 
substitutes the appropriate data from the document for the place holder. If a keyword does not 
match the list of defined keywords, nothing happens and the keyword is left in place in the quote 
letter without substitution. 

You can type in the keywords from the keyboard, but this is very tedious. More commonly, you 
select the keyword from the “Fields” pop up menu. Whenever a selection is made from the menu, 
the text in the menu is inserted in the phrase at the current location of the cursor. 

The following table contains all of the defined keywords. It is important to note that there are two 
different kinds of place holders. The first group begins with “inv” and refers to invoice data. This is 
data that is part of the document itself as opposed to jobs and charges that have their own data 
and are part of a document. The second group begins with “job” and refers to data in a job. 
Although there is no real restriction as to where and how you use “inv” place holders, the “inv” fields 
work best as part of the header and footer phrases. They can also be placed in the body phrase, 
but understand that the same data is repeated for each job. The “job” fields are designed for the 
body phrase. They should not be used in either the header or footer. 
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Table 8.2: Phrase Fields 
Field Name Description 

  

inv.discountFactor Customer discount rate 

inv.customerName Customer name 

inv.customerPhone Customer phone number 

inv.customerFax Customer fax number 

inv.attention Attention or contact name 

inv.contactFirstName Contact first name. 

inv.contactLastName Contact last name. 

inv.contactPrefix Contact prefix. 

inv.contactSuffix Contact suffix. 

inv.contactJobTitle Contact job title. 

inv.contactSalutation Contact salutation. 

inv.ordernum Document number. 

inv.takenby[default] Taken by. This field has a default value that is set by replacing the word default 
with text of your choice. If the taken by field is empty, this “default” text is used 
instead. 

inv.salesRep[default] Sales Representative. This field has a default value that is set by replacing the 
word “default” with text of your choice. If the field in the document is empty, the 
“default” text is used instead. 

inv.total Total amount of the invoice before any deposits or payments are accounted 
for. 

inv.alttotal Total amount expressed in the alternate currency. 

inv.shipping Shipping. This is the value that is manually entered in the Document Totals 
window. 

inv.taxRate This is the tax rate used in this document. 

inv.title Document title. 

inv.PO Purchase order number. 

inv.custAcctNumber Account number of customer assigned to the document. 

inv.orderDate Date the document was created. 

inv.wantedDate Date customer wants order. 

inv.proofDate Proof date. 

inv.completedDate Date the document was completed. 

inv.notifiedDate Date the customer was last notified. 

inv.pickupDate Date the document was posted. 

inv.reorderDate Date that the product in this order is due for re-order. 

 The following fields refer to job data and are most appropriate for the Body 
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Field Name Description 
  

phrase. 

job.itemnumber Job Number 

job.ordered Quantity ordered 

job.description Job Description 

job.ticketnotes Job Ticket Notes 

job.price Job Price 

job.altprice Job Price in alternate currency 

job.originals Number of originals 

job.parentsize Parent Size 

job.runsize Run size 

job.finishsize Finish size 

job.stockname Name of the stock used in the job. 

job.stockcolor Color of the stock 

job.frontcolors Number of colors on the front 

job.frontink Ink used on the front 

job.backcolors Number of colors on the back 

job.backink Ink used on the back 

job.stockcost Cost of the stock in sales units. This is the stock units field from the stock 
definition. 

job.stockmarkup Stock markup 

job.sheets Number of originals 

job.unitprice[multiplier] Unit price. An important feature is the “multiplier” that is enclosed in brackets. 
You must either remove “[multiplier]” entirely or replace “multiplier” with a 
number that multiplies the unit price. For example, “[1000]” will generate a price 
per thousand or “M” price. 

job.multiqty[1/2/3] Up to three additional quantities can be specified using the “Multi-Quantity” 
command in the job menu. You choose which of the three possibilities to use 
by changing [1/2/3] to [1], or [2] or [3]. Entering one and only one bracketed 
amount is mandatory. Often, this field will be repeated 3 times to show all of 
the quantities. 

job.multiqtyprice[1/2/3]  Up to three additional prices can be generated using the “Multi-Quantity” 
command in the job menu. You choose which of the three possibilities to use 
by changing [1/2/3] to [1], or [2] or [3]. Entering one and only one bracketed 
amount is mandatory. Often, this field will be repeated 3 times to show all of 
the prices. 

«charge.quantity» 
«charge.description» 
charge.price» 

Charges can be displayed as part of the quote letter. Any of the three items 
can be enabled for display: quantity, description or price. 
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Changing a Document Preference to a Quote Letter 
If you need to convert an existing Document Preference to generate a quote letter, you must go 
through all of the panels and change the settings as follows: 

• Page Panel - Shut off all options. Turn on “Print phases” and optionally, “Not for use as 
Invoice”. The settings in this panel are fully functional, but generally do not look good on a 
letter. There may be special circumstances or a particular format that they make sense so feel 
free to use them as needed. 

• Header Panel - Shut off all options except for the address selection and date options. 

• Body Panel - Settings regarding hiding jobs and charges apply. 

• Footer Panel - Shut off all options except “No totals”. Turn on “No totals”. 

• Fonts - Use Header Font, Body Font, and Footer Font for their respective phrases. 

• Phrases Panel - Click “Get Starters” in the phrase selection drop tab. This installs the 
standard text, which you can then modify as needed. 

• Adjust Document - Click “No Number”. Document numbers can be included in the quote letter 
body so the standard document number is needed. You can just as easily leave the standard 
positioning of document numbers as part of the preference. 

• Customize Form - In the “Item Layout” panel of the Customize Document Form, “First Line 
Item” is the position on the page the phrases begin to print. “Last Line Item” is the end of the 
phrases. If the quote letter generator has more text than will fit in this area it starts another 
page. When “Print Phrases” is turned on in the “Page” panel, the “Line Item Tabs” panel is 
markedly different.  

 

Adjust Document 
This button opens a window that allows you to move the entire printout on the page. It is also used 
to set any one of the six possible locations for the invoice number. 

You save the settings with the OK button; discard changes with the Cancel button, and test the 
results with the Print Sample button. This button prints a sample form showing the placement of 
each element in the document. This makes it easy to set up your own form on a light table, for 
example. 

 

Customize Form 
When we talk about moving the form and elements of the form, we are talking about changing a 
form definition built into each document preference which controls where the data in the document 
(such as the customer address) is placed on the page. Click this button to open the Customize 
Document Form window. 

The window is separated into logical panels that are used to customize different aspects of the 
printed document. Clicking the OK button stores the changes in the document preference. 
However, the change will not be permanent until the document preference itself is saved. 

The Cancel button closes the window and discards all changes. 
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Measuring Element Placement 
Measurements of all elements can be specified in pixels, inches, millimeters or centimeters. 

Note that the internal representation is in pixels so changing to a different measurement system 
results in the closest approximation of pixels in the selected measuring system. For example, if you 
use inches and enter a position for something of 5.4 inches. The closest approximation in pixels is 
388 so the internal value will be 388 pixels. When this is converted to inches for display, the value 
is 5.39 inches – very close, but not exact. 

Measurements are based on the printable area, not the size of the page. If the selected printer has 
a 0.25 inch gap between the printed area and the edge of the sheet, you would place an item at 
0.75 in the form definition in order to achieve a 1” measurement from the edge of the sheet. It is 
best to experiment with the target printer using the Print Sample button to get a feel for the results 
of your changes. 

 

Form Layout 
Figure 8.61: Form Layout Customize Document Form Window 

 
 

Invoice Number 

This rectangle describes all of the possible locations of the document number. In the Adjust Invoice 
Form window, you decide where within this rectangle the document number is placed by selecting 
buttons for top, left, middle, bottom and right. 

First Address 

When an address is selected in Invoice Preferences, it is placed entirely within this rectangle. If the 
address is too large to fit, it is clipped. 
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Second Address 

If Invoice Preferences are set so that both the invoice and statement address are selected, the 
statement address (taken from the customer account) is placed within this rectangle. 

Store Name 

Normally, the store name is positioned in the top center of the form automatically with the text itself 
center justified. If you choose to, you can specify a specific location for the store name. In this case, 
the text is left justified within the rectangle you specify. 

Remarks 

The remarks rectangle defines the area where PrintSmith places special instructions, COD/Charge 
and Sales Rep. 

Deposit 

The deposit block (usually the bottom of the form to the right of the remarks rectangle) defines 
where PrintSmith puts the deposit information as well as the notify date, wanted date, file original 
notice and document title. 

Image Base 

Defines the rectangle for the form image. 

Logo Base 

Defines the rectangle within which an internal picture of a logo is printed.  

Image Offset 

This is used to position the form image on the page. Generally, the form image and form definition 
will be aligned unless you make adjustments in “Adjust Invoice Form”. 

Document Type 

A set of positioning values that permits the document type text to be positioned independent of the 
document number. The new values are ignored if both are zero that ties the position to the 
document number. 

Measurements In 

Set how you would like the measurement to appear. All internal measurements are stored in pixels. 
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Element Position 
Figure 8.62: Element Position Customize Document Form Window 

 
 

PO Number 

The PO Number is normally in the header below the document date. 

Document Date 

The document date is normally in the upper right of the document header below the standard 
number position. 

Customer Number 

The customer account number is positioned in the upper left corner of the form if you have not 
specified a location and the option to show it is turned on. 

Sales Rep 

Normally, the sales rep is placed in the remarks block. However, you can move this to a set 
location by specifying a position here. 

Attention 

Normally, the Attention or contact name is placed in the address block either at the top or bottom of 
the address. You can move this to a set location by specifying a position here. 

Phone 

Normally, the phone number is placed in the bottom of the address block. You can move this to a 
set location by specifying a position here. 

FAX 

Normally, the FAX number is placed in the bottom of the address block with the phone number. 
You can move this to a set location by specifying a position here. 
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Attention2 

Normally, this Attention or contact name of the statement address is placed in the second address 
block either at the top or bottom of the address. You can move this to a set location by specifying a 
position here. This is only used when two address are placed on a document. 

Phone2 

Normally, the phone number of the statement address is placed in the bottom of the second 
address block. You can move this to a set location by specifying a position here. This is only used 
when two address are placed on a document. 

FAX2 

Normally, the FAX number of the statement address is placed in the bottom of the second address 
block with the phone number. You can move this to a set location by specifying a position here. 
This is only used when two address are placed on a document. 

Note: If you specify a position for Phone, Phone2, FAX, or FAX2 the tag for the field is removed. 
 

Item Layout 
Figure 8.63: Item Layout Customize Document Form Window 

 
First Line Item 

First Line Item is the vertical position of the first job or charge in the document. The Quote Letter 
generator starts printing the Header phrase in this position. 

Last Line Item 

The Last Line Item is the bottom of the print area for jobs and charges. If there are more line items 
than can fit in this area, additional pages are printed. 
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Line Spacing 

Line Spacing defines the vertical spacing between each line item. Leave this set to zero to use the 
standard line spacing for the selected font. 

First Total 

First Total is the base line of the first total in the document, usually this is the Sub-Total. 

Total Right Margin 

This field is the right margin to use for displaying document totals. Normally, this should be the 
same number as used in Right Amount in the Item Tabs panel. 

Total Line Spacing 

This field is the vertical spacing between each document total. 

Tax Lines 

Tax Lines is only used in areas where more than one tax needs to be shown on invoices (Canada 
for example generally requires two tax lines). Additional tax lines are inserted in the document total 
block right after the standard tax line. In most cases, your form will need to be modified somewhat 
to accommodate the extra lines. Alternatively, you can leave the total block empty and let 
PrintSmith fill in both the description and amount of all document totals. 

 

Line Item Tabs 
There are two views, one for standard documents (shown below) and a differing one for Quote 
letter formats. 

Figure 8.64: Line Items Tabs Customize Document Form Window 

 
Quantity 

Quantity is the left margin for job quantities. 
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Description 

Description is the left margin of the job description. 

Inset Quantity 

Inset Quantity is the left margin for charge quantities that are attached to jobs. 

Inset Description 

Inset Description is the left margin for the description of charges attached to jobs. 

Description End 

Description End is the right margin of the description text. If a job or charge description is too long 
to fit within this area, it wraps around to the next line. 

Unit Price 

Unit Price is a way of defining an additional column for a unit price. The amount is calculated by 
dividing the quantity printed on the same line by the total price for the same line. A value other than 
zero in Unit Price position causes PrintSmith to calculate the unit price. 

The recommended way to set this up is as follows: 

Get the width of the price column by subtracting “Right Amount” minus “Left Amount”. 

Set unit price to “Description End” minus 5. The unit price is right justified to this position. 

Subtract the width of the price column from Description End. 

For example, in the standard invoice form shown here, changing Description End to 400 and 
entering 465 in Unit Price will provide good results. 

Left Amount (x) 

Left Amount describes the left margin of the price column of the document form. 

Right Amount 

This field is the right margin of prices. Prices are right justified. 

Alternate Currency Right 

If Alternate currency is enabled and you want to show the alternate currency in a separate column, 
you define this column here. If the form definition already defines the entire width of the form you 
will need to adjust the other factors to make room. To add this column to the right edge of the form 
using the width of the Amount, follow these steps. 

Get the width of the price column by subtracting “Right Amount” minus “Left Amount”. 

Set “Alternate Currency Right” to “Right Amount”. 

Subtract the width of the price column from Right Amount, Left Amount, Unit Price, and Description 
End. 
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Quote Letter Tabs 
When customizing a quote letter (the “Print Phrases” option is on), the line item adjustments are 
much different. 

Figure 8.65: Item Tabs Customize Quote Letter Form 

 
It is very important to understand exactly how the items tabs are used when designing how the 
quote letter will work. There are two basic formatting methods for item tabs on quote letters: with 
and without tabs. The following table explains how this works. 

Left Margin: The left margin is the position on the line that text starts to print for the header and 
footer phrases. The body phrase also uses the left margin if there are no tabs “\t” in the phrase. 

Right Tab: The right tab is used only by the body phrase and then only when there are tabs “\t” 
embedded in the text. All the text before the first tab is right justified (less a small margin for 
appearance) to this position. All text up to the next tab in the text is printed just after this tab - this is 
column 2. 

Column End: Column end is used only by the body phrase and then only when there are tabs “\t” 
embedded in the text. This is the position where the text in column 2 starts wrapping to the next line 
if it is too long to fit on one line. 

Right Margin: The right margin is the end of text for all phrases. For body phrases that contain 
tabs, all text after the second tab “\t” is right justified to this position. Usually this will be a price. 

If there are no tabs in the body phrase, the entire phrase is printed between the left and right 
margin with words wrapped to the next line as needed. 

If there are tabs in the body phrase, all text before the first tab is right justified to the Right Tab. All 
text after the first tab and before the second tab is drawn between the Right Tab and Column end 
with words wrapped to the next line as needed. All text after the second tab is right justified to the 
Right Margin. 
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Images 
This panel is used to specify the image of the form and for a logo to be printed with documents. 
Using this panel and the Image Picker you can choose from a wide variety of built in form 
definitions or add your own. 

Figure 8.66: Images Customize Document Form 

 
 

If you know the image ID that you want, you can enter it directly in the ID field. Most of the time it is 
much easier to use the Image Picker to select built in form images. 

Image ID - This image is used as a form image and combined with the data from the estimate or 
invoice to complete the form. 

Logo ID - This image adds your company logo to the form. The Image Picker also lets you import 
your own logo. 

Note:  The only time you should let PrintSmith print your logo is when printing directly to a FAX 
machine or PDF. For most other activity, we recommend that you use letterhead or a pre-
printed form that includes a printed logo.  
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Image Picker 
The Image Picker is used wherever PrintSmith supports user selection or importing of form images. 

Figure 8.67: Image Viewer Window 

 

Selecting Images 

Each image is shown compressed to fit in the viewer. A description line below the image contains a 
complete description of the image. 

The description consists of the name of the image, the image ID, the file it is located in (PrintSmith 
application or Customizers), and its position in the list, and the number of images in the list. 

You use the navigation buttons to look through the list and the Select button to select an image. To 
leave the picker without making a selection, close the window. 

Importing Images 

To import an image you must first copy it into the Clipboard from a different application or from the 
Scrapbook. The image must be capable of being represented as a PICT (in Mac) or a TIFF, JPEG, 
or BMP (in Windows) otherwise nothing gets pasted in. Most DTP programs will create a PICT 
version of a graphic that is copied to the clipboard using the “Copy” command in the Edit menu. 

Once it is on the clipboard: 

1. Enter the PrintSmith application. 

2. Click the Image Picker button. 

3. Select Paste from the Edit menu. The image will appear in the Image Picker window 
with a description of “User Image” and a file name of “PS Customizer - User”. 

4. Click the Select button to add the image to the form. 

The first time you import an image, PrintSmith will create a file named “PS Customizer-User” in the 
PrintSmith Folder if you do not already have one. This file is used to store custom images (among 
other things). You should include this file in your backups and move it to your prices folder so any 
Workstations that need the form images in the file get them during an update pricing folder. 
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Import and Export Document Preferences 
To import or export document preferences click on either button and navigate to the document 
preference you want to import or to the place you want to save the export. Exported preferences 
are given the name of the document preference and stored in the PrintSmith folder. This is 
convenient if you create a preference on a Workstation and either want to preserve it for updating 
prices or install it system wide. 

You can move a document preference to the Master by exporting it at the Workstation and using 
the Send File command at the Workstation to send it to the Master. Then, on the Master, you can 
use the import command to load it into the Master’s document preferences. 

Group 
These settings allow you to “link” other document preferences to this one. Linked preferences are 
used to create multiple versions of the same document using a different, or even the same, format. 

Figure 8.68: Group Customize Document Form 

 
 

Some possible uses for this feature are: 

• Print the same form a set number of times. On a laser printer, for example, you could link the 
same form to itself to print 2 copies each time. This is a lot slower than simply typing the 
number of copies you want in the print dialog, but it is less prone to error. 

• Print a suite of documents: Invoice, Packing List, Shipping document, Thank you letter, etc. 

• Print an Estimate and Quote Letter. 

It is very simple to use, click the Choose button and select one of the document preferences from 
the list that opens up. To remove a selection, click the “Choose” button next to the preference you 
want to remove, when the list opens, click the “Cancel” button. 

Normally, all the documents are printed with only one printing dialog. Selecting Open Print Dialog 
before each format will give you a print dialog before each of the linked preferences. This allows 
you to change the form in the printer or even to redirect it to a different printer. These settings are 
stored with the individual document preference. 
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Table Editor 
Tables add the ability to customize important parts of the PrintSmith user interface and expand 
other capabilities in a simple, easy to understand manner. Some of the most common uses for 
tables are quick fill fields, pop up lists, and pop up menus. The Table Editor is a tool designed to 
manage the contents of these tables and control how they are used. 

Select Table Editor from the Admin menu. Select the Job Title table. 

Figure 8.69: Table Editor Window 

 
 

The title of the window includes the name of the table currently being edited. The Tables field is a 
pop up menu containing a list of all the defined tables from which to select. In this list, disabled 
tables are in italics and the active size table is underlined. Next to the menu is a Properties icon 
used to change how a table is applied. 

The bottom area of the window contains the table data. The actual data displayed varies somewhat 
with the type of the table (a predefined property discussed below) but shares some features: 

• Each table can contain at least 100 lines; some tables as many as 25,000 lines (also referred 
to as table elements). 

• All tables have an ID column. Each table element has a unique, non-editable, sequentially 
assigned ID, which permanently identifies the item. This ID is important because it is often 
stored in other parts of the PrintSmith database instead of the text in the name. Not only is this 
more efficient, it also allows changing the item to instantly affect everywhere it is used. 

• Tables can be sorted by clicking on one of the column headers. You can also drag items with 
the mouse to position items exactly as you wish. This feature is very useful for QuickFill fields 
because elements at the beginning are preferred over items at the bottom of a table. 

 

Clicking on an editable element opens an edit field. You can also navigate around on the keyboard 
using <tab>, <return>, or an up or down arrow key. New items can only be added immediately after 
the last defined element in the table. To delete items, click on their ID number in the ID column and 
press the <delete> key or backspace (Windows). 
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Defining Table Properties 
The properties associated with a table are: the table ID (a unique identifier for the entire table), the 
table type, table title, whether the table can be used, and how the table is used. 

Figure 8.70: Table Properties Window 

 
 

ID 

This number is a unique ID for the entire table. For the most part you need not be concerned with 
table ID’s. However, since you can change the name of any table, the ID serves as a constant 
reference. 

Disable Table 

You can disable a table that is used for QuickFill fields or pop up lists if you do not want it to be 
used. This option changes all edit fields that use the table into standard edit fields. Table driven pop 
up menus cannot be disabled. 

Enable Size Translation 

This button is only used with Size tables that can be selected as the active size table. This option 
enables size translation for this table if and when it is the active size table. 

Title 

All tables have titles that can be up to 48 characters long. You can change the title of any table. 
Mostly this only affects how the table is listed in the table editor; however, there are a number of 
tables where this title is actually the title of a pop up menu or the prompt on an edit field. For 
example, the Sales Rep table title is also the prompt on all the fields that use this table - even if the 
table is disabled. 

Number of Entries 

This field indicates the number of defined entries in the table. Tables can hold a minimum of 100 
entries and some can hold up to 25,000. 
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Table Status 

The table status pop up menu contains 5 settings: 

Table 8.3: Table Status 
Setting Definition 

  

Editable Most tables are marked as editable – you can add or remove any item. 

Locked A Locked table does not allow additional entries to be added or its status to be 
altered. Existing items in the table can still be changed. An example of a locked 
table is the “Phone Tags Table”. There are only 4 numbers that can be tagged so 
the table has 4 entries and is locked. 

Add Edit Command This setting adds an edit menu to the bottom of all pop menus and pop up lists that 
use this table. Selecting the edit command opens the table editor in a special mode 
just for editing that table. 

Add From Input This setting is useful only for pop up lists and QuickFill fields. It tells the system to 
add a new item to the table if the user types an entry into the edit field that isn’t in 
the list. PrintSmith asks before adding the item to a pop up list. Normally, this is the 
best setting for a QuickFill table if you want it to “learn” from user input. 

Add Fm Input & Edit This setting combines both an Edit command and the ability to add items based on 
user input. 

  

 

Sort By 

The functions in this menu are identical to those available by clicking on the column headers in the 
Table Editor window. 
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Defining Table Type 
There are three basic types of tables: Keyed Tables, Size Tables, and Standard Tables. Keyed 
Tables have a Key column where additional data can be entered. Size Tables contain a size 
column (middle column) that expects sheet sizes for data entry. Standard Tables are composed of 
an ID and a Name only. The middle column is left blank. 

Table 8.4: Table Usage 
ID Name Usage 

   

14
  

Basic Sizes Size Table – not usable as an active size table. Shows the basic size 
for each of the paper types in the United States. 

15 Business Type Pop Up list used in marketing panels. 

30 City QuickFill Table for address editor. 

19 Common Interest QuickFill Table for address/contact/prospect editor. 

27 Contact Name Prefixes QuickFill Table for contact editor. 

28 Contact Name Suffixes QuickFill Table for contact editor. 

35 Country QuickFill Table for contact editor and also used to control addresses 
are formatted in each country. Do not add entries to the Country table 
in the Table Editor - use the Address Format preference window to do 
this. 

6 Generic Colors QuickFill Table for stock picker window. 

42 Hold State QuickFill Table for pending document window/account info screen. 

39 Ink Color QuickFill Table for ink colors in job window. 

32 Job Title QuickFill Table for contact editor. 

17 Lead Source Marketing tables used as pop up lists in Customer and Contact 
marketing panels. 

26 Mailer Type QuickFill Table for address/contact/prospect editor. 

16 Marketing Date Labels Marketing tables used as prompts for dates in Customer and Contact 
marketing panels. 

36 Phone Tags Prompts for phone number fields in contact editor. 

57 Production Copiers Pop up menu for the Machine Name field in the Copier Definitions 
window.  Copier names are also used in the Employee Production 
Filter to determine which jobs will be seen in the Tracker Console. 

41 Production Dates Dates of production by Production Location.  This list is used in the 
production data window. 
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ID Name Usage 
   

58 Production Exceptions Pop up menu for the Exception code field in the Stop Tracker Step 
window.   

54 Production Facilities The default Production Facility has been set as In House.  Supports 
the Tracker Module. 

50 Production Locations The name of a process that indicates what stage a job is at in the 
overall production process.  These can be customized based on your 
internal referencing system.   

56 Production Presses Pop up menu for the Machine Name field in the Press Definitions 
window.  Press names are also used in the Employee Production 
Filter to determine which jobs will be seen in the Tracker Console. 

52 Production Priority Set based on your internal language and referencing system for 
indicating which jobs should take precedence.  These can be 
assigned to a job in the Tracker Production window. 

53 Production Stations The computer terminal where PrintSmith is running.  Supports the 
Tracker Module. 

40 Products Product list used as pop up menu in jobs. 

37 Report Categories Pop up menu in Report Manager for categorizing reports. 

33 Sales Rep  Used everywhere a Sales Rep is entered - usually as a pop up list. 

34 Ship Via Pop Up list for selecting shipping method. Fields using this pop up list 
do not allow user entry of data - it must come from list. 

3 Sizes – Metric CM Size Table. Metric paper sizes in centimeters. 

2 Sizes – Metric MM Size Table. Metric paper sizes in millimeters. 

4 Sizes – Metric IN Size Table. Metric paper sizes in inches. 

1 Sizes – United States Size Table. US sizes plus metric sizes in inches. 

20 Sport Interest QuickFill Table for address/contact/prospect editor. 

29 State QuickFill Table for address editor. 

8 Stock Colors QuickFill Table for Job and Stock Definitions. 

7 Stock Finish QuickFill Table for Stock Picker and Stock Definitions. 

9 Stock Grade QuickFill Table for Stock Picker and Stock Definitions. 

10 Stock Group QuickFill Table for Stock Picker and Stock Definitions. 

14 Stock Type Size Table – not usable as an active size table. Shows the basic size 
for each of the paper types in the United States. 
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ID Name Usage 
   

25 Type of Work QuickFill Table for address/contact/prospect editor. 

19-26 User 1- User 8 Marketing tables used as a pop up list in Customer and Contact 
marketing windows. 

38 Vendor QuickFill Table for Stock Definitions. 

31 Zip QuickFill for address editor. 
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Understanding Table Sizes 
PrintSmith can include many sizes - the list can hold 32,000 definitions. This method was 
introduced primarily for metric based systems (A4, A3, SRA2, etc.) but also has many uses on an 
imperial based system. 

Figure 8.71: Sizes Window 

 
 

Enter in a size to translate and then enter a name or text to use. The size to translate must be the 
same as the base system (e.g. If it is Metric Based in millimeters, all sizes to translate should be 
MM. x MM.). When enabled the size can be entered either way. This feature is a helpful tool for 
certain sizes like Business Cards that may not be easily remembered. 

Products 

Product names can be assigned to any job. You can define 25,000 products to track. This 
information is available only with the Report Writer or DownLoader (optional products). If you would 
like to track the number of reruns for example you would simply mark those jobs and then use the 
DownLoader to extract that information for reporting as you desire. Refer to the Report Writer 
Guide for more information about this powerful utility. 
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Clear Estimates 
Clear Estimates provides a simple method for reviewing all pending Estimates allowing you to 
quickly remove old ones from the pending list. 

Figure 8.72: Clear Estimates Window 

 
You have the option of clearing or voiding all Estimates, those older than a certain date, estimates 
within a range or estimates for selected accounts, or a combination of these options. Cleared 
estimates will be placed in Estimate History; voided estimates however, will not. 

Selection filter settings are remembered when the window is closed except for the name of 
selected account. PrintSmith warns you prior to moving documents from the pending list to 
estimate history. 

Some Estimates 

This command enables the following options to filter your pending Estimates. 

Estimates Over xx Days Old 

When enabled compares today’s date on each estimate and ignores any document newer than the 
created date and the numeric value you enter. 

Estimate Numbers From X To Y 

Enter in a range of estimate numbers to be cleared. Estimates whose number is less than the first 
or greater than the second are ignored. You can enter a starting or an ending point and 0 in the 
other field to review all prior or later. 

For Selected Account 

Only estimates assigned to the selected account. If no account is assigned then only unassigned 
estimates are reviewed. 
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Clear Estimates 

Setting this option removes the estimate from the pending list and records it in Estimate History 
with a status of loss. 

Do Not Change Win/Loss Ratio 

Setting this option removes the estimate from the pending list and records it in Estimate History 
with a status of Neutral which has no effect on the win / loss ratio. 

Void Estimates 

Voided / Cancelled estimates are removed from the pending list and do not appear in history. The 
document number can recall them. A cancelled Estimate is voided. Generally, you should use this 
only for mistakes. It does not affect the Win/Loss ratio and is not recorded in Estimate History. If 
you want to remove a single Estimate without adding it to history, open it and use the Cancel 
Document command under the Invoice menu. 

Ask Before Each 

When enabled allows you to review each Estimate that matches the set criteria. For each 
document you are presented with the options to clear, void or skip the estimate.  

Estimate Win/Loss Status 
When using the Clear Estimates to remove estimates from the Pending List, a Loss is recorded and 
the estimate is removed from the Pending List and placed in the accounts estimate history. Void 
will cancel the document and not place it in history. If you elected not to affect win / loss ratio then 
the document will be placed in history with a neutral status. 

When you convert an Estimate to an Invoice, the original Estimate is placed in history and 
considered a Win. Copying an Estimate to an Invoice simply copies the document and does not put 
it into the Estimate History. 

If you convert a previously lost Estimate it will be updated to a Win in Estimate History. 

Note:  You can only convert it to a win one time. 
When you copy an Estimate to an Invoice, the original Estimate remains in the Pending List and is 
not considered a Win or a Loss. For this reason we suggest you use the Convert to Invoice 
command and not Copy to New Invoice when appropriate. 

A cancelled Estimate is voided. Generally, you should use this only for mistakes. It does not affect 
the Win/Loss ratio and is not recorded in Estimate History. 

When an Estimate is converted to an Invoice (a “Win”), the winning Invoice number is recorded in 
the historical Estimate. Opening a historical Estimate that was a “Win” shows, in the deposit block 
on the document window, the Invoice number that the estimate was converted to.  

You can also now convert historical estimates that are losses to an Invoice thereby converting the 
history entry to a Win. Once any entry has been made in Estimate History, it is permanent. It can 
be annotated and losses can be converted to Wins, but not deleted. You should individually Cancel 
any pending estimate that you don't want placed in History. 
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Paper Calculator 
The Paper Calculator has been designed as a powerful tool for planning and setting up jobs. 
Though not an imposition tool, it handles gripper edges, bleeds, gutters, folio edges, white space 
and back trimming. The calculator displays the number of sheets out and the number of cuts for 
any combination of parent, run, and finished sheet sizes. 

Figure 8.73: Paper Calculator Window 

 
 

Sizes 

If you are using the Paper calculator in a job then, parent and run sizes are generally pulled from 
the job. If no job is open then you can either type the size in or select it from the sizes listed. Those 
sizes come directly from the active size table. You can double click on a size and it will try to fill in 
the selected size field. 

Gripper Edge 

This is the amount of space needed on one edge of the run sheet for the press to pick up the 
paper. The size of the gripper edge normally comes from the Press Definition. If not specified there, 
this preference panel is used. 

Folio Edge 

This is the amount of space to reserve on an edge of the run sheet for a multi-part job maker. It is 
used when folding signatures to offset the imposed image so as to leave one edge of the folded 
signature overhanging the other. If both the gripper and folio use the same edge, the larger of the 
two is used (they are not added together) and the edge shows half in red and half in green. 

Gutter 

This is the space between multiple images on a sheet. The first value is the vertical gutter; the 
second is the horizontal gutter. 
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Bleed 

A bleed is a specification that requires an oversize run sheet so that the ink can fill more of the final 
sheet. It generally increases the number of cuts quite a bit since the bleed must be trimmed off of 
each finish sheet in addition to the cuts needed to separate each sheet.  

You can specify the required bleed differently for each edge. However, since most of the time, the 
same bleed is used for all sides, entering a value in the “top” field automatically fills in the other 
sheets with the same value. Bleeds are shown as blue borders around each sheet and are added 
to any gutter that is specified. 

White Space 

This allows you to define a part of the run sheet as unusable to give you control over your page 
layout. The calculator would determine the maximum images per sheet based solely on the run 
size. It was hard to enter exact specifics for running four up on letter size paper when the printed 
image was smaller than 4.25 inches x 5.5 inches. White Space eliminates that dilemma and allows 
you to plan for these types of jobs. 

Back Trim, Parent 

Enable this if you consistently trim the edges from all four sizes of the parent sheet. It effectively 
adds four cuts to the parent cut and centers the run sheets in the parent sheet. 

Trim 4 Sides 

Enabling this works much the same as a back trim, except that it is applied to the run sheet. Many 
times, especially on large format presses, the entire image is centered on the plate in order to 
obtain the best ink coverage and this requires trimming all 4 sides after printing. 

Work and Tumble 

Enabling this changes the cut out diagram for tumbling by showing two gripper edges. It then 
changes the title of the “Work & Turn” button in the job window to “Work & Tumble”. Except for a 
possible change in the number of sheets out due to the additional gripper edge, no other change to 
pricing is made as a result of enabling this setting. 

Use Color Bar 

Adds a color bar opposite the gripper edge. 

Grain Direction Options 

• Neither - Grain direction is ignored and a best fit strategy is utilized without considering the 
possibility of rotating any sheets. 

• Match Grain - Grain direction is matched by forcing the calculation to base the sheets out on 
the order in which length and width are specified. Sheets are never rotated to improve the 
number of sheets out. 

• Swing / Combination - This uses a best fit strategy where sheets may be rotated in differing 
alignments to maximize the number of sheets which may be cut out. 
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Cut Diagram 

Cut diagrams can be printed and contain more information such as the number of cuts which can 
be used as a cutting job ticket. 

Figure 8.74: Cut Diagram Window 
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Order Stock 
This command is designed to simplify the paper ordering task. PrintSmith takes care of figuring out 
how many parent sheets you will need and the cost of the order. 

Figure 8.75: Order Stock Window 

 
 

Order 

Adds the currently displayed stock entry to the stock order report. This button is disabled if “Run 
Quantity” is 0. 

Search 

Searches for the Invoice # and Job # entered in the window and sets up the stock order for that job. 
If you do not enter a job number, PrintSmith will look for the first job that has not had stock ordered. 
If the job you specified has already had stock ordered, it will ask you if you want to reorder. The 
stock is not actually place in the report until you click the Order button. 

Select Stock 

Opens the standard stock selection window so you can select a stock from the stock list. To special 
order a stock not shown in the stock list you enter the stock description yourself. 

Report 

Opens the stock order report window. The stock order report can be sorted by the date entered, 
stock name, or invoice number.  

Close 

Exits from Stock Order and closes the window. 
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Cancel 

Clears the current entry. 

Currently on hand 

If the stock is inventoried, the Stock On Hand value is displayed. 

Committed 

If the stock is inventoried, the amount of the stock already committed to orders is displayed. 

Auto Order 
This function makes it even easier to order stock. It goes through every Invoice in the pending list 
and orders stock for all the jobs that have not already had stock ordered for them.  

Figure 8.76: Auto Order Window 

 
 

Pending List Items 

Select this option to automatically order stock for all jobs in the Pending List for which stock has not 
yet been ordered. 

Search for low stock Inventory items 

Select this option to search for and order stock for inventoried stock that has dropped below the 
Minimum Order Level. 

Verify Each 

If the Verify Each option is turned on (the default), PrintSmith stops after each stock order entry is 
prepared. You then click the OK button to add it to the report, or the Cancel button to skip it. You 
can exit from this function by closing the window using the close box. If Verify Each is turned off, 
PrintSmith automatically orders stock for all stock that has not yet been ordered. 
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Batch Print Documents 
This command allows you to print a group of invoices without having to open them one by one. If 
you plan to implement batch printing as a daily function, it is best to do it before you run your Daily 
Closeout. If you try to print today’s pickups after doing a Daily Close-out, the list will always be 
empty as it uses the Register Tape to find new documents. 

Figure 8.77: Batch Print Documents Window 

 
 

Today’s  

Whenever you use the pickup function in POS, PrintSmith makes a record of the pickup in the 
Register Tape. If this button is selected, PrintSmith looks through the register tape for these 
invoices and when it finds one, prints it. 

Invoice Pickups 

Invoices picked up since the last daily closeout. 

New Documents 

Prints documents created since the last Daily Closeout. 

Other Days 

This button opens a window showing all Daily Closeouts. You select the day for which you want to 
print documents by clicking on the desired date. You select a range of days by selecting the first 
day, then hold down the <shift> key while clicking the last day. 

Use Form 

By defining suitable Quote Letters you can create marketing pieces for mailing to existing 
customers. For example, you could create a “Thank You” letter for all new invoices created today, 
select that document preference and batch print all the letters thanking them for the opportunity to 
print their “Annual Report” or whatever the document title was. 
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Skip If Already Printed 

PrintSmith keeps track of when each document was printed. If you turn this button on, it will 
automatically skip any document that was already printed. If the button is off, PrintSmith will still ask 
you before it reprints an invoice. 

Include Invoices 

If you select Skip If Already Printed and Include Invoices you would only get invoices that haven’t 
been printed. 

Include Estimates 

If you select Skip If Already Printed and Include Estimates you would only get estimates that 
haven’t been printed. 

OK 

Starts printing the documents based on the buttons selected above. 

Cancel 

Cancels the request and closes the window. 

 

Network Chat 
Network Chat allows you to send instant messages to other PrintSmith users in your network. The 
Chat window consists of a list of current PrintSmith users, an edit field for typing your messages 
and a log window where you see messages sent to you as well as the ones that you send. On 
Workstations, the user list refreshes every five minutes - the PrintSmith Master’s list is always 
current. Clicking the “people” icon refreshes the list. 

Figure 8.78: Network Messaging Service Window 
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When you receive a message from another user, the chat window automatically opens. The chat 
command functions even when PrintSmith is in the background. A message appears in a dialog 
box with the message text. You can then bring PrintSmith to the front and reply to the message. 

Connected Users 

The list of connected users is automatically updated on the PrintSmith Master. It shows the name 
of the user and computer who last logged on. 

Note:  When sending a sensitive or private message, make sure the intended recipient is actually 
at the Workstation that is receiving your message. Remember, a user could have logged 
off and the Workstation may be idle with the log in window open. 

Message Text 

This is an area where you can type up to 250 characters of message text to be transmitted to one 
or more connected users. 

Message Log 

When messages are sent or received, the originator of the message and the message text are 
displayed in the log. This is just a temporary log; it goes away when the window is closed. 

When you receive a message from another user, the Chat window is opened if necessary and 
automatically set up to reply to that user. 

Note:  Receiving a message overrides security and opens the Chat window even if the user does 
not have access to the menu command. 

Send to Selected 

This button is enabled if you clicked on one or more of the users in the user list. Clicking this button 
sends the text in the message text field to those users. 

Note:  After a message is sent, selected users are cleared. Likewise, if you receive a message 
while you are typing one in, the Chat window will set up to reply to the last message. 

Send to All 

Clicking this button sends the message text to all connected users. 

 

Send File 
Use this command to send files from a Workstation to the Master’s PrintSmith Folder. You can 
send any file. Suggested uses include sending reports, document preferences, Customizers and 
other PrintSmith related files.  
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Network Administration 
This chapter discusses configuration and management issues on a multi-user PrintSmith system. 
See the Installation Guide for additional instructions on installing and setting up a PrintSmith 
Network. Often a network is already installed. If you have a printer that can be used by more than 
one computer without moving wires around, you already have a network. A PrintSmith network 
requires that AppleTalk, Open Transport or TCP/IP is installed and properly configured in the 
computer on which you intend to use PrintSmith. It can be used with virtually any network cabling 
system. It is also completely compatible with other networking systems such as Novell, Windows 
NT, and AppleShare. You do not need any additional networking software like AppleShare or 
Windows NT Server. As a matter of fact, PrintSmith ignores this software if it is installed. PrintSmith 
uses the networking capabilities that are part of the standard operating system on all supported 
platforms rather than server software. We therefore rely on a properly configured network already 
existing prior to the installation of the PrintSmith software. This chapter attempts to describe those 
issues and together with the Installation Guide, provides some direction for a relatively simple 
installation. 

Note:  We are unable to provide the same level of instruction as the manufacturer of your 
computer system. For complex installations, you may need the services of a local expert 
to install the cabling and set up your network. 

There is virtually no day to day maintenance required to use the PrintSmith Master. The only 
recurring maintenance is when you change the pricing system or create new templates; the 
changes must be copied to each Workstation.  

 

How PrintSmith Multi-User Works 
The PrintSmith Multi-User system consists of two components: the PrintSmith Master and the 
PrintSmith Workstation. When you start the PrintSmith Master, it tells everyone on the network that 
the PrintSmith Master is available. When you start a PrintSmith Workstation, it looks for the 
PrintSmith Master and asks for permission to connect to the PrintSmith Master. The PrintSmith 
Master then checks to see if it can support an additional Workstation and if so, registers the 
Workstation and allows it to start. Always start the PrintSmith Master before starting any 
Workstations. A standard PrintSmith Master can support three Workstations. You can purchase as 
many extra Workstations as you need.  

The PrintSmith Master can operate as a stand-alone system by holding down the <shift> key while 
the system is starting and selecting “Disable Networking” when the Network Setup window opens. 
You can also shut down the network from the PrintSmith Master using the Close command in the 
File menu when the System Monitor is open. In order for a PrintSmith Workstation to function, it 
must be connected to the PrintSmith Master. If the PrintSmith Master goes down for any reason, all 
Workstations connected to it will also go down eventually. Do not shut off your computer while the 
PrintSmith Master is running; always use the Quit command to leave PrintSmith so the network can 
be reset.  

Generally speaking, the system can recover and re-configure it as needed to maintain the network 
connection. If part of the network does go down for some reason, give the system time to recognize 
the situation to adjust itself as necessary. If the network does not respond in a reasonable amount 
of time, PrintSmith allows you to cancel an outstanding network request by pressing <command>+ 
<.> (<ctrl>-C on Windows). You’ll know this has happened when the mouse pointer changes to 
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show the Macintosh command key icon “ ” with a blinking period. If you exercise this option from a 
Workstation, your only choice is to quit from PrintSmith and re-establish the connection. 

The PrintSmith Master will usually be able to clear out a “hung” Workstation connection as soon as 
the Workstation quits. You can view this activity by viewing the “Sessions” panel in the System 
Monitor. If a Workstation no longer connected shows an open connection, try restarting the 
Workstation computer. In a couple of minutes, the PrintSmith Master will notice the Workstation is 
gone and will close its end of the connection. If this does not clean things up, shut down the 
PrintSmith Master and restart the computer it resides on. You can continue to operate with a hung 
Workstation. This can prevent you from registering a Workstation if the maximum number of 
Workstations is already registered, but has no other effect on the operation of the PrintSmith 
Master. If the Master goes down, all Workstations may appear to “hang”. Generally, after about 
thirty seconds, the Workstation will realize there is no longer a PrintSmith Master and shut down 
but, this can take a few minutes.  

The PrintSmith Master is responsible for supplying all data in the PrintSmith database to 
Workstations, except pricing. Workstations need this data and have no way to access it unless the 
PrintSmith Master gives it to them. It is for this reason Workstations do not start until they locate the 
PrintSmith Master. The PrintSmith Master also controls the number of Workstations it will “talk” to 
at once. A PrintSmith Master can support up to 250 Workstations; your system can support the 
number of Workstations you have purchased. The PrintSmith Master reserves memory for each 
possible Workstation connection when it sets up the network. When a Workstation connects, 
additional memory on the PrintSmith Master may be required. As shipped, the PrintSmith Master 
has adequate memory for ten workstations. 

TCP/IP Or AppleTalk - Selecting the Correct Protocol 
A protocol is a set of defined conventions used by computers to communicate with each other. For 
all practical purposes, you can think of a protocol as a language in the same sense as English, 
French, or Spanish. If you were sitting in a room listening to multiple conversations, you would be 
able to ignore those languages, which you do not understand and follow those conversations 
whose language you understand.  

You can think of the underlying network cabling system such as EtherNet, or LocalTalk, or Token 
Ring as a room in which a variety of languages are spoken. Since these are computer languages, 
the names are typically acronyms such as ADSP, TCP/IP, IPX/SPX and many, many more. All of 
these languages can be spoken in the same room and conversations maintained without interfering 
unduly with each other although you may have to repeat yourself more often if there are lots of loud 
conversations around you. This is loosely how networks operate. 

PrintSmith understands and communicates in two protocols: ADSP (an Apple developed protocol) 
and TCP/IP (a public protocol that is used, among many other things, to communicate over the 
Internet). TCP/IP has become the dominant protocol on computer systems throughout the world 
primarily because of the Internet. 
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IP Addresses 
Each computer on a network must have a unique IP address. The address must be in the form 
specified for the protocol selected for communication. For TCP/IP, the address form is called 
“dotted decimal”. A “dotted decimal” address for TCP is four numbers separated by periods (e.g. 
“0.0.0.0”) where each number is between 0 and 255. 

If your network is a local network with no outside connections, it is sufficient to specify an address 
that is unique within the local network. For example, the address of one computer could be 
“1.2.3.4”; another could be “1.2.3.5” and so on. There are many ways in which TCP addresses are 
assigned; controlled and used that are beyond the scope of this document.  

The single requirement is that the PrintSmith Master must have a known and static address (one 
that does not change).  

A computer with access to the Internet can connect to another computer running PrintSmith with 
access to the Internet, anywhere in the world. Although slower than a local network, such a 
connection provides excellent performance and is extremely usable. 

DNS is a system whereby names, which mean something, can be substituted for “dotted decimal” 
addresses. For example, “www.printsmith.com” is the DNS address for PrintSmith’s web site. The 
actual address of our web site is actually a series of numbers that have and will change over time. 
It is much easier to remember a DNS style name than a “dotted decimal” style name. You can use 
either address to specify the PrintSmith Master in the Network Setup panel. 

Security in a Connected World 
Using TCP/IP as a networking model gives you unprecedented connectivity. However, it is 
important to understand that connections are a two sided sword. If it is easy for you to connect to 
your computer, it is easy for someone else, who may not be your friend, to also connect to your 
computer. 

In many network systems, including a surprising number of email packages, when you enter your 
password it is transmitted directly to the mail server over the network. It is pretty easy to monitor 
network traffic and read those passwords as they go across the network. PrintSmith has always 
understood the importance of security and always encrypts passwords before they are transmitted 
on the network. 

If your network is connected to the Internet all someone needs is the IP Address of the PrintSmith 
Master and your serial number and they can connect to your system. The only thing protecting your 
data is the user IDs and passwords! 

Should the person trying to break into your system be another PrintSmith owner, they probably 
know the default system administrator name and password and they probably know that the blank 
user id your system initially came with had full access. If you have not changed any of these, you 
are leaving yourself wide open to being “hacked”. 

Before turning on TCP/IP in PrintSmith where outside access is possible you must “audit” your 
security setup. Delete the blank user id, change the System password to something really difficult 
to guess using letters and numbers (then write it down and put it in a sealed envelope), and check 
all of the other user definitions to make sure they have passwords. You might try to break into your 
own system by guessing the passwords of the other users. Try using the same password as the ID 
name, the last, first, or middle name, spouse names, children names, or birth data. Instruct your 
staff on the importance of security. 
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Controlling the Network 
The Network Messaging Service window is used to control and supervise activity on the PrintSmith 
network. The File menu commands Close Network and Open Network are available when the 
System Monitor window is selected. When you select the Close Network or the Quit command, the 
PrintSmith Master immediately stops accepting connections and if any users are connected, a 
special version of the Network Chat window opens.  

Usually you will send a message to everyone with a warning to exit the application. This gives them 
an opportunity to exit gracefully without losing any data. Recipients of the shut down message can 
send a reply back. Perhaps asking to delay shutting down while they complete an important task.  

As long as users are connected, this window will remain open. If you close the window while users 
are connected, they are allowed to remain connected and no further action is taken although the 
PrintSmith Master will still refuse to accept new connection attempts. When the last user 
disconnects, the network is shut down and the window closes automatically. If it opened as a result 
of the Quit command, PrintSmith finishes shutting down and exits the application. When a user 
disconnects, they are removed from the list. At any time, you can force all users off the system by 
clicking the Disconnect All button. To turn the network back on, select the System Monitor 
command in the admin menu, then Open Network from the File menu. To abort closing the 
network, close the Network Messaging Service window and select Yes in the window below. 

Connected Users 

The list of connected users is automatically updated on the PrintSmith Master. It shows the name 
of the user who last logged on to each connected computer (they may have since logged off and 
the Workstation may be idle with the User Log In window open) as well as the computer name. 

Message Text 

An area where you can type up to 250 characters of message text to be transmitted to one or more 
connected users. 

Message Log 

When messages are sent or received, the originator of the message and the message text are 
displayed in the log. This is just a temporary log; it goes away when the window is closed. 

Send to Selected 

This button is enabled if you clicked on one or more of the users in the user list. Clicking this button 
sends the text in the message text field to those users. 

Send to All 

Clicking this button sends the message text to all connected users. 

Disconnect Selected 

Click on this button to force the selected user off the system. 

Disconnect All 

This button immediately forces all the users to disconnect from the PrintSmith Master. 
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Configuring the Network 
The type and location of the machines in your PrintSmith network is entirely up to you. There are a 
number of issues in setting up a multi-user network you may have never had to deal with before.  

In spite of the simplicity of setting up a PrintSmith network, a multi-user database is much more 
complicated than a network configured to share printers or use electronic mail because the overall 
speed and responsiveness of the system is determined by all of the machines on the network, the 
speed of the PrintSmith Master, and the transaction volume on the network. 

In all cases, you will get the best performance with a small network. If possible, it is always best to 
limit the network to just those machines, which will be using PrintSmith. On a very large network, 
you will see much better performance if you set up a separate zone just for the machines that will 
be using PrintSmith. 

When planning the network, it is a good idea to think about the problems you are trying to solve 
with the network. 

• Are you installing a network to handle a large number of transactions? If so, you may need to 
consider dedicating a machine to act as the PrintSmith Master and not use it for data entry at 
all. 

• Are you installing the machine to facilitate the work flow in your business and you need 
convenient locations for Workstations? In this case, speed is a secondary consideration and 
the location of the PrintSmith Master depends on how each computer is put to use. 

The most important element in a PrintSmith network is deciding the type, location and daily usage 
of the PrintSmith Master. Often, these factors must be balanced against the funds allocated to the 
system. The following guidelines describe different types of PrintSmith Master stations and should 
be of some help in deciding how to configure your network. 

Ideal PrintSmith Master System 
A fairly powerful Power PC based Macintosh with 128MB of RAM with a fast hard disk, running 
Mac OS 9.2.2 or later. This computer is used exclusively for PrintSmith and has no non-Apple 
System Extensions. It is used only for performing Daily Closeout. This is an ideal system because it 
is used only to support the network so you will get better performance in a busy environment. 
Another benefit is that this type of configuration is the least likely to crash. By isolating the user 
interaction to Workstations you reduce the possibility of the software hanging up the entire network. 
There are a number of times when the PrintSmith Master does not respond to the network. If the 
PrintSmith Master is not used for data entry, these events never occur. 

Back Room PrintSmith Master 
This is probably the most practical type of system. The PrintSmith Master is used as a 
management or bookkeeping system. It can be put in an office and used for posting payments, 
generating statements and so on, while the machines in the front of your shop are used for creating 
estimates, invoices and POS transactions.  

One of the nice features of this type of system is that it can be used to experiment with pricing 
system modifications. When you are satisfied with the changes, you update them from the 
Workstations. This gives you a lot of flexibility – if you “ruin” the pricing system on the PrintSmith 
Master, you can take the “live” prices folder installed in a Workstation and install it on the 
PrintSmith Master. Changes you make to the pricing system do not show up until you install them 
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in the Workstation so you are less likely to forget to change prices after a minor change to pricing. 
Another benefit is the improvement in physical security of the machine.  

Often, back office computers are intended for typesetting, running spreadsheets and so on. 
Therefore, if the PrintSmith Master is running in the background on one of these machines, it could 
run slower than average due to the foreground applications. In addition, these types of systems are 
often heavily loaded with fonts and system extensions. If this is the case in your business, you 
probably do not want to put the PrintSmith Master in a back office.  

This type of system may not be practical if you plan to install a single cash drawer for all the 
Workstations to use. Only the PrintSmith Master can support a central cash drawer. You can use a 
long cable to connect the cash drawer. However, it will have to be specially ordered and may not 
be practical due to the layout of your shop. 

Front Counter PrintSmith Master 
Our experience to date indicates that frequently, the PrintSmith Master is actually on the front 
counter and is one of the most heavily used machines. PrintSmith was designed in this 
environment. However, this setup does place the most strain on the resources of the computer and, 
in an extremely busy environment, will be somewhat slower than other configurations. 

What Not To Do 
Do not install the PrintSmith Master on a computer with less than the minimum RAM requirements. 
This does not leave enough memory for the PrintSmith Master to operate comfortably. It may not 
work, and is not recommended.  

Do not perform long, disk intensive operations on the Master and expect good performance. 
Examples of operations that will dramatically slow down network response are: Generating 
Statements, Account Aging, Clear Estimates (without “Ask before each”), Automatic Stock Order, 
and Work in Progress (Press Schedule). Although performance on the individual Workstation will 
be much slower than on the PrintSmith Master, the overall network performance will not degrade 
very much.  

Do not mount remote volumes unnecessarily. Keeping the hard disk or folder updated can generate 
significant network traffic. 

Is Your Network Already Busy? 
One indicator your network is too busy is if you sometimes have difficulty getting Workstations to 
“register”. The first thing a Workstation does is search for the PrintSmith Master on the network. 
This procedure is somewhat time critical. In other words, you are much more likely to have 
problems getting a Workstation to start talking to the PrintSmith Master than to keep talking to the 
PrintSmith Master. 

Sometimes a network is too busy for short periods of time, but is otherwise fine. Connecting to a 
remote PrintSmith Master over the Internet is a prime example of a situation where you may 
occasionally have difficulty in registering with a PrintSmith Master. Busy DTP department sending 
lots of files to a printer could also cause this type of problem. It is difficult to give concrete examples 
since this area of computing is constantly changing.  

You can test this further by running the PrintSmith Master in the background. If Workstations are 
able to register with the PrintSmith Master in the foreground, but not in the back-ground, your 
network may be very busy. However, this could also be because of the foreground application.  
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If you find that your network is really busy there are a few options to consider. You can divide the 
network into separate zones to segregate activities or you can install a higher powered network 
cabling system such as 100 Base-T or fiber optics. Each has its own advantages and drawbacks. 
Separate zones are usually cheaper to set up, but they are slightly more complex to use. Ethernet 
is usually more expensive and laborious to install, but requires almost no administration once it is 
set up, and will give you better performance. A qualified consultant or knowledgeable dealer can 
often help with suggestions and installation. 

Maintaining Your Workstations 
In order to reduce network traffic and improve performance, the Prices folder is not shared. This 
means each Workstation and the PrintSmith Master have their own Prices folder. It is important that 
the prices folders on each computer in the network are identical; you can only modify pricing from 
the PrintSmith Master. When you change prices, each Workstation must copy the prices folder from 
the PrintSmith Master using the “Update Pricing Folder” command in the Admin menu. 

Notes: Each Workstation must have its own Prices folder and it should always match the Prices 
folder in the PrintSmith Master. 

Templates 
Templates are a powerful and effective tool for simplifying complex order taking. Each template 
whether a complete document or a job template, resides in an individual file. Usually, these 
templates are stored in the “Templates…” folder in each PrintSmith folder. They are not shared; 
each Workstation and the PrintSmith Master have their own folder.  

Unlike the Pricing folder, which must be unique to each computer in a PrintSmith network, you can 
share the template folder using File Sharing. However, PrintSmith always looks in the local 
“Templates…” folder first so it may be a little cumbersome to use a different folder for templates.  

You can create an “Alias” (on Windows, this is called a “Shortcut”) of the template folder on the 
PrintSmith Master and copy this Alias to the Template folder on each Workstation. This procedure 
can also be used with the History and Archives folders. When the Templates folder on the 
Workstation is opened for selecting a template file, you will see this alias and, if you select it, the 
templates folder on the PrintSmith Master will open. Remember to turn on File Sharing on the 
PrintSmith Master. 
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 Using a Workstation 
A Workstation has a few restrictions in its operation, which are not present on a PrintSmith Master 
or stand-alone system. 

• Only the PrintSmith Master allows changes to the pricing system. In addition, the Admin menu 
is much shorter because all of the commands dealing with preferences and setting up the 
security system are eliminated with the exception of Document Preferences. 

Note:  Any document preference created or modified at a Workstation will be lost upon 
Pricing Update. To keeps those preferences see “Import and Export Document 
Preferences 

• Only the PrintSmith Master allows changes to the security system except for changing the 
password of the currently signed on user. Any changes you make to the security system also 
apply to Workstations. Changes to user definitions take effect the next time the log in 
command is used at a Workstation. Changes to menu security levels and keyboard shortcuts 
take effect when the Workstation first “connects” to a PrintSmith Master. 

• Daily and Monthly Closeouts can only be performed at the PrintSmith Master so these 
commands are not in the AR menu at a Workstation. In addition, the network must be 
temporarily shut down while running a Daily Closeout. PrintSmith takes care of this 
automatically. However, it will prompt you before it shuts down the network when users are 
connected. 

Note:  It is imperative that all Workstations have the same Prices folder. 

Network Responsiveness 
The PrintSmith Master services the network when it is not otherwise engaged. Most computers 
spend the majority of their time waiting for something to happen like a mouse click or a key being 
pressed. The PrintSmith Master uses this time to check the network and see if one of the 
Workstations needs service. If it finds a request from a Workstation, it fulfills the request.  

This means that when the PrintSmith Master is busy doing something else, it may not respond to 
requests from Workstations. In addition to being busy, there are a few other instances in which the 
PrintSmith Master does not respond to the network: 

• (Macintosh Only) While a menu is pulled down. 

• While printing. Printing long reports from the PrintSmith Master should be avoided as it can 
cause Workstations to time out (see below). 

•  (Macintosh Only) When selecting a template, old tape, or old deposit ticket while the selection 
window is open. This window is actually part of the Macintosh operating system, which, of 
course, does not know anything about a PrintSmith network. 

• When a PrintSmith message window is open (most of the time). These windows are always 
opened in the upper right corner of the screen and consist of text and from one to three 
buttons. They are used to warn users of unusual conditions, ask yes or no questions, and 
explain attempts to perform illegal operations. Network requests must be ignored because it is 
often necessary to resolve the question or condition before it is safe for PrintSmith to continue. 



Chapter 8:  System Administration 

 
 

 
Page 521 

Time Outs 
The PrintSmith Master may not immediately respond to requests from Workstations. When the 
PrintSmith Master has some free time, it will eventually respond. If, after a reasonable amount of 
time, the PrintSmith Master still has not responded to a Workstation request or notified the 
Workstation that it is busy, the Workstation software allows the user to decide if the PrintSmith 
Master is likely to respond. Pressing command-period will give you the option to abort the current 
network transaction and shut down the Workstation. Before shutting down under these conditions 
we strongly recommend checking the PrintSmith Master to see if there is a valid reason for the lack 
of response. When this option becomes available, the mouse pointer changes to show the 
Macintosh command key icon “ ”. 

WARNING: Shutting down by aborting a pending transaction can result in incomplete posting of 
transactions. Always notify the system administrator before aborting. 

Even when there is no “real” network activity, the PrintSmith Master and each Workstation 
periodically check with one another to see if communication is still possible. If the PrintSmith 
Master does not hear from a particular Workstation for several minutes, it assumes the Workstation 
has gone down and un-registers the Workstation. This is important because the Workstation may 
have records locked, and part of the cleaning up that is done when a Workstation is unregistered is 
releasing any record locks belonging to that Workstation. For example, if a Workstation had an 
invoice open and was accidentally shut off, the PrintSmith Master would not know this for several 
minutes. This means that no one can open that invoice until that Workstation “times out”. 
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Chapter 9 Optional Modules 
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PrintSmith Portable 
PrintSmith Portable is a version of PrintSmith specifically designed to function as a stand-alone 
estimator or as a Workstation that is part of a PrintSmith Network. You can take a portable 
computer out on the road with you, containing current customer information. While on the road you 
can generate quotes, orders, and capture new customer information. When you get back to the 
shop, simply plug the portable computer into the network. When the portable computer is 
connected to a PrintSmith network and starts up, it connects as a Workstation and opens a special 
window to update (synchronize) the PrintSmith database. It is this synchronization that makes 
PrintSmith’s portable version of PrintSmith so flexible and powerful. The Synchronize Portable tool 
is used to create new customer accounts and transfer your field quotes and invoices into the actual 
PrintSmith database. 
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Using PrintSmith Portable 
Using PrintSmith Portable is virtually identical to using a Workstation. However, because you are 
not connected to a PrintSmith Network there are some differences: 

• When you create Invoices and Estimates, they are stored in a folder named “Portable…” that 
PrintSmith creates in the PrintSmith folder. Each document is stored as a special type of 
template that retains customer information and document type. 

• Since you are not connected to the PrintSmith Master, documents are not numbered until they 
are transferred to the main database. 

• The Pending List is actually a list of all the documents in the Portable… folder. They can be 
edited and cancelled from within PrintSmith. You can also delete a document by throwing 
away the individual file outside of PrintSmith. 

• Security Setup and user definitions are specific to each PrintSmith Portable system when 
operating in stand-alone mode. When connected to a PrintSmith network, the PrintSmith 
Master determines security settings and user definitions. 

• When a PrintSmith Portable system is connected to a PrintSmith Network, a Synchronize 
Portable command is added to the Admin menu. This is the tool you use to transfer the work 
you did on the road into the PrintSmith Master and obtain fresh pricing information, and up-to-
date customer and prospect lists. The command is also available at the PrintSmith Master so 
you can set a security level for the command, except in unusual circumstances, it is not used 
to perform any useful work. 

• When you create documents using the “<<<WALK - IN>>>” account you are actually capturing 
new account information. One option during database synchronization is to automatically 
create new accounts from these documents. If you create multiple documents for the same 
new account, only one new account will be created during synchronization and all of the 
documents for that account will be added to the new account. 

• A PrintSmith Portable system must be periodically refreshed, by connecting to the PrintSmith 
Master and updating the Pricing… folder. This ensures that your PrintSmith Portable systems 
come back home since they carry important business information. We recommend that you 
refresh your Portable system weekly. 
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Setting Up a PrintSmith Portable 
A standard Workstation installation requires PrintSmith, “PS Setup”, and a “Pricing…” folder; a data 
folder is not required. A PrintSmith Portable installation needs a partial “Data…” folder that contains 
“Customers”, “Customer Index”, “Prospects”, and “Prospect Index”. You can operate PrintSmith 
Portable without a data folder. However, you are then unable to use or capture customer 
information. This information can be copied from the PrintSmith Master over the network using the 
“Synchronize Portable” command or installed using a floppy disk. When PrintSmith Portable is first 
installed, a “Data…” folder is created containing a “Customers” and “Customer Index” files with the 
“<<< WALK - IN >>>” account pre-defined. 

Note:  When using PrintSmith Portable on the road, the program will start much faster if you 
disable TCP/IP using the Chooser. This significantly lengthens the life of your portable 
computer’s batteries. 

Updating PrintSmith from the Portable 
When you connect your PrintSmith Portable to the PrintSmith Network the Synchronize Portable 
window automatically opens. This is a special command designed specifically to make sure that 
your PrintSmith Portable installation has everything it needs, safely and simply. Using this 
command completely protects you from inadvertently copying data in the wrong direction and 
damaging your PrintSmith database. This command is also added to the Admin menu so you can 
invoke it at your convenience. 

You can upload selected documents, update customers, or update pricing systems in any order. 
However, if you create new customer accounts based on the information in the portable document 
list, always update customers using the “Update Customers” button after completing the document 
transfer to ensure that you have a customer list containing all of the new accounts.  

If you wish to review a document before transferring it, hold down the <command> key and click on 
the document. You can look at one document at a time. Clicking on a different document with the 
<command> key held down will close any open document before opening the new selection. 

Hold down the <option>/<alt> key when clicking on a document to change all of the documents to 
match. In other words, if a document is not selected for transfer and you click on it while holding 
down the <option>/<alt> key, all of the documents in the list will be selected for transfer. 

There is quite a bit of flexibility in how documents are transferred, indicated by the buttons to the 
right of the Upload Selected Documents button. 
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Creating Accounts 
If a document is created using the “<<< WALK - IN >>>” account, it is considered to be a new 
account. PrintSmith will check the existing accounts for a match and automatically assign the 
document to an existing account. If there is no account matching the account on the document, a 
new account is created. This is a great way to capture new customer information. 

Deleting Documents after Processing 
You use these two buttons to decide how you want portable documents to be handled after they 
are transferred. PrintSmith will either delete them or move them to the “Archives…” folder on the 
PrintSmith Portable system (they are NOT moved to the archive folder on the PrintSmith Master). 
Use this option only if you think you will need to refer to these documents while on the road. 
Normally, you will want to delete documents as processed. 

Leaving skipped documents in Portable folder 
If you have decided not to upload a document now, but wish to retain it for possible future transfer, 
be sure to turn this button on. If you have Delete Documents after Processing selected and you 
turn Leave Skipped Documents In Portable Folder off, every document in the PrintSmith Portable 
folder is deleted whether or not it has been transferred. 

Note:  You must maintain the pricing folder on a PrintSmith Portable system the same way as 
you do with a normal Workstation. In addition, you will need to transfer a copy of the 
Customer file to the “Data…” folder of the PrintSmith Portable so it will have current 
information to use when generating quotes and orders. 

Printing a report 
After completing a document transfer, you should select the Print command in the File menu to 
generate a report detailing the actions taken during the synchronization run. The report information 
is not saved when the window is closed. 
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Updating PrintSmith Portable from PrintSmith (Mac and Windows) 
In addition to synchronizing the PrintSmith Master with data collected using PrintSmith Portable, 
you must also synchronize the PrintSmith Portable from the PrintSmith Master. To do this, copy the 
customer file, prospect list, and pricing folder from the PrintSmith Master to the PrintSmith Portable. 

From a PrintSmith Portable connected to a TCP/IP network the steps are as follows: 

1. Select Synchronize Portable from the PrintSmith menu. 

2. Click the Update Customers button. 

3. Click the Update Pricing button once the customers have been updated. 

4. Quit from PrintSmith once the pricing has been updated. 

Next time PrintSmith is started it will use the new data. 

If you do not have a network or do not understand how to transfer files across a network, you can 
use floppy disks and “Sneaker Net” (you walk over to the other computer carrying the data in a 
floppy disk – if you are wearing tennis shoes you have established a Sneaker Net). 

Updating PrintSmith Portable without Multi-User 
Since there is no PrintSmith Network without the Multi-User version of PrintSmith you will need to 
follow a different procedure to synchronize both systems. If you are using the system on a network 
you can “Share” the PrintSmith folder and copy the information across your network. You will need 
some familiarity with file sharing to do this.  From a PrintSmith Portable connected to a network the 
steps are as follows: 

1. On your desktop select the Network Neighborhood icon. 

2. Mount the PrintSmith folder or the Hard Disk on the computer that contains 
PrintSmith. 

3. Copy the “Portable” folder from the PrintSmith folder on the PrintSmith Portable to the 
main PrintSmith folder. 

4. Start PrintSmith on the main computer. The “Synchronize Portable” window will open 
if there are any documents in the “Portable” folder. Use this window to transfer 
document to the main system. 

5. Quit from PrintSmith. 

To update the customer list on the PrintSmith Portable, copy the “Customers” and “Customer 
Index” to the “Data” folder on the PrintSmith Portable. Be careful, it is easy to copy in the wrong 
direction. 

To update the pricing system on the PrintSmith Portable, copy the entire pricing folder from the 
main system to the PrintSmith folder on the PrintSmith Portable. Again, be careful, it is easy to 
copy in the wrong direction. 
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Extended Price Book Generator 
The Extended Price Book Generator is a separately purchased option that greatly expands the 
ability of PrintSmith to generate a price list for any part of the pricing system. The standard Price 
Book Generator, part of every PrintSmith system, is limited to generating price lists only for printing 
and only in a preset format. The Extended Price Book Generator is capable of maintaining a 
complete, high quality manual pricing system. You can define a variety of formats, control the 
layout, and type specifications, even rounding. 

First, there can be as many different price book setups (specifications) as needed. Use the “Save 
As” command in the File menu to create a new book from an old one. Each specification is stored 
as a separate file in the Prices folder. We recommend always ending the name with “Price Book”. 

Initially, the format used by the Extended Price Book generator matches the format used by the 
Generate Price Book command. Use the Save command to make any changes to a price book 
specification permanent. The name of the currently open price book specification is shown in the 
window title. Use the Open command in the File menu to select a different price book specification. 

When the window opens, there is a list of buttons on the left side of the window. Use these buttons 
to change parts of the price book specification and you click the “OK” button to save these changes 
and close the page. The “OK” button does not permanently change the price book. Clicking on 
another page button is equivalent to clicking the “OK” button and then the page button. The 
“Cancel” button discards changes made while the “page” was open. The Save command in the File 
menu writes these changes out to the book specification file. The “Output Options” page is used to 
actually generate a price book. 

Page Format 
This option controls elements outside the price list itself like page numbering, title and sub title text. 

Page numbering and its placement on each price book page is controlled by the Page Numbers 
pop up menu. The starting page number is entered next. The page number increment tells 
PrintSmith how much to increase the page number for each page. For example, entering a first 
page number of 2 and an increment of 2 would generate even numbered pages. Page number 
prefix and suffix are added before and after the page number. Enter a space after the prefix and 
before the suffix if you want one, otherwise PrintSmith runs them together with the page number. 

Dates are controlled with the “Dates are” pop up menu. Be careful to avoid using the same position 
for both numbers and dates – you will get what you ask for. Finally, the date text itself is shown in a 
text box. Initially it will be today’s date, but you can change it to any-thing (up to sixty characters). It 
does not even have to be a date. 

Note:  If you want the date to be the current date you must erase the text in the date field before 
you save the book specification. PrintSmith only generates today’s date if this field is 
empty when the price book specification is loaded. 

The last group of options controls the text just before the list. They are either on or off. You cannot 
change the text although you can specify a finish size on the Pricing Settings page. PrintSmith will 
not show a size if it is blank so you do not have to turn it off just because you are doing envelopes. 
Likewise, “Show Machine Name” shows the copier for copier lists, the press for press lists, and 
shows nothing for blank stock lists. 
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You may position the page numbers and dates relative to the list or the page. On the displayed 
version, the bottom of the page is the same as the bottom of the list. On the printed version, the 
bottom of the page depends on the size of the paper it is being printed on, and will be different. 

List Format 
List format describes the general characteristics of the list to be generated: the number of columns, 
the column titles, unit pricing, rounding, shading and the pricing method to use.  

The first option controls how the unit price columns are grouped with the price columns. PrintSmith 
uses Unit Price Columns together as the “standard”. You can also specify “unit price next to 
column” or get rid of unit prices altogether. 

Note:  The price book supports a maximum of six columns on a page. If unit prices are 
generated, only three columns can be specified. 

Any of the five major pricing methods can be used though only one per book specification. You can 
use the same price book specification, change the pricing method, or generate another section of 
the book; but it is usually easier to set up separate price book specifications.  

Use the pricing method pop up menu to select a pricing method – they are all treated as “In Stock”. 
The next three fields define the column header text (each column has a separate title – see Column 
Settings, page 530). The exact placement of the text is determined by the List Format selection. 
The number of columns is a number from 1 to 6 (or 1 to 3 if using unit price columns). 

The unit count is used to calculate the unit price column. A 1 generates a price for each item, 1000 
generates a price per thousand and so on. Whatever you decide to use for a unit count, make sure 
that the unit column title accurately reflects it. 

Next, specify rounding and the number of decimal places for the price columns and the unit price 
columns. If the unit price is using a very small unit count (such as 1) you should add at least one 
decimal place to Unit rounding. Generally, you should have more than 2 decimal places if you 
generate a price for each item to avoid odd looking unit prices. 

The shading option allows you to specify a “screen” to be placed behind prices. Experiment and 
see what, if any, shading you like. This option is heavily dependent on the output device for its 
results. You will have to experiment with your equipment. The Show Rules button turns off line 
drawing so that just the text is printed. Shading, if enabled, is also shown. 

The Print Explanation option prints a description of the pricing method and other options as well as 
a list of the charges used for the price list below the price list. 

Quantities 
You can specify quantities for each book, or use the system default for printing that is defined in the 
Quantity Breaks Preference panel. If you want PrintSmith to generate a default set of quantities for 
you, hold down the <option>/<alt> and <shift> keys when you click the Quantities button. You can 
switch back and forth between custom quantities and the system default with the Use Default 
Quantities button. 

Note:  Put a minus sign before any quantity if you want PrintSmith to draw a line across the price 
list before that quantity. 
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Pricing Settings 
Normally, for each selected stock, the generator checks the stock to see if there is a preset press 
definition. It uses the preset press or selects the first press in the press list. The same rule applies 
to copiers. 

The Select Press button lets you override both the default press and the press selected in the stock 
definition and force all price lists to use the same press. Cancel this override by clicking the button 
and then, when the list of presses is presented for selection, clicking the Cancel button. The name 
of the selected press, if any, is shown to the right of the button. 

The price book generator will not generate a price list for a run size that is larger than the maximum 
allowed by the press. If you are printing to the screen, it will tell you what the problem is. If printing 
to a printer, it skips the stock with no notice. 

On prices lists using the copier pricing methods, the same rules apply except that the first copier in 
the list is used as the default copier when generating prices for Copier 1 and the second for Copier 
2 pricing method. The Select Copier button allows you to specify a different copier using the same 
rules as presses. 

The Add Charges feature lets you add up to twenty additional charges from any of the six charge 
definition commands (pre press, bindery, merchandise, etc.). These charges are in addition to any 
preset charges in the selected press or copier definition. Override Preset Charges option tells the 
price book generator to ignore any charges defined in the definition and only use the charges that 
you add with the Add Charges button. If you have not added any charges, enabling the Override 
Preset Charges button effectively removes all charge specifications from the generated price list. 

Any charge you add to the price list should be job aware or have a default quantity because you 
cannot change anything in any charge. They are added, “as is” and unless they are job aware will 
generate the same price at all quantity levels. Use the “Preset Info” button in the charge definition 
to set up charges that are not “job aware” with appropriate quantities. 

There are several rules to be aware of: 

• If there is no run size, the parent size is used. 

• If the parent size is smaller than the run size no list is generated. 

• If the run size is smaller than the finish size no list is generated. 

• A parent size is deemed to exist if there is a price - there does not have to be a size (needed to 
do envelopes). 

The Run Size is Finish Size option tells the generator to copy the run size to the finish size. 

The Calculate Up from Finish Size option tells PrintSmith to calculate the number of up it can run 
for a particular finish size. If the Run Size is Finish Size option is enabled, it will always be 1. This 
button should only be on if you enter a finish size. If you do not specify a finish size to use, the 
results are undefined. This option overrides the Up count you specify in column settings and will 
also do swing cuts automatically. Most of the time this should not be a big problem, but if you do 
business cards you must take care as you could get unexpected up counts. 

The Add Wash Up On Multiple Copies option automatically adds a wash up charge on each side 
for each color after the first one. The assumption is that you are running black ink as one of the 
colors and are only charging for the additional colors. A 2/2 job would add one wash up on the front 
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and one on the back. If you need something different you should set up a charge definition to 
handle it. 

Column Settings 
The Column Settings page is used to define pricing options for each defined column. Only the 
columns actually being used as specified on the List Format page are displayed. However, the 
book specification contains 6 column specifications and remembers your settings even if they are 
not being used. For each column, enter the column title, the number of colors on the front and 
back, the number of sheets (originals) and the number up. Sheets and Up must be at least 1. The 
generator may override the Up count, if you enabled the Calculate Up from Finish Size option in the 
Pricing Settings page. 

Fonts  
You have complete control over all the fonts, faces, and styles used in the price book. Each button 
represents a font setting. Click on a button, and a description consisting of the font name, size, and 
styles is displayed followed by the name of the button using that font specification. Use the Change 
Font button to change the font represented by the selected button. The default font used by 
PrintSmith is Geneva. When printed on a LaserWriter, Helvetica may replace it, if font substitution 
is turned on. Helvetica looks much better than Geneva (unless you have TrueType Geneva), but 
more importantly, the font measurements are different, even at the same point size. You will get the 
best results by using a TrueType or PostScript font and not allowing font substitution during 
printing. 

Output Options 
All these settings lead up to printing a price book. This page controls how this is done. The top part 
of the page is used to select the stocks to be included in the book. You can do a price list for all 
stocks automatically, for individually selected items, or for selected subsets of the stock list. 

The price book can be sent to the screen or the printer using the “Output to:” menu. When output is 
directed to the screen, you can still print the list using <command>+<P> on the keyboard (you 
cannot use any menu while the view window is open). When output is generated to the screen you 
get the next page of the price book by pressing the <return> key. To stop generating the list, close 
the window. If you are using “Selected Entries” you will be asked to select the next stock after each 
page. If the selected stock cannot generate a price list you will be asked to select another. 
PrintSmith will tell you why it could not generate the list when displaying the list but not when 
printing. 

When making changes to a book specification you can use Show Sample to see how it will lay out 
on the page (except that it is centered on the printed page when printed). You can use 
<command>+<P> to print the sample. You can also experiment with actual price lists by sending 
the output to the screen. Use the <return> key to go to the next list and <command>+<P> to print it 
out. Print Book starts the price list generation process and prints the each page to the selected 
output device. Note that printing to a printer will print in batches of about 10 pages although you will 
only be asked for printing instructions once. 
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Crouser Pricing 
Your Crouser Pricing system may be delivered to you in many ways; floppy diskette, E-mail, zip 
drive or CD. However the method, the installation and update instructions are the same. You must 
be running PrintSmith version 6.0.3 or newer to utilize the Crouser Pricing module. 

You will receive 4 serialized files from Crouser and Associates. The files are serialized for use on 
your PrintSmith system. The files cannot be used on any other system. Only one file can be 
installed and used in your PrintSmith system. 

Crouser XYZ is a file that contains the print pricing from all three Crouser guides X, Y and Z. The 
remaining files are for specific Crouser books exclusively. For example, the Crouser X file has 
ONLY the schedules from the “X Crouser Guide to Estimating…” 

Select the one file that you would like to use and copy that file into your Prices folder inside the 
PrintSmith folder on your Master computer. 

Note:  Windows users - if you were provided with files on CD - they may be locked which renders 
them unreadable. To make certain the files are usable - locate the Crouser file in the 
PrintSmith/Prices folder, right click on properties and un-click “Read Only”. 

It is not necessary to install the file onto a Workstation or Portable. Use the Update Pricing 
command under the Admin menu on Workstation software or Synchronize Portable command on 
Portable PrintSmith. 

1. Open the PrintSmith Folder. 

2. Copy the selected prices file into the Prices… folder on Macintosh and Prices on 
Windows. The same file works on either platform. 

Although there are currently 4 different pricing files (X, Y, Z, and XYZ), only one file should be 
installed at a time. Installing more than one file will probably open the first one alphabetically, but 
this behavior is basically undefined and unsupported. The PrintSmith system monitor can be used 
to see which file was opened. It is highly recommended to install only one file into the Prices folder. 

Using the Installed Crouser Pricing 
Once the Crouser file is installed into the Prices folder, start PrintSmith version 6.0.3 or newer. 

Viewing Crouser List Price Schedules 
In the Pricing menu of the master station, select List Price Schedules. Crouser lists are displayed. 
Use the find command to help locate the Schedule you want. You will find that the Schedule name 
comes from the Manual Price Book. For example the selected stock comes from the Bond/Offset 
section for 11” & 14” stocks that cost $15.00 per thousand in the X Crouser Guide to Estimating. 

Double click on the list or highlight the list and press the Select button or press return to open the 
selected schedule. 

List Price schedules have a Quantity on the left of the schedule and then values used to calculate a 
price from the Crouser Guide to Estimating. You can change these values however; the schedules 
cannot be copied or renamed. Any changes made to any schedule will be replaced on updates to 
Crouser Guide to Estimating. Click the Cancel or OK button to close the window. 

Note:  You can not delete any one Crouser schedule. 
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Assigning a Crouser List to a Stock 
The next step in installing Crouser Pricing into PrintSmith is to modify every stock selection that will 
be using Crouser Pricing. 

Warning: Do not replace the Stock file unless you are just beginning with PrintSmith. If you are 
using PrintSmith currently replacing the stock file will cause unexpected results. 
• Select Stock Definitions from the Pricing menu. Select the stock for which you would 

like to assign a Crouser List. 

• Click on select Schedule and a List picker window appears: 

• File the stock definition. Repeat this procedure for each stock in your system. 

• Once each Stock has an assigned schedule you are nearly ready to begin using 
Crouser Pricing. 

Note:  New users that have not used PrintSmith before may install Stock and Stock Index files 
delivered by Crouser & Associates that contain Crouser Stocks that are linked to Crouser 
Schedules. This installation allows a new user to get up and running with PrintSmith very 
quickly. 

Modifying Crouser Pricing 
If you like Crouser pricing but would like it to be 2% higher or lower you can attach a charge 
definition to your presses or stocks that can adjust the pricing by a% point. 

Create a Markup charge that has the rate of change you desire and attach it to the press definitions 
utilized in Crouser Pricing. If you like you can add a rate list to the charge that would allow you to 
change prices at varying rates and quantities. 

Variable Rate Change - This charge would add a rate of 0% from the charge to the 
corresponding rate found in the attached list and alter the Crouser List price or Job Price 
by that amount. 

Attached rate list - Simply add these charges to any job and they will adjust the Crouser 
Price accordingly. If you prefer you can add charges like this to any press or stock 
definition. 

Contacting Crouser Customer Support 
If you have questions on how to install the Crouser List or how to use List Pricing, please contact 
PrintSmith for support. If you have questions on how prices were developed or how to use the 
Crouser Guide to Estimating please contact Crouser and Associates. www.crouser.com. 

http://www.crouser.com/
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Job Tracking 

The job tracking system is extremely simple to use and requires very little setup. The system is 
designed to use a bar code reader. Although job locations can be updated manually in the job 
window, it is usually easier to use the bar code reader. When you purchase a bar code reader from 
PrintSmith, we configure it for use with PrintSmith with the user-defined locations shown in the 
Tracking Locations Preference panel. You install bar code fonts to use when generating bar codes 
on job tickets and for printing the job location bar code menu should you choose to change them. 

To add bar codes to job tickets, select the Add Tracking Bar Codes option in the Job Ticket 
Preference panel. Printing out a job ticket generates a unique bar code that identifies the job to the 
tracking system. 

PrintSmith prints a bar codes menu that supply the descriptions of the various locations and states 
that a job can be in as defined by you. These can be printed in the Job Ticket Preference panel. 

To use the bar code tracking system, scan the job bar code and one of the status bar codes. 
PrintSmith uses this information automatically. A successful scan is shown below. 

If the update is processed successfully, the Invoice status as shown in the POS Status window is 
also updated in addition to the job status. You must use the bar code reader to enter any 
information in this window. Closing the window without completing a scan cancels the update. 

Methods of Job Tracking 
PrintSmith supports several methods for updating job and invoice location. 

• Manual updating in the job window. 

• Manual updating in the POS Location window. 

• Scanning with Bar Code reader attached to a Workstation. 

Depending upon the method you choose there are slight differences in the process as described 
below. In general you’ll need to: 

1. Define locations in the Tracking Locations preference panel. If you choose to do 
manual updates then step 1 is all that is necessary. If you choose to implement either 
bar code reader then you will need to follow these next steps. 

2. Install Carolina code 39 bar code fonts that can be purchased from PrintSmith. Install 
the font on every workstation that will print job tickets.  

3. Select the font and enable Add Tracking Bar Codes in the Job Ticket preference 
panel. Then print the Bar Code font location sheet to use when updating jobs. 

4. Update prices on all workstations. If using a custom job ticket you will need to add a 
formula using the bar code tracking field and update that report on all workstations. 

5. If using the Symbol Modified Palm Pilot you will need to review Palm Tracker 
preference panel and synchronize the location log with your Palm Pilot. 

6. Print job tickets with Bar Code information.  
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Now that you have a job ticket with bar code information updating jobs is a simple 2 step operation 
and the steps can be in any order. 

1. Scan the job ticket bar code. 

2. Scan the location sheet with the appropriate location. 

If using the bar code reader the job status window will appear and you can see the update 
occurring. If using the symbol modified palm pilot the locations will be updated the next time you 
synchronize the system with PrintSmith. 

There are a variety of reporting mechanisms for locations. The pending document window reports 
the last scanned location per invoice. The location window in the pending document window reports 
the location of each job. 

Various work in progress reports report and can sort on location. The Work In Progress –Press 
Schedule report type sorted by Location uses the data collected in this manner to maintain a 
current list of each jobs location. Also many custom reports using the Report Writer report on job 
location. 
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Palm Tracker 
The PrintSmith Palm Tracker SPT 1550 is a handheld device. This optional hardware device will 
help you track jobs quickly in your shop enabling you to have accurate and timely location 
information on all of the jobs in your operation. 

The first part of this document describes the product options and their use. The next part of the 
document describes the installation of HotSync software that is necessary to transfer data from the 
handheld device to PrintSmith software. The HotSync software can be installed on any Windows or 
Macintosh machine that you plan on using as a PrintSmith workstation with a HotSync connection. 
Installing HotSync is followed by a discussion on setting up your handheld device. Once you have 
your handheld device configured you will need to set up PrintSmith software to accept this valuable 
information. 

Note: The PrintSmith Palm Tracker has been discontinued, though the functionality is still 
supported. 

Product Options 
The following table lists products and their associated descriptions. Most of these items are 
available from PrintSmith. 

Table 9.1: Palm Tracker Options 
Product Description 

  

SPT 1500 (Handheld) This Symbol Modified Palm Pilot is different from the popular Palm Pilot in that it 
has a bar code reader integrated into the unit. However, this product like all Palm 
Computing products uses the Palm OS software. The SPT 1500 has 2 MB of ram. 
Adding software to the device takes up available RAM. You can check available 
RAM by selecting Applications and then from the Menu command select Info to 
display Free Memory. 

HotSync Cradle This optional device allows a user to place their handheld into the Cradle and per-
form a HotSync operation at the touch of a button. Available for purchase are single 
cradles or four slot cradle attachments. 

HotSync Cable The optional serial cable allows for connection to the host computer using the 
HotSync application installed on your SPT 1500. If you plan on using the 
Ruggedized boot then you will prefer this option to the Cradle. This cable connects 
to the device easily with the device in the boot where as the device must be 
removed from the boot to connect to a cradle. 

Macintosh Adaptor The Cradle and the Cable connect to a 9 pin serial cable. Macintosh serial 
connections (modem or printer port) require this adaptor to the 9 pin configuration. 

USB Adaptor If you’re using a Windows or Macintosh computer with USB connections you can 
purchase a device like “Keyspan USB to Serial Adaptor” to connect directly from a 
USB port to the cable or cradle options. http://www.keyspan.com 

Ruggedized boot The handheld device is relatively fragile. Theoretically, it can survive a drop from 1 
foot high one time only. Nestled in the boot it can survive repeated drops from less 
than one foot, in theory. In a rugged shop environment the boot provides added 
insurance. 

PrintSmith CD The conduit and “.prc” files required to run Palm Tracker are supplied on the CD. 
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The table lists typical options for using the PrintSmith Palm Tracker. The SPT 1500 is based upon 
the Palm OS software. As a result there are many other, atypical, applications for the Symbol 
Handheld device. For example, games, modems, business applications, E-mail software and other 
products are available for the device. Visit http://www.palm.com for optional items for your Palm 
Tracking device. 

Installing Software 
Palm Desktop organizer software developed by 3Com’s Palm computing division can be found at 
http://www.palm.com. 

After Palm Desktop organizer software is installed you will need to run a PrintSmith Palm Tracker 
installer to place PrintSmith specific files on your computer. Specifically the installers will put a 
Conduit file that translates scanned Palm Tracker data for use in PrintSmith. 

Decide which computer or computers will serve as HotSync stations and install the Palm Desktop 
software on those computers. 

Palm Tracker 
1. Locate the CD Extras folder on the PrintSmith CD provided. In that folder you will find 

a folder called “Palm Tracker” that is different than the “Palm Desktop” folder that has 
installation software for both Macintosh and Windows. Open the Palm (Mac) folder to 
reveal the following. 

2. Double click on the Palm Tracker installer. 

3. Click on install to continue. Upon installation of the conduit you will be presented with 
a message like the following. 

4. Click OK to continue and then Quit the installer. 

5. Locate and open the Palm folder on your computer. Double Click on HotSync® 
Manager to ensure that HotSync is “Enabled” and select Enable HotSync software at 
system startup to ensure that HotSync operations are simple and easy. 

6. From the User menu select current palm user. This name is usually drawn from the 
computer at installation. The name is provided to the SPT unit the first time it is 
synchronized with HotSync. If you want to rename the handheld device you can 
perform a hard reset and start the process over again. If the name is acceptable click 
OK and move on to installation of PrintSmith Palm Tracker software. If you desire, 
you can have many devices that synchronize at a single station. To enable multiple 
users select Show Palm User List from the Users menu command. Click on New 
Palm User and enter a new user name. 

If you elect to have multiple users you should visit the Conduit settings for each user, as their 
settings can be unique. 

http://www.palm.com/
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Install Palm Tracker Software 
1. Select Install from the HotSync menu command. 

2. Click on install. Then click on Add to List and locate the Palm (Mac) folder on the 
PrintSmith CD. 

3. Select the PalmTracker.prc and click on add File. 

When you perform your next HotSync the Palm Tracker software will be installed on your handheld 
device. If you have more than one handheld device you will need to install Palm Tracker software 
on each device. 

To change or select Users for Installation select the appropriate command from the User menu in 
HotSync manager. 

Note:  If you are not installing Windows Desktop software continue to PrintSmith Preference 
Settings. 

Windows 
1. Locate and open the Palm folder on your hard drive. Double Click on palm.exe to 

display the Palm Desktop opening window. 

2. Select Setup from the HotSync menu. 

3. Ensure that HotSync is “Always Available” at system startup to ensure that HotSync 
operations are simple and easy. Click on the Install button in the main window or 
select Install from the View menu to display the install tool. 

4. Click on Add and navigate to the PrintSmith CD extras folder. In that folder you will 
find a folder called Palm (Win). In that folder is a file called PalmTracker.prc. Select 
the PalmTracker.prc and click on Open. 

5. Click the Done button and when you perform you next HotSync the Palm Tracker 
software will be installed on your handheld device. If you have more than one 
handheld device you will need to install Palm Tracker software on each device. 

To change or select Users for Installation select the appropriate command from the Tools menu in 
Palm Desktop software. 

Setting up your Handheld Device 
Perform a HotSync to install the PrintSmith Palm Tracker and then continue to preference settings. 
With the device in the Cradle click on the HotSync button. If the device is connected via serial cable 
select the HotSync application on the device and select Local Sync. 

During the HotSync you will identify the user to the device. This names the device on the first Sync. 
After that initial name you will no longer need to select a user. 
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Defining PrintSmith Preference Settings 
1. From PrintSmith main menu, select the Admin>Preference. Select the Tracking 

Locations panel. Enter up to 200 different locations. (A sample set of locations has 
been configured in your PrintSmith system.) Click OK to save your changes. 

2. Locate and click on the Job Ticket panel. 

3. Enable Add Tracking Bar code so that all job tickets at this workstation will print bar 
codes on each job ticket. 

4. Click on Set Bar Code Font and select C39HrP24DmTt as the default font for 
Windows or Macintosh computers. 

5. Click OK to save your changes. 

6. Click on Print Bar Codes to produce a Location chart with the named location and 
corresponding bar code for scanning locations. 

7. Locate and click on the Palm Tracker panel. 

8. Click on User Palm Pilot tracking to enable that feature as shown above. 

9. Click on Browse and locate the HotSync application in the Palm folder installed on 
your computer. When you select the HotSync application PrintSmith learns the path 
and will create a folder called Palm Tracker Data in the Users folder and create a 
location file. Any-time that you make changes to the Tracking Locations you should 
create a new location file. 

10. Set the polling interval to the time frame that you’d like PrintSmith to check for 
updated information transferred from the handheld. The default setting is 60 seconds.  

11. Click to create a location file. (This is an optional step. When you select Browse 
PrintSmith creates a location file for transfer to the handheld. 

12. Click OK to save your changes. 

Using the Palm Tracker 
Please review the Quick Reference Guide (QRG) for the Symbol SPT 1500 that came with your 
handheld for instructions on using that device. 

Now that you have installed Palm Desktop software, the conduit for Palm Tracker, and the 
PalmTracker.prc file, you are ready to start using this device. 

Put the device in the Cradle or attach to the serial cable and perform a HotSync operation. Once in 
the Cradle, press the HotSync button. 

If you are connected to the device by cable, select the application HotSync on your handheld 
device. Then select Local HotSync to update your handheld and PrintSmith.  This HotSync 
provides the device with PrintSmith location information. 
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Now you are ready to scan job tickets and update locations. 

1. Select the Palm Tracker application on your handheld.  

2. Point the laser device at a job ticket bar code and click on one or both of the Green 
scan buttons on your handheld. Never point the laser device at anyone’s eyes. It may 
cause damage. 

3. When you hear a simple beep you will see the document and job information on your 
screen. The detail view of a scan log entry automatically appears when the scan 
button is pressed on the SPT 1500. 

4. Now scan a location from the printed location list and you will return to the scan log 
list. Otherwise, press the Return To Log List button to exit from the detail view and 
return to the scan log list. 

The process is always the same; scan the job ticket first followed by a location. The location can be 
scanned or repeated from previous entry.  

If you make a mistake you can click on the bad entry and then click on the Menu command and 
delete log item or simply re-scan the job ticket. If you scan a job with location A for example and 
then scan the job again in location B. PrintSmith ignores the first scan and updates the job in 
location B. If a job is no longer on the pending list PrintSmith ignores the location update. 

If you plan on scanning several job tickets that have the same location, you will appreciate the 
optional detail view. When performing multiple scans, back to back, the last scanned location can 
be repeated by pressing the Repeat button. 

When you have scanned all the Job tickets perform a HotSync. 

At the next polling interval PrintSmith will update the locations of the jobs scanned. 

Use the Pending Document window from the POS command to view locations of Invoices and jobs. 
Also available is a Work In Progress report Press Definitions sorted by Location that provides job 
tracking information. 

Set your preference for location update polling to 10 seconds and watch the information change on 
screen in the pending document window. Make sure you have made location visible in your 
Pending list preferences. 
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Troubleshooting Problems 
Your device was delivered with a Quick Reference Guide (QRG) please review that document to 
answer most of your questions. 

Table 9.2: Palm Tracker Troubleshooting 
Problem Solution 

  

Device Will Not HotSync HotSync not installed or not active. Check to see if Palm folder contains 
HotSync application. If application is present, check settings to enable 
HotSync. Otherwise install Palm Desktop Software on the selected computer. 

Device Will Not HotSync Remove the device from the Cradle and replace on the Cradle to reset the 
connections and try HotSync again. 

??? Appears On Handheld 
In Location field. 

Create a new location file and HotSync your handheld. 

Bad Scans Position the handheld closer or further away from the bar code until a good 
scan is achieved. 

Laser Will Not Operate Check the condition of the batteries using Symbol Scan Info. This application 
presents a battery indicator for the Bar Code reader that is different from the 
indicator for the handheld device. Replace batteries if necessary. 

Memory Full HotSync to transfer data and or eliminate unnecessary applications, i.e. 
games. 

  

 

Performing a Hard or Soft Reset 
See the Quick Reference Guide (QRG) for the Symbol SPT 1500 that came with your product. If 
you would like to reset the device and start the installation process over again use the Hard Reset 
to put the device back to factory settings. 
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Power User Tips 
Table 9.3: Palm Tracker Power User Tips 

Tip Instructions 
  

Use A Built In (Physical) Device Button To 
Open Palm Tracker Software. 

Select Preference application. Select But-tons preference and 
set one or all buttons to open Palm Tracker. 

Use Last Scan In History PrintSmith saves the last scan at Pickup and locks it in history 
use this tool to verify that jobs are being scanned complete and 
marked ready for pickup. 

Have Multiple Devices At Any One 
Machine. 

Set up User profiles in HotSync application to accommodate 
multiple devices being Hot Synced at the same machine. 

Hook Up Cradles At Many Machines Add cradles to computers throughout the shop. Add all users to 
all computers and update locations with greater frequency and 
ease. 

Provide All Of Your Staff Palm Tracking 
Devices 

With the software that comes with the Palm Pilot each person 
could have an electronic to do list, share data with each other, 
have contact listings, calendar of activities and fund fun. 

Update Locations On Multiple Devices Create location file from PrintSmith Palm preference panel. 
Open the Palm folder on your computer and then open the Palm 
Tracker folder and copy “locations.txt” to the desktop. HotSync 
the first handheld and then copy the “locations.txt” back into the 
Palm Tracker folder. 

  
 



EFI PrintSmith 7.2 |  Reference Guide 

 
 

 
Page 542 

Integrated Credit Card Processing 
Processing credit card transactions with PrintSmith is a simple as swiping a card or typing a credit 
card number. Setting it up will take some time and may require you to select a different merchant 
service processor. 

Credit Card integration is a system comprised of features in PrintSmith, plus third party software 
that takes the information collected by PrintSmith and completes the processing of the credit card 
transaction. It affects all areas in PrintSmith that deal with credit cards, from the Cash Register and 
Post Payments to Daily Closeout. The optional credit card system is comprised of the following 
elements: 

• PrintSmith - Product Activation Preference Panel for enabling the optional interface. 

• PrintSmith - Credit Card Info Preference Panel for configuring the integration. 

• PrintSmith - Credit Card Manager for collecting credit card transaction information 

• Magnetic Card Reader (optional) for “swiping” credit cards and a Receipt Printer (optional) for 
printing receipts for customer signature. 

• PrintSmith - Credit Card Approval for manually processing credit card data when you can’t 
swipe a card. 

• Credit Card Processing Software - third party software that can communicate with PrintSmith 
and perform the actual processing of the credit card transaction. 

Although the ability to process cards in PrintSmith is completely independent of the platform on 
which you are running PrintSmith, the processing software that is supported runs only on the 
Windows platform. While you won’t need a Multi-User version of PrintSmith to use this feature, you 
will have to be able to share a folder on the machine running the Credit Card Processing software. 
There are a wide variety of ways in which this can be accomplished: Windows Peer to Peer, or if 
you operate a Macintosh master then PC MacLan, Dave and other third party utility packages 
allows virtually any Macintosh to connect to a Windows machine. It is also possible to run the 
software on your Windows master and use a folder on that machine. 

For security reasons, credit card numbers are rarely, if ever, displayed in their entirety. We encrypt 
the numbers as soon as they are entered into PrintSmith and we store them on disk in encrypted 
form. Un-encrypted numbers are only used when the card data is sent for processing. 

Note:  The machine that runs the Credit Card software should make full use of Security 
measures to protect this un-encrypted information especially if connected to the Internet. 

In addition to an upgrade in PrintSmith, an optional third party credit card system purchased 
through PrintSmith is only available in the United States at this point in time. This system 
communicates the credit card transaction to a third party vendor via the Internet or a modem. 
Conceptually, the system is very simple. WorkStations collect credit card information and pass it to 
the PrintSmith Master. The Master sends it to the Credit Card Processing software, which sends it 
out using either a dedicated modem or an always-on Internet connection. It returns the results of 
processing the transaction (an approval code or reason for rejection) to the Master which routes it 
back to the requesting Workstation. 
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There are two basic ways in which a credit card transaction can be approved: 

• Using a modem, communicate via dial up, which has a response time of 10 to 100 seconds. 
This is about the same time it takes for a credit card transaction to process through external 
credit card machines. 

• Using an Internet on-line connection provides a much faster response time of from one to 10 
seconds. 

This optional module is set up in 2 distinct steps; the first step configures PrintSmith for these 
transactions while the second step configures the 3rd party software for Credit card processing. 
Both procedures need to be completed prior to use. 

Configuring PrintSmith for Credit Card Approval 
You will need to contact PrintSmith or your reseller to purchase this optional module. When you 
purchase this system you’ll be given an Activation code that is unique to your system. When you 
enter this code in the Product Activation preference panel, you will have access to Credit card 
features: Credit Card Manager Credit Card activation in the Credit Card preference panel. 

PrintSmith has selected (2) vendors of credit card approval software for direct integration. If you 
license this optional software, you’ll be able to automatically and completely manage credit cards 
whether the card is swiped, you enter the data manually, or your customer specifies the credit card 
payment in PrintSmith Site. After you’ve decided to implement credit card processing, you must 
select which Credit Card Processing Software package to utilize. 

Selecting the Processing Software 
We offer two packages: Supercharge and Payment Resources. Each package has different prices, 
capabilities, and requirements. 

Note:  Additional information can be found for Supercharge at http://www.super-charge.com/ and 
for Payment Resources at http://www.paymentresource.com/.  

Purchasing a License 
Once you have selected the package you wish to use, contact PrintSmith. We will either send you 
the paperwork you’ll need to get started or put you in contact with the vendor to get it set up. 

Installing the Software 
The instructions for installing and configuring this software vary with the vendor. You should follow 
the instructions that come with the package. 

Configuring the Software 
After installing the software, the software must be configured, merchant accounts must be set up 
and the system tested and verified to work correctly. Once that has been completed, you can 
proceed with establishing the connection to PrintSmith to complete the installation. 
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Integrating with PrintSmith 
PrintSmith communicates with both packages the same way, via a shared folder. Outgoing 
transactions are placed in that folder and incoming responses are retrieved from the same location. 
We can help you configure this folder using the selected credit card software. Depending on the 
operating system you use on the master and the machine running the credit card software, you 
may need to purchase a utility to support sharing folders.  

Supercharge 
The process for implementation using Supercharge software is as follows: 

1. Download evaluation software from their web site http://www.super-charge.com/ 

Warning: PrintSmith integrates with evaluation software but no processing occurs. 
Therefore, do not process any “real” transactions using the evaluation software. 

2. Select a Merchant Service Processor. Obtain current list from Supercharge. 

3. Obtain new merchant number for Visa/Master card. If you have an American Express 
or Discover/Novus merchant number, continue using those merchant numbers. 

4. When you get your merchant account you’ll also get Telephone authorization 
numbers. Additionally, you’ll need to get Modem Authorization telephone numbers 
and a 12 digit merchant account number. 

12 digit merchant account # 

Chain number - usually 6 digits 

Bank id number 

Terminal ID # - usually 001 

5. Call Supercharge for an activation code after you have all the necessary numbers. 
Payment for the software is required at this time. Consider the options of purchasing 
or renting the software and using Modem or Internet connectivity.  

Note:  Internet connectivity is the recommended solution. 
Once you have PrintSmith enabled for Credit Card processing, Supercharge software installed and 
configured with your merchant accounts, and the communication process tested with Supercharge, 
you are ready to integrate with PrintSmith as follows: 

1. Start SuperCharge server application. 

2. Start ASCII gateway application. 

3. Start SuperCharge client. 

Note:  As this application handles credit card processing, you will want to consider 
security of this software and all information handled by it and PrintSmith. Most 
likely this computer will be always used for processing credit card information 
and you should consider putting shortcuts to the 3 applications in the start folder. 

4. Within the Supercharge folder is a folder called “drop”. Enable sharing of that folder if 
the PrintSmith Master is on a different machine. 

5. In PrintSmith, Credit Card Info Preference panel, indicate the location of that shared 
folder and activate Credit Card approval processing. 
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Payment Resources International (PRI) processing: 
The process for implementation using PRI software is as follows: 

1. Download application form from their web site http://www.paymentresource.com/ 

2. Complete and return application form to PRI. 

3. Obtain new merchant number for Visa/Master card. If you have an American Express 
or Discover/Novus merchant number then you will be able to continue using those 
merchant numbers. 

4. When you get your merchant account you’ll also get Telephone authorization 
numbers. In addition to that you’ll need to get Modem Authorization telephone 
numbers and a 12 digit merchant account number. 

12 digit merchant account # 

Chain number - usually 6 digits 

Bank id number 

Terminal ID # - usually 001 

5. Download Microsoft.NET software from http://www.microsoft.com/net/ 

6. Install.NET and necessary service pack updates. 

7. Restart computer. 

8. Download PRI Gateway and install on your computer. 

9. Start PRI software and indicate location of drop folder. You’ll get an E-mail from PRI 
indicating your account status. 
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Using Integrated Credit Card Processing 
Throughout PrintSmith you will be able to enter credit card information. For example while in the 
Cash Register window you click on the credit card icon or swipe a card to enter payment 
information. 

Entering Payments 
There are three places where credit card payments are entered: Invoice Deposits, Cash Register 
and Post Payments. The process of entering a credit card varies somewhat depending on where, in 
PrintSmith the payment is being entered. 

1. Click the Pickup button for an invoice in the pending list, or select a customer 
account in the Cash Register. 

2. If the card is available and you have a card reader, swipe the card. 

OR 

If the card is not available, select CR Card payment method, click the credit card icon 
that appears and manually enter data. 

3. Wait for processing to complete. 

Automatic Credit Card Approval 

If you swipe a credit card using a magnetic card reader when the credit card payment method is 
selected, the information is passed directly to the integrated system for processing. 

If approved, the approval code is placed in “Ref#” and the payment is added to the transaction. If 
declined or not completed, a message appears with the reason for declining or not processing the 
card. 

Note:  Credit card hardware items are available from PrintSmith. Call today or visit our on line 
store www.printsmith.com. 
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Manual Credit Card Approval 

The Credit Card Approval window captures information about the credit card used in the sale and 
passes it on to the optional integrated credit card processing system. If the card and/or a magnetic 
stripe reader are not available, manually enter the credit card information. 

The rules for entering data in this window are as follows: 

Card Number Enter the number of the credit card with no spaces or hyphens. It must be a 
card type that has been set up in the Credit Card Preference Panel. 

Card Status Provides information on problems with the data in this window. When all 
fields are filled in correctly, this changes to the name of the card. 

Card Holder Enter the name from the credit card. 
Expires This is the expiration date. Enter this date as MMYY. 
Amount The amount to be charged to the card. Often, this field will already be set 

and in some cases, the amount can’t be changed. 
Order Number Generally this is the invoice number being charged. 
Street The street address of the card holder’s account. This data is optional but 

sometimes results in a better rate when supplied with the transactions. 
Zip The zip code is also optional and is used much like the street address, as an 

additional verification tool. 
Verbal Auth# Enter the verbal authorization number provided by merchant when required. 
Verbal Auth Date Automatically recorded date when a Verbal Authorization number is entered. 
Verbal Auth Time Automatically recorded time when a Verbal Authorization number is entered. 

 

Note:  If the Credit Card Approval window is open when a card is swiped, most of the fields in 
this window will be populated with information from the card swipe. 

If the card was swiped then the process automatically starts. If the card information was manually 
entered then clicking OK starts the authorization process. 

 

Credit Card Manager 

This command is only available when the Credit Card Processing system is enabled. See Credit 
Card Info preference panel on page 465 for instructions. The Credit Card Transaction Manager 
displays all credit card transactions since the last Daily Closeout. This applies to transactions 
entered manually or with the optional credit card magnetic stripe reader. Transactions can be 
viewed or voided. Voids performed in this window do not affect the transactions listed on the cash 
register tape, but are transmitted to the credit card processing system. 
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Current 
The Current tab lists the current transactions. These transactions are cleared during a daily 
closeout. The entries in the list are color coded as follows: 

Table 9.4: Transaction Color Codes 
Color Definition 

  

Green Active/Pending Transactions (data has been sent and awaiting a response) 

Red Credits and Reversals 

Pink Canceled, Declined, and/or Incomplete Transactions 

Black Processed and Approved Transactions 
  

 

This window provides a centralized listing of all credit card transactions processed through the 
system since the last daily closeout for review or trouble shooting and is available at all 
Workstations. The controls at the top of this window implement the functions available as follows: 

Print Prints a listing of all the transactions. The data is not retained when the closeout is 
performed. 

Refresh Updates the report since the report is a snapshot of the current state of credit card 
transactions. 

Void If necessary, you can void a transaction manually by selecting it and clicking this 
button. Note that voiding transactions in this manner is not generally recommended 
because it does not change the register tape. Instead, you should void the 
transaction on the register tape to properly void a credit card transaction. Only 
transaction shown in Green (pending approval) can be voiced. It is used only for 
clearing “hung” transactions. 

Receipt To reprint credit card receipts you can click on a transaction and the click on 
Receipt to re-print the credit card transaction. 

Transaction Details the transaction, card type and card number. 
Amount Amount of credit card transaction. 
Status Status of transaction. 
Order # Order number. 
User User logged on at time of transaction. 
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Historic 

This tab shows all credit card transactions in reverse chronological order. It also provides more 
information on the transaction. 

Type Credit, manual or debit. 
Reference # Reference number. 
Message Message from approval system. 
Flag The last column in the Historic view. 

 

 

Table 9.5: Flag Status 
Flag Definition 

  

T Has card swipe track data. 

M Manual approval code. 

P Permanent, like in the contact record. 

A Has address supplied. 

N Address failed to match. 
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Status 

This window opens while a transaction is being processed and displays the status of the 
transaction. They will appear in a window similar to this one. The types of entries and their meaning 
are as follows: 

Table 9.6: Credit Card Transaction Statuses 
Status Definition 

  

Waiting... Active transaction waiting for approval system to give approval code 

PrintSmith Timed Out Transaction has failed because PrintSmith did not receive a response. 

Unknown Results Unrecognized response from the approval system. 

Approved Transaction was approved. The approval code is shown following the 
status. 

Declined Transaction was declined. 

Approved – No Reference 
Number 

The transaction was approved, but no approval code was generated. 
Typical on refunds. 

Declined – Expired Card Transaction was declined because the expiration date on the referenced 
credit card has passed. 

Approval System Not Ready An attempt to process a credit card was made but the system is not 
ready to handle it. 

Error In Approval System The transaction was unable to be processed, probably because of 
problems with the data in the transaction. 

Call Credit Card Center There is a problem with this card. The credit card center needs to be 
contacted - the card may be stolen or additional security checks may be 
needed to gain approval. 

Reversal Approval A previous charge has been successfully reversed. 

Approval System Timed Out Transaction failed due to a failure in the communication link between the 
credit card software and the credit card approval center. 

Cancelled By User The user in the Credit Card Transaction manager VOIDED the 
transaction. 

  

 



Chapter 9:  Options Modules 

 
 

 
Page 551 

Magnetic Card Reader 

In order to properly process credit cards if you are presented with a physical card, you’ll need a 
device for reading the cards and a receipt printer for printing the receipt that your customer will 
sign. We can supply you with pre-configured USB magnetic stripe card readers. We do not support 
card readers or receipt printers that have not been purchased from PrintSmith although they may 
work. 

Note:  Generally, you’ll get a better transaction rate for a Swiped card transaction. 
The Cash Drawer preference panel has an option for printing two receipts for each transaction. 
This is intended for use with credit cards so be sure to turn this on if you plan to be processing 
physical cards. 

Canceling Payments 

Follow these steps should the need arise to cancel a credit card transaction. 

1. Select the transaction to be cancelled in the Register Tape. 

2. Void the transaction. 

3. Credit Card processing of the cancelled transaction will start automatically. 

Refunds 

PrintSmith and the selected software outside of PrintSmith handle refunds following a daily 
closeout. You will need to have the reference number from the original transaction. 

Other Issues 

Debit Cards - cards with a Visa logo will work fine. Some Debit cards require specially configured 
terminals that are not currently supported by this software. 

PrintSmith does not directly support batch transactions; however, you can perform such operations 
using the processing software outside of PrintSmith. 

Receipt Format 

The credit card receipt has information on it that is useful when processing a void, return or to 
search the Credit Card database. 
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